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ix

 This book was written from course materials compiled over many years of 
training in analytical courses in Australia and globally—most frequently 

courses such as Financial Modelling in Excel, Data Analysis & Reporting in 
Excel, and Budgeting & Forecasting in Excel, both as face‐to‐face workshops 
and online courses. The common theme is the use of Microsoft Excel, and I’ve 
refi ned the content to suit the hundreds of participants and their questions over 
the years. This content has been honed and refi ned by the many participants 
in these courses, who are my intended readers. This book is aimed at you, the 
many people who seek fi nancial analysis training (either by attending a seminar 
or self‐paced by reading this book) because you are seeking to improve your 
skills to perform better in your current role, or to get a new and better job. 

 When I started fi nancial modelling in the early nineties, it was not called 
fi nancial modelling —it was just “using Excel for business analysis,” and this is gg
what I’ve called this book. It was only just after the new millennium that the 
term  fi nancial modelling  gained popularity in its own right and became a re-g
quired skill often listed on analytical job descriptions. This book spends quite a 
bit of time in Chapter   1   defi ning the meaning of a fi nancial model, as it’s often 
thought to be something that is far more complicated than it actually is. Many 
analysts I’ve met are building fi nancial models already without realising it, but 
they do themselves a disservice by not calling their models, “models”!

 However, those who are already building fi nancial models are not nec-
essarily following good modelling practice as they do so. Chapter   3   is dedi-
cated to the principles of best modelling practice, which will save you a lot 
of time, effort, and anguish in the long run. Many of the principles of best 
practice are for the purpose of reducing the possibility of error in your mod-
el, and there is a whole section on strategies for reducing error in Chapter   4  . 

 The majority of Excel users are self‐taught, and therefore many users will 
often know highly advanced Excel tools, yet fail to understand how to use 
them in the context of building a fi nancial model. This book is very detailed,
so feel free to skip sections you already know. Because of the comprehensive 
nature of the book, much of the detailed but less commonly used content,
such as instructions for the older Excel 2003 users, has been moved to the 
companion website at  www.wiley.com/go/steinfairhurstrevised . References

                                                                  Preface         Preface

http://www.wiley.com/go/steinfairhurstrevised
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to the content on the website, and many cross‐references to other sections of 
the book, can be found throughout the book.   

BOOK OVERVIEW 

This book has 12 chapters, which can be grouped into three sections. Whilst 
they do follow on from each other with the most basic concepts at the be-
ginning, feel free to jump directly to any of the chapters. The fi rst section—
Chapters   1   to 3—addresses the least technical topics about fi nancial model-
ling in general, such as tool selection, model design, and best practice. 

 The second section—Chapters   4   to 8—is extremely practical and hands‐
on. Here I have outlined all of the tools, techniques, and functions in Excel 
that are commonly used in fi nancial modelling. Of course it does not cover 
everything Excel can do, but it covers the “must‐know” tools. 

 The third section—Chapters   9   to 12—is the most important in my view. 
This covers the use  of Excel in fi nancial modelling and analysis. This is really 
where the book differs from other “how‐two” Excel books. Chapter   9   cov-
ers some commonly used techniques in modelling, such as escalation, tiering 
tables, and depreciation—how to actually use Excel tools for something use-
ful! Chapter   11   covers the several different methods of performing scenarios 
and sensitivity analysis (basically the whole point  of fi nancial modelling to my t
mind). Last, Chapter   12   covers the often‐neglected task of presenting model 
output. Many modellers spend days or weeks on the calculations and func-
tionality, but fail to spend just a few minutes or hours on charts, formatting, 
and layout at the end of the process, even though this is what the user will see, 
interact with, and eventually use to judge the usefulness of the model.  

ACKNOWLEDGMENTS 

This book would not have been written had it not been for the many people 
who have attended my training sessions, participated in online courses, and
contributed to the forums. Your continual feedback and enthusiasm for the
subject inspired me to write this book and it was because of you that I real-
ized how much a book like this was needed. 

 The continued support of my family and network made this project 
possible. In particular, Mike, my husband, for his unconditional commit-
ment and to whom this book is dedicated; my children who give me so 
much joy; as well as my remarkable parents and siblings, who have always 
inspired and encouraged me without question. I would like to give a special 
thanks to my ever‐patient assistant Susan Wilkin for her continuing dedica-
tion and diligence, as always. I could not do it without you all. 

 I hope you fi nd the book both useful and enjoyable. Happy modelling!
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Chapter 1
What Is Financial Modelling?

There are all sorts of complicated definitions of financial modelling, and in my 
experience there is quite a bit of confusion around what a financial model 

is exactly. A few years ago, we put together a Plum Solutions survey about the 
attitudes, trends, and uses of financial modelling, asking respondents, “What do 
you think a financial model is?” Participants were asked to put down the first 
thing that came to mind, without any research or too much thinking about it. 
I found the responses interesting, amusing, and sometimes rather disturbing.

Some answers were overly complicated and highly technical:

■■ “Representation of behaviour/real‐world observations through mathe­
matical approach designed to anticipate range of outcomes.”

■■ “A set of structured calculations, written in a spreadsheet, used to analyse the 
operational and financial characteristics of a business and/or its activities.”

■■ “Tool(s) used to set and manage a suite of variable assumptions in order 
to predict the financial outcomes of an opportunity.”

■■ “A construct that encodes business rules, assumptions, and calcula­
tions enabling information, analysis, and insight to be drawn out and 
supported by quantitative facts.”

■■ “A system of spreadsheets and formulas to achieve the level of record 
keeping and reporting required to be informed, up‐to‐date, and able to 
track finances accurately and plan for the future.”

Some philosophical:

■■ “A numerical story.”

Some incorrect:

■■ “Forecasting wealth by putting money away now/investing.”
■■ “It is all about putting data into a nice format.”
■■ “It is just a mega‐huge spreadsheet with fancy formulas that are stream­
lined to make your life easier.”
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Some ridiculous:

■■ “Something to do with money and fashion?”

Some honest:

■■ “I really have no idea.”

And some downright profound:

■■ “A complex spreadsheet.”

There are many (often very complicated and long‐winded) definitions 
available from different sources, but I actually prefer the last, very broad, 
but accurate description: “a complex spreadsheet.” Whilst it does need some 
definition, a financial model can pretty much be whatever you need it to be.

As long as a spreadsheet has inputs and outputs, and is dynamic and 
flexible—I’m happy to call it a financial model! Pretty much the whole point 
of financial modelling is that you change the inputs and the outputs. This 
is the major premise behind scenario and sensitivity analysis—this is what 
Excel, with its algebraic logic, was made for! Most of the time, a model will 
contain financial information and serve the purpose of making a financial 
decision, but not always. Quite often it will contain a full set of financial 
statements: profit and loss, cash flow, and balance sheet; but not always.

According to the more staid or traditional definitions of financial 
modelling, the following items would all most certainly be classified as 
financial models:

■■ A business case that determines whether or not to go ahead with a 
project.

■■ A five‐year forecast showing profit and loss, cash flow, and balance 
sheet.

■■ Pricing calculations to determine how much to bid for a new tender.
■■ Investment analysis for a joint venture.

But what about other pieces of analysis that we perform as part of our 
roles? Can these also be called financial models? What if something does 
not contain financial information at all? Consider if you were to produce a 
spreadsheet for the following purposes:

■■ An actual‐versus‐budget monthly variance analysis that does not contain 
scenarios and for which there are no real assumptions listed.
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■■ A risk assessment, where you enter the risk, assign a likelihood to that 
risk, and calculate the overall risk of the project using probability calcu­
lations. This does not contain any financial outputs at all.

■■ A dashboard report showing a balance scorecard type of metrics report­
ing like headcount, quality, customer numbers, call volume, and so on. 
Again, there are few or no financial outputs.

See the section, “Types and Purposes of Financial Models,” later in this 
chapter for greater detail on financial models that don’t actually contain 
financial information.

Don’t get hung up on whether you’re actually building something that 
meets the definition of a financial model or not. As long as you’ve got inputs 
and outputs that change flexibly and dynamically, you can call it a financial 
model. If you’re using Excel to any extent whereby you are linking cells 
together, chances are you’re already building a financial model—whether 
you realise it or not. The most important thing is that you are building the 
model (or whatever it’s called!) in a robust way, following the principles of 
best practice, which this book will teach you.

Generally, a model consists of one or more input variables along 
with data and formulas that are used to perform calculations, make pre­
dictions, or perform any number of solutions to business (or nonbusi­
ness) requirements. By changing the values of the input variables, you 
can do sensitivity testing and build scenarios to see what happens when 
the inputs change.

Sometimes managers treat models as though they are able to produce 
the answer to all business decisions and solve all business problems. Whilst a 
good model can aid significantly, it’s important to remember that models are 
only as good as the data they contain, and the answers they produce should 
not necessarily be taken at face value.

“The reliability of a spreadsheet is essentially the accuracy of the 
data that it produces, and is compromised by the errors found in approx­
imately 94 percent of spreadsheets.”1 When presented with a model, the 
savvy manager will query all the assumptions, and the way it has been 
built. Someone who has had some experience in building models will 
realise that they must be treated with caution. Models should be used 
as one tool in the decision‐making process, rather than the definitive 
solution.

1	 Ruth McKeever, Kevin McDaid, and Brian Bishop, “An Exploratory Analysis of 
the Impact of Named Ranges on the Debugging Performance of Novice Users” 
(presented at the annual conference of the European Spreadsheet Risks Interest 
Group, Paris, France, July 2–3, 2009). Available at arxiv.org/abs/0908.0935.

http://arxiv.org/abs/0908.0935
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What’s the Difference between a Spreadsheet and a 
Financial Model?

Let me make one thing very clear: I am not partial to the use of the word 
spreadsheet; in fact, you’ll hardly find it used at all in this book.

I’ve often been asked the difference between the two, and there is a fine 
line of definition between them. In a nutshell, an Excel spreadsheet is simply 
the medium that we can use to create a financial model.

At the most basic level, a financial model that has been built in Excel is 
simply a complex spreadsheet. By definition, a financial model is a structure 
that contains input data and supplies outputs. By changing the input data, 
we can test the results of these changes on the output results, and this sort of 
sensitivity analysis is most easily done in an Excel spreadsheet.

One could argue then, that they are in fact the same thing; there is really 
no difference between a spreadsheet and a financial model. Others question 
if it really matters what we call them as long as they do the job. After all, 
both involve putting data into Excel, organising it, formatting, adding some 
formulas, and creating some usable output. There are, however, some subtle 
differences to note:

	 1.	“Spreadsheet” is a catch‐all term for any type of information stored in 
Excel, including a financial model. Therefore, a spreadsheet could really 
be anything—a checklist, a raw data output from an accounting system, 
a beautifully laid out management report, or a financial model used to 
evaluate a new investment.

	 2.	A financial model is more structured. A model contains a set of variable 
assumptions, inputs, outputs, calculations, scenarios, and often includes 
a set of standard financial forecasts such as a profit and loss, balance 
sheet, and cash flow, which are based on those assumptions.

	 3.	A financial model is dynamic. A model contains variable inputs, which, 
when changed, impact the output results. A spreadsheet might be simply 
a report that aggregates information from other sources and assembles 
it into a useful presentation. It may contain a few formulas, such as 
a total at the bottom of a list of expenses or average cash spent over 
12 months, but the results will depend on direct inputs into those col­
umns and rows. A financial model will always have built‐in flexibility to 
explore different outcomes in all financial reports based on changing a 
few key inputs.

	 4.	A spreadsheet is usually static. Once a spreadsheet is complete, it often 
becomes a stand‐alone report, and no further changes are made. A 
financial model, on the other hand, will always allow a user to change 
input variables and see the impact of these assumptions on the output.
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	 5.	A financial model will use relationships between several variables to 
create the financial report, and changing any or all of them will affect 
the output. For example, Revenue in Month 4 could be a result of Sales 
Price × Quantity Sold Prior Month × Monthly Growth in Quantities 
Sold. In this example, three factors come into play, and the end user can 
explore different mixes of all three to see the results and decide which 
reflects his or her business model best.

	 6.	A spreadsheet shows actual historical data, whereas a financial model 
contains hypothetical outcomes. A by‐product of a well‐built financial 
model is that we can easily use it to perform scenario and sensitivi­
ty analysis. This is an important outcome of a financial model. What 
would happen if interest rates increase by half a basis point? How much 
can we discount before we start making a loss?

In conclusion, a financial model is a complex type of spreadsheet, 
whilst a spreadsheet is a tool that can fulfill a variety of purposes— 
financial models being one. The list of attributes above can identify the 
spreadsheet as a financial model, but in some cases, we really are talking 
about the same thing. Take a look at the Excel files you are using. Are 
they dynamic, structured, and flexible, or have you simply created a static, 
direct‐input spreadsheet?

Types and Purposes of Financial Models

Models in Excel can be built for virtually any purpose—financial and non­
financial, business‐related or non‐business‐related—although the majority 
of models will be financial and business‐related. The following are some 
examples of models that do not capture financial information:

■■ Risk management: A model that captures, tracks, and reports on project 
risks, status, likelihood, impact, and mitigation. Conditional formatting 
is often integrated to make a colorful, interactive report.

■■ Project planning: Models may be built to monitor progress on projects, 
including critical path schedules and even Gantt charts. (See the next 
section in this chapter, “Tool Selection,” for an analysis of whether 
Microsoft Project or Excel should be used for building this type of project  
plan.)

■■ Key performance indicators (KPIs) and benchmarking: Excel is the best 
tool for pulling together KPI and metrics reporting. These sorts of statis­
tics are often pulled from many different systems and sources, and Excel 
is often the common denominator between different systems.
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■■ Dashboards: Popularity in dashboards has increased in recent years. 
The dashboard is a conglomeration of different measures (sometimes 
financial but often not), which are also often conveniently collated and 
displayed as charts and tables using Excel.

■■ Balanced scorecards: These help provide a more comprehensive view 
of a business by focusing on the operational, marketing, and develop­
mental performance of the organisation as well as financial measures. 
A scorecard will display measures such as process performance, market 
share or penetration, and learning and skills development, all of which 
are easily collated and displayed in Excel.

As with many Excel models, most of these could be more accurately cre­
ated and maintained in a purpose‐built piece of software, but quite often the 
data for these kinds of reports is stored in different systems, and the most 
practical tool for pulling the data together and displaying it in a dynamic 
monthly report is Excel.

Although purists would not classify these as financial models, the way 
that they have been built should still follow the fundamentals of financial 
modelling best practices, such as linking and assumptions documentation. 
How we classify these models is therefore simply a matter of semantics, and 
quite frankly I don’t think what we call them is particularly important! Going 
back to our original definition of financial modelling, it is a structure (usually 
in Excel) that contains inputs and outputs, and is flexible and dynamic.

Tool Selection

In this book we will use Excel exclusively, as that is most appropriate for the 
kind of financial analysis we are performing when creating financial models. 
We often hear it said that Excel is the “second‐best solution” to a problem. 
There is usually a better, more efficient piece of software that will also pro­
vide a solution, but we often default to the “Swiss army knife” of software, 
Excel, to get the job done. Why do many financial modelling analysts use 
Excel almost exclusively, when they know that better solutions exist? At 
Plum Solutions, our philosophy is also one of using only “plain‐vanilla” Ex­
cel, without relying on any other third‐party software, for several reasons:

■■ No extra licences, costly implementation, or software download is required.
■■ The software can be installed on almost any computer.
■■ Little training is needed, as most users have some familiarity with the 
product—which means other people will be able to drive and under­
stand your model.



What Is Financial Modelling?� 7

■■ It is a very flexible tool. If you can imagine it, you can probably do it in 
Excel (within reason, of course).

■■ Excel can report, model, and contrast virtually any data, from any 
source, all in one report.

■■ But most important, Excel is commonly used across all industries, 
countries, and organisations, meaning that the Excel skills you have are 
highly transferable.

What this last point means to you is that if you have good financial mod­
elling skills in Excel, these skills are going to make you more in demand— 
especially if you are considering changing industries or roles or getting a job 
in another country. In fact, one of the best things you can do for your career 
is to improve your Excel skills. Becoming an expert developer on a propri­
etary piece of software is useful, but becoming a highly skilled Excel expert 
will stand you in good stead throughout your career.

Excel has its limitations, of course, and Excel’s main downfall is the ease 
with which users can make errors in their models. Therefore, a large part of 
financial modelling best practice relates to reducing the possibility for errors. 
See Chapter 3, “Best Practice Principles of Modelling,” and “Error Avoidance 
Strategies” in Chapter 4 for details on errors and how to avoid them.

The other issue with using Excel is capacity; we simply run out of rows, 
especially in this “Age of Big Data.” Microsoft is trying to keep Excel relevant 
by introducing Power Pivot, which is a free add‐in that is part of your Excel 
licence if you are using Excel 2010 or above. Power Pivot can handle much 
bigger data than plain Excel, which gets around Excel’s capacity limitations.

Is Excel Really the Best Option?

Before jumping straight in and creating your solution in Excel, it is worth 
considering that some solutions may be better built in other software, so 
take a moment to contemplate your choice of software before designing a 
solution. There are many other forms of modelling software on the market, 
and it might be worth considering other options besides Excel. There are 
also a number of Excel add‐ins provided by third parties that can be used 
to create financial models and perform financial analysis. The best choice 
depends on the solution you require.

The overall objective of a financial model determines the output as well 
as the calculations or processing of input required by the model. Financial 
models are built for the purpose of providing timely, accurate, and mean­
ingful information to assist in the financial decision‐making process. As a 
result, the overall objective of the model depends on the specific decisions 
that are to be made based on the model’s output.
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As different modelling tools lend themselves to different solutions or 
output, before selecting a modelling tool it is important to determine pre­
cisely what solution is required based on the identified model objective.

Evaluating Modelling Tools

Once the overall objective of the model has been established, a financial 
modelling tool that will best suit the business requirements can be chosen.

To determine which financial modelling tool would best meet the 
identified objective, the following must be considered:

■■ The output required from the model, based on who will use it and the 
particular decisions to be made.

■■ The volume, complexity, type, and source of input data—particularly 
relating to the number of interdependent variables and the relationships 
between them.

■■ The complexity of calculations or processing of input to be performed 
by the model.

■■ The level of computer literacy of the users, as they should ideally be able 
to manipulate the model without the assistance of a specialist.

■■ The cost versus benefit set off for each modelling tool.

As with all software, financial modelling programs can either be pur­
chased as a package or developed in‐house. Whilst purchasing software as a 
package is a cheaper option, in a very complex industry, in‐house develop­
ment of specific modelling software may be necessary in order to provide 
adequate solutions. In this instance, one would need to engage a reputable 
specialist to plan and develop appropriate modelling software.

Which package you choose depends on the solution you require. A data­
base or customer relationship management (CRM) data lends itself very well 
to a database, whereas something that requires complex calculations, such 
as those in many financial models, is more appropriately dealt with in Excel.

Excel is often described as a band‐aid solution, because it is such a flex­
ible tool that we can use to perform almost any process—albeit not as fast 
or as well as fully customised software, but it will get the job done until a 
long‐term solution is found: “Spreadsheets will always fill the void between 
what a business needs today and the formal installed systems.”2

2	 Mel Glass, David Ford, and Sebastian Dewhurst, “Reducing the Risk of Spread­
sheet Usage—A Case Study” (presented at the annual conference of the Europe­
an Spreadsheet Risks Interest Group, Paris, France, July 2–3, 2009). Available at 
arxiv.org/abs/0908.1584.

http://arxiv.org/abs/0908.1584
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Budgeting and Forecasting

Many budgets and forecasts are built using Excel, but most major general 
ledger systems have additional modules available that are built specifically 
for budgeting and forecasting. These tools provide a much easier, quicker 
method of creating budgets and forecasts that is less error‐prone than using 
templates. However, there are surprisingly few companies that have a prop­
erly integrated, fully functioning budgeting and forecasting system, and the 
fallback solution is almost always Excel.

There are several reasons many companies use Excel templates over a 
full budgeting and forecasting solution, whether they are integrated with 
their general ledger system or not.

■■ A full solution can be expensive and time consuming to implement 
properly.

■■ Integration with the general ledger system means a large investment in a 
particular modelling system, which is difficult to change later.

■■ Even if a system is not in place, invariably some analysis will need to 
be undertaken in Excel, necessitating that at least part of the process be 
built using Excel templates.

Microsoft Office Tools: Power Pivot, Access, and Project

Plain‐vanilla Excel (and by this I mean no add‐ins) is the most commonly 
used tool. See the next section for a review of some extra add‐ins you might 
like to consider. However, there are other Microsoft (MS) tools that could 
also serve to create the solution.

MS Power Pivot  First introduced as a free add‐in in Excel 2010, and slightly 
more diffcult to find in Excel 2013, Power Pivot replaces and improves 
the SQL Server Analysis Services for Microsoft’s Business Intelligence (BI) 
suite. Put simply, Power Pivot is PivotTables on steroids. It extends the 
capabilities of the PivotTable data summarisation and cross‐tabulation 
feature by introducing the ability to import data from multiple sources. 
It will allow you to do things you couldn’t do before in plain Excel, like 
matching data from multiple sources and pulling them together into a 
single report. Because it is a relational database, Power Pivot makes it 
easy to link together data from various sources employing a simple‐to‐use 
“drag‐and‐drop” graphical user interface.

Wonderful as it is, we know that plain‐vanilla Excel stops being quite 
so wonderful when your data is more than 1,048,576 records long or if 
the data needs to be consolidated from multiple sources. When faced with 
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this problem, Excel users find themselves migrating to a data warehouse 
or other, more powerful software. Microsoft has tried to retain these users 
by introducing Power Pivot, which addresses these problems with added 
capacity and speed yet retains the familiar Excel interface that we all know 
and love.

As a self‐service BI product, Power Pivot is intended to allow users with 
no specialised BI or analytics training to develop data models and calcula­
tions, sharing them either directly or through SharePoint document librar­
ies. For more sophisticated users, Power Pivot can:

■■ Create your own BI solutions without purchasing expensive software.
■■ Manipulate large data sets quickly, even if they consist of millions of 
rows (Excel can’t do that!).

■■ Construct complex what‐if reporting systems with data modelling and 
data analysis expressions (DAX).

■■ Link data from various sources quickly and easily.

Power Pivot is one of the most exciting things to happen to Excel in a 
long time, and certainly worth some consideration when you are building 
an Excel solution. Although more appropriate for data analysis than pure 
dynamic financial models, Power Pivot is worth bearing in mind as a pos­
sible tool. If you find that your model has the following attributes, then you 
should consider using Power Pivot:

■■ Your data contains many thousands of rows and your model is starting 
to slow down.

■■ PivotTables or Tables are used extensively.
■■ Data needs to be sourced from multiple locations.

One of the great things about Power Pivot is that it is a free download 
that comes with the licence you have already if you’re using Excel 2010. Be 
careful, however, about which version you buy if you’re using Excel 2013, 
as Power Pivot is not included with every version (for some inexplicable 
reason). There are also a number of differences between the Excel 2010 and 
2013 versions, and as this is an area of rapid change, I have no doubt that 
the availability of versions and features may have changed by the time this 
book goes to print, so be sure to research carefully before you purchase your 
license if you are specifically upgrading with the intention of using Power 
Pivot.

The disadvantage of using Power Pivot is that although you don’t need 
to be a BI specialist to use it, learning how to use Power Pivot is not particu­
larly straightforward even for advanced users. We offer a number of Power 
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Pivot training courses at Plum Solutions through our partners, and there 
are many videos and online resources that can help you to get started if you 
decide that Power Pivot is the solution that you need.

If you are trying to decide whether your Excel skills are advanced 
enough to consider tackling Power Pivot, here are some questions that will 
help you to determine whether you are ready to take on Power Pivot. You 
should:

■■ Understand and have used Excel’s SUMIF function.
■■ Have a working knowledge of filtering data in Excel (e.g., Auto or Ad­
vanced Filters).

■■ Know how to deal with multiple criteria (e.g., SUMIFS, SUMPRODUCT, 
or DBASE functions).

■■ Be able to import data from third‐party databases and/or files (e.g., Ac­
cess, SQL, MIS systems).

■■ Regularly use, adapt, and modify PivotTables (see Chapter 8 for more 
on PivotTables).

■■ Have created calculated fields in PivotTables.
■■ Have created and/or modified an Excel Table (a structured reference 
table, not a data table) (see Chapter 8 for more on Excel Tables).

■■ Have access to either Excel 2010 or Excel 2013 Professional Plus.

Although still quite new, Microsoft seems to be devoting a lot of re­
sources to developing the Power Pivot product, so it is likely to gain even 
more popularity in the near future. It’s worth investing some time in learn­
ing it: Being skillful in Power Pivot may become similar to having advanced 
Excel skills and will be a valuable addition to your CV, and benefit your 
career as an analyst.

MS Access  Access is probably the closest alternative to Excel, and is 
worth a mention. There is often some resistance to using Access, and it 
is certainly less popular than it was a decade or so ago. Prior to the re­
lease of Excel 2007, Excel users were restricted to only 65,000 rows, and 
many analysts and finance staff used Access as a way to get around this 
limit. With now over 1.1 million rows (and purportedly up to a billion 
rows if you install Power Pivot), Excel is able to handle a lot more data, 
so there is less need for the additional row capacity of Access. If you’ve 
been using Access over the years, you might have noticed that not very 
much has changed in Access between versions. It seems that Microsoft is 
investing more of its efforts into the new Power Pivot rather than Access, 
and therefore we can expect more models in the future to be built using 
Power Pivot.
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Advantages of Excel
■■ Excel is included in most basic Microsoft packages (unlike Access, 
which often needs to be purchased separately) and therefore comes as 
standard on most PCs. Excel is much more flexible than Access and 
calculations are much easier to perform.

■■ It is generally faster to build a solution in Excel than in Access.
■■ Excel has a wider knowledge base among users, and many people find it to 
be more intuitive. This means it is quicker and easier to train staff in Excel.

■■ It is very easy to create flexible reports and charts in Excel.
■■ Excel can report, model, and contrast virtually any data, from any 
source, all in one file.

■■ Excel easily performs calculations on more than one row of data at a 
time, which Access has difficulty with.

Advantages of Access
■■ Access can handle much larger amounts of data: Excel 2003 was limited 
to 65,536 rows and 256 columns, and later versions of Excel are limited 
to around 1.1 million rows (1,048,576 rows, to be precise) and 16,384 
columns. Access’s capability is much larger, and it also has a greater 
memory storage capacity.

■■ Data is stored only once in Access, making it work more efficiently.
■■ Data can be entered into Access by more than one user at a time.
■■ Access is a good at crunching and manipulating large volumes of data.
■■ Due to Access’s lack of flexibility, it is more difficult for users to make errors.
■■ Access has user forms, which provide guidance to users and are an easy 
way for users to enter data.

In summary, Access is probably most commonly used for legacy software; 
databases that have been around for a long time. If it’s a brand‐spanking-new 
solution that you need, consider Power Pivot instead.

MS Project  MS Project is specifically for creating project plans and associ­
ated component tasks, assigning resources to those tasks, tracking progress, 
managing budgets, and monitoring workloads. The user can also create 
critical path schedules and Gantt charts.

Because the program handles costs, budgets, and baselines quite well, Proj­
ect could be considered a viable alternative to a financial model, if the purpose 
of the model were simply to create an actual‐versus‐budget tracking report. In 
fact, as with most purpose‐built software, if your aim is to track and monitor a 
project, Project is a superior option to Excel. Of course, creating a project plan 
and even a Gantt chart is certainly possible in Excel, although it will take longer 
and be far more prone to error than Project. There are many reasons, however, 
why users will opt to use Excel rather than Project for a project plan:
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■■ Project is not included in any of the Office suites and therefore needs to 
be purchased separately.

■■ The plan may need to be accessed, updated, and monitored by different 
users, who may not be able to use Project due to lack of skills.

■■ For a reasonably small project, it’s probably not worth the trouble; it’s 
simpler to just handle it in Excel.

In summary, the choice between Excel and Project really depends on 
the size, scope, and complexity of the project plan model you are building. 
Bear in mind of course that there are many other pieces of project planning 
software besides Project on the market!

Excel Add-Ins  Add‐ins are programs that add optional commands and fea­
tures to Excel. Although Power Pivot is also an add‐in to Excel, it has been 
discussed in a previous section. There are many add‐ins on the market that 
have been developed specifically for the purpose of financial modelling. For 
more complex calculations or processing of input, it may be useful to ac­
tivate or install one or more add‐ins, especially tools such as Solver, which 
are included in your MS Excel licence. Bear in mind that other users will 
probably not have add‐ins enabled, so they will not be able to see how your 
model has been created or calculated.

Excel add‐ins can be categorised according to source:

■■ Add‐ins such as Solver and the Analysis ToolPak that only need to be 
activated once Excel has been installed.

■■ Add‐ins that must be downloaded from Office.com and installed before 
they can be used (such as Power Pivot).

■■ Custom add‐ins created by third parties that must be installed before 
they can be used: Component Object Model (COM) add‐ins, Visual 
Basic for Applications (VBA) add‐ins, Automation add‐ins, or DLL 
add‐ins.

Excel add‐ins from all sources can be used to perform a variety of tasks 
that assist in the financial modelling process. These add‐ins can be broadly 
defined as:

■■ Standard Excel add‐ins such as the Analysis ToolPak and Solver.
■■ Audit tools.
■■ Integration links between Excel and the general ledger system.

The most commonly used add‐ins are the Analysis ToolPak and Solver, 
which are standard add‐in programs that are available when you install 
Microsoft Office or Excel. They are included in the program but are disabled 
by default, so if you want to use them, you need to enable them.
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Prior to the release of Excel 2007, the only way to access certain func­
tions (e.g., =EOMONTH and =SUMIFS) in Excel 2003 was to download 
the Analysis ToolPak. However, these functions are now standard in Excel 
2007 and later, so the Analysis ToolPak is now less commonly used. Other 
features in the Analysis ToolPak are tools like the Data Analysis ToolPak, 
which has some powerful statistical and engineering functions not com­
monly used in financial modelling. Solver, however, is an extremely use­
ful but quite advanced tool for calculating optimal values in financial 
modelling.

Audit add‐ins for Excel are used to ensure the accuracy of data and 
calculations within a spreadsheet or workbook. They can very quickly iden­
tify formula errors by looking at inconsistent formulas, comparing versions, 
and getting to the bottom of complex named ranges. There are several cus­
tom add‐ins available both from Microsoft and other parties that will fa­
cilitate accuracy by performing formula investigations, precedent/dependent 
analysis, worksheet analysis, and sensitivity reporting.

Whilst they can assist with checking for formula errors, there are many 
other types of errors that can be easily overlooked, and using these add‐ins can 
provide a false sense of security. See the section “Error Avoidance Strategies” 
in Chapter 4 for greater detail.

Integration add‐ins allow information from the financial reporting sys­
tem to be transferred into Excel for further analysis, or data stored in Excel 
to be transferred into the financial reporting system. These are often used 
for the purpose of:

■■ Transferring information from the general ledger system into Excel for 
the purposes of reporting and analysis. Many management reports are 
built in Excel, and extract up‐to‐date data directly from the general 
ledger system into the reports.

■■ Loading information in the form of journal entries back into the general 
ledger system. Data is often manipulated in Excel, and then loaded into 
the general ledger as a journal. For example, if an invoice needs to be 
split among different departments based on headcount allocation, this 
calculation might be done in Excel, split to departments in the journal, 
and loaded into the general ledger system.

The Final Decision

The more sophisticated a financial model is, the more expensive it is to maintain. 
It is therefore best to use a model with the lowest possible level of sophistication 
needed to provide a specific solution. For this reason, purchasing a software 
package, provided it can deliver the desired solution, might be advisable.
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Once the decision has been made to purchase a software package, it 
must be determined which package will provide the best solution as certain 
solutions may be better provided by particular software packages.

There are many forms of software and Excel add‐ins on the market that 
can be used to create financial models. However, provided that it can deliver 
an adequate solution, we recommend using plain Excel, as it is easy to use 
and no extra licenses, training, or software downloads are required. If ad­
ditional functionality is needed, Excel add‐ins may be considered.

32-Bit versus 64-Bit Excel

Since the introduction of Excel 2010 several versions ago, Excel is now 
available in 64‐bit; this has become a topic of discussion and interest for 
many Excel users. With all the buzz around the 64‐bit version, many of us 
are wondering: Is 64‐bit Excel better than 32‐bit Excel? Should I make the 
switch? Is 64‐bit MS Excel the solution to poor Excel performance?

First, let’s explore exactly what 32‐bit and 64‐bit really means. A 32‐bit 
system can process the data in 32‐bit pieces whereas 64‐bit can process 
double that. Because more data is being processed at once, the system will 
operate more quickly and will use the physical memory more efficiently. 
Installing the 64‐bit version of Excel will certainly make your Excel models 
run faster and more efficiently, but consider whether it’s really necessary 
before you take the plunge.

You need to consider three components: the software, the operating sys­
tem, and the hardware. Just because you have 64‐bit-capable hardware does 
not mean you have a 64‐bit operating system, or software, but if you want 
to run the 64‐bit, your machine and operating system need to be 64‐bit. 
See below to check which hardware, operating system, or software you are 
running.

Increasing to the 64‐bit version of Excel will increase the speed, capac­
ity, and efficiency of working in Excel significantly. For those working in 
Office, what this means is that you are no longer limited to 2GB file sizes. 
This is quite revolutionary for Excel users as, at the moment, Excel file sizes 
are nowhere near 2GB, simply because anything over around 50MB does 
not work very efficiently on 32‐bit. Most Excel files rarely exceed 20MB, 
unless you are working in Power Pivot. So if you’re a heavy‐duty file‐size 
Excel user, you’ll notice a big difference, but otherwise consider whether 
you are really going to gain much advantage with the upgrade. If you’re 
having trouble with your memory, see the section on “Improving Model 
Performance” in Chapter 10.

The file size supported by 64‐bit Excel is limited only by the system capac­
ity (hard drive) and memory (RAM) available for storage and computation, 
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respectively. Also, the 64‐bit solutions also offer much better security features 
than the 32‐bit versions.

What Are You Using at the Moment?  To figure out what is on your machine, 
there are three different things that you need to consider here: first, is your 
machine 64‐bit capable, is the operating system 64‐bit, and is the version of 
Office you’ve installed 32‐bit or 64‐bit? Whilst you can’t install 64‐bit Of­
fice on a 32‐bit machine, it is entirely possible (and very common) to have 
32‐bit Office installed on a 64‐bit‐capable machine. In fact, this is the de­
fault option when you install Office 2010, even if you are running the 64‐bit 
edition of Windows. It is also important to note that 64‐bit computers can 
still use 32‐bit‐based software programs, even when the Windows operating 
system is a 64‐bit version.

	 1.	To check whether your computer is 32‐bit or 64‐bit capable, go to the 
Start button, and right‐hand click on Computer or My Computer, select 
Properties, and look for system type. If you’re using Windows 8 and 
you don’t have a Start button, go to the Control Panel and search for 
System. On the system tab you’ll be able to see either “x32‐based pro­
cessor” or “x64‐based processor.”

	 2.	If you’re running Windows XP, you’re probably on a 32‐bit operating 
system, but on other versions, it’s anyone’s guess. Go to the Control 
Panel, and choose “System.” In the section where it explains basic infor­
mation about your computer, it should say “System Type” and you’ll be 
able to see whether it is 32‐bit or 64‐bit. By the way, it’s important to 
know which version you’re running when you install device drivers for 
your hardware.

	 3.	Last, to check if your version of Excel is 32‐bit or 64‐bit, if you’re using 
the latest, Excel 2013, click on the File button, go to Account, and then 
About Excel. A dialog box will appear with either 32‐bit or 64‐bit at the 
top of the screen.

If you’re using Excel 2010, click on the File button, and then Help. 
About Excel will appear on the right‐hand side and underneath it will 
state the version and whether it is 32‐bit or 64‐bit.

What to Beware of before Installing the 64-Bit Version  You have established that 
you have a 64‐bit‐capable computer. This doesn’t mean you necessarily 
should instantly install the 64‐bit operating system and Office software! 
Bigger is better, right? Hold on a minute. While 64‐bit does improve the 
capacity of the file size, there are some limitations with the 64‐bit, mainly 
due to its nascence. Despite the fact that it has been around for at least two 
versions (Office 2010 and 2013), it’s still a relatively new introduction, and 
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as such many add‐ins and other pieces of software don’t work well with the 
64‐bit version of Office.

The 64‐bit Excel is a little more stable, but if you are sticking to fairly 
standard Excel functionality, the switch from 32‐bit to 64‐bit will probably 
not impact you; in fact, you probably won’t even notice the increased ca­
pacity. For Power Pivot users, though, the additional amount of RAM that 
64‐bit can access might well come in handy, especially if you are regularly 
working with data models that contain over a million rows.

However, if you need to use advanced features with add‐ons like 
ActiveX, VBA codes from an older Excel version or other third‐party 
add‐ons, you could encounter all sorts of problems. This is because many 
Excel add‐ons are 32‐bit versions that are not fully compatible with the 
64‐bit Excel. Of course, if you upgrade to 64‐bit Excel, then you’ll need 
to upgrade for the rest of Office, and you may encounter similar problems 
with add‐ins for these products as well. Users have particularly complained 
about add‐ins for Outlook, such as not syncing with mobile phones or 
other devices.

Microsoft has a newer version of VBA called VBA 7, which comes in 
32‐bit and 64‐bit formats that are compatible with both Excel versions. For 
ActiveX controls and other third‐party add‐ons, you need to either edit the 
source code (if you can access it) for 64‐bit compatibility or look for an 
alternative or upgrade.

Last, if you are planning to build a solution or a tool using 64‐bit Excel, 
you need to ensure that your solution will work on both 32‐bit and 64‐bit 
Excel. Given that 64‐bit Excel is still not as prevalent as 32‐bit, building a 
64‐bit compatible solution could be detrimental to its popular adoption or 
usage.

In summary, if you are looking at moving to 64‐bit Excel, you need 
to evaluate how you use Excel. Unless you are a data‐hungry Power Pivot 
user with the need to generate Excel files bigger than 2GB, there is no 
real value in making the switch. The 32‐bit Excel versions can and will 
continue to meet your needs until the 64‐bit solution becomes the norm.

What Skills Do You Need to Be a Good Financial 
Modeller?

When you decide your financial models are not as good as they should be, 
should you immediately take an advanced Excel course? Whilst this is help­
ful, there’s a great deal more to financial modelling than being good at Excel!

When considering the skills that make up a good financial modeller, 
we need to differentiate between conceptual modelling, which is to have 
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an understanding of the transaction, business, or product being modelled, 
and spreadsheet engineering, which is the representation of that conceptual 
model in a spreadsheet. Spreadsheet skills are reasonably easy to find, but a 
modeller who can understand the concept of the purpose of the model and 
translate it into a clear, concise, and well‐structured model is much rarer.

People who need to build a financial model sometimes think they need 
to become either an Excel super‐user or an accounting pro who knows every 
in and out of accounting rules. I’d argue you need a blend of both, as well as 
a number of other skills, including some business common sense!

Spreadsheet and Technical Excel Skills

It’s very easy for financial modellers to get bogged down in the technical 
Excel aspects of their model, get carried away with complex formulas, and 
not focus on key high‐level, best‐practice procedures, such as error‐checking 
strategies and model stress‐testing.

Excel is an incredibly powerful tool, and almost no single Excel user 
will have the need or desire to utilise most of the functionality this program 
offers. As with most software, the 80/20 rule applies: 80 percent of users use 
only 20 percent of the features—although some would argue that 95 percent 
of Excel users use only 5 percent of the features! Still, there are those select 
few who understand every in and out of Excel, every single function, and 
work out how to do practically anything in Excel. Do you need to have this 
level of Excel skill to become a good financial modeller? Unfortunately, hav­
ing great software skills doesn’t always help when it comes to applying them 
to a specific area of business. Realise that Excel is used in several capacities, 
so being an Excel super‐user doesn’t automatically mean you’ll be a super 
financial modeller. The best financial models are clear, well structured, flex­
ible, and dynamic; they are not always the biggest and most complicated 
models that use the most advanced tools and functions! Many of the best 
financial models use only Excel’s core functionality.

Having said that, to be a good financial modeller, you do need to know 
Excel exceptionally well. Those people who maintain that you don’t need 
good Excel skills to be a financial modeller are usually those with weak Ex­
cel skills. You should be building a superb model using simple and straight­
forward tools because you’ve chosen to make your model clear and easy to 
follow, not because that’s all you know how to do! You don’t have to be a 
super-user—the 99th percentile in Excel knowledge—but you must certainly 
be above average. A complex financial model might use features in Excel 
that the everyday user doesn’t know. The best financial model will always 
use the solution that is the simplest tool to complete the task (as simple as 
possible and as complex as necessary, right?), so the more familiar you are 
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with the tools available in Excel, the easier it will be. An array formula or 
a macro might be the only way to achieve what you need to achieve, but a 
simpler solution may well be—and often is—superior. You might also need 
to take apart someone else’s model, which uses complex tools, and it’s very 
diffi cult to manipulate an array formula or a macro if you’ve never seen 
one before! So, if you are considering a career as a fi nancial modeller (as I 
assume you are), improving your Excel knowledge is an excellent place to 
start. 

    eXaMples oF teChnICal eXCel skIlls QuestIons  

 ■      How do I use the appropriate formula? For example, should I use 
a VLOOKUP or a SUMIF? 

 ■    How do I hide a sheet and then protect it so that the user can’t 
access it? 

 ■    How do I construct a complex but concise formula?   

      Industry knowledge 

 One of the fantastic things about fi nancial modelling is that it is applicable 
across so many different industries. Good fi nancial modelling skills will al­
ways stand you in good stead, no matter which industry or country you 
are working in! Financial modelling consultants or generalists will prob­
ably work in many different industries during their careers and be able to 
build models for different products and services. They will probably not 
be experts in the intricacies of each industry, however, and that’s why it’s 
important for a fi nancial modelling generalist to consult carefully with the 
subject matter expert for the inputs, assumptions, and logic of the fi nancial 
model. Don’t be afraid to ask lots and lots of questions if the details are not 
absolutely clear. It’s quite likely that the person who has commissioned the 
model hasn’t actually thought through the steps, inputs, assumptions, and 
even what the outputs should look like, until you ask the right question. 

 Financial modelling consultants are very careful to transfer responsibil­
ity for the assumptions to the end user, which is a very sensible course of 
action. The person building the model is often not the one who has commis­
sioned it or the person who is actually using it. Model builders are often not 
overly familiar with the product or even the organisation, and they cannot 
(and should not) take responsibility for the inputs. (See the section “Docu­
ment Your Assumptions” in Chapter   3   for greater detail on the importance 
of documentation of assumptions.) 
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 For example, when building a pricing model, the modeller needs to 
understand the product and how the costs and revenue work. Experience 
with regulatory constraints will help the modeller to understand the basis 
of regulation and its components (e.g., cost building blocks, cost index, rev­
enue cap, weighted average price cap, maximum prices, etc.). Understanding 
of economic concepts, such as effi cient cost calculation, return on and of a 
regulatory asset base, operating costs and working capital, long‐run versus 
short‐run marginal costs, and average costs, are other examples of industry 
knowledge that is useful for the fi nancial modeller. 

    eXaMples oF InDustry knoWleDGe  

 ■      Regulatory constraints. 
 ■    Industry standards. 
 ■    Maximum price that can be charged for a certain item.   

      accounting knowledge 

 Elements such as fi nancial statements, cash fl ow, and tax calculations can 
be an important aspect of many fi nancial models. Professional accountants 
know every single accounting rule and law there is, but this does not neces­
sarily make them good fi nancial modellers. If a highly skilled accountant 
built a fi nancial model, you would guess that the layout and structure of 
the fi nancial statements will be 100 percent correct, but will they be linked 
properly? If you change some of the inputs, does the balance sheet still bal­
ance? Sometimes not! A good accountant, or even someone qualifi ed who 
has a master’s degree in applied fi nance, for example, might not be familiar 
with all of the modelling technical tools, even if he or she is a competent 
Excel user. As with the other modelling skills, you don’t need a top level of 
accounting knowledge to build a fi nancial model. In fact, fi nancial mod­
els are often relatively straightforward from an accounting standpoint. You 
certainly do not need to be a qualifi ed accountant to become a fi nancial 
modeller, although a good understanding of accounting and knowledge of 
fi nance certainly helps. 

 There are some situations where industry knowledge and accounting are 
required for fi nancial modelling. For example, in manufacturing or, particu­
larly, in the oil and gas industry, the modeller needs to know whether FIFO 
(fi rst in, fi rst out) or LIFO (last in, fi rst out) accounting is being used, as this 
has a big impact on the way that inventory is being modelled. A fi nancial 
modeller who has never worked in these industries may not have ever heard 
of FIFO and LIFO, and would probably have no idea how to model them. 
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    eXaMples oF aCCountInG knoWleDGe  

 ■      How is a profi t‐and‐loss statement structured? 
 ■    How do I construct a cash‐fl ow forecast from my model? 
 ■    How do I turn capital expenditure into a depreciation expense?   

      business knowledge 

 A modeller with wide‐ranging business experience is well equipped to probe 
for the facts and assumptions that are critical for building a fi nancial model. 
This is probably the most diffi cult skill to teach, as it’s most easily picked up 
by working in a management role. 

 Business acumen is particularly important when commissioning, design­
ing, and interpreting a fi nancial model. When creating the model, the modeller 
needs to consider the purpose of the model. What does the model need to tell 
us? Knowing the desired outcome will assist with the model’s build, design, 
and inputs. If, for example, we are building a pricing model, we need to con­
sider the desired outcome—normally, the price we need to charge in order to 
achieve a certain profi t margin. What is an acceptable margin? What costs 
should we include? What cost will the market bear? Modellers should also 
have an understanding of economic concepts, such as effi cient costs and how 
these are calculated, an expected return on an asset base, operating costs and 
working capital, or long‐run versus short‐run marginal costs. 

 Of course the answers to these questions can be obtained from other 
people, but a modeller with good business sense will have an innate sense of 
how a model should be built, and what is the most logical design and layout 
to achieve the necessary results.      

    eXaMples oF busIness knoWleDGe  

 ■       What is cost of capital and how does that affect a business case? 
 ■    Which numbers are important? 
 ■    What does the internal rate of return mean, and what is an 
acceptable rate?   

 aesthetic Design skills 

 This is an area that many modellers and analysts struggle with, as aesthetics 
simply do not come naturally to left‐brain thinkers like us. We are mostly 
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so concerned with accuracy and functionality that we fail to realise that the 
model looks—and I’m not going to mince words here—ugly! Although it’s 
just a simple matter of taking our time when formatting, most of us could 
not be bothered with such trivial details as making models pretty, and con­
sequently most models I see use the standard gridlines, font, and black‐and‐
white colouring that are Excel defaults. I’m certainly not suggesting that you 
embellish your models with garish colours, but you should take some pride 
in your model. See the section “Bulletproofing Your Model” in Chapter 7 for 
some ideas on how to remove gridlines and change some of the standard set­
tings so that your model looks less like a clunky spreadsheet and more like 
a reliable, well‐crafted model you’ve taken your time over. Research shows 
that users place greater faith on models with aesthetic formatting than those 
without, so one of the fastest and easiest ways to give your model credibility 
is to simply spend a few minutes on the colours, font, layout, and design.

Some aesthetic formatting is critical for the functionality and to avoid 
error (see section “Error Avoidance Strategies” in Chapter 4), but mostly it 
adds credibility and makes your model easier to work with.

Models can become complex very quickly and without a well‐planned de­
sign they can be unintelligible. Some basic components of a model should be a 
cover sheet, instructions, and clearly labelled inputs, outputs, workings, and re­
sults. For extremely long and complex models with many sheets, a hyperlinked 
table of contents is also a valuable addition to help the user navigate the model.

Communication and Language Skills

This is also an area that we left‐brain thinkers are not always good at. Some 
analysts like to lock themselves away, working on spreadsheets without 
communicating with other people. If this is your tendency, then you might 
need to consider whether financial modelling is a good career choice for 
you, because there is a surprising amount of human interaction required for 
most financial modellers.

■■ Assumptions validation: In order to gain buy‐in from stakeholders, the key 
assumptions and inputs often need to be communicated verbally or in writ­
ing. People in various parts of the business should be involved in order to 
check the accuracy and appropriateness of inputs for inclusion in a model. 
Stakeholders will often query the assumptions or the way they have been 
used and provide extremely valuable insight for modellers (particularly for 
a consultant or modeller with little industry or product knowledge). Per­
forming this task well is a critical step in the modelling process.

■■ Data gathering: There are some modelling projects where more time 
is spent gathering and collating data than actually building the model. 
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Holders of information can be guarded about giving access to data, some­
times irrationally, but often it’s because they’ve had bad experiences in 
the past. This can occur when someone provides estimates off the record, 
and later discovers that those numbers have been used in budgets or other 
documents to which they are held accountable. So, people can be under­
standably reticent about providing data when requested for an ad hoc 
project such as a financial model. A modeller with good communication 
skills will be able to dig, delve, and coax the information out of them!

■■ Presentation skills: Senior management, when approving a project, often 
wants to hear about the financial implications of the project from the per­
son who actually built the model, and so modellers are sometimes required 
to present the key outcomes to a board or executive committee. Being able 
to distill a 30‐megabyte, extremely complex financial model that contains 
20 tabs and took you six weeks to build, into three PowerPoint slides and a 
six‐minute summary presentation can be quite a challenge!

■■ Client skills: Whether you are a consultant or an in‐house employee, 
working well with clients is a useful skill. Even in‐house modellers have 
clients; every person you work with or for should be considered a cli­
ent and treated with the same respect and consideration as though they 
were paying your bill.

In all of these interactions with other people, financial modellers must 
show confidence in their model. Build the model to the best of your ability. 
Use best practices, check for errors, and follow a good and logical thought 
process, so that when you present or discuss your model, you can do so in 
a way that exudes absolute confidence. Doing so reduces questions about 
the accuracy, usefulness, and validity of your model. Be honest about the 
fallibility of your model and its known shortcomings (let’s face it, no model 
is perfect), but be confident that you have built it to best‐practice standards 
within the limitations of time, data, or scope. This will serve to increase your 
model’s credibility, building your reputation within your company and, of 
course, enhancing your career!

Numeracy Skills

Financial models, of course, have a significant mathematical component, and 
people with good numeracy skills are best suited to it. Solid math skills can be 
particularly useful in error‐checking and sense‐checking. The ability to make 
rough estimates quickly means they will be able to spot errors more easily. 
If we sell 450 units at $800 each, will our sales revenue be $3.6 million, or 
$360,000? If we’ve made a calculation error, the numerate modeller will pick 
up the mistake much more quickly.



24� Using Excel for Business Analysis

The numerate modeller will also have a gut feel for differentiating be­
tween critical assumptions that need further verification, and input that is 
insignificant or immaterial to the model. The less‐numerate modeller will 
have to test it manually, and will probably end up with the same result, but 
it will simply take longer.

General numeracy is a skill that is difficult to teach, and one that can be 
easily tested for in the recruitment process. Experience working with models 
over time can drastically improve these skills as the modeller who is less 
numerate will learn ways to compensate through error‐testing, and these 
techniques will become acquired, innate habits.

Ability to Think Logically

Modelling is often like programming, and complex logic needs to be interpreted 
into the language of Excel so that the program can understand and create the 
modeller’s expected results. For example, if we want to show a value, but only 
if the cell being tested is in the future, we would vocalise it by saying: “Show me 
the value, but only if the test cell is greater than or equal to today’s date.” The 
way that we need to translate this into Excel’s language is to use the formula:

=IF(test_cell>=today,value,0)

Logic is also critical for model layout, design, and the use of assumptions 
in calculations. The issue of timing in annual models is one that I use often 
when demonstrating logic in my training workshops. If we are estimating the 
revenue for a new insurance product, and the assumption is that we acquire 
30,000 customers every year, we can’t assume revenue for the full 30,000 cus­
tomers, as not all of them will begin on the very first day of Year 1. Customers 
will be acquired gradually throughout the year, so we need to take an average 
in order to calculate revenue. This is an example of how it is very easy to get 
logic wrong and overestimate revenue by a substantial amount.

Logic is one of those analytical skills that is very difficult to teach, but 
modellers who have made a logic error (like the one illustrated above) learn 
quickly from their mistakes and are quite careful to use clear, well‐documented 
logic for others to follow and check.

The Ideal Financial Modeller

In general, most modellers have at least some of the aforementioned skills, 
and at times it is necessary to consult specialists in order to create a success­
ful financial model. Having read the section on the skills that you need to be 
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a good financial modeller, you should have a fairly good idea about which 
areas you are lacking in. Once you have identified these areas, you can work 
to improve them and liaise with other specialists to ensure that your model 
is not lacking as a result of your weaknesses.

What financial modellers bring to the table is a combination of skills. 
First, they know Excel well enough to be able to choose the simplest and 
most functional tool to build a model. They can create a PivotTable, array 
formula, or macro (but only when necessary, of course); use a simple or 
complex nested formula; and choose the best technical tool to perform a 
scenario analysis. They also understand all the relevant business and ac­
counting principles. At the end of the day, the balance sheet has to balance, 
and the ending cash on your cash flow statement needs to tie to the balance 
sheet, for example.

The ideal financial modeller brings a unique combination of skills that 
neither an Excel guru nor an accounting whiz possesses. He or she under­
stands sensitivity and relationships between variables, how fluctuations in 
inputs will impact the outcomes, and how this needs to be modelled in Ex­
cel. A financial modeller can also take a step back and realise what the 
ultimate goal of the model should be. Are we building a model for in‐house 
use, or to present to investors? Do we need a valuation, a variance analy­
sis, a nice summary, or a detailed, month‐by‐month profit‐and‐loss report? 
The financial modeller can take information, build an Excel model that is 
technically correct from an accounting standpoint, set up the model, and 
ultimately reflect what the business is looking to achieve.

What’s the Typical Background for a Financial Modeller?

A key problem in the financial modelling industry is that modelling is of­
ten incorrectly considered a junior task and is often given to inexperienced 
graduate analysts who undoubtedly have good Excel skills but simply do 
not have the depth of business experience to create good financial models. 
If a modeller is able to check off all of the above boxes (i.e., good financial 
skills, good communicator, able to resolve ambiguity), he or she is likely 
to quickly move into a more senior position to execute more management 
responsibilities and spend less time building financial models.

Most financial modellers come from a finance background and have 
gradually been exposed to industry knowledge. They often become spe­
cialists in a field, picking up business acumen, communication skills, and 
logic along the way. Quite often engineers, project managers, construction 
specialists, or even scientists who are required to build their own financial 
models end up pursuing a career in financial modelling. They have the in­
dustry and product knowledge and are able to learn the Excel skills but may 
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struggle with the finance side of things. Some would argue that it is easier 
to teach an engineer or scientist financial skills than it is to teach a financial 
accountant about the industry, but I think both have a tough job. Every 
modeller will have strengths and weaknesses, but a good financial modeller 
will span different skill sets and will have a little bit of everything.

Training Courses

As a specialist financial modelling consultant and trainer, I spend a lot of my 
time running training courses and, consequently, many people expect me to 
be a firm advocate of the face‐to‐face training workshop, right? Not neces­
sarily. I’ve come under fire from my training partners in the past for publi­
cising this opinion, but I’m not entirely convinced that going on a training 
course is always the best option for someone keen to improve his or her 
financial modelling skills.

Excel is the backbone to any custom‐built financial model, and as dis­
cussed in the previous section, one of the core attributes of a financial mod­
eller is to have good technical Excel skills. When struggling with financial 
models, some managers’ first reaction is to send their staff on an advanced 
Excel course to improve their modelling skills. However, with training bud­
gets under constant scrutiny, you really need to make sure that you get the 
best value out of your training options. Is a training course really what you 
need?

When considering an advanced Excel course, there are a few points you 
should consider.

■■ As financial modellers, our use of Excel is quite narrow. I know it’s 
hard for us to conceive, but there is a whole world of Excel outside the 
finance industry! Statisticians, database programmers, and engineers, to 
name a few, are able to use Excel’s advanced functions to create nonfi­
nancial spreadsheets. Most advanced Excel courses are very broad and 
will cover functions and capabilities that do not apply to your needs as 
a financial modeller. You may learn a few tricks, but the time and money 
spent could be invested elsewhere.

■■ Research shows that a large percentage of the skills learned in training 
courses are not retained. Will you really remember everything that you 
learn? A program of continuous, applied learning is often more effective 
than an intensive training course.

■■ Are your Excel skills really the problem? Following best practices and 
mastering the logic behind a financial model are more important than 
building in complex formulas and, for the most part, you will want to 
keep formulas as simple as possible.
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Alternatives to Attending a Training Course  Other options to improve your fi­
nancial modelling skills without going on an advanced Excel course include:

■■ Read a book. Buying this book is a great start. You’ll still have it to 
refer to when the excitement and enthusiasm you felt after completing a 
training course are long gone, and you’re back to struggling with build­
ing your financial models.

■■ Take an interest in what work your colleagues have done and how they 
did it—you can always learn from the techniques of others.

■■ Read, use, and dissect other people’s models. Sometimes the best way 
to learn is to see what someone else has done. Try taking someone else’s 
model apart and see how he or she built it. It’s probably best to use your 
company’s models, but if you don’t have access to those, take a look at 
some of the sample models provided on this book’s companion website, 
which can be found at www.wiley.com/go/steinfairhurstrevised.

■■ Read specialist financial modelling publications or subscribe to e‐mail 
newsletters about using Excel. They often contain useful articles about 
specific techniques and tips that can enhance your skills. Getting a short 
e‐mail tip every day is much more effective than reading many all at 
once. You’ll retain the information better in bite‐size pieces.

■■ Search online. If you’re struggling with a formula or layout problem 
and are convinced that there must be an easier way to do something, 
there usually is! Chances are that others have had the same problem in 
the past and, if you’re lucky, they’ve documented it as a blog post. There 
are some fantastic, publicly available online resources including tutori­
als, articles, blogs, forums, and videos specialising in Excel and financial 
modelling that can be used at your convenience rather than taking an 
entire day or two to attend a course. You will find links to some of my 
favorite websites and online resources listed on the companion website 
at www.wiley.com/go/steinfairhurstrevised.

Select the Right Training Option for You  The strategies outlined here are great 
for continually improving your Excel and financial modelling skill set, and 
they certainly won’t break the budget, but what if you really need to give 
your skills a quick boost to get you ready for an upcoming project? There 
are a number of options available:

■■ Try to find a course specifically aimed at Excel for financial modellers, 
and—even better—find one dedicated to your industry. Although good 
financial modelling skills are relevant across many different industries, 
there is nothing like specialised training dedicated to the modelling 

http://www.wiley.com/go/steinfairhurstrevised
http://www.wiley.com/go/steinfairhurstrevised
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issues inherent in your own industry. In recent years, many more spe­
cialist financial modelling courses have become available, especially in 
major cities.

■■ If your company is able to arrange a group in‐house training course, this 
will be even better, as you may be able to learn with the templates and 
models actually used within your organisation. You also have the added 
advantage of choosing a time and location that suit you.

■■ If you can afford a private session, this is the most convenient and time‐
efficient method, as you can ask questions and cover only topics that are 
useful to you. Many specialist training companies provide one‐on‐one 
mentoring sessions with Excel.

Do You Really Need an Advanced Excel Course?

It’s true that “you don’t know what you don’t know,” and so some people 
go on training courses because they want to make sure there isn’t something 
about the subject that they are missing. Having heard or seen something in a 
training course gives you exposure to something that you might never have 
heard about, but if it’s simply inspiration you’re after, a good newsletter 
might well suffice (and be a lot cheaper).

You might learn a few tricks in a course, but most people have got to 
think really hard before spending the money and taking a day or two out of 
their schedules to commit to training workshops. There is no question that 
face‐to‐face workshops are very effective; for many people, they are the best 
way to learn. However, I would recommend that potential attendees exhaust 
the available blogs, forums, and newsletters first. Please visit this book’s 
companion website at www.wiley.com/go/steinfairhurstrevised for a list of 
my favourite blogs and other online resources.

In summary, an advanced Excel course would certainly benefit those who 
plan on extensively using Excel in their role for multiple purposes. However, 
if your main objective is to become an expert financial modeller, focus in­
stead on mastering the few tools you need—such as logic and methodology— 
either in a course or via another medium, rather than expending time and 
money to learn things you may not use.

Summary

In this chapter, we have discussed the definition of a financial model, and 
determined that, at a basic level, a financial model is really just a complex 
spreadsheet that contains inputs and outputs in a dynamic way. However, not 

http://www.wiley.com/go/steinfairhurstrevised
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every spreadsheet could be called a financial model. Models in Excel can be 
built for virtually any purpose, both financial and nonfinancial, business or 
nonbusiness, although the majority of models will be financial‐ and business‐ 
related—and these are the kinds of examples we will mainly focus on.

Although this book is about how to use Excel in the context of business 
analysis and financial modelling, consider that there are many other avail­
able modelling tools besides Excel, including Microsoft products, add‐ins, 
and third‐party software. Excel is the most commonly used software for 
this type of analysis, and in terms of building your skill set, improving your 
Excel skills will always stand you in good stead for a career in finance.

Having good technical Excel skills is not the only attribute of a good fi­
nancial modeller: industry knowledge, accounting, business acumen, design 
skills, communication, logic, and numeracy are also important. Modellers 
will have all of these skills in varying degrees, so think about which skills 
you need to work on the most. Going to a training course, using and taking 
apart others’ models, reading specialist publications and blogs, and using 
other online resources are all great ways to improve your financial model­
ling skills.
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Chapter 2
Building a Model

Before launching in to build a model, it’s important to think about model 
design, structure, layout, and planning. A well‐thought‐out design and 

clear project plan can make a huge difference to the quality and success of 
the modelling project.

Model Design

Design can sometimes be the most difficult part of building a financial mod-
el and, in my experience, one of the most difficult to teach and learn. The 
best way to develop design skills is to critically assess other people’s models, 
taking note of what works and doesn’t, and then applying it to your own 
models.

Even the simplest models can become complex if poorly designed, and 
a well‐designed model will be so straightforwardly logical that it will simply 
speak for itself. It’s pretty easy to just dive in and start building a model 
without thinking about the implications of the design. It’s not a bad idea 
to spend some time thinking about the layout before you get started. The 
layout and structure of the model relate to the look and feel of the model, 
and how users navigate through the model.

The following examples outline a couple of different challenges you 
might come across when designing the layout of a model.

Practical Example 1—Assumptions Layout

Let’s say you are creating a high‐level five‐year forecast. We’ve got 15,065 
customers in 2017, and we are expecting that number to increase by 5 percent  
every year. If you set up your model as shown in Layout Option 1 in Figure 2.1, 
with only one growth assumption, you’re very much restricted to a single in-
put for the growth number.
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If we change the design of the calculations by adding multiple input 
assumption cells, and change the formula just a little, we are making our 
model a lot more flexible and useful in the long term. This way, if we decide 
to change the growth number for each year, as shown in Figure 2.2, we 
won’t need to change any of our formulas in the future, and our model is 
much more robust and less prone to error.

Of course, Layout Option 2 is slightly more complex but is more func-
tional for the user. This example demonstrates the constant balance that 
a modeller needs to maintain between functionality and simplicity when 
building a financial model.

Practical Example 2—Summary Categorisation

Arranging products to display into categories in a model is another po-
tentially difficult model layout problem. Let’s say you’re creating a pricing 
model for some advertising products. You’ve got print ads and digital ads, 

Figure 2.1  Model Layout Option 1

Figure 2.2  Model Layout Option 2
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and these are both split into Display and Text Only. The question is, should 
you display the output of the model as shown in Figure 2.3 or Figure 2.4?

The example in Figure 2.4 is more concise, but shows less detail, so it re-
ally depends on how much detail you want to show your user. This compari-
son demonstrates the constant balance that a modeller needs to maintain 
between detail and conciseness when building a financial model.

The Golden Rules for Model Design

There are a few rules for model design that should be followed when de-
signing the layout of a model. Most experienced modellers will follow these 
instinctively, as they are generally common sense.

Figure 2.3  Model Categorisation Option 1

Figure 2.4  Model Categorisation Option 2
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Separate Inputs, Calculations, and Results, Where Possible

Clearly label which sections of the model contain inputs, calculations, and 
results. They can be on separate worksheets or separate places on a given 
worksheet, but make sure that the user knows exactly what each section is 
for. Colour coding can help with ensuring that each section is clearly defined.

See the forthcoming section titled “The Workbook Anatomy of a Model” 
for more discussion on whether it is always practical to separate these sections.

Use Each Column for the Same Purpose

This is particularly important when doing models involving time series. 
For example, in a time‐series model, knowing that labels are in Column B, 
unit data in Column C, constant values in Column D, and calculations in 
Column E makes it much easier when editing a formula manually.

Use One Formula per Row or Column

This forms the basis of the best‐practice principle whereby formulas are kept 
consistent using absolute, relative, and mixed referencing, as described in greater 
detail in Chapter 3, “Best Practice Principles of Modelling.” Keep formulas con-
sistent when in a block of data, and never change a formula halfway through.

Refer to the Left and Above

The model should read logically, like a book, meaning that it should be 
read from left to right and top to bottom. Calculations, inputs, and outputs 
should flow logically to avoid circular referencing. Be aware that there are 
times when left‐to‐right or top‐to‐bottom data flow can conflict somewhat 
with ease of use and presentation, so use common sense when designing 
the layout. By following this practice, we can avoid having calculations 
link all over the sheet, which makes it harder to check and update.

Excel will also calculate more quickly if you build formulas in this way, 
because it calculates left to right, and top to bottom, so not only does it 
make your model easier to follow, it will calculate more efficiently.

Use Multiple Worksheets

Avoid the temptation to put everything on one sheet. Especially when blocks 
of calculations are the same, use separate sheets for those that must be 
repeated to avoid the need to scroll across the screen.
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Include Documentation Sheets

A documentation sheet where assumptions and source data are clearly laid 
out is a critical part of any financial model. A cover sheet should not be 
confused with an assumptions sheet. A model can never have too much 
documentation!

Design Issues

Here are four key issues you need to think about before you start a model.

	 1.	Time series: Most financial models include a time‐series element, and 
the majority of these will be monthly, quarterly, or annual. It’s impor-
tant to get this right from the start, as it’s much easier to summarise a 
monthly model up to an annual basis than it is to split an annual model 
down to a monthly basis!

	 2.	Data collection: Often, the majority of time is spent not in building a 
model, but rather collecting, interpreting, analysing, and manipulating 
data to put into the model. For example, you could be building an an-
nual model for your company’s fiscal year, which goes from July 1 to 
June 30, but the survey data you’ve collected and want to include is for 
the period January 1 to December 31. If you’ve got access to the raw 
data on a monthly basis, you’ll be able to manipulate the data so that 
it’s accurate—or else you’ll need to extrapolate.

	 3.	Model purpose: Think about what it is that you want the model to 
do. What outputs do you expect the model to show? See “Types and 
Purposes of Financial Models” in Chapter 1 for greater detail on dif-
ferent types of financial models. The outcome that you want the model 
to show will greatly influence the design of the model. For example, in 
a business case or project evaluation model, the outcome that we are 
working toward is the net present value (NPV), and in order to get that, 
we need cash flow, for which we need a profit‐and‐loss statement, and 
this then determines how we build the model.

	 4.	Model audience: Who will be using your model in the future? If it’s 
for only your use, no need to make it very fancy, but most models 
are built for others to use. If so, you will need to make your model 
as user‐friendly as possible, and clearly define which cells are input 
variables and which cannot be changed. If you expect users to have 
limited knowledge of Excel, the model needs to be as simple to use 
as possible.
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The Workbook Anatomy of a Model

Typically, modellers will work from back to front when building their mod-
el. The output, or the part they want the viewer or user to see, will be at the 
front, calculations will go in the middle, and source data and assumptions 
should go at the back. Figure 2.5 shows an example of what your tabs in a 
well‐structured model might look like.

Like the executive summary, a board paper, or other report, the first few 
pages should contain what casual viewers need to see at a glance. If they 
need further information, they can dig deeper into the model.

Unless a model is very small, there should be a dedicated tab worksheet 
for each major component of the model. Whilst by no means a prescriptive 
list, the following is an example of what might be included on each tab.

■■ Cover sheet: The cover sheet contains many details about the model. 
Whether or not a cover sheet is necessary is an issue for debate;  one can 
include (but is not limited to) details such as:

■■ A log of changes and updates to the model with date, author, change 
details, and their impact to the output of the model. This is important 
for version control.

■■ Flow chart of the model structure.
■■ Table of contents.
■■ Instructions on how to use the model.
■■ The purpose of the model for which it should be used.
■■ Disclaimers as to the limitations of the model, legal liability, and caveats.
■■ Global or key assumptions integral to the use of the model.

■■ Input sheet: This is the only place where hard‐coded data is permissible. 
There may be one or more input sheets if there are copious amounts 
of data, but the input data should be laid out in logical blocks, for 
example: consumption data, WACC data, assets and depreciation data, 
inflation and indices, pricing and tariffs, assumptions and constants 
(such as tax rate, discount rates, concession rates).

■■ Output, summary, and scenario sheets: These present the final outcomes. 
They may also contain scenario drop‐down boxes, spin buttons, or 
check boxes that allow the users of the model to generate their own 
outputs. Tables and charts summarising the outputs should be set up in 

Figure 2.5  Model Structure
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such a way that they can be easily printed or used to generate reports. 
Ensure that these can be easily printed directly from the model, or cop-
ied or linked to other programs such as Word or PowerPoint.

■■ Calculation or workings sheets: Split the calculation sheets logically and 
then, within each sheet, set them up consistently. If calculation sheets 
are split, ensure that the layout and formatting are as consistent as pos-
sible across all sheets.

■■ Error check sheet: This sheet contains links to all error checks in the 
model. Error checks should be performed in the calculation section, 
but a summary of all error checks in one location means that once the 
model is in use, the modellers can quickly check to see if any of the error 
checks have been triggered.

Workbook Anatomy Issues

Matters to consider when designing the layout and structure of the model 
include:

■■ A cover sheet: Is a cover sheet necessary? It’s not absolutely critical, 
but it is good practice to put one in. In my experience, cover sheets and 
instruction pages are rarely used. If you decide not to include a cover 
sheet, make sure that the model contains explicit instructions regarding 
operation, purpose, assumptions, source data, and disclaimers.

■■ Input and output locations: Should there be a dedicated input sheet, or 
should the inputs and outputs be contained in one sheet? Many mod-
elling specialists maintain that inputs, outputs, and calculations must 
be clearly separated, but this is not always practical. Generally, larger 
models should have a dedicated input sheet, whilst smaller models may 
show inputs and outputs on the same sheet. However, if you’ve created 
a large model with inputs and outputs on different sheets, and then 
want to perform a scenario analysis using a data table, you’ll need to 
move the inputs and outputs to the same sheet. For example, in a small 
model that takes inputs and generates simple tables of output data and 
charts in reports, the modeller may set up the sheet to have a block 
of input at the top of the worksheet with the calculations and charts 
directly underneath. You may consider splitting the charts and ratio 
calculations into separate worksheets to avoid the worksheet becoming 
too long and unwieldy.

■■ Calculation organisation: Should calculations be on one or multiple 
sheets? Depending on the size of the model, all calculations could be 
contained within one worksheet, spread over several worksheets, or 
even spread over several workbook files. If the calculations become long 
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and confusing, it makes sense to split them into logical sections. For 
example, they can be split by type of service, customers, financial tables, 
geographical location, or business segments.

■■ Colour coding: If you decide to use colour (and I recommend that you 
do, or else your model will look pretty boring), make sure that the co-
lours you use are consistent. For example, if African regions are yellow, 
Europe is blue, and Asia is pink, make sure that you use those same 
colours every time numbers for Africa, Europe, and Asia are displayed. 
These colours should be consistent in calculations in your model, dis-
play tables, and charts. Some companies have standard colour coding, 
but if your company does not, you might consider developing a stan-
dard. You could consider including a colour code key in the cover page. 
The use of predefined styles (found on the home tab) can make colour 
coding very quick and easy. Below are some commonly used colour 
codes that are supported by the in‐built styles in Excel that you may 
consider adopting in your company:

■■ Blue font and beige background for input cells.
■■ Pink or grey for error checks.
■■ Green or orange for external links.

Formatting can be quite time consuming and using Styles is a much 
faster way of creating consistent formatting. Figure 2.6 shows where to find 
the styles menu on the home tab.

Use a double border to indicate that the calculations change. In Figure 2.7, 
the double line shows that the formula is not consistent across the row.

Many companies have their predefined colour coding loaded as style 
templates, which ensures consistency in colour coding in financial models.

Project Planning Your Model

Whilst planning ahead is very important for successful modelling, it is unre-
alistic to expect that a detailed project plan can be created prior to starting 
to build it. Quite often the modellers do not have much idea of the size and 
scope of a model until they get in and start working on it.

How Long Does It Take to Build a Financial Model?

Whether you are a consultant building a model for a client, or an internal 
modeller, you or the person who has commissioned the model build will, 
understandably, want to know how long it will take. The answer is never 
straightforward. As with many other tasks, it really depends on how much 
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Figure 2.7  Commonly Used Formatting for Inconsistent Formulas

time you have (and there’s never enough time) and how much detail the us-
ers need. The more time you have, the better the model will be! Some models 
could take months and months of dedicated work, but it is also possible to 
throw together a very high‐level model in a day or two.

In a high‐level model, the assumptions would probably be only esti-
mates, as you won’t have had time to validate them with stakeholders, and 
the calculations will be pretty rough. You also might not have much in the 
way of fancy colours, formatting, drop‐down boxes, or check boxes, but the 
numbers should still be reasonably accurate.

Building a Model under Pressure

It’s a critical point to remember that even when under immense time pres-
sure, the modeller should never compromise on good work practices. Even 
in a high‐level model, best practices should be adhered to, and correct la-
beling and documentation of assumptions should be maintained. For this 
reason, there should be surprisingly little difference in the base numerical 
outcome between a high‐level model that takes a few days, and a detailed 
model that could take months. If pressed for time, cosmetic features such as 
those shown below should be omitted.

Time permitting, the detailed model may show:

■■ Detailed assumptions documentation, validated by key project stakeholders.
■■ Scenarios and sensitivity analysis, using drop‐down boxes, check boxes, 
or data tables.

■■ Table of contents or navigation tools.
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■■ Colours and formatting, conditional formatting, and insertion of com-
pany logos.

■■ Output summary and detailed analysis of output.

Time should be spent on quick wins. Use your judgement to spend your 
time on calculations that are material to the model. Don’t waste time on 
validating minor assumptions that are not material to the outcome of the 
model.

Model Layout Flow Charting

Based on an initial concept discussion of the problem, modellers can map 
out the structure of the model and how it will arrive at the required out-
puts. For models that will be viewed by external parties, and large or more 
complex models, a flow chart diagram that maps the model’s structure and 
how it solves the problem is essential. Not only does this help in building 
the model, it also helps users of the model to better understand the model’s 
logic, design, and purpose, and can be used as a presentation tool when 
explaining the model. Taking time to design the layout and structure of the 
model is particularly helpful if there is uncertainty about what the model 
needs to cover, in terms of both breadth and depth.

Such flow charts, if created, should become part of the model’s final 
documentation. There are some pieces of software that will automatically 
create model flow charts, but most modellers will create them manually us-
ing PowerPoint, Visio, or Excel. Of course, it is highly likely that your model 
will be amended during the build or as the result of a review. Therefore, if 
you create the flow chart manually, remember to update it as the design of 
your model changes!

In Figure 2.8, the output that is required is to determine what price 
needs to be charged per customer. This is a high‐level flow chart of what the 
model might look like.

Steps to Building a Model

Once the aforementioned factors have been determined, you can begin to cre-
ate your model. Most modellers will just dive in and start building, and whilst 
it’s good to encourage innovation and creativity in creating financial models, 
it’s still important to follow some ordered steps to achieve the best outcome.

If you’re working as the sole financial modeller in a company or as a 
consultant, you might be able to follow a less formal process, and so I’ve 
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Figure 2.8  Sample Flow Chart of Model Calculations
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provided a more streamlined version of the steps to follow (“The Stream-
lined Version,” below). If you are working as part of a team of financial mod-
ellers, the steps are more detailed, as it’s more important to follow a docu-
mented and structured process, particularly if there are many modellers and 
stakeholders providing input. (See “The Team Version” section further on.)

The Streamlined Version

This version of the model‐building process is for less formal projects, es-
pecially those models designed to be used exclusively by their creator. The 
seven steps to the streamlined version are as follows:

	 1.	Design the high‐level structure. You’re not going to know exactly what 
the layout of the model will be until you dig into it, but you should have 
some idea of the tabs. Start by assembling the data you have so far into 
the tabs as shown in Figure 2.5.

	 2.	Design outputs: summaries, charts, and reports. Begin with the end 
in mind. By thinking about the output of your model early on in the 
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process, you’ll be more focused and will ensure that all of your calcula-
tions work toward the desired end result.

	 3.	Design inputs. Thinking about the input design issues, get your input 
data into the right format or layout so that you can link your calcula-
tions to it.

	 4.	Plan calculations by breaking larger problems into smaller ones. Now 
begin your calculations. You might begin by thinking that all expenses 
can go on one tab, but if staff costs, for example, begin getting rather 
complicated, you might decide that staff costs needs a tab of its own.

	 5.	Finalise outputs. Link through your calculations to the outputs page. 
Test at every stage to make sure that the model makes sense and adjust 
as necessary.

	 6.	Design sensitivities and scenario analysis. Once the model is working 
correctly, you can add sensitivities and scenario analysis. See “Overview 
of Scenario Analysis Tools and Methods” in Chapter 11 for greater de-
tail to help you choose which methods of scenario analysis to use.

	 7.	Document as you go. Assumptions documentation should not be left to 
the end. Do it as you go!

The Team Version

If you are working in a large organisation and the modelling project is large, 
involving several financial modellers and stakeholders, you’ll need to follow 
a more formal process. The larger the size of the model and the scale of the 
project, the more up‐front project planning will be required. This detailed 
process is simply to provide a framework in the absence of one; it should by 
no means make the process more complex or constrict it, and how closely 
you stick to the process will depend on the size and scale of the project.

The 12 steps have been split into two stages: planning and building.

Planning Stage

	 1.	Scope out the project. Assess what needs to be done in order to com-
plete the model.

■■ What is the purpose of the model? Clarify the scope and parameters 
of the model. Be clear about what the model will be designed to do 
and its limitations.

■■ What is the problem we are trying to solve? Is a model really re-
quired and is Excel necessarily the best solution? See “Tool Selection” 
in Chapter 1 for greater detail on alternative tools. (The rest of this 
book assumes that the model will continue to be built in Excel.)

■■ What’s the time frame? Create a project plan by separating the work 
that needs to be done into sections and assign the tasks and milestones.
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	 2.	Assign project tasks. Once the project has been defined and scoped, 
you’ll be able to determine the skills and resources required to complete 
the project.

■■ What kind of skills will be needed for this project? Make sure you 
have a balance of industry, finance, and business skills in the team. 
(See “What Skills Do You Need to Be a Good Financial Modeller?” in 
Chapter 1 for greater detail.) Consider hiring external consultants if 
the skills are not available in‐house.

■■ Who will be involved? Identify the stakeholders who need to provide 
input and validations on the model. Communicate with them about 
their project requirements and time‐frame expectations.

	 3.	Determine the users of the model. The modeller must know who will be 
using the model, as this will affect the technical development. Creating 
a model for others to use will require designing an interface that is suit-
able for their needs and, in particular, their level of familiarity with Ex-
cel. This requires consideration of several issues that impact the model 
build:

■■ Excel version. The modeller needs to consider whether the user may 
be opening the model in an earlier version of Excel.  There are several 
considerations the modellers need to make if the model must be com-
patible with the older versions of Excel. For example, the file must be 
saved as an .xls version, not .xlsx, and the modeller must avoid some 
of the newer functions. See “Excel Versions” in Chapter 5 for more 
information on this issue, and “Reducing File Size” in Chapter 10 for 
how to change the file type.

■■ User‐friendliness. The weaker that users’ skills are with spreadsheets 
and modelling, the more user‐friendly the model will need to be, for 
example, by incorporating more instructions, control tools (such as 
drop‐down boxes, option boxes), and simple macros. In some cases, 
a model may be supplied to a third party or made publicly available, 
through a website, for example. In such cases, the modeller should as-
sume the user has an extremely low level of Excel skill, and the model 
should be highly protected to make sure that users do not damage 
the model. See “Bulletproofing Your Model” in Chapter 7 for more 
information on how to protect models.

■■ Data validation. The model can be constructed so as to minimise the 
risk of users entering incorrect data. For example, when entering staff 
names, they may enter “William Jones” as “Will Jones,” “W. Jones,” 
“Jones, W.,” or any other number of variations, which can cause er-
rors in a model. The modeller must consider how much validation of 
inputs should be included, and if error messages should be provided, 
as this functionality can be quite time consuming to build and test.
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■■ Frequency of use. The modeller needs to consider how outputs can 
be located and generated and how often the model will be used. 
If the model is to be used often, the design of the outputs and the 
time it takes to run should take this into account. Most models will 
calculate automatically, but more complex models may include a 
procedure that needs to be manually updated, or macros that may 
take time. If the model is only to be used occasionally, it may be of 
less importance if it takes longer to create the outputs each time the 
model is used.

■■ Testing and adapting. Creating a model for your own use may not 
require as much work as creating a model for others. However, it is 
important to keep in mind that someone else will need to test and 
validate the model, and others may need to use or adapt the model 
in future. Modellers should always ensure that the model is generally 
logical and user‐friendly.

	 4.	Design the high‐level structure. Create a flow chart as discussed in 
“Model Layout Flow Charting” earlier in this chapter.

■■ The flow chart will include a place for the input, outputs, summaries, 
and charts. Create a list of all the outputs needed and how they may 
be presented (e.g., in a table, chart, diagram, or other method). The 
outputs and their presentation format should be taken into account 
when designing the layout of the model.

■■ Translate the flow chart into the model. You should have an idea of 
the number of tabs and how they will be arranged within the model. 
Try to ensure that the data will flow logically in one direction (right to 
left) throughout the model, so that links do not jump around, making 
it confusing to the user.

■■ Remember to update the flow chart if the design of the model changes 
during the building process.

	 5.	Create a data collection plan. Data collection can be the most time‐con-
suming part of a financial modelling project, so this needs to be care-
fully incorporated into the project plan to ensure that the data used in 
the model is as accurate as possible and received on time.

■■ Create a list of inputs that will be required and where they will be 
sourced. These will feed into the project plan as tasks.

■■ At this stage you may be able to identify data‐related issues that need 
attention and consider solutions to anticipated problems. If you are 
creating a risk register as part of the project planning process, this 
is a key risk. For example, some inputs may be critical to the model 
but rely on the data being available. You will need to consider risk‐
mitigation strategies to ensure the availability and reliability of data 
to be provided by your sources.
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■■ The model should be designed to accommodate the format in 
which the necessary data is available and the output is required. 
For example, if the data is provided in a weekly format, but the 
output is required as monthly, you need to consider whether you 
want to preserve the original data as weekly and consolidate it as 
part of the model, or consolidate it prior to entering the data into 
the model.

■■ You may even consider designing an information request form for 
sources to fill in so that the data can be easily extracted and entered 
into the model.
With the plan in place and layout, structure, and logic determined, 

you can now begin to build the model.

Building Stage

	 6.	Build inputs. Enter the data into the input pages. Make sure that you 
follow best practices by documenting all assumptions and source refer-
encing. It is critical that this is done as you enter the data, or when you 
record from where you got the data. If there is any possible misinterpre-
tation or lack of clarity about how a calculation works, make sure that 
it is explicitly documented, either in the calculations page or as part of 
the assumptions. See “Methods and Tools of Assumptions Documenta-
tion” in Chapter 3 for greater detail on tools and techniques that can be 
used for documenting assumptions.

As inputs become available and the model is populated with actual 
data, it is critical that the source of that data is kept up‐to‐date. Source 
referencing of inputs should be sufficiently detailed to allow a third 
party to track it back to the source easily. Information should include 
title, date, author, page number, web page, and so on to allow for easy 
tracing and validation of the model’s input data.

Documentation should include:
■■ A description of the model’s functionality so users will be able to see 
the general purpose of the model and its limitations, often graphically 
displayed by a flow diagram of the model’s structure.

■■ Instructions on how to use the model, including a colour‐code key 
explaining the colours and styles used in the model.

■■ If a calculation or data point in one section is treated differently from 
the rest of the model, an explanation of the reason for the difference.

■■ Changes to the structure of a model in the version log on the cover 
page, detailing what structural or major changes were done, when, 
and by whom.

	 7.	Build calculations and workings. Building accurate and clearly au-
ditable calculations is a critical step in building a financial model. A 
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logical calculation should allow users to follow and trace the calculation 
easily—from the inputs to the outputs, and back again.

■■ Follow best practices by linking to input cells, only enter data once, 
and always refer to the original source’s cell where possible, rather 
than linking to another link.

■■ Don’t mix hard‐coded data with formulas. If you need to hard‐code a 
number into a cell, it should be included in the assumptions or source 
data sheet, and linked from there.

■■ Try to work from left to right and top to bottom where possible.
■■ Use name ranges in Excel to name single‐cell constants, or tables of 
inputs. This can make it easier to build and validate formulas in a 
financial model. (See “Named Ranges” in Chapter 5 for detail on that 
topic.)

■■ Use the superior method and the most efficient functions. This meth-
od will be the simplest, most efficient, and easiest to follow.

■■ Link logically throughout the model. Try to make sure links go in 
one direction (from left to right) instead of jumping backward and 
forward between different tabs.

■■ Build error checks wherever possible, and sense‐check and test for 
errors as you go.

■■ Double‐check calculations using alternative calculation methods or 
by manually calculating from first principles.

■■ Document the calculations and their logic as you go; don’t leave it all 
to the end. Your process may seem obvious to you at the time, but it 
is probably not clear to someone else reviewing your model. There is 
a fairly high likelihood that later on you won’t remember why you’ve 
calculated something a certain way.

■■ Long calculations should be broken up into logical components 
of simpler calculations. This will avoid one long formula in Excel, 
making it easier to understand, test, and update, and greatly reduce 
the possibility of error. (See “How Long Should a Formula Be?” in 
Chapter 4 for an example of how trying to do too much in one cell 
can make a calculation extremely difficult to follow.)

■■ A more detailed flow chart expanding out the calculations into sub-
components may be the clearest way to present the model’s logic if a 
calculation is particularly complex. This can be done in Excel by tak-
ing an example piece of input data and documenting its flow through-
out the calculations.

	 8.	Build outputs: summaries, charts, and reports. Begin to summarise the 
calculation on the output page.

■■ Continue to test and check for formula and logic errors at every stage 
of building.
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■■ Follow best practices as outlined above for outputs as well as calculations.
	 9.	Peer and client review of draft model. Now that the model’s design, 

logic, and calculations have been determined, it is important to go 
through it with the rest of the team to ensure that the model meets 
its purpose. Get the team together, take a key input, and follow it 
through from beginning to end. The timing of this review is impor-
tant, as it needs to occur after some of the model has been built, to 
allow the reviewers to check the expected outputs and how the mod-
el operates in practice; however, the model should not be finalised yet 
in case there are significant structural changes required as a result of 
the review.

Not only must a model solve the problem for which it is designed, 
user acceptance of the model is also important. Clients (end users) must 
accept and understand the model. A walkthrough at this stage may as-
sist to identify areas where corrections or modifications are needed, and 
will also allow the user to become familiar with how the model is in-
tended to work.

Factors to be considered in the peer draft review are:
■■ Walk through the calculations: Are they accurate at a high level?
■■ Are the assumptions and source data clearly driving the output?
■■ Does the model solve the problem it is being designed to solve?
■■ Are the flow and structure easy to follow?

Note that this peer review is your last chance to ensure that there 
are no formula or logic errors in the model prior to the formal quality 
assurance (QA) of the model. Modellers should be confident that their 
models submitted for formal QA are free from mistakes.

	10.	Design sensitivities and scenario analysis. Once the base model is com-
pleted and working correctly, you can add sensitivities and scenario 
analysis. The inputs for scenario analysis may not have been determined 
as part of the planning process, and now that the base model is com-
plete, you will be able to test the inputs to see their impact. This may 
influence your decision as to what to show in the scenario analysis.

	11.	Formal model QA (quality assurance) check. This final QA check of the 
model is a formal process and should not be confused with continual 
testing and debugging that should have taken place during the model 
build. (See “Error Avoidance Strategies” in Chapter 4 for greater detail 
on the tests and checks that should be done by the modeller during 
the build process.) It is the modeller’s responsibility to ensure that the 
model is accurate, robust, and operational. The QA process should not 
uncover formula or logic errors at this late stage, and discovery of such 
will raise questions about the competency of the modeller. The model’s 
final QA testing process includes:
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■■ Stress‐testing the inputs with a wide range of values to check the inner 
workings of the model. This includes testing values at the extremes 
to ensure that the model processes the input as expected, especially 
where validation and protection are used. Also test a wide range and 
combination of input variables, as some hidden bugs may exist in the 
calculations. Using 0 or 1 can help to highlight obvious errors, as the 
outputs should be simple. For example, a unit price of zero should 
generate a revenue of zero and if it does not, you’ll need to investigate 
why not!

■■ Check that Excel errors such as “#DIV/0!” have not been triggered by 
entering zeros or other invalid data as inputs.

■■ Make sure that all inputs can still be entered properly. By applying 
protection to a model, a modeller can inadvertently cause switches 
and drop‐downs to stop working. If protection is applied, additional 
testing and checking will need to be carried out.

■■ Check the sensitivity of outputs (dependent variables) to chang-
es in the inputs (independent variables). Part of the QA process 
should be to check that the direction and magnitude of the change 
are in accordance with how you logically expect the outputs to 
behave.

■■ Check all documentation for spelling, grammar, colour coding consis-
tency, and presentation.

■■ As the model goes through several iterations, it’s common to find that 
redundant calculations are included even though they are no longer 
useful or applicable to the model. Tracing dependents is useful for 
identifying input data that is not being used.

	12.	Maintain the model. Once a model is completed and provided to the 
users, it is fairly likely that at some point—weeks, months, or years after 
the model has been completed—maintenance or updating of the model 
will need to be undertaken. If it’s simply to change inputs, this can be 
done by the user, but if the change is major or structural, a model devel-
oper should be the one to make the changes.

Depending on the availability of resources, it is preferable that a 
member of the original model‐building team undertake the update, but 
if best practices have been followed throughout the build process, if it 
has been well documented and built in a robust fashion, and if the mod-
eller doing the update is well versed in financial modelling procedure, 
updating the model should not pose any problem.

When the model is updated or amended, especially if the change is 
structural, version control processes need to be followed to ensure that 
the correct version of the model is used. Below is some more informa-
tion on how to document versions correctly.
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Information Requests

The collection of data is a critical part of financial modelling, as a model is 
only as good as its inputs and, in many cases, the inputs of the model rely 
solely on information from other parties, whether internal or external to the 
organisation. Therefore, the receipt of timely and accurate information from 
these parties is important. Sometimes as much time can be spent collecting 
data as actually building the model and if this is an issue, you may consider 
creating a formalised information‐request procedure.

Larger organisations, particularly government agencies, often already 
have information templates in place for purposes such as compliance and 
monitoring, and will not encounter much resistance internally to their in-
troduction. However, advice on how to go about implementing information 
requests is outlined in the following:

■■ Incorporate tables for key data and make provisions for executive 
sign‐off.

■■ Liaise at an early stage with the other parties about the information 
requested and its purpose. Different departments and other companies 
have different information systems, and so the form in which data is 
available may differ. Work closely with the other parties to communi-
cate the purpose of the information, and to devise templates that facili-
tate easy collection of input data.

■■ Design the information request so that the data is provided in the cor-
rect format by using import and export sheets. This is useful for large 
data sets and, if used frequently, macros speed up the insertion of data 
into the model.

■■ Design the data‐collection sheets such that once completed, they can be 
fed directly into the model by copying and pasting or using links. No 
manual data entry should be required to save time and reduce the pos-
sibility of error.

■■ Make clear what is expected in terms of data quality. It is possible 
that the information provided by other parties is not entirely accu-
rate, so you may consider subjecting that information to internal QA 
processes. Normally model input data is simply taken at face value, 
and the source documented in the assumptions, but a QA of the data 
will provide a greater degree of assurance that the data being input 
to the model is complete, accurate, and consistent. Make sure that 
the party providing the information is aware of this procedure in 
advance.

■■ Provide a timeline that is sufficient for the parties to respond to infor-
mation requests. This will feed into the project plan as outlined above. 
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The modellers will also need to allow time to check the quality and reli-
ability of the information that has been submitted.

■■ Ensure consistency of information‐request templates with previous tem-
plates that have been issued, and try to ensure consistency with previous 
requests that may have been distributed in the past.

■■ Pre‐fill information request documents with existing information where 
available, as this will expedite the process.

■■ Even if the modeller sets up an information request in the correct for-
mat that is required to input directly into the model, there is always the 
risk that the person entering the data will insert or delete rows, columns, 
or formulas. It is advisable to protect the worksheets to prevent this 
happening, as an extra row when copying, pasting, or linking data can 
be disastrous!

Version-Control Documentation

A new version of the model means structural changes to the design or new 
calculations. It should not be confused with changes to input variables such 
as those in blue font on the source data page. Changes to input variables are 
simply changes to scenarios or sensitivity, not a new version.

A version‐control log is usually located on the cover sheet of a model, 
although in particularly long or complex models it may warrant having its 
own worksheet tab.

It’s important to remember that any new versions of a model subse-
quent to its being completed still need to go through the QA process. There 
is no point in creating a model that has been through the sign‐off process 
only to make changes that do not meet the same standards.

Below are a few generally accepted guidelines to follow when creating 
a new model version:

■■ File names should end with a version number. For example:
■■ [description of model] [date] [Version number].xlsx
■■ HoneyCorp RePricing Model 16 July 2016 V1.xlsx

■■ If this is a sizable project and it’s going through multiple versions, which 
need to be tracked, each model should contain a log (usually located on 
the cover sheet) that lists the original version of the model and details 
the calculation changes made to that version since inception. Informa-
tion that needs to be included on the version‐control log is:

■■ Version number and date.
■■ Description of changes clearly detailing each change that was made 
for that version.
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■■ Where in the model the changes were made.
■■ Who made the changes.
■■ A mark to show that the changes have been through QA.
■■ Any necessary comments explaining the changes (e.g., a change in 
cost structure or a new scenario needed to be built).

File Structure

Over the course of a complex modelling project with multiple versions, you 
need to put some thought into the file structure to ensure ease of finding the 
correct version. A modeller who picks up and works on the incorrect file can 
experience disastrous results and also waste a lot of time.

Your file directory might look something like Figure 2.9.
Keep a separate folder for each project. In this case, the HoneyCorp 

Repricing project has its own folder. Underneath you find:

■■ Models: A list of the model with version‐control nomenclature applied. 
If there are several models pertaining to the project, create subfolders 
in this section. You might delete older versions of the model (if you are 
sure that they are completely redundant) once the project is complete to 
save on file space.

■■ Project planning: Documents relating to the project plan, resource al-
location, and timelines.

■■ Source data: All the details about where the data for the model came 
from. The models should be linked to this folder for auditability. Be ex-
tremely careful with linking if there are several versions of the source 
data files. Use the “edit links” function to manage the links between the 
files.

This sample folder directory is only a guideline, and assumes a medium‐
sized financial modelling project in terms of size and complexity. Add as 

Figure 2.9  Sample File Structure
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many folders as you need, but make sure they’re well organised and easy to 
navigate so you can find the required information.

Summary

In conclusion, considering the layout and design of a financial model is an 
important part of the model build. It takes a unique mixture of logic, clar-
ity of thought, and graphic layout skills by the financial modeller to build 
a well‐designed model, and this often proves to be difficult to implement in 
practice. Model design can sometimes be the most difficult part of building 
a financial model and it is, in my experience, one of the most difficult aspects 
to teach and learn. When building your model, pay close attention to the 
design layout and ensure that it is clear, coherent, and logically structured.
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Chapter 3
Best Practice Principles 

of Modelling

The principles of best practice outlined here are for the purpose of reduc-
ing errors and making a model easier to read, audit, update, and use for 

its intended purpose. This chapter is by no means exhaustive, but outlines 
the most important principles in using Excel for business analysis and fi-
nancial modelling. By following these key principles, your model is easier to 
navigate and check, and much more likely to be robust, accurate, reliable, 
and error‐free.

Document Your Assumptions

Good assumptions documentation is one of the most important principles 
of best practice. It is impossible to check, validate, or use a model if you are 
unable to verify the integrity of the data sources or methods of calculation 
in the model. Your model design, layout, and structure can be perfect, but its 
validity is really reliant on the assumptions that go into it (i.e., garbage in, 
garbage out). The most beautifully structured model in the world is pretty 
useless if the assumptions that go into it are garbage!

Documentation of assumptions helps with validation and avoids misin-
terpretation. If there is any possible misunderstanding about why, how, or 
what the assumptions are in the model, make sure it’s recorded in black and 
white on the assumptions page.

List assumptions on a separate page, clearly labelled. For a smaller 
model, you might decide to mix source data and assumptions together, or 
they could be separated in a large model.

The more detail, the better! If your assumptions are extremely detailed, 
you could have a section for key assumptions, where you summarise the 
important assumptions but leave all the detail in case it is needed.
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Document source data and unique calculations as you go. Don’t leave it 
all to the end and don’t rely on your memory. Months later you or another 
modeller will have no idea why you calculated something a certain way. 
Make sure it’s well documented.

Linking, Not Hard Coding

Financial models are, by definition, dynamic and changing, depending on 
the input variables, and they need to include links in order to facilitate this. 
This becomes particularly important when performing scenario and sensi-
tivity analysis. Always link as much as possible in your model so that when 
the inputs change, the outputs also change (which is pretty much the whole 
point of financial modelling). By linking, you can trace source data back 
through the links, which makes your model auditable, traceable, and easy 
to validate.

■■ When you link to external files, make sure that you use named ranges. 
(See “Linking to External Files” in Chapter 4 for greater detail on this.)

■■ There should be no hard coding except for input variables, unless refer-
enced or source data is listed or it is otherwise blindingly obvious where 
you got the number from.

■■ Never use a value within a formula. The only exceptions are those 
things that are considered standard or commonly accepted and will not 
change, such as:

■■ 24 hours in a day.
■■ 7 days in a week.
■■ 60 minutes in an hour.

You may notice that many modellers put input variables in blue font. 
Whilst this is a bit old‐fashioned, it’s still quite standard practice and it acts 
as a signal to your user or another modeller that this is a hard‐coded input 
variable that can change (i.e., you are allowed to change this value). The 
problem with blue font, though, is that you can’t see it when there is no 
value in the cell, so many modellers use a beige or yellow background with 
blue font. The use of Styles makes it much easier to format, and Microsoft 
has helpfully created a Style called “input” in Excel that has become a fairly 
commonly used standard nowadays in financial modelling, and seems to be 
used more frequently than the old blue font standard. Styles can be found 
on the Home Tab in the Styles group, and you can see how to find the input 
style in Figure 2.6 in Chapter 2. Also see “The Workbook Anatomy of a 
Model” in Chapter 2 for greater detail on colour coding.



Best Practice Principles of Modelling� 57

Enter Data Only Once

Source data should always be entered only once. For example, list inflation 
assumptions on the source data or assumption documentation page and, ev-
ery time you use inflation in the model, refer back to that cell or row of cells. 
This will make the model easier and faster to update and less prone to error.

Never use a value within a formula. For example, ¼IF(G$6.¼$E7, 
136800,0) should have a link, not 136800 typed in. This means that you don’t 
have to edit each cell when the value changes, and makes the model much easier 
to audit. However, make sure that you do not link source data to a cell that 
itself has been linked to the original source. Always go directly to the source 
data. The result of this malpractice has been aptly termed “daisy‐chaining” in 
financial modelling best practice circles.1 It is an inefficient and error prone (yet 
tempting!) practice, and should be avoided when building financial models. It 
causes the link flow throughout the model to be a lot longer and complex than 
it needs to be, and will cause errors if a section of the model is deleted.

Avoid Bad Habits

Here are a few bad habits financial modellers can get into:

■■ Hitting the Enter key or the green check box after editing a formula. Don’t 
just click elsewhere. It’s a bad habit many people have, and one that can cause 
unintentional errors. See “Avoiding Simple Formula Errors” in Chapter 4 
for more explanation on how this common habit can cause errors.

■■ Highlighting a range only, instead of the entire row or column. Using 
the entire row or column is tempting, but it takes up too much memory 
and can really slow down the calculation speed. This is often done be-
cause the modeller wants to be able to add extra rows to the data, but 
consider using Tables instead to avoid this problem. See “Structured 
Reference Tables” in Chapter 8 for how to create Tables.

■■ Daisy‐chaining links throughout the entire model instead of linking to 
the source, as described above.

Use Consistent Formulas

In a table or block of data, the same formula should exist all the way across 
and down the entire block. Use mixed cell referencing to achieve this. (See 
the section “Cell Referencing Best Practices” in Chapter 5 for a practical 

1	 FAST Modeling Standard, www.fast‐standard.org.

http://www.fast-standard.org
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exercise on how to do this.) It saves time and avoids errors—and this prac-
tice is a keystone to good financial modelling technique. If you only pick up 
one modeling technique from this book, let this be it!

If you really need to change formulas so that they differ across adjacent 
cells, you can indicate this with a double border to show that the formula 
has been broken. This will help with auditing. See the section “Model De-
sign” in Chapter 2 on colour coding for an example of how this looks.

■■ Avoid blank rows or columns in data blocks where possible, as this can 
cause problems with sorting, filters, and PivotTables.

■■ If sheets are similar, use a template where possible and copy the same 
sheet. Then when you need to update it, group the sheets to make global 
changes.

■■ Try not to use macros to perform lengthy calculations or manipulations 
because this reduces transparency. Only in limited areas, such as goal 
seek on the scenario generation page, should macros be used, and these 
instances should be clearly documented.

Format and Label Clearly

Formatting and labelling in a model will reduce error and make your model 
easier to understand. It sounds simple, but, like mixing apples and oranges, 
mixing units is a common source of error in financial modelling. Clear for-
matting and labelling will avoid this.

■■ Format cells appropriately. Use symbols for currency (e.g., $, €, £, ¥), 
the percent symbol (%) for percentages, and commas for thousands. 
This makes your model easier to read and avoids mistakes and misin-
terpretations.

■■ Include a dedicated units column (e.g., column C) and make sure the units 
are entered into that column, (e.g., $, 1,000s, MWh, liters, headcount, etc.).

■■ If you decide to round figures into thousands, show this clearly at the 
top of the row with a descriptive heading such as “Revenue ($1,000s)” 
to avoid confusion and misinterpretation.

■■ Column and row headings should have unit or currency headings and 
only contain one type of unit or currency.

■■ When building multisheet models, columns should be used consistently. 
For example, if building a model for the period 2017–2027, use column 
F on each worksheet for 2017, column G for 2018, and so on.

■■ It is often a good idea to reserve a column (for example, column D) 
for constants that apply to all years, months, or days. For example, if 



Best Practice Principles of Modelling� 59

growth rate is 5 percent, have that in column D and then link all calcu-
lations to column D.

In general, these best‐practice guidelines are really just common sense. 
Whilst some of them may seem tedious and overly prescriptive to the begin-
ner, most of these points are for the purpose of reducing error and bringing 
increased robustness and clarity to the model. These practices are probably 
second nature to the experienced financial modeller, who will most likely 
already follow these guidelines by instinct.

Methods and Tools of Assumptions Documentation

Many senior managers put a lot of faith in a business case, new venture, or 
decision supported by a financial model. I’ve seen many cases where manag-
ers will blindly decide to go ahead with a project because the financial model 
seems to indicate that they should. Unless the assumptions are clearly under-
stood and listed beside the outputs of the model, the financial model should 
not be considered a definitive decision‐making tool. Important decisions are 
made based on the outputs of the model, and it is critical to list the assump-
tions that have gone into the model. A model is only as good as the accuracy 
of the assumptions. It is important to mitigate your liability by documenting 
your assumptions thoroughly and adding caveats where necessary.

As documentation of assumptions is one of the key points of best prac-
tice in financial modelling, let’s take a look at some commonly used methods 
and Excel tools for including this documentation in a model. All assump-
tions should be listed somewhere in the model, but key assumptions should 
be visible and easily accessible (e.g., via footnotes or statements). The defini-
tion of what is classified as a key assumption is somewhat subjective. As the 
modeller, you need to assess and identify the assumptions that are critical 
to the model. This could be something to which the model is very sensitive, 
and in this case, sensitivities should be performed. You may also choose to 
include the assumptions on which, in your opinion, there has been little re-
search available and you are perhaps not entirely comfortable with the data. 
In such cases, this should be stated, and a recommendation to perform more 
research proposed.

General notes and instructions about the model should be entered in the 
cover page of the model, but notes relating to a certain worksheet should 
be placed in the top area of that particular worksheet. Most assumptions 
will simply be documented on the assumptions page using straightforward 
pasted text, but there are a few other sections of the model that may contain 
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assumptions documentation as well, and there are several different methods 
and techniques for doing this. Greater detail on each tool is outlined in the 
following list:

■■ In‐cell comments
■■ Red triangle comment
■■ Input message

■■ Footnotes
■■ Hyperlinks
■■ Hard‐coded text
■■ Linked, dynamic text

In-Cell Comments

There are two different methods of creating in‐cell comments: the ordinary 
comment with the red triangle in the corner (which I will call red triangle 
comments, as Excel rather unhelpfully simply calls them “comments”), and 
the less commonly used data validation input message.

Documentation of assumptions using in‐cell comments is most appro-
priate for specific matters relating to only one cell or set of calculations, as 
they can be viewed only in a single cell. These are useful for communicating 
details to another modeller about specific calculation details, as they will be 
shown only on the soft copy of the model. More wide‐ranging, generic as-
sumptions should be documented using other methods.

Useful comment entries would be sources or assumptions relating to 
the data in the commented cell. For example, the casual observer of a model 
may wonder why volume is so low at that time of the year. This can be docu-
mented with a comment as shown in Figure 3.1.

Figure 3.1  Assumptions Documentation Using In‐Cell Comment
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    hoW to insert a CoMMent  

   Go to the Review tab and select the New Comment icon from the 
Comments section. Alternatively, you can right‐click on the cell and 
select Insert Comment. 

 To make a change, right‐click on the cell with the comment and 
select Edit Comment to edit. Similarly, right‐click and select Delete 
Comment to delete. 

 You see the red triangle, but the comment doesn’t appear until you 
 hover your mouse over the cell. 

    In‐cell comments are a good way of documenting models, but they are 
not usually printed, so they are only helpful on a soft copy of the model. It is 
possible to print comments, but this isn’t a great option, as they look messy 
and can cover other numbers or text in the model.   

 Data validation input Messages   The less commonly used type of in‐cell com-
ment is to use data validations. These types of comments are more discreet, 
as they do not have the red triangle in the corner, and you don’t see the com-
ment until you actually click on the cell. See Figure   3.2   . 

    Figure   3.2    Assumptions Documentation Using Data 
Validation Input Messages 

   red triangle Comments   The most commonly used method is to simply insert 
a comment within the cell as shown in Figure   3.1  . 
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Table 3.1  Comparison of In‐Cell Comment Methods

Red Triangle Comments Input Message Comments

Can detract from the model, making 
it look messy.

More discreet; don’t distract the eye 
of the user.

Can be viewed all at once. Can only be viewed one at a time.

More obvious to the user. Easily overlooked.

Most appropriate for details about a 
cell‐specific calculation for another 
modeller’s information.

Most appropriate for instructions 
relating to inputs for the user, as 
opposed to the modeller.

Figure 3.3  Data Validation Input Message Dialog Box

This sort of in‐cell comment is especially useful for creating little in-
structions and warnings regarding input data to users, as they won’t see it 
until they actually click on the cell to enter the data.

The dialog box will look like Figure 3.3.
Data validations are incredibly useful in financial modelling. For other 

uses, see the section on “Bulletproofing Your Model” in Chapter 7. Table 3.1 
is an overview comparison of the different types of in‐cell comment methods.
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    hoW to vieW aLL CoMMents in the Worksheet  

 Go to the Review tab and select the Show all Comments button on the 
Comments section. Unselect it to hide the comments. 

    hoW to insert an input Message  

 In Excel for Mac 2011, go to the Data tab and select the Data Valida-
tion icon from the Data Tools section. Select the second tab entitled 
Input Message and type the message you wish to see. This message will 
appear only when the cell is selected. 

            My personal preference is to use input message comments wherever 
possible, as they are neater and cleaner‐looking. Remember, though, 
that if the cell isn’t selected, the comment won’t be viewed, so make 
sure that the comment is only cell‐specifi c. More important, general as-
sumptions and comments should use plain text or another method of 
 documentation.    

 Footnoting 

 Unfortunately, the footnote tool in Excel is almost completely useless for 
assumptions documentation in fi nancial modelling because: 

 ■    It cannot be linked to sections of the model, which greatly limits its 
usefulness. 

 ■    The modeller cannot see the footnote in the ordinary soft copy working 
view whilst building the model.   

 For these reasons, the footnote tool in Excel is really only useful for 
information such as fi le names, page numbers, print dates, and times. How-
ever, linked footnotes can be done manually by formatting the cell font to 
superscript. 

 Footnotes are highly recommended for noting sources of data, assump-
tions, and other important information. For an example, see Figure   3.4   . 

  We can go further with this by making the assumptions documenta-
tion linked so that the numbers update automatically. How to do this is 
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detailed later in this chapter in the section “Linked Dynamic Text Assump-
tions Documentation.”   

 hyperlinks 

 There are two different types of hyperlinks that are useful in fi nancial mod-
elling: URL web links and links to other fi les or locations within the model.  

 Cell and File hyperlinks   You can also create hyperlinks to source or other 
reference fi les and other sections of a model. They can aid in navigation of 
a long and complex model and are especially helpful for new users to fi nd 
their way around the model. 

    hoW to ForMat to supersCript  

 If you select the cell, the entire cell’s format will change. Alternatively, 
you can highlight part of the cell’s text, which will change only the 
highlighted section. 

 Right‐click, go to the Format Cells option, and choose the Super-
script box on the Font tab. 

    Figure   3.4    Example of Manual Footnoting in Excel 

    hoW to insert a hYperLink  

     1.  On the Insert tab, select the Hyperlink icon from the Links  section. 

   In Excel for Mac 2011, select Insert on the Menu bar, then 
select Hyperlink from the drop‐down menu. 
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    Warning  

 Bear in mind that unlike formula links, hyperlinks do not move if the 
source cell moves. If you create a hyperlink to a cell on another tab (e.g., 
A1), and then insert a row above row 1, the hyperlink will not auto-
matically update to A2 as a linked formula would. 

         Similarly, you can insert a hyperlink to another fi le in your source refer-
encing as shown below. 

 Test this out on one of your models. This is useful if you obtained data 
from another fi le and want to document it as a source reference without 
retaining links in the model. 

   2.  On the left‐hand side, select Place in This Document. Note that 
in Excel for Mac 2011, you must fi rst select the Document 
menu, then click the Select . . . button and choose the document 
you are working in. Then type the name of the range you wish 
to link to in the Anchor text box. 

   3.  Select the sheet and cell reference or named range of the hyper-
link source. 

   4.  You can change the Text to Display at the top to display some-
thing like Go to Staff Salaries instead of Salaries!A45, for 
 example.   

    For this reason it is a good idea to hyperlink to a named range rather 
than a cell reference, as hyperlinks do not follow insertion or deletion of 
rows and columns, and this will make your model more robust. To learn 
how to create a named range, see the box on “How to Create a Named 
Range” in Chapter   5  . 

    hoW to insert a hYperLink to another FiLe  

     1.  On the Insert tab, select the Hyperlink icon from the Links  section. 

   In Excel for Mac 2011, select Insert on the Menu bar, then 
select Hyperlink from the drop‐down menu. 

(continued)
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      Web urL hyperlinks   Hyperlinks can also be used to refer to relevant Internet 
or intranet sites directly from your spreadsheet. For example, if the tax rate 
we have assumed in our model was obtained from the World Health Orga-
nization (WHO), we should put a reference to the WHO next to the assump-
tion as shown in the “How to Insert a Website Hyperlink” box. 

       hard-Coded text 

 This method of assumptions documentation is not very sophisticated, but 
like with many things in fi nancial modelling, a simple solution is often best. 

 It’s fairly obvious in the calculations in row 5 of Figure   3.5    that the 
growth rate does not change over time, but the modeller is making it 

    hoW to insert a WeBsite hYperLink  

     1.  In the cell next to or beneath your assumption, type  www.who
.int/research.  

   2.  Make sure you hit Enter after you fi nish typing, and it will turn 
into a hyperlink. 

   3.  Test it out by clicking on the link. 

   4.  If you would rather show text such as Health Research than the 
web address, open the hyperlink dialog box as shown in the box 
above, and change the text to display to Health Research. This 
will display the text, but retain the website link.   

   2.  Click on the Browse for File icon, which is located at the top 
right‐hand corner. Select the fi le that you want to insert. 

   Note that for Excel for Mac 2011, you will select the Docu-
ment menu, then click the Select . . . button before selecting the 
fi le you want to insert. It can be any fi le type. 

   3.  Hit OK, and this will create your hyperlink. 

   4.  You can also create a hyperlink to another fi le or web page that 
does not show the full web or fi le address of the fi le. Follow the 
instructions above, but change the Text to Display fi eld at the 
top of the Edit Hyperlink dialog box such that it shows your 
desired text rather than the full fi le path or web address.   

http://www.who.int/research
http://www.who.int/research
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Figure 3.5  Hard‐Coded Assumptions Documentation

absolutely, explicitly clear by typing the hard‐coded text below the table. 
There is no danger here that a modeller or user can overlook this assump-
tion, whether it is being viewed in soft copy or has been printed out.

Linked Dynamic Text Assumptions Documentation

Documenting assumptions liberally within your model is very important—
however, it is very difficult to keep the documentation up‐to‐date when your 
model is dynamic and inputs are continually changing.

For example, in a business case it would be useful to put the cost of capi-
tal next to the net present value (NPV), as this is a very important assumption. 
If we type “Cost of capital is 12 percent,” however, it will be out‐of‐date as 
soon as we change the assumption, and there is a very high risk that we could 
distribute the model with incorrect assumption documentation. The answer 
to this is to use an ampersand (the “&” symbol). The CONCATENATE func-
tion will do a similar thing, but using the ampersand is quicker to build (and 
easier to spell)! You can join any cells together by using this symbol.

Practical Exercise 1

Let’s try a basic exercise of seven steps to get the hang of how the ampersand 
works. This is demonstrated in Figure 3.6.

	 1.	Practice this in a blank worksheet: Type Hello in cell A1 and Robert in 
cell B1.

	 2.	In another cell, type the formula =A1&B1, which will give you the re-
sult HelloRobert.

	 3.	Now try adding some text. For example, =A1&B1&"how are you?" 
will give you the result: HelloRobert how are you?
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	 4.	Next add a space between Hello and Robert like this: =A1&""&B1&" 
how are you?"

	 5.	Now add a comma after Robert like this: =A1&""&B1&," how are you?".
	 6.	Your sheet should look like the sample in Figure 3.6.
	 7.	Now change the word Robert to Mary and see how your text changes.

Practical Exercise 2

	 1.	Go to a model and practice creating a sentence using linked text to 
document an assumption.

	 2.	For example, number of customers starts at 15,065 in 2016, as shown 
in Figure 3.7.

	 3.	Practice changing either the date or the beginning number of customers 
and watch the text change.

	 4.	If you want to format the number so that it shows as 15,065 instead of 
15065, you can use the TEXT function like this: =TEXT(B5, "###,###") 
Remember that this function turns the data to text, so it is no longer a 
number. You can find out the format that the TEXT function required 
by going into Custom Formatting, as shown in Figure 3.8, by right‐
clicking on a cell, selecting Format Cells and Custom.

	 5.	The total formula would be: ="Number of customers starts at "&TEXT 
(B5, "###,###")&" in "&B4.

Figure 3.7  Linked Dynamic Assumptions Documentation

Figure 3.6  Linking Text Using Ampersand
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Practical Exercise 3

This seven‐step method of documentation can also be used in reporting to 
create commentary on outputs. This commentary can then be easily copied 
to Word or PowerPoint.

	 1.	Create a simple calculation on a new worksheet as shown in Figure 3.9.
	 2.	The formula in cell B4 should be =B2‐B3 and the formula in cell B5 

should be =B4/B2.
	 3.	Now in cell A7 create a comment that says Profit margin is 20%. Re-

member to use the TEXT function to format it as a percentage.
	 4.	Your formula should be ="Profit Margin is" &TEXT(B5, "#%").
	 5.	Now try changing the revenue amount to $3 million. Your profit margin 

changes to 33 percent, and your text commentary still remains accurate. 
Change the revenue back to $2.5 million.

Figure 3.8  Format Cells Dialog Box
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	 6.	If you would like the text to say Profit margin is 33.33% instead of 
33%, add some decimal places to your formula after the # symbol: 
="Profit Margin is "&TEXT (B=,"#.##%").

	 7.	Your sheet should look like Figure 3.10.

What Makes a Good Model?

A well‐built model will have the following user‐friendly features and struc-
tural attributes:

User‐Friendly Features
■■ Well‐documented assumptions, so there is no possibility of misunder-
standing or misinterpretation of the model.

■■ Explanation of the functionality. Many models lack this. What is the 
model for? How do I use it and where do I input data?

Figure 3.9  Practical Commentary 
Exercise

Figure 3.10  Practical Commentary Exercise (Completed)
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■■ Logical flow (left to right and top to bottom).
■■ Inputs and outputs, workings, and results are clear and easy to find.
■■ Built‐in error checks and input validation such that the user is aware as 
soon as there is an invalid entry or calculations are not correct.

■■ Easy navigation to help users find desired information. Use a hyper-
linked table of contents to help users find their way around if there are 
a large number of tabs.

■■ Instructions on how to use it if the functionality is not self‐explanatory or 
obvious. These instructions could be dispersed throughout the document in 
the form of comments (my preference) or as a separate instructions page.

■■ Printability so outputs are summarised and fit onto printable pages, 
which are easy to read. Reports are legible and colours are not too dark.

■■ Formatting that is easy on the eye and consistent. The whole model 
should have the same look and feel even if different modellers have built 
different parts of it.

■■ The user should be able to access summarised information as well as the 
detail. Each page should form the backup data and source information. 
Users should be able to print or distribute this page if further informa-
tion is required.

Structural Features
■■ The only hard coding should be the inputs and source data. The sources or 
assumptions for these must be documented. All other information is linked.

■■ Duplication is minimised.
■■ Names, formulas, and formats should follow a consistent convention.
■■ The model should be built in a modular form so that pieces can be re-
moved and reused if required.

■■ The build is logical such that each topic is handled on a different sec-
tion, and similar inputs or calculations are grouped together.

■■ The most efficient function is used.
■■ The model should be scalable so that greater detail or a large number of 
units, for example, can be added with minimal rework.

At www.wiley.com/go/steinfairhurstrevised, you will be able to down-
load a model assessment checklist, which will help you to assess how a 
model stacks up against financial modelling best practices.

Standards in Financial Modelling

There have been some good attempts in recent years to standardise finan-
cial modelling practice, with good reason. Excel is such a flexible tool that 
anyone can jump in and start creating the most frighteningly poorly designed 

http://www.wiley.com/go/steinfairhurstrevised
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and error‐prone models—and they do! The FAST Modelling Standard 
is a philosophy that promotes FAST (Flexible, Accurate, Structured, and 
Transparent) design, and a recently developed methodology called SMART 
focuses on transparency, flexibility, and presentation. To download these 
standards, refer to the list of online resources that can be found at www.wiley 
.com/go/steinfairhurstrevised.

Whichever methodology you follow, using the key principles outlined 
in this chapter or in the above methodologies, your model will be easier to 
navigate and check, and much more likely to be robust, accurate, reliable, 
and error‐free.

Summary

By following the points of modelling best practice such as assumptions 
documentation, linking, only entering data once, ensuring formulas are 
consistent, and avoiding bad modelling habits, financial modellers can be 
sure that their models are more robust, have fewer errors, and are easier to 
audit. One of the most important principles of best practice is to document 
assumptions, and this chapter lists different technical methods of assump-
tions documentation, such as comments, footnoting, hyperlinks, and linked 
text. We also explored the features and structural attributes of a well‐built 
financial model.

http://www.wiley.com/go/steinfairhurstrevised
http://www.wiley.com/go/steinfairhurstrevised
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Chapter 4
Financial Modelling Techniques

In this chapter, we’ll take a look at some of the more frequently used 
techniques, as well as some of the common errors (and avoidance strategies), 

issues, and decisions a financial modeller encounters when building models 
in Excel.

As discussed in Chapter 1 in “Tool Selection,” Excel is by far the most 
commonly used tool for financial modelling due to its wide acceptance and 
ubiquity in the market. However, it most certainly has its flaws, mostly to do 
with the prevalence of undetected mistakes in Excel‐built models. Astute fi-
nancial modellers need to understand the dangers of a poorly built financial 
model and the ease with which mistakes can be made.

The Problem with Excel

A well‐built financial model or piece of analysis is an invaluable tool in 
decision making and financial management, but all too often a wrong cal-
culation can have disastrous consequences. Many executives and decision 
makers rely far too heavily on Excel models—probably because they don’t 
fully understand the risks involved.

There are many well‐documented cases of high‐profile Excel model 
blunders. Some of those documented by EuSpRiG, the European Spread-
sheets Risks Interest Group, include1:

■■ The auditor’s office that divided the growth from one year to the next 
by the second year, rather than the first year, specifically, calculated it 
using (Year 2 Year 1)/Year 2 instead of (Year 2 Year 1)/Year 1.

1	 European Spreadsheets Risks Interest Group (EuSpRiG), “EuSpRIG Original 
Horror Stories,” available at www.eusprig.org/stories.htm.

http://www.eusprig.org/stories.htm
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■■ Aspiring police officers were told they passed an exam only to discover 
that the administrators had incorrectly sorted the results to the names 
and scores were mismatched.

■■ A gas company submitted the wrong week’s gas storage figures, leading 
to artificial inflation of natural‐gas prices and a lawsuit.

■■ Shares of a self‐storage company dropped when it was disclosed that it 
had overpaid its chief executive and another investor $700,000 each. It 
took more than six months to find and correct the error, which was due 
to using the wrong spreadsheet.

The list of Excel horror stories continues to grow, reminding us that sim-
ple mistakes in spreadsheet and financial models can cause companies to lose 
significant amounts of money—not to mention the resulting embarrassment.

Figure 4.1 is an example of one of many very simple and yet common 
formula mistakes often found in Excel models. In the figure, row 13 has 
been entered, but it’s not been picked up in the summary total below it.

To avoid this error, when creating summary totals, leave an extra gap 
row between the last row of values and the sum formula. Therefore, when 
new rows are inserted, the summation formula will automatically include 
the newly inserted rows. This will minimise the chance of error when the 

Figure 4.1  Common Excel Error in Modelling
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model needs to be expanded. The use of error checks can also help to alert 
the user or modeller when this happens.

Excel is just such an amazingly flexible program that you can do anything 
with it; however, it is for this very reason that it is so prone to user error. So, 
what’s the solution to Excel’s error problem? It is extremely difficult to ensure 
an error‐free model, but by employing certain strategies, you can most defi-
nitely reduce their number and impact. When building a model in Excel, it’s 
recommended to proceed carefully and build and use it with caution.

Error Avoidance Strategies

There are certain strategies the modeller can employ during the build pro-
cess that will help identify errors as they occur. Even extremely skilled mod-
ellers make mistakes all the time. A good, experienced modeller, however, 
will pick up these errors as they are made and avoid situations where mis-
takes are likely to happen.

Avoiding Simple Formula Errors

Silly formula mistakes are the easiest to avoid, and the most embarrassing 
when they are not picked up. Commonly, it’s the wrong cell being picked up 
or a dollar sign in the wrong place.

Use the Enter Key  Many Excel users get into the bad habit of clicking else-
where in the page when they have finished typing a formula. This is a dan-
gerous practice. Instead, always hit the Enter key when you’ve finished with 
a formula. Most of the time you’ll get away with neglecting this, but every 
now and then it can cause problems, so you must get out of the habit.

In Figure 4.2 you can see that the modeller had his or cursor in the 
middle of the formula, and by clicking on another cell has inadvertently 
changed the formula entirely.

Figure 4.2  Clicking Elsewhere Instead of Using the Enter Key Can Cause 
Errors
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As you can see in Figure 4.2, it’s easy to accidentally pick up the wrong 
formula if your cursor happens to be in the wrong place. More importantly, 
however, the modeller is moving onto another cell without thinking about 
the formula that has just been written. You need to be deliberate about en-
tering the formula and checking it before moving onto the next cell. When 
modelling quickly, it’s easy to mentally move onto the next task before com-
pletely finishing the last one.

Once you’ve finished the formula, hit the Enter key and look at the formu-
la. Does it look right? Does it look sensible? Is this what you intended to show?

Check Your Work and Use the F2 Shortcut Key  The worst kind of error is one 
that you are not aware of. Constantly performing rough checks on the re-
sults of the formulas as you build will minimise the chance of an error. Every 
time you hit the Enter key (and you must use the Enter key), check the result. 
Is the number what you expected? Before you add anything else to the for-
mula, make sure the first part is right.

A lot of modelling is trial and error, and it’s okay to make mistakes—
just make sure you pick up mistakes before someone else does! The only 
thing worse than finding a mistake in your model is not finding the mistake 
in your model, and your model being wrong. Worse than that is having your 
boss find the error! There’s no faster way to lose credibility as a modeller or 
analyst than having your mistakes pointed out in public.

Clicking in the cell or hitting the F2 key (as demonstrated in Figure 4.3) 
will also show the source cells, or precedents of a formula. This is most use-
ful if the source cells are nearby and on the same sheet. When you’ve copied 
down all the cells in a block of data, do a spot‐check with the F2 key to 
make sure it’s picking up the correct cells. Note that this shortcut is Control 
+ U in Excel for Mac 2011.

Have Someone Else Check Your Work  Once you’ve checked and checked again, 
it’s good to have your model reviewed or audited by someone else, as that 
person will bring a fresh perspective. Sometimes you’ve looked at your mod-
el for so long you just can’t see the glaring error in front of you. Working in 
pairs can be very effective.

If the model is high profile or very important, it might be worth getting 
it audited by a model audit firm. There are many organisations that spe-
cialise in conducting professional model audits. This is really the best way to 
be confident that there are no errors and your model is working correctly!

Now that the reality of spreadsheet error has been established, the next 
step is to ask what we can do to reduce spreadsheet errors. Unfortunately, 
only one approach to error reduction has been demonstrated to be effective. 
This is code inspection, in which a group of spreadsheet developers checks a 
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spreadsheet cell‐by‐cell to discover errors. Even this exhausting and expen-
sive process will catch only about 80 percent of all errors.2

Stress-Testing  Test the technical workings of the model by stress‐testing it 
(i.e., varying the inputs to see how much the outputs change). Insert some 
ridiculous numbers into the inputs and see if the results are what you expect. 
The following are some stress tests you can perform:

■■ Set inputs to zero and check that the outputs respond as you would 
expect. For example, by setting price to zero, you would expect revenue 
to also be zero.

■■ If you add one unit, is the output increased by the value of one unit?
■■ Double your headcount. Do your staff costs roughly double?
■■ If you are indexing costs, try setting the indexation percentage to zero 
and see if the costs remain flat.

2	 Raymond R. Panko, “Spreadsheet Errors: What We Know. What We Think We 
Can Do,” European Spreadsheet Risks Interest Group 2000, available at arxiv.org/
abs/0802.3457.

Figure 4.3  Showing Formula Source Cells

http://arxiv.org/abs/0802.3457
http://arxiv.org/abs/0802.3457
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■■ If you double the pricing, does gross revenue double as well? If not, why 
not? The answer could be due to the effect of discounting or complex 
pricing structure. Make sure that you get to the bottom of any anoma-
lies and discrepancies.

■■ Chart metrics on a line graph such as cost per head, price per unit, cost 
to serve a customer, or other metrics relevant to your business. Look 
at the curve and make sure that you can explain each and every trend, 
spike, and downturn.

Thorough stress‐testing, along with scenario and sensitivity analysis, 
will provide your business case the rigour and robustness to cope with vari-
ous fluctuations in economic inputs. Greater detail on how to perform sce-
narios and sensitivity analysis is provided in Chapter 11.

Avoiding Logic Errors  Compared to formula mistakes, logic errors can be 
more difficult to spot. They include things like incorrect timing, inserting 
the wrong inputs and source data assumptions, and using pretax instead 
of post‐tax inputs, to name a few. Sometimes the mistakes can be a com-
bination of both formula and logic errors, and we need to diligently guard 
against both types of errors.

Validate Your Assumptions  A model is only as good as the accuracy of the as-
sumptions. The phrase garbage in, garbage out has never been more relevant 
than in the context of financial modelling. Even the most beautifully built, 
best‐designed model will be completely worthless if the assumptions that go 
into it are not validated. This is one of the most important points of financial 
modelling best practice, and different technical assumptions documentation 
methods are detailed in Chapter 3 under “Methods and Tools of Assump-
tions Documentation.”

Important decisions are made based on the outputs of the model, and 
it is absolutely critical to list clearly (and often painstakingly!) the assump-
tions that have gone into the model. While a good model can aid your busi-
ness or decision‐making process significantly, it’s important to remember 
that models are only as good as the data they contain, and the answer they 
produce should most certainly not be taken at face value. When presented 
with a model, a smart manager or decision maker will query all the assump-
tions, and the way it’s built.

As a financial modeller, ensure that all the assumptions have been vali-
dated to the best of your ability. Document clearly where the numbers came 
from so that there can be no possible misinterpretation of the assumptions 
you have used, so that the assumptions can be revisited and possibly revised 
at a later date.



Financial Modelling Techniques� 79

Document Your Methodology  Using a flow‐chart format, document the inflows 
and outflows of your data within the model. This helps to check your logic but 
is also useful in explaining the methodology of your model to other people.

For example, you can calculate the customer acquisition of a business 
case using the following methodology. If you start with the total population, 
apply the number of pet owners and then a take‐up rate, you get the number 
of acquired customers. This methodology can be documented as follows in 
Figure 4.4.

Use Models in the Right Context  Some managers treat models as though they 
are able to produce the answer to all their business decisions and solve all 
their business problems. It’s absolutely terrifying to see the blind faith that 
many managers have in their financial models. Anyone with any real expe-
rience in model building will appreciate how incredibly easy it is to get a 
dollar sign in the wrong place and end up with the wrong result. Models 
should be used as one tool in the decision‐making process, rather than the 
definitive solution.

All too often back‐of‐the envelope models turn into something more 
permanent. They’ll then perhaps be used to determine pricing. Then used 

Figure 4.4  Methodology Documentation

Total population

x 64% pet ownership

x 2% takeup rate

= Customers required

= Pet owners
(potential market)
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as a cash‐flow forecast. Then later, when it’s budget time, the same model 
gets used for that, too, and you end up with an important model based on 
hastily gathered assumptions and a flaky design structure. Models should 
always be built for a specific purpose. If you do pick up a model to use for 
another purpose, make sure you understand the model fully before making 
any changes. See “Rebuilding an Inherited Model” in Chapter 10 for more 
information on how to take someone else’s model apart.

Sensitivities and Scenario Analysis  Do lots and lots of sensitivities and scenar-
io analysis. If the absolute worst happens, what happens to my bottom line? 
How sensitive is my model to changes in key assumptions? This will help to 
test the logic and robustness of your model, as well as the soundness of the 
business, product, or project the model is representing. At the minimum, you 
should do at least a best case, a base case, and a worst case.

This can often flush out anomalies in the model. Look carefully at the 
results of your scenario analysis. Is it what you would expect to see? Com-
pare the sensitivity results side by side. If you increase the escalation factor 
from 2 percent to 3 percent, do costs increase by the same margin as if you 
increase escalation from 3 percent to 4 percent?

See Chapter 11 for more information on stress‐testing, scenarios, and 
sensitivity analysis in financial modelling.

Sense-Checking Methodology  Let’s look at an example of using sense‐checking 
methodology.

Figure 4.5 shows a pretty common one. Let’s say you are adding up 
these totals and accidentally double‐count by including the subtotals in your 
grand total. If you look at the subtotals you can see that the grand total 
should be around $170,000. Instead of doing this in your head, you could 
highlight the two subtotals using the Control key, and the total will appear 
at the bottom right‐hand side of the screen, as shown by the outlined box at 
the bottom of Figure 4.5.

Highlighting cells and checking totals using this method is a good way 
of sense‐checking for errors, and by employing a sense‐checking methodol-
ogy, you are less likely to let errors slip through the cracks.

Note

Note that in Excel for Mac 2011 you only see the sum at the bottom in the status bar. You can 
easily change this by right-clicking (or Control-clicking) in the status bar to show average, 
count, min, max, and so on—but you can see only one at a time. In later versions of Excel, 
as shown above, average, count, and sum are all shown automatically by default.
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How Long Should a Formula Be?

If you’ve been modelling for a while you’ll know that it’s pretty easy to end 
up with a really long formula. Excel will handle them—as long as they are 
constructed correctly—but they can be pretty tricky to follow, especially 
for other people. Even if you’ve written a lengthy formula yourself, you’ll 
struggle to follow it at a later date.

As with most concepts in financial modelling, a formula should be as 
simple as possible and as complex as necessary.

The way to make a formula shorter, of course, is to break it down into 
several steps, by adding additional working cells. Too much of this can make 
your model cumbersome; therefore the good modeller needs to strike a bal-
ance between the following two practices:

	 1.	Making the formula too long and complex
	 2.	Having a model with additional working rows and columns

Figure 4.5  Sense‐Checking Methodology Using the Sum Total
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If you do have a very long formula, one way to make it a bit easier to 
understand is to use Alt+Enter in the middle of the formula to force the 
next section of the formula onto another line. Note that this shortcut is 
Control+Option+Enter in Excel for Mac 2011.

For an example of what this looks like, see Figure 4.6.
Of course, a formula of this length is not recommended. One of the 

new features in later versions of Excel is the expandable formula bar, but 
it is generally accepted best practice that a formula should not exceed 
about half of the width of the formula bar. This does not include file 
paths if the formula is linking to an external file that is currently closed, 
and therefore the full file path is included in the formula (as shown in 
Figure 4.7). Keep formulas particularly short when linked to external 
files for this reason.

Figure 4.8 reveals two different ways of achieving the same result. The 
first example shows that revenue has been calculated by:

Row 3: Forecasting the number of customers.

Row 4: Forecasting how many calls per day each will make.

Row 5: Applying seasonality to these calls.

Row 6: Multiply row 3 by row 5 to get the total number of calls per day.

Row 7: Multiply row 6 by the number of days in the month to get the 
number of calls per month.

Row 8: Multiply row 7 by the price to get the total revenue.

Figure 4.6  Very Long Formula Broken in Several Lines

Figure 4.7  Formula Linking to a Closed External File
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Figure 4.8  Revenue Calculated Two Different Ways

Alternatively, the whole calculation could be done in row 9 using the 
complex formula:

=Assumptions!$B$9*(1+cust_growth)^(B2-$B$2)*B4* 
Assumptions!B6*Assumptions!B4*price

You could argue that this is a more succinct, sparse way of modelling. 
However, it makes it very difficult to take apart this formula for checking 
or debugging. Calculating the revenue step by step, as shown in the first 
example, is a much better way of modelling.

Linking to External Files

One of the important principles in Excel modelling best practice is to link to 
the source data. Wherever possible, hard coding should be avoided, and you 
should always try to link your cells so that as variables change, the results 
remain accurate.

However, if your source data exists in an external file, this can cause 
many problems, such as broken links, incorrect data, and error messages. 
In fact, some analysts avoid linking to external files at all costs! However, if 
done properly, external links add value to your models.

The following is a list of reasons you should link to external files:

■■ It’s best practice to never hard code when you could link.
■■ Your numbers are auditable. There’s nothing more frustrating than trying 
to audit a model and finding hard‐coded numbers with no annotation.

■■ The numbers will automatically update, so the model is less prone to error.
■■ It saves time because you’ll spend less time entering and checking your 
data and more time analysing.
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Table 4.1 shows the problems and solutions as to why many analysts 
don’t link to external files.

Table 4.1   

Problem Solution

The links break. Avoid moving files. Use Edit Links to fix. Use 
named ranges to minimise the number of formulas 
to fix when this does happen (and it will!).

People move the data and my 
formulas are wrong.

Use named ranges to refer to external files, 
which will minimise this. Use more robust 
formulas such as INDEX & MATCH.

The numbers keep changing. Yes, they should. Consider saving in one 
location to maximise version control.

Why You Should Use Named Ranges in External Links

One of the main issues with linking to external files is that if users insert or 
delete rows or columns in the source file, this can easily mess up the files 
that are linking to it.

Imagine you want to use a pricing threshold in your financial model, 
which is being generated in another model. Using best practices, you de-
cide to create a link, rather than hard coding the number. This will make 
your model more auditable so that we can see exactly how that threshold 
amount was calculated. You create a link from your financial model to an-
other source file, using the link:

='C:\Plum Solutions\Clients\Transactions\Files\[Financial 
Statements.xlsx]July'!$C$46

If you are using Excel for Mac 2011, your file name might look more 
like this:

='MacintoshHD:Users:plumsolutions:Dropbox:Clients: 
Transactions:Files:[Financial Statements.xls]July'!$C$46

If both files are open at the same time, and you insert a row in the Finan-
cial Statements file, the link will automatically update from $C$46 to $C$47. 
However, if your file is closed, your model will not update. This means that 
next time you open it, your model will be picking up the wrong cell!

The way around this issue is to create a named range in the source file 
(for example, threshold) and then if that cell moves in the source file, the cell 
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will still retain its name, and the formula in your model will still be correct. 
See “Named Ranges” in Chapter   5   for how to do this.

='C:\Plum Solutions\Clients\Transactions\Files\[Financial 
Statements.xlsx]July'!threshold)

 The next time your model tries to update the link, it will look for the 
name  threshold , rather than  $C$46 , and the integrity of the link will be 
maintained. This is why using named ranges when dealing with external 
links is considered best practice; it is a much more robust way of linking 
fi les together.  

 dealing with links and the potential errors they Can Cause   If you have linked two 
fi les together, you should not start moving either of the fi les around into 
other drives or directories. If you do, Excel will not be able to fi nd the fi le 
that has been moved, and the link will be broken. If a fi le  has  been moved 
or had a name change, you can try to amend this by using Edit Links as 
described in the following text. 

 Before you start linking workbooks together you need to think about 
what will happen to the workbooks in the long term. Will other people be 
using them? Will they be making copies? Will they be mailing copies to 

    how to edIt lInKS  

 Click on Edit Links on the Data tab, in the Connections group. 

   In Excel for Mac 2011, go to Edit, then select Links. 

   Use the Change Source button to tell your model the new location 
of the fi le it has been linked to.   

    TIP  
 Another handy use for Edit links is to break all links in a fi le. if you are e-mailing a fi le, 
it is not recommended that you leave links in it. you could paste the cell values one by 
one, but breaking links will convert every single formula in the entire fi le to their hard-
coded values. click on Edit links, and then you will be able to select the external fi les 
and click on the Break links button. see figure   4.9   . 
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Figure 4.9  Break Links Dialog Box

other people? If so, then perhaps in that case, you should avoid creating a 
link to an external spreadsheet.

Linking Do’s and Don’ts  Here are some common do’s and don’ts to keep in 
mind when linking:

■■ Do use named ranges when linking to external files.
■■ Don’t e‐mail files that contain links. Save another version, and use Break 
Links in such cases.

■■ Don’t change file names and sheet names unless you really need to.

Building Error Checks

Basic reconciliations can be built within a model, and a well‐built financial mod-
el should have error checks included where possible so that the user or modeller 
can see at a glance if the formulas are calculating correctly. For example, when 
creating management reports, check that the sum of each individual depart-
ment’s report adds to the company‐wide total. This can be done by inserting a 
simple IF function, or several other methods, as shown in the next section.
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Note that error checks are not a substitute for good practices such as 
checking and auditing your formulas. Error checks are most appropriate for 
capturing errors a subsequent user has made; they are less likely to highlight 
a model building error. See “Error Avoidance Strategies” in this chapter for 
greater detail on how to reduce errors when building models.

Error Check Exercise

Let’s say, for example, that you have the following cars in stock in a show-
room. You want to know how many of each type of transmission you have in 
stock, so you have created a SUMIF formula to summarise how many of each 
type are in stock. (See Figure 4.10.) “Aggregation Functions” in Chapter 6 
discusses how to create a SUMIF formula.

If someone is updating this model and accidentally types Autmatic in 
cell B3 instead of Automatic, your totals at the bottom will be wrong.

Figure 4.10  Summary Report
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In cell C18, we can create an error‐checking formula that will alert 
us if something like this happens. There are two different formulas we 
could put in cell C18 that will alert us if the model is not balancing 
properly:

	 1.	= C17=C13 will return the value TRUE if they are the same, or FALSE 
if not. However, this is also subject to a false error, as shown in the fol-
lowing section.

	 2.	= C17‐C13 is the easiest formula to build that would serve as an error 
check, as it would return a value in the case of an error. Although this 
would not necessarily alert the user immediately that an error had been 
made, it is certainly quick and easy to follow and for this reason, a fairly 
common error check favoured by many modellers. It’s a good idea to 
format it using the Comma Style (found on the Home tab in the Num-
bers group) and then removing the decimal place and formatting it to 
red font. This will mean that the zero will not show if there is no error, 
and a red number will show if there is an error.

Allowing Tolerance for Error

=IF(C17<>C13,"error",0) is a superior error check, but on a small number 
of occasions, there can be an issue with this.

This formula usually works, but it can occasionally return a false error 
result, even though the values are the same. This is a bug caused by the fact 
that Excel carries calculations to 14 decimal places. After that, it truncates 
the value, and can cause a minute discrepancy, which will report an error 
when it’s only 0.00000000000001 off.

Therefore, to avoid this potential issue, you could use an absolute 
value formula, which would allow a tolerance for error. =IF(ABS(C17‐
C13)>0.1,"error",0) will allow the values to be off by 0.1 before it reports 
an error. If you use the ABS function in Excel, this will take the absolute 
value of the result, such that it does not matter if it is a positive or negative 
number.

In Figure 4.11, if the sum of each individual item does not equal the 
grand total, the cell will return the word error; otherwise it will show a 
zero. There are many variations of this formula, and I’m sure you can come 
up with many of them. Many modellers prefer to show the word OK if the 
numbers are right, and Check if they are not.

To make the error check even more prominent to the user, use condi-
tional formatting to add a rule that makes the entire cell turn red if the error 
check has been triggered. See “Conditional Formatting” in Chapter 7 for 
how to do this.
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Error-Check Alerts

Consider adding in an error‐checking page at the very back of your model 
that links through to all the error checks in the entire model. This page can 
be hidden, as the user does not need to see it, and the modeller can unhide 
it if necessary.

Create a summary cell that will identify, in a single cell, whether or not 
there are any errors in the entire model. This can be achieved with a COUNTIF 
formula like this:

=COUNTIF($A$3:$A$21,"error")

See “Aggregation Functions” in Chapter 6 for greater detail on how to 
use a COUNTIF function.

The COUNTIF function returns a 1 if there are errors. Now nest this 
with an IF statement, which will show the text Errors exist within this model 
if any of the error checks have been triggered.

=IF(COUNTIF($A$3:$A$21,"error")>0 
"Errors exist within this model",0)

Figure 4.11  Error‐Check Example
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Now copy this formula (see Figure 4.12) to somewhere prominent at 
the top of each page (such as within the header) to create a global error 
check indicator, which will alert users to any error as soon as it is triggered.

Global error check alerts are particularly useful for a modeller who has 
users working with the model regularly. The error check will alert the user 
that something has gone wrong in the model—usually the user has simply 
entered some incorrect data—and hopefully the user will be able to correct 
the input, ensuring the continuing integrity of the model.

Avoid Error Displays in Formulas

Sometimes a formula may return an error message. Usually, you will want 
to know when a formula error occurs. But now and then you may prefer 
to avoid the messages. For example, if you are calculating a percentage in a 
column and one of the entry fields contains a zero, you will get a #DIV/0! 
error. Or if using a VLOOKUP function, the criteria you have entered does 
not exist in the data, a #N/A error will appear. You can stop these errors 
from appearing by using an IFERROR function to check for an error.

=IFERROR(VLOOKUP("payback",Payback!B1:C109,2,0),0)

Note that many modellers do not agree with avoiding error displays and 
recommend that you always show errors. The reason for this is that using error 
suppression can mask other, genuine errors, so use this function with caution.

Circular References

If you have been using Excel for any length of time, you’ve probably come 
across a circular reference. If your formula is trying to refer to itself, you’ll 

Figure 4.12  Error Check Alert Formula
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end up with a circular reference. A common (and easily fixed) cause of this 
is when a sum range includes the sum itself. For example, in the formula 
in Figure 4.13, cell B11 refers to cell B11, and this means that the formula 
cannot calculate properly and is returning a zero value. You can see in the 
status bar at the bottom where the circular reference resides.

You cannot rely on a model that contains circular references. The 
calculations may not work, and you can’t be sure the other formulas are 
calculating properly.

How to Fix Circular References

In certain rare situations, you can have intentional circular formulas that 
you have deliberately allowed in your model (in which case you’ll have to 
enable iterative calculations, as shown in the box below) but it’s more likely 
that your circular reference is unintentional, so you’ll have to get rid of it as 
soon as possible. If you leave it and try to find it later, or worse still, leave it 
for someone else to fix, the formulas can become more complicated, mean-
ing that the circular reference can become further embedded in the model, 
making it more difficult to track down and fix.

Figure 4.13  Formula Creating a Circular Reference
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 You’ll get a warning message as soon as the circular reference happens, 
so the simplest way to fi x this is to stop and simply undo the last thing you 
did. You really just need to fi nd the offending cell and remove the link. 
Sounds simple, but sometimes it’s not that easy. The notifi cation in the sta-
tus bar in the bottom left‐hand corner of Figure   4.14    may help fi nd the cell 
causing the problem. 

  However, you need to be on the correct tab in order for this message 
to show. If you aren’t sure which tab the circular reference is on, you need 
to hunt it down by going to each tab to see if it shows on the status bar. 
Alternatively, you can use the auditing tool to locate the circular reference, 
as shown in the box below.       

    FIgure   4.14    Circular Reference Notifi cation in the Status Bar 

    loCatIng a CIrCular reFerenCe wIth the audItIng tool  

 On the Formulas tab, in the Formula Auditing group, click the arrow 
on the Error Checking button. Select Circular References, and this will 
show the circular reference in the model. Click on the reference to go 
to the circular reference. See Figure   4.15   . 

 In Excel for Mac 2011, there is no circular reference tool, but 
there is a way to fi x one. On the Formulas tab, in the Audit Formula 
group, click the Trace Precedents button. See Figure   4.16   . 

    FIgure   4.15    Finding the Circular Reference Auditing Tool in the Ribbon 
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 You can move between cells in a circular reference by double‐
clicking the tracer arrows. Keep reviewing and correcting the circular 
reference until the status bar no longer shows the words  Circular 
References . 

 Circular references in Interest Calculations 

 There are a few instances where you might wish to keep a circular reference 
within the model. A common reason for this is when you are calculating 
interest payments on a profi t‐and‐loss statement as shown in Figure   4.17   . 

  When modelling fi nancial statements, this circular reference can be 
avoided in a few different ways: 

 ■    Hard‐code one of the inputs, such as the interest amount. This is not rec-
ommended, as this will impede the fl ow of numbers throughout the model. 

 ■    Use a macro to update the numbers, keep the links fl owing, but paste the 
number to avoid the circular reference. This will work, but it needs some 
good testing to make sure it works properly. See “Macros” in Chapter   8   
for points to consider before including macros in a fi nancial model. 

 ■    Calculate the interest based on the closing balance of the debt 
amount in the previous period. This is most appropriate for state-
ments modelled on a monthly basis, as the variance between debt 
balances from year to year can mean that the interest amount calcu-
lated using this method is less accurate. Although not perfect, this is 
still my preferred method for getting around the problem of circular 
references in interest calculations. 

 ■    Last, another commonly used method in fi nancial statements is to allow 
the circular reference by enabling iterative calculations. The problem with 

    FIgure   4.16    The Trace Precedents Auditing Tool in the 
Ribbon in Excel for Mac 2011 
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this method is that it might allow other circular references to be enabled, 
which means that other parts of the model might not calculate properly.     

 enabling Iterative Calculations 

 If you decide to enable iterative calculations, you must determine how many 
times the formula should recalculate. When you turn on iterative calcula-
tions without changing any of the defaults, Excel stops calculating after 100 
iterations or after all values in the circular reference change by less than 
0.001 between iterations, whichever comes fi rst. However, you can control 
the maximum number of iterations and the amount of acceptable change.         

How much profit the company
earns will impact its cash

and need for funding

Funding required is
how much debt the

company has,
which impacts its

interest

Interest payments
are an input to

profit

    FIgure   4.17    Circular Reference in Interest Calculations 

    how to enable IteratIve CalCulatIonS  

 Go to Excel Options by either clicking the File tab or the Microsoft 
Offi ce Button (if you are using Excel 2007), and then select Options 
(or Excel Options), and then click on the Formulas category. 
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 In the Calculation Options section, select the Enable Iterative Cal-
culation check box. See Figure 4.18. 

Excel for Mac 2011 : Go to Preferences (or hit Command +
comma). In the Formulas and Lists section, select Calculation, then 
select the Limit Iteration check box. See Figure   4.19   . 

    FIgure   4.18    Enabling Iterative Calculations 

    FIgure   4.19    Enabling Iterative Calculations 
in Excel for Mac 2011 
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Summary

This chapter has discussed a collection of techniques and strategies com-
monly used in financial modelling. Those who have been using Excel for any 
length of time will know how easy it is to make a mistake, and what a huge 
effect this can have on their business models. Therefore, knowing and using 
strategies for reducing errors is an important skill for the Excel modeller to 
have. We also looked at how to avoid overly long and complex formulas, 
and how to dissect them if we are unfortunate enough to have inherited a 
model that includes overly complicated formulas! Linking to external files, 
building error checks, and dealing with circular references are also issues 
that are commonly encountered in financial models.
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Chapter 5
Using Excel in Financial Modelling

In this chapter, we take a look at some of the practical tools, functions, and 
formulas commonly used in financial modelling in Excel.

Formulas and Functions in Excel

Excel contains over 300 different formula codes, called functions. The most 
commonly known function is the SUM, used to total a range of cells. Most 
Excel users only use a very small percentage of the available functions, and 
many of them are irrelevant for use in finance and financial modelling. It is 
impossible to go over all of them, but here we will cover the ones that are 
going to be the most useful in using Excel for business analysis.

In most cases, you will find it easiest to use the Function Wizard, acces-
sible via the “Insert Function” button on the “Formulas” tab as shown in 
Figures 5.1 and 5.2.

Note that the Function Wizard is called the Formula Builder in Excel 
for Mac 2011; however we will refer to it as the Function Wizard in future 
for simplicity.

It’s fair to say that some Excel users are guilty of using Excel as a fancy 
calculator! If so, you’d be just using a formula in Excel, such as =A1+A2 or 
=452*12.

There are, however, predefined formulas in Excel such as IF, SUM, VLOOK-
UP, INDEX (and several hundred more). These are referred to as functions.

So, you could write a formula containing a function, like =MAX(A1:B20), 
or you could just write a simple formula that does not contain a function, 
like =A1/A2. Many of us use the words formula and function interchange-
ably, but it’s nice to know the difference!
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Because there are hundreds of functions in Excel, you should familiarise 
yourself with as many as possible, so that you know what is available.

For use in business analysis, the most useful functions fall into the cat-
egories of logical, aggregation, lookup, and financial. The most commonly 
used functions in financial modelling are listed here:

■■ Logical functions (IF, AND, etc.) are used when you need to evaluate a 
condition. For example: “Shall we include tax in our calculation?” If the 
user enters yes, the calculation will include the tax; if no, it is excluded.

■■ Aggregation functions (SUMIF, COUNTIF, etc.) are helpful when there 
is a lot of data arranged either vertically or horizontally that must be 
added together.

■■ Lookup functions (HLOOKUP, VLOOKUP, etc.) are used when you 
need to look up a value to return a single amount.

Figure 5.1  Function Wizard
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■■ Financial functions (NPV, IRR, PMT, etc.) can usually be created manu-
ally using a long and complicated formula, but the predefined function 
in Excel saves time and makes it much easier to calculate commonly 
used financial calculations such as net present value, interest payments, 
or depreciation amounts.

There is a bit more, like choosing the right function, however, than sim-
ply knowing lots and lots of functions in Excel. Choose the simplest formula 
to perform the task you need it to do. Choose one that is not overly compli-
cated and don’t try to do too much in one cell. If it starts getting difficult to 
decipher, consider breaking the formula into several parts. See “How Long 
Should a Formula Be?” in Chapter 4 for an example of this.

Figure 5.2  Formula Builder in Excel for Mac 2011
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As with most tools in financial modelling, you should choose the simplest 
option—not because you don’t know how to do a more sophisticated func-
tion, but because you want to make the model as clear, simple, and transpar-
ent as possible. However, you still need to arm yourself with as many different 
functions as possible. The more you know, the more options you have avail-
able to you, and the more likely you are to find the best solution.

For example, Figure 5.3 shows the calculation of a compound growth 
rate when escalating the starting sales number by 5 percent to the power 
of the year. In order to do this, we’ve had to insert a helper row to link to. 
This makes the formula easier to follow, but a helper row is distracting and 
makes the model look messy, so it needs to be hidden. The entire row cannot 
be hidden in this instance, so we’d probably change the font to a pale grey 
to make it less distracting

Alternatively, we can achieve the same result without the helper row as 
shown in Figure 5.4 by calculating it all in one cell. Instead of inserting 1, 2, 
3, and so on across the top, we can do the entire calculation in one cell by 
looking at the difference between the years; in this case, 2016 minus 2016 
equals zero, and 2017 minus 2016 equals one, and so on.

Using the second method, the value 1 in the helper row has been re-
placed by the formula (C9‐$B$9). This makes the second formula more dif-
ficult to follow, but the model is less cluttered.

This is an example of how a modeller needs to strike the balance be-
tween having a streamlined model, yet formulas that are easy to follow. 

Figure 5.3  Compounding Growth Rate Calculation Using a Helper Row

Figure 5.4  Compounding Growth Rate Calculation without a Helper Row
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Either of these methods would be perfectly acceptable, but as this is not a 
terribly long or complicated formula, the second option is probably prefer-
able because it avoids the addition of a potentially confusing helper row.

Excel Versions

There are currently several different versions of Excel available in Microsoft 
Windows that modellers are likely to be using. Each time a new version of Excel 
is launched, new features are introduced, and subtle changes in the look and feel 
take place. The biggest change was back with the big jump from Excel 2003 to 
2007; in the versions since then, the changes have been less noticeable.

If you are building models in Excel that other people using different ver-
sions need to use, then you need to consider the version capabilities when 
building your models. The following features were introduced in Excel 2010:

■■ Power Pivot (See Chapter 1)
■■ Sparklines (See Chapter 7)
■■ Slicers in PivotTables (See Chapter 8)

It’s important to be aware that these features did not exist in previous 
versions of Excel, so if you are creating a model that contains sparklines or 
slicers, and the model is opened by a user still on Excel 2007, those features 
will disappear from their model, and there will be a blank field in their 
place! Similarly, the new functions that have been introduced in 2013 such 
as PDURATION() or ISFORMULA() will return a #NAME? error when 
opened in Excel 2010 or earlier.

Summary of New Features

At a high level, here is a quick summary of the new features introduced in 
Excel 2013.

General
■■ Interface look and feel with the capitalisation of the Ribbon.
■■ Start screen.
■■ New mobility options allow access to different devices on one licence.

Analysis
■■ Flash Fill will learn the pattern of the data you’re entering and complete 
it for you.
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■■ Quick Analysis makes it easy to analyse your data with formatting and 
charts after highlighting with the mouse.

Charting
■■ Chart Recommendations and Customisations.
■■ The Layout tab for charting has disappeared from the Ribbon, and 
Chart Elements appear to the right of the chart itself.

■■ More Data Labelling options for charts.

Functions

As with every new version, Excel has introduced a number of new func-
tions. This time, there are no fewer than 50 new predefined functions to 
enhance the already rich function set. Most are for the purpose of math, 
trigonometry, and engineering, but here are a few worth mentioning 
that you might find useful for financial modelling:

■■ PDURATION() returns the number of investment periods required for 
the invested amount get to the specific value.

■■ IFNA() allows you to suppress a #N/A error only.
■■ ISFORMULA() will return the value TRUE if the cell contains a for-
mula.

Other Features
■■ Single window per worksheet allows the same session of Excel to show 
different files on multiple monitors (my personal favourite!).

■■ New web‐based functions help in building links to web services, reading 
XML content, and connecting with online content.

■■ You can create relationships between tables for enhanced data analysis 
without having to consolidate all the information into a single table and 
create pivot charts.

■■ Slicers, previously only available for PivotTables, are now available in 
Excel tables as well.

■■ Power Pivot is now a built‐in feature of Excel 2013.

For more detailed explanations of the changes between versions and how 
they impact model building, please see www.wiley.com/go/steinfairhurstrevised  
to download supplementary material in PDF format. This section also discuss-
es the difference between using Windows and Mac for financial modelling.

This book assumes readers are using Windows Excel 2013, but in most 
cases instructions for Excel 2010, 2007, and Excel for Mac 2011 have also 
been provided.

http://www.wiley.com/go/steinfairhurstrevised
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Handy Excel Shortcuts

Working in Excel—particularly for the purpose of financial modelling—can 
be very time consuming, and increasing your speed and accuracy will in-
crease productivity significantly. Excel users just starting out with using Excel 
would be very comfortable with using the mouse for navigation and editing 
purposes. However, with growing familiarity, the mouse is not the fastest or 
most efficient way of modelling. Excel offers a lot of shortcuts to tackle this 
problem, and as you become faster, you will find them very handy.

There are many advantages of using Excel shortcuts:

■■ Ease of use: Whilst intuitively it may seem that a mouse is the more 
comfortable option, it is a lot more comfortable for your wrist, arm, 
and shoulders to punch the keys on the keyboard than to align the cur-
sor on the screen.

■■ Easier on the body: Given the natural placement of keyboard and 
mouse on any desktop, using the keyboard more often is less stress-
ful on the body. Using the mouse constantly can cause stress on the 
wrists and shoulders. With the mouse most users typically end up using 
just the wrists and index finger, which can cause fatigue and long‐term 
problems.

■■ Speed of execution: Keystrokes are much faster than the mouse. To put 
this to the test, try creating a new worksheet in Excel using the mouse 
by clicking on File (or the Microsoft Button in Excel 2007), then New—
Blank Workbook. Alternatively try the shortcut CTRL‐N. There is a 
distinct improvement in speed with keystrokes over the mouse click.

■■ Standard shortcuts: Within the Windows environment, you will find 
that similar functions have the same shortcuts, so the expertise you de-
velop can be applied to programs other than Excel. The shortcuts in 
Excel are generally common across all other office suites and even other 
applications like browsers, Notepad, Paintbrush, and more.

■■ No other choice: There are some functions for which shortcuts are nec-
essary to get the desired results, unless you want to insert manual edits. 
For example, when creating an array formula, the Control‐Shift‐Enter 
shortcut is the only way to get your array formula to insert correctly.

Windows Shortcuts

Table 5.1 is a small selection of some of the most common and particu-
larly useful shortcuts that are invaluable when using Excel for financial 
modelling. Note that a printable list of these shortcuts is also available at 
www.wiley.com/go/steinfairhurstrevised.

http://www.wiley.com/go/steinfairhurstrevised
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Tip
Any command that is shown on the Ribbon can be activated by clicking on the icon 
using the mouse, but can also be activated using shortcut keys. These are displayed 
when the ALT key is pressed, as can be seen in Figure 5.5. For example, Wrap Text can 
be selected by using the shortcut ALT, pressing H (not case-sensitive), and then W.

Also note that the Quick Access Toolbar (highlighted in Figure 5.5) can also be customised 
to contain commands that are frequently used. In Figure 5.5, Paste Values and Print Pre-
view have been added to the Quick Access Toolbar so that the user can simply press ALT, 
then 5 to Print Preview, hence saving three mouse clicks. The Quick Access Toolbar op-
tions need to be manually customised, and this can be done by clicking on the drop-down 
to the right of the Quick Access Toolbar, and then selecting More Commands.

Figure 5.5  Shortcut Keys Shown after Pressing the ALT Key

Table 5.1  Useful Windows Keyboard Shortcuts for Financial Modellers

Editing

CTRL+S Save workbook

CTRL+C Copy

CTRL+V Paste

CTRL+X Cut

CTRL+Z Undo

CTRL+Y Redo

CTRL+A Select all

CTRL+R Copies the far left cell across the range*

CTRL+D Copies the top cell down the range*

CTRL+B Bold
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Editing (continued)
ALT+TAB Switch program

ALT+F4 Close program

CTRL+N New workbook

SHIFT+F11 New worksheet

CTRL+W Close worksheet*

ALT+E+L Delete a sheet*

CTRL+TAB Switch workbooks

Navigating

CTRL+9 Hide row

SHIFT+CTRL+9 Unhide row

SHIFT+Spacebar Highlight row

CTRL+Spacebar Highlight column

CTRL+Minus sign Delete selected cells

Arrow keys Move to new cells

CTRL+Pg Up/Down Switch worksheets

CTRL+Arrow keys Go to end of continuous range and select a cell

SHIFT+Arrow keys Select range

SHIFT+CTRL+Arrow Select continuous range

Home Move to beginning of line

CTRL+Home Move to cell “A1”

SHIFT+ENTER Move to cell above

TAB Move to cell to the right

SHIFT+TAB Move to cell to the left

ALT+Down arrow Display a drop‐down list

Formatting

CTRL+1 Format box

ALT+H+0 Increase decimal*

ALT+H+9 Decrease decimal*

SHIFT+CTRL+B General format

SHIFT+CTRL+! Number format

SHIFT+CTRL+# Date format

SHIFT+CTRL+$ Currency format

SHIFT+CTRL+% Percentage format
(continued)
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In Formulas

F2 Edit formula, showing precedent cells

CTRL+’ Edit formula, showing precedent cells  
(same as F2)

ALT+ENTER Start new line in same cell

SHIFT+Arrow Highlight within cells

F4 Change absolute referencing (“$”)

ESC Cancel a cell entry

= (equal sign) Start a formula

ALT+”=“ Sum selected cells

CTRL+` Copy formula from above cell

CTRL+B Show formulas or values

F9 Recalculate all workbooks

SHIFT+CTRL+Enter Enter array formula

ALT+M+P Trace immediate precedents*

ALT+M+D Trace immediate dependents*

ALT+M+A+A Remove tracing arrows*

CTRL+[ Highlight precedent cells

CTRL+] Highlight dependent cells

F5+Enter Go back to original cell

SHIFT+CTRL+{ Trace all precedents (indirect)

SHIFT+CTRL+} Trace all dependents (indirect)

*Note that these are unavailable as preset keyboard shortcuts for Mac for Excel 2011. Create 
shortcuts for these functions by selecting Tools—Customize Keyboard.

Mac Shortcuts

Almost all of the keyboard shortcuts that are available for Windows are avail-
able on the Mac version as well. If you are new to Mac, remember that in most 
cases, Command replaces Control, and Option replaces Alt. See Table 5.2.

A few of the keyboard shortcuts found in Excel for Windows are un-
available for Mac (as noted in Table 5.1). These, however, may be created 
manually by selecting Tools—Customize Keyboard.

TABLE 5.1  (continued)
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Table 5.2  Useful Mac Keyboard Shortcuts for Financial Modellers

Editing

COMMAND+S Save workbook

COMMAND+C Copy

COMMAND+V Paste

COMMAND+X Cut

COMMAND+Z Undo

COMMAND+Y Redo

COMMAND+A Select all in an area

COMMAND+A twice Select all data on the sheet

COMMAND+B Bold

COMMAND+TAB Switch program

COMMAND+Q Close program

COMMAND+N New workbook

CONTROL+TAB Switch workbooks

COMMAND+page up Select next worksheet to the right

COMMAND+page down Select next worksheet to the left

Navigating

CONTROL+9 Hide row

SHIFT+CONTROL+9 Unhide row

SHIFT+Spacebar Highlight row

CONTROL+Spacebar Highlight column

CONTROL+Minus sign Delete selected cells

Arrow keys Move to new cells

COMMAND+Pg Up/Down Switch worksheets

COMMAND+Arrow keys Go to end of continuous range and 
select a cell

SHIFT+Arrow keys Select range

SHIFT+COMMAND+Arrow Select continuous range

Function+Left Arrow Move to beginning of line

COMMAND+Function+Left Arrow Move to cell “A1”

SHIFT+ENTER Move to cell above
(continued)
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Editing

TAB Move to cell to the right

SHIFT+TAB Move to cell to the left

CONTROL+Down arrow Display a drop‐down list

Formatting

COMMAND+1 Format box

SHIFT+CONTROL+B General format

SHIFT+CONTROL+! Number format

SHIFT+CONTROL+# Date format

SHIFT+CONTROL+$ Currency format

SHIFT+CONTROL+% Percentage format

In Formulas

CONTROL+U Edit formula, showing precedent 
cells

CONTROL+OPTION+RETURN Start new line in same cell

SHIFT+Arrow Highlight within cells

COMMAND+T Change absolute referencing (“$”)

ESC Cancel a cell entry

= (equal sign) Start a formula

CONTROL+SHIFT+T Sum selected cells

COMMAND+` Copy formula from above cell

CONTROL+ Show formulas or values

F9 Recalculate all workbooks (Note that 
the user will have to inactivate Expose 
in order for this shortcut to work)

SHIFT+CONTROL+RETURN Enter array formula

Auditing

COMMAND+[ Highlight precedent cells

COMMAND+] Highlight dependent cells

SHIFT+COMMAND+{ Trace all precedents (indirect)

SHIFT+COMMAND+} Trace all dependents (indirect)

TABLE 5.2  (continued)
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Basic Excel Functions

Now that we understand the basics of formulas and functions in Excel, it 
is time to start looking at some of the basic Excel functions. With financial 
modelling—or any other use for Excel for that matter—it is highly unlikely 
that the entire range of Excel functions will get used. However, the more 
functions we know, the better equipped we are to translate our business 
logic into a highly functional, dynamic, and robust financial model.

There are some common basic functions that are used frequently, and 
understanding them is important for any modeller. Some of the basic math-
ematical functions included in the Excel suite are: SUM(), MAX(), MIN(), 
COUNT(), and AVERAGE(). The function names are indicative of the 
functions they perform.

SUM()

This function is used to sum up a series of numbers. You can add individual 
cells, by separating them with commas, and you can also specify a range of 
cells. Figure 5.6 is an example of using a comma in the SUM function.

Figure 5.6  Using the SUM Function
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MAX()

This function helps identify the maximum value. The syntax for this func-
tion is very similar to SUM(); you can enter a range of cells, individual cells 
separated by commas, or a combination of both. This function will return 
an error if the cells you need to analyse have some text that cannot be con-
verted appropriately. Similarly, if the cells do not contain any numbers, the 
function returns 0. See Figure 5.7 in which the maximum average monthly 
temperatures have been calculated for various cities around the world.

MIN()

This function is the inverse of the MAX() function, giving the least value in 
the list. The MIN() function can also use any combination of ranged series 
and individual cells. The limitations on inputs and the results are similar 
to the MAX() function. In Figure 5.8, the MIN() function has been used to 
calculate the minimum average monthly temperatures.

Note

You can use ranges as well as numbers in the SUM() function; just separate each entry by 
a comma.

Tip
Place the cursor at the end of the series of numbers you want to sum and click on 
the AutoSum button under the Editing section of Home tab. The AutoSum button 
is found in the Function section of the Formula tab in Excel for Mac 2011. Also, try 
using the ALT+ = shortcut instead of clicking the mouse. Note that this shortcut is 
Command+Shift+T in Excel for Mac 2011.

Figure 5.7  Using the MAX Function
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AVERAGE()

As the name suggests, this function calculates the average, or mean of the 
numbers in the list. AVERAGE is a very useful function in certain situations, 
as can be seen in Figure 5.9.

Figure 5.8  Using the MIN Function

Figure 5.9  Using the AVERAGE Function

Tip
It is important to note that the AVERAGE function only counts the cells with values. 
Make sure that your model recognises the difference between no value and zero. The 
AVERAGE function will count the cells with value 0 but it will ignore the empty cells. In 
most cases, there is not a lot of difference between a blank cell and a cell containing 
a zero value, as most functions, such as SUM() for example, will treat them the same 
way, but when using the AVERAGE function, it’s important to distinguish the difference.

Combining Basic Functions

These basic functions can be used individually to calculate the respective results, 
but they can also be used in combination for various calculations. For example, 
if you want to find the maximum deviation (or range of values) in the values, 
you could subtract the maximum and minimum value. So you would have a 
formula such as =MAX(B2:B8)‐MIN(B2:B8), as shown in Figure 5.10.
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Logical Functions

Logical functions, particularly IF statements, are very commonly used in 
financial models because they allow the user to turn on and off certain 
calculations, and create scenarios and certain conditions or thresholds for 
calculations to maintain.

IF Statement

The IF statement takes three fields (Excel calls them arguments, but I’m 
going to stick with the term “field”):

Where:

Field 1 = the logical expression that is evaluated.

Field 2 = the result if Field 1 is true.

Field 3 = the result if Field 1 is false.

The syntax therefore looks like this:

= IF(statement being tested, value if true, value if false)

Figure 5.10  Combining Functions to Calculate the Deviation
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The first field consists of a logical expression (i.e., something that, when 
evaluated, is either TRUE or FALSE). The expression in the first field is 
evaluated. If it is TRUE, then the IF statement returns the value of the second 
field. If it is FALSE, then the IF statement returns the value of the third field.

Consider the following example:

= IF(6>5, greater , less than )" " " "

The statement being tested is true so the “greater” value is returned. Try 
this out, using the Function Wizard if you’re new to IF statements.

Note

Using the Function Wizard is highly recommended as it will help you to figure out which inputs 
go into which field. To open the Function Wizard, select the fx symbol to the left of the formula 
bar, or go to the Formulas Tab and select Insert Function from the Function Library group. The 
easiest way to get to an IF statement, for example, is to type "=IF(" and then hit the fx symbol, 
or Control + A. Note that you can’t use the Function Wizard, however, with nested functions.

Consider another example:

= IF(4>5, greater , less than )" " " "

The first expression is false so the “less than” value is returned.
IF statements can also be nested, meaning that it is possible to have an 

IF statement inside another IF statement. See the “Nesting” section in this 
chapter for further information.

For example:

= IF(6>5, IF(11>10, both , second ), first )" " " " " "

The first field is TRUE so the second field is then evaluated. Because the 
second field is also true, it returns its second field. Hence the result for this 
formula is both.

Test this formula in Excel and enter criteria in the first field such that it 
returns second and first.

Tip
When trying to take apart nested formulas, you can highlight a section of the formula 
that makes sense in its own right and hit F9. This will show you the result of the logic 
test. For example, in the formula above, you could highlight the section "6>5" and then hit 
F9, giving the result TRUE. Be sure to hit ESCAPE, not ENTER afterward; otherwise the 
result will be pasted as text. Note that this option is not available in Excel for Mac 2011.
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Practical Example  Let’s look at a practical example of an IF statement in 
a financial model. In the valuation model shown in Figure 5.11, we have 
decided that if the value of the deal is greater than the cost of the deal, then 
we should accept it, otherwise we should reject it. The syntax is =IF(value 
of deal > cost of deal, "Accept," "Reject"), and because the value is greater 
than the cost, it will return the decision “Accept.” If any of the inputs in this 
model change, such that the value becomes lower than the cost, the formula 
will automatically show “Reject” instead.

AND Statement

The AND statement can take up to 30 logical fields. It returns TRUE only if 
all the logical expressions are TRUE.

Figure 5.11  Using an IF Statement for Decision Analysis
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For example:

= AND(2<3,4<5)

Both of these fields are true, so the result of the formula will be TRUE.
For example:

= AND(2<3,4<3)

Only one of these fields is true, so the result of the formula will be FALSE.
The AND statement is most commonly used in conjunction with IF.
For example:

= IF(AND(2<3,4<5), A , B )" " " "

Only if both of the fields are true will the second field be returned. If one 
or both are false, then the third will be returned.

The result of this formula is A, because both AND fields are TRUE.

OR Statement

The OR statement is very similar to the AND statement except that either 
field can be true, rather than both.

For example:

= AND(2<3,4<3) is FALSE because only one of these fields is true.

However,

=OR(2<3,4<3) is TRUE because any one of these fields is true.

Nesting: Combining Simple Functions to Create 
Complex Formulas

Excel allows you to include more than one function in a formula. For 
example, you can add two totals using the formula:

=SUM(A1:A2)+SUM(B1:B2)
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But this does not make it a nested formula.
A nested formula is one in which a function is included in the field of 

another function. This technique allows you to build more complex formu-
las. Fields appear in parentheses after the function. Some functions require 
several fields; some require only one. A field can be a number, a reference, or 
text (usually in inverted commas). If a formula has more than one field, they 
will be separated by commas.

Some examples follow. This formula has one field range:

=SUM(A3:A23)

This formula has three fields: a reference, text, and another reference:

=SUMIF(A1:A10, ProductA ,B1:B10)" "

Finally, we have an example of a nested function, containing another 
function in a field. This one calculates the average of two totals:

= AVERAGE(SUM(A3:A23),SUM(D3:D23))

Nested IF Functions

In basic terms, a nested function is a function within a function, and the IF 
statement is probably most commonly used as a nested function.

The IF function can normally be used to test a cell and perform two 
different actions depending on the outcome of the test. But by nesting an-
other IF function inside an IF function, you can test a cell and perform three 
different actions depending on the outcome of the tests. You can actually 
nest up to 64 functions within a formula model, however, this is not recom-
mended, and certainly is not good modelling practice.

With most functions, we recommend the use of the Function Wizard; 
however, the Function Wizard does not work with nested formulas, and 
therefore you need to know the syntax of the formula before attempting 
to nest. Because an IF statement is one that is very commonly nested, it is 
important that you know the IF function syntax.

Let’s take a look at a practical example of a useful nested IF for-
mula. See the volume pricing table in Figure 5.12. You can create this 
sheet yourself or a template can be found, along with the accompanying 
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models to the rest of the screenshots in this book, at  www.plumsolutions 
.com.au/book.

If you have 63 items, you can see that they would be $10.50 each. If 
you want to create an automatic calculation for this, you’d need to create a 
nested formula, in the following three steps.

	 1.	Start with a basic IF statement. If your volume is less than or equal to 
five, the price is $15; otherwise it’s $12 (for now). So your formula in 
cell B8 would be =IF (A8<=B3,C3,C4). With me so far?

	 2.	Once we’ve got this working, we can make it more complicated. In another 
cell, say B9, let’s do another formula, which will deal with the value if it is 
greater than five. Create the formula =IF(A8<=B4,C4,C5) in cell B9.

	 3.	Once we’ve got both of these working, you can add them together. Go 
into the formula in cell B9, highlight and copy the whole formula except 

Figure 5.12  Volume Pricing Table

Figure 5.13  Highlight and Copy IF Statement

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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for the equal sign using a Control+C shortcut. (Note that this shortcut 
is Command+C in Excel for Mac.) See Figure 5.13.

	 1.	Now hit Escape (the copied formula will remain on your clipboard), go 
back to your formula in cell B8, and replace the C4 with the formula you 
have copied onto the clipboard. Do this by highlighting C4 and pressing 
Control+V. (Note that this shortcut is Command+V in Excel for Mac.)

	 2.	Your entire formula in cell B8 should now be =IF(A8<=B3,C3,IF(A8<
=B4,C4,C5))

	 3.	Multiply your price by the volume in cell C8 so we know the total, using 
the formula =B8*A8.

	 4.	Your sheet should look something like the sheet shown in Figure 5.14.

So the following rules will apply in this formula in cell B8:

■■ If cell A8 is less than or equal to 5, the price is $15 each.
■■ If cell A8 is less than or equal to 50, the price is $12 each.
■■ If cell A8 is less than or equal to 150, the price is $10.50 each.

Thus, the formula tests cell A1 to see if it is greater than or equal to five. 
If it is less than five, the formula will stop there and return the first value 
if true. If it is greater than five, however, it is then tested again to see if it is 
greater than or equal to 50. If it is, it will stop there and return the second 
value if true. If it is greater than five and greater than 50, only then will it 
return the value if false.

Figure 5.14  Completed Nested IF Function
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Note that a nested IF statement is an appropriate formula to use in this 
situation. However, if there were more than three pricing steps in the table, it 
is recommended that you use a close match VLOOKUP or LOOKUP function 
instead as this is a much simpler function than nesting multiple IF statements. 
(See the section “Building a Tiering Table” in Chapter 9 for how to do this.) 
Basically, if you find yourself including more than two or three IF statements 
in a formula, consider whether the formula should be broken into several 
steps, or whether an alternative, simpler function should be used instead.

Cell Referencing Best Practices

Formula consistency is critical for fundamental best practice both in finan-
cial modelling and any other sort of analysis using Excel, for that matter. In 
order to have consistent formulas across and down the block of data, you 
need to understand how cell referencing works. Whilst this is a very basic 
feature of Excel that is taught in introductory Excel courses, it is surprising 
how many modellers don’t understand its importance.

The $ sign in a cell referencing tells Excel how to treat your references 
when you copy the cell. If there is a dollar sign in front of a row number or 
column letter, the row or column does not change when you copy it. Other-
wise, it does change.

Relative and Absolute Referencing

Cell references are relative, by default. This means that when you copy the 
cell, it will change. In Figure 5.15, if cell B3 is copied down, the reference 
=B2 will change to =B3 and so on, down the row.

Figure 5.15  Relative Cell Referencing
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However, if you want the formula to anchor itself to cell B2, you’d need to 
use absolute referencing. For example, if you wanted to calculate the price be-
low of $450 at various numbers of units, you’d need to anchor the cell reference 
to the price as shown. This means that when you copy the formula down, the 
reference to cell A3 is relative, and changes to A4, A5, or wherever you paste it, 
but $B$2 remains anchored to cell B2 because it is an absolute reference.

Mixed Referencing

To illustrate further, suppose the following formulas are in cell B3 and you 
copy them to cell B4.

Here are the results in each case:

=B2 copies as: =B3

=$B$2 copies as: =$B$2

=B$2 copies as: =B$2

=$B2 copies as: =$B3

The $ sign anchors a row number or column letter when you copy it. 
You can anchor both the column and row (this is absolute referencing), or 
you can anchor one or the other (called mixed referencing).

In summary:

=B2 is relative referencing.

=$B2 or =B$2 is mixed referencing.

=$B$2 is absolute referencing.

Figure 5.16  Absolute Cell Referencing
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Mixed Referencing Exercise

	 1.	Type the table shown in Figure 5.17 into a blank Excel worksheet. You 
can create this sheet yourself or a template can be found, along with 
the accompanying models to the rest of the screenshots in this book, at 
www.plumsolutions.com.au/book.

	 2.	In cell B2, create a formula, using absolute referencing, that can be 
dragged across and down the entire block to cell D4 in one action (with-
out editing), hence showing the interest payable for different borrowing 
amounts at different interest rates.

	 3.	Remember that if you want to anchor the row, the dollar sign goes in 
front of the row, and to anchor the column, the dollar sign should be in 
front of the column. Spend a few minutes on this before looking at the 
answer in the next step, and in Figure 5.18.

	 4.	Your formula in cell B2 should look like this: =$A2*B$1. Copy your for-
mula across and down the block of data so that it looks like Figure 5.18.

Figure 5.17  Mixed Referencing Exercise

Tip
A quick way to fix a reference is to enter a reference like =B3 and then tap the F4 key. 
Note that this shortcut is Command+T in Excel for Mac. Each time you hit F4, Excel 
cycles to another option. To illustrate:

=B2 Then tap F4 to get:

=$B$2 Then tap F4 to get:

=B$2 Then tap F4 to get:

=$B2 Then tap F4 to get:

=B2 and so on . . .

http://www.plumsolutions.com.au/book
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Figure 5.18  Answer to Mixed Referencing Exercise

Note

Note that understanding mixed cell referencing is critical for good financial modelling prac-
tice and so it’s important for a financial modeller to understand it. The fewer unique formulas 
in your model, the better. Formula consistency is fundamental to best practice for a number 
of reasons. Consistent formulas using mixed references are:

■■ Faster to build and more efficient
■■ Less prone to error
■■ Cheaper to audit

For more information about financial modelling best practice, see Chapter 3.

Named Ranges

Excel allows you to select a single cell, or a range of cells, and give it a name. 
You can then use the name to move to the cells and select them, or include 
them in a formula.

In Figure 5.19, we have used an absolute reference to anchor our for-
mula to the consistent price of $450.

This cell is called B2, and this won’t change; however, we can also 
change the name of it to something else.

Why Use a Named Range?

Those new to named ranges sometimes struggle to see the benefits of includ-
ing them in models. It’s true that most of the time‐named ranges are not 
entirely necessary, but there are some good reasons to use named ranges 
when building a model:
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 ■ It makes your formulas easier to follow . A formula containing lots of 
cell references can be confusing to look at and diffi cult to edit. But if 
the cell references are replaced by a range name it becomes much easier 
to understand. For example, the formula = SUM(B3:B24)‐SUM(F3:F13)  
could be expressed as  =TotalIncome−TotalExpenditure . 

 ■     It doesn’t need absolute referencing.  By default, a named range is an 
absolute reference, so you don’t need to add in any. 

 ■     Drop‐down lists with off‐sheet sources.  You won’t be able to create 
drop‐down boxes with dynamic sources unless you use a named range. 
(See the section on “Using Validations to Create a Drop‐Down List” in 
Chapter   7   for a practical example of this.) 

 ■ Linking to external fi les.  It’s best practice to use named ranges when 
linking to external fi les. This means that when the source fi le changes, 
the data linking to it will automatically update.   

 FIgUre   5.19    Absolute Reference in a Formula

    hoW to Create a naMed range  

     1.  Select the cell, in this example B2. 

   2.  Go to the Name box in the top left‐hand corner. See Figure   5.20   . 

(continued)
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           Finding, Using, editing, and deleting named ranges 

 Clicking on the drop‐down arrow next to the name will show all the defi ned 
names in the workbook (as shown in Figure   5.21   ). Clicking on the name 
will take you directly to the cell(s). 

      Excel will then move to and select the range. It does not matter what 
sheet you are in when you select the name. This can make fi nding your way 
around the named ranges in a model much faster. 

 Having created a range name, you can now use that name in a formula 
instead of cell references. For example, if you have created the range name 
called  TotalIncome  for the cell containing the total income result, and a 
range named  TotalExpenditure  for the cell containing the total expenditure 
result, you can create a formula  =TotalIncome−TotalExpenditure  (just by 
typing this text into a cell). 

   3.  Type over the name and call it something else, like  Price , and 
press Enter. Alternatively, you can select Defi ne Name from the 
Defi ned Names group on the Formulas Tab, but typing over the 
cell reference in the name box is faster.   

 Note that the name must not contain any spaces or special charac-
ters. For instance, if you want to call it  Year 1 Price , you’d need to call 
it  Year1Price  or  Year1_Price . 

 Named ranges don’t necessarily need to be confi ned to only a sin-
gle cell; you can also create named ranges for an entire range of cells, 
and these can be used in formulas. Simply highlight the range instead 
of a single cell and type over the name as shown above. 

 FIgUre   5.20    The Name Box
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Figure 5.21  Finding a Named Range Using the Name Box

Another example: If you have created the range name Costs for all the 
cells in a column containing your numerical costs data, you can calculate the 
total costs using the formula =Sum(Costs).

A cell does not need to be an input field in order to assign a name to it, 
although it often is in financial models. The cell can also contain a formula 
as well as a hard‐coded input value.

Named ranges can be useful, but it’s not good practice to have too many. 
They can be confusing, especially if you have not used a consistent naming 
methodology. It’s also quite easy to accidentally name the same cell twice. So 
in order to keep names neat and tidy, you might need to edit or delete them.

Also, if you have added more data to a spreadsheet, and a range name no 
longer expresses the correct range of cells, you can redefine the named range.
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       sUMMary 

 This chapter introduced the more basic tools and functions that are com-
monly used in fi nancial modelling, such as basic functions, cell referencing, 
and named ranges. We also covered functions, such as IF, SUM, AVERAGE, 
and nesting these, as well as useful shortcuts that will make your model 
building faster and more accurate. The fundamental techniques of using 
cell referencing for best practice as well as the use of named ranges are the 
critical basic knowledge required for fi nancial modellers before moving on 
to more advanced tools. The Windows and Mac shortcuts named here will 
also prove invaluable to increasing your speed, productivity, and accuracy 
as a fi nancial modeller.  

    hoW to edIt or delete a naMed range  

 On the Formula tab, in the Defi ned Names group, click on the Name 
Manager. Here you can add, edit, or delete existing named ranges. 

 In Excel 2011 for Mac, go to Insert Name Defi ne. 
 The only difference between Windows Excel and Excel for Mac 

in this instance is that you can add comments to named ranges in 
Windows. Also, it is called a Name Manager in Windows, but other-
wise works in exactly the same way as it does in Excel for Mac. 
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Chapter 6
Functions for Financial Modelling

In this chapter, we will introduce the most useful functions commonly 
used in financial modelling. Whilst there are hundreds of functions that 

can be used in a model, I have attempted to list only the ones you are most 
likely to come across, and that you will find most useful when building 
models. Please don’t stop here, though! There are many more wonderful 
Excel functions that you will find useful in your financial modelling and 
business analysis.

Aggregation Functions

COUNTIF, SUMIF, COUNTIFS, and SUMIFS are very handy functions to 
know for modelling, and are particularly useful in Power Pivot. They add 
or count ranges of data, and count amongst some of my favourite, most 
frequently used functions.

COUNTIF

COUNTIF is used to count the cells that match specified criteria. For ex-
ample, let’s say you have sold $6,160 worth of different products on a par-
ticular day, as shown in Figure 6.1. You can create this sheet yourself or a 
template can be found, along with the accompanying models to the rest of 
the screenshots in this book, at www.plumsolutions.com.au/book.

You’d like to know how many (in terms of number of products) you’ve 
sold of each product: books, CDs, and DVDs. Follow these six steps:

	 1.	In cell B18, use the Formula Wizard to find the COUNTIF function. 
(Simply begin typing =COUNTIF( and then Control+A, or hit the fx 
symbol next to the formula bar.)

http://www.plumsolutions.com.au/book
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	 2.	Highlight the product names in column B for the range, and the word 
“Book” in cell A18 for the criteria. Do not type in the word “Book”! It 
needs to be linked to the input cell so that we can then copy down the 
formula.

	 3.	Your function wizard box should look like Figure 6.2.
	 4.	Press OK. The answer is 5. Your formula should look like: =COUNTIF 

(A2:A13,A18).
	 5.	Change your formula to use absolute referencing as follows: =COUNTIF 

($A$2:$A$13,A18) and copy the formula down the range. You don’t 
want absolute referencing on the criteria, because it needs to change its 
row references to CD and DVD as you copy down the formula.

As a shortcut, highlighting B2:B13 in the formula bar and pressing 
F4 (Command+T in Excel for Mac 2011) will set absolute references 
$B$2:$B$13. Remember that each time you press F4 (or Command+T 
in Excel for Mac 2011) it will scroll through the various absolute, rela-
tive, or mixed cell referencing options.

	 6.	Copy the formula down, and add a total at the bottom. Your sheet 
should now look something like Figure 6.3.

Figure 6.1  Sales List
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Figure 6.2  COUNTIF Function Wizard Dialog Box

Figure 6.3  Completed COUNTIF Function
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SUMIF

SUMIF is similar to COUNTIF but it sums rather than counts the values of 
cells in a range that meet a given criteria. SUMIF can be used in place of a 
PivotTable, and doing so is preferable as it uses less memory, and (most im-
portant) because SUMIF formulas are live links. PivotTables do not update 
automatically, which can cause errors in models if not refreshed correctly. 
Therefore, although quicker to build, PivotTables are sometimes avoided in 
favour of a SUMIF function in financial modelling.

	 1.	Let’s say that you’d like to know how much (in terms of dollar value) 
you’ve sold of each product: books, CDs, and DVDs.

	 2.	Select cell C18. Find the SUMIF wizard or start typing =SUMIF(. Be-
cause there are several fields required for this function, I’d recommend 
you use the wizard, as it’s easier to find your way through the function.

	 3.	The items you are adding together go in the Range field, the criteria you 
are looking for in that range go in the Criteria field, and the numbers 
you want to sum together go in the Sum_range field.

	 4.	Your wizard should look like Figure 6.4.
	 5.	Press OK. The answer is 2,430. Your formula should be: =SUMIF 

(A2:A13,A18,C2:C13).
	 6.	Add in the absolute referencing, and copy the formula down the range. 

Your formula should be =SUMIF($A$2:$A$13,$A18,$C$2:$C$13). 
You don’t need absolute referencing on the criteria (A18), because it 
needs to change its reference as you copy down the formula.

	 7.	Add a total. Your sheet should now look like Figure 6.5.

Figure 6.4  SUMIF Function Wizard Dialog Box
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We’ve now got a summary report at the bottom, showing us how much 
we have sold in terms of number and dollar value.

Be careful: If your Range and your Sum_range don’t match up, your re-
sult will be wrong. For example =SUMIF($A$2:$A$10,A18,$C$1:$C$13) 
will give you an incorrect result without warning! This is a very easy mis-
take to make, and quite common in financial modelling. You can see in 
Figure 6.6 that the totals are not the same because the SUMIF function is 
picking up the incorrect range. This is the same for COUNTIF functions, but 
it is not a problem with the SUMIFS, as the formula will return an error and 
therefore you will notice the error straightaway, unlike the SUMIF function.

Figure 6.5  Completed SUMIF Function

Tip
We can see that there is an error because the totals in rows 11 and 21 are not matching, 
but you might like to make this more obvious by adding an error check below the sum-
mary in cell C22 to pick up errors such as this. This can be done using a simple minus 
or equals formula, or see the section on “Building Error Checks” in Chapter 4 for greater 
detail on how to create an error check.
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Additional Exercise—PivotTable versus SUMIF

	 1.	Create a PivotTable in cell G3 that will give you exactly the same result 
as the SUMIF function. Your PivotTable should look like this:

Sum of Price

Product Total

Book $1,970

CD $1,760

DVD $2,430

Grand Total $6,160

See the section on “How to Create a PivotTable” in Chapter 8 for 
instructions if you don’t know how to build a PivotTable.

	 2.	Change one of your values in column C. What happens to the PivotTable? 
What happens to the SUMIF function?

Figure 6.6  Incorrect SUMIF Calculation
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You’ll notice that the SUMIF formula will change, but the PivotTable 
does not. This is why the use of PivotTables is not recommended in pure 
financial models: because PivotTables do not update automatically. See 
the section on “Using PivotTables in Financial Modelling” in Chapter 8 
for greater detail.

AVERAGEIF

The AVERAGEIF function will average values in the specified range that 
match specified criteria. This is similar to SUMIF.

	 1.	Let’s say that you’d like to know the average in dollar terms of each 
product sold. Select cell D18. Find the AVERAGEIF wizard or start typ-
ing =AVERAGEIF(.

	 2.	The items you are interrogating go in the Range field, the criteria you 
are looking for in that range go in the Criteria field, and the numbers 
you want to average go in the Average‐range field.

	 3.	Press OK. The answer is 486. Your formula should be:

=AVERAGEIF(A2:A13, A18,C2:C13)

	 4.	Use absolute referencing, and copy the formula down the range. Your 
formula should be: 

=AVERAGEIF($A$2:$A$13,$A18,$C$2:$C$13)

You don’t need absolute referencing on the criteria, because it needs 
to change its reference as you copy down the column.

COUNTIFS

COUNTIFS (along with similar functions such as SUMIFS and AVERAGEIFS) 
is a relatively new function that was introduced in later versions of Excel. 
COUNTIFS applies criteria to cells across multiple ranges and counts the num-
ber of times all criteria are met. For instance, COUNTIFS could answer how 
many of each product had been sold for a particular customer.

	 1.	In row 16, create a filter cell to show which customer we want to show in 
our summary. So in cell B16, enter the value Jenny. By linking the COUN-
TIFS function to this cell, we can change it in the future if we want to.

In cell B18, use the formula wizard and find the COUNTIFS func-
tion, or simply begin typing =COUNTIFS( if you prefer. If you are using 
the Formula Wizard, it should look like Figure 6.7.
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As you can see, we are invited to keep adding more ranges and crite-
ria to the function COUNTIFS, which was not possible in COUNTIF. Use 
absolute references for all ranges in your formula, with the exception of 
Criteria1 in cell A18. The reference to the word “Book” will change to “CD” 
and “DVD” as the formula is copied down.

The formula should be

= COUNTIFS A A A B B B($ $ :$ $ ,$ ,$ $ :$ $ ,$ $ )2 13 18 2 13 16

The result should look like Figure 6.8.

SUMIFS

Like the COUNTIFS function, the SUMIFS function applies criteria to 
cells across multiple ranges and sums specified columns for which criteria 
are met. For instance, SUMIF tallied up the value of all products, whereas 
SUMIFS could add up only those purchased by Jenny.

In cell C18, use the formula wizard and find the SUMIFS function, or 
simply begin typing =SUMIFS(. Complete the instructions given to achieve 
the result in Figure 6.9.

As you can see, we are able to append one or more ranges and criteria 
to the function SUMIFS in the form Criteria_range, Criteria, which was not 
possible in SUMIF. When using the SUMIFS function, we can appreciate the 

Figure 6.7  COUNTIFS Dialog Box
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Figure 6.8  Completed COUNTIFS Function

Figure 6.9  Completed SUMIFS Function
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value of using the function wizard, as it helps to see which criteria match 
which criteria range. The formula should be:

=SUMIFS C 2 C 13 A 2 A 13 A18 B 2 B 13 B 16($ $ :$ $ ,$ $ :$ $ ,$ ,$ $ :$ $ ,$ $ )

AVERAGEIFS

AVERAGEIF averaged the value of all products, whereas we could use 
AVERAGEIFS in a similar way to average only those products purchased 
by Jenny. In cell D18, use the formula wizard and find the AVERAGEIFS 
function, or simply begin typing =AVERAGEIFS(. Complete the instructions 
given to achieve the result in Figure 6.10.

As with COUNTIFS and SUMIFS, the AVERAGEIFS function also al-
lows you to append one or more additional criteria to it in the form Crite-
ria_range, Criteria.

The formula should look like this:

= AVERAGEIFS C 2 C 13 A 2 A 13 A18 B 2 B 13 B 16($ $ :$ $ ,$ $ :$ $ ,$ ,$ $ :$ $ ,$ $ )

As can be expected, the result of this formula will be $660, as there is 
only one instance of sales that were made to Jenny. Now copy the formula 
down to cells D19 and D20. D20 returns an error, because Jenny did not 
buy any DVDs, so we need to use the IFERROR function to suppress this 
error. Go back to cell D18 and put the IFERROR function around your 
formula. The formula should look like this:

= IFERROR AVERAGEIFS C 2 C 13 A 2 A 13 A18 B 2

B 13

( ($ $ :$ $ ,$ $ :$ $ ,$ ,$ $

:$ $ ,$$ $ ), )B 16 0

Then copy the formula down the range. Cell D20 should now show a 
zero instead of the #DIV/0! Error.

Tip
Cell D19 gives us a value of $880, so let’s do a sense-check to make sure that it is accu-
rate by highlighting both CD sales made to Jenny and looking at the AVERAGE amount 
showing in the status bar in the bottom left-hand corner, as shown in Figure 6.11.

To make this table more complete, we need to put a total in cell D21; how-
ever, neither the total of the range ($1,540) nor the average of the range ($513) 
makes sense. In cell B21, we are showing the total number of purchases by 



137

Fig
ur

e 
6.

10
 

A
V

E
R

A
G

E
IF

 F
un

ct
io

n 
W

iz
ar

d



138� Using Excel for Business Analysis

Jenny, and then in cell C21 we are showing the total amount of her purchases. 
Therefore, it makes sense to show the average of all purchases by Jenny in cell 
D21, which is $807. This cannot be done by copying the function down, so we 
need to create a new AVERAGEIF function, which should look like this:

= AVERAGEIFS C 2 C 13 B 2 B 13 B 16($ $ :$ $ ,$ $ :$ $ ,$ $ )

The completed report can be seen in Figure 6.12.
Now, try changing the word “Jenny” in cell B16 to “Faisal” and watch 

the numbers change.

Filtering IFS Functions by a Variable Value

Note that instead of filtering to show one customer, we could, for example, 
show only those products that exceed $50. This is not particularly easy using 
IFS functions (i.e., SUMIFS, COUNTIFS, and AVERAGEIFS), but it is possible.

Let’s remove the word “Jenny,” and instead add the minimum $50, 
and change the label to show that the cell now contains only sales that are 
greater than $50, as shown in Figure 6.13. Note that we are now showing 

Figure 6.11  Sense‐Checking the AVERAGEIFS Function
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the filter in column C because it lines up better with the sales amount, which 
is also in column C. We can now change the original COUNTIFS function to 
only aggregate the values greater than $50. It is an idiosyncrasy of all these 
IFS functions, however, that we cannot easily link when using the greater 
than (>) or less than (<) symbols. The function will force us to use inverted 
commas, and enter the filter value directly into the function, rather than 
linking it to an individual cell on the worksheet. Your formula in cell B18 
will look like this:

= >COUNTIFS A 2 A 13 A18 C 2 C 13 50($ $ :$ $ ,$ ,$ $ :$ $ ," ").

This is not very good financial modelling practice, however. Any 
decent modeller would want to allow the user to change the filter 
minimum value. We therefore need to use a tricky work‐around involv-
ing the handy ampersand (&) symbol. We’ll need to replace the ">50" 
with the phrase ">"&$C$16 instead, and therefore the minimum filter 

Figure 6.12  Completed Filtered Sales Report
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will change according to the value in cell C16. Your formula in cell B18 
should now look like this:

= >COUNTIFS A 2 A 13 A18 C 2 C 13 C 16($ $ :$ $ ,$ ,$ $ :$ $ ," " $ $ ).&

Copy it down and then try the same technique with the SUMIFS 
function. The solution for the SUMIFS is shown in Figure 6.13.

Similarly, the AVERAGEIFS function can be completed in the same way, 
and should look like the solution shown in Figure 6.14. As in the last ex-
ample, the formula to calculate the total for the Average needs to be the 
average for all Sales greater than $50.

Note that dates can also be used as input criteria for these IFS functions.

LOOKUP Formulas

LOOKUP functions are very often used in financial modeling and analysis—
sometimes a little too often, in my opinion. They are useful to know, but 
sometimes another function would create a more robust solution.

Figure 6.13  SUMIFS Function with a Minimum Filter
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VLOOKUP (Vertical Lookup)

VLOOKUP stands for Vertical Lookup. It can be used anytime you have a 
list of data with the key field in the leftmost column, and it is by far the most 
commonly used form of LOOKUP formula.

Let’s say you have a shopping price list like in Figure 6.16. You can 
create this sheet yourself or a template can be found, along with the 
accompanying models to the rest of the screenshots in this book, at www 
.plumsolutions.com.au/book.

In cell C12, we’d like to find out how much it will cost to buy four or-
anges, using a VLOOKUP.

How to Create a VLOOKUP  The following is an 11‐step process for creating a 
VLOOKUP.

	 1.	Find and select the VLOOKUP function. Using the wizard is probably go-
ing to be the easiest for VLOOKUPs, as there are four parameters it needs.

	 2.	The first parameter is the criteria we are testing, in this case the word 
oranges, so enter B12 in the first field.

Figure 6.14  AVERAGEIFS Function with a Minimum Filter

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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	 3.	The next parameter is the table, which contains the data you want to 
reference. This is where it gets tricky. The criteria you are looking for must 
always be in the far left‐hand column of the data table you are referencing 
in the table array. So, in this case, the data we are referencing will be the 
range B7:C10. Figure 6.15 is what your wizard should look like so far.

	 4.	Now, if you were going to copy this formula down the page, you would 
have to use absolute referencing for the table array, or use a named 
range. Let’s create a named range here.

	 5.	Press Escape to cancel out of the wizard and create a named range for 
the whole table. Highlight the range B3:C6 and type over the name box 
in the top left‐hand corner of your screen with the word FruitList, and 
press Enter. We can now use this in the VLOOKUP. Now that we have 
used a named range, we won’t have to worry about absolute referencing 
in our VLOOKUP formula. See Figure 6.16.

	 6.	Go back into the VLOOKUP wizard again, re‐reference the lookup 
value to B8, and either select the table array in the second field box, or 
simply type in FruitList. Make sure you have spelt it the same way as 
your named range! If you can’t remember what you called it, use the F3 
shortcut as shown in Figure 6.17.

Figure 6.15  VLOOKUP Dialog Box

Tip
When referencing a named range in a formula, you can also use the F3 paste name 
shortcut to bring up a list of all named ranges in the model.
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Figure 6.16  Creating a Named Range

	 7.	The third field, called Col_index_num, tells Excel in which column the 
value is found. We need to tell the function which column in the table 
array we want it to return. In this case, we want it to tell us the price. 
So, counting from the far left‐hand side of the table array (starting in 
column B), we want it to return to the second column. So we enter a 
number 2 in the Col_index_num field.

	 8.	The optional fourth parameter tells Excel if a close match is okay. If you 
want an exact match, enter zero; otherwise leave it blank. You may also 
enter TRUE or FALSE, but typing a zero or leaving it blank is quicker. 
Click OK to complete the formula.

Note

There are very few instances where you want a close match. (See the section on “Building 
a Tiering Table” in Chapter 9 for an example of using a close match in VLOOKUPs.) In most 
VLOOKUPs, you want an exact match, so enter a zero in the last field.

	 9.	The wizard should look like Figure 6.18 and the formula should now be:

= VLOOKUP B12 FruitList 2 0( , , , ).

	10.	Now, try changing the word oranges to apples. The price should change.
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	11.	Last, we need to multiply the price by the number of items we are 
purchasing. Change your formula to:

= VLOOKUP B12 FruitList 2 0 A12( , , , )* .

#N/A Errors in VLOOKUPs  While this example worked out perfectly, when view-
ers use VLOOKUP, it usually means that they are matching up lists that came 
from different sources. When lists come from different sources, there can al-
ways be subtle differences that make the lists hard to match. This means you 
will get a #N/A error if the VLOOKUP function cannot find a match. Here are 
two examples of what can go wrong and how to correct the error.

Example 1. One list has dashes, for example, and the other list does 
not. The first time that you try the VLOOKUP, you will get #N/A errors. 
To remove the dashes with a formula, use a find and replace. Replace with 
nothing (i.e., leave the field blank). Your data will now match and the for-
mula works.

Example 2. One list has a trailing blank space after the entry. This one is 
subtle, because you can’t see it with the naked eye, but very common. In fact, 
I’ve spent many happy hours searching for an invisible space! When you initial-
ly enter the formula, you find all of the answers are N/A errors. You know for 
sure that the values are in the list and everything looks okay with the formula.

One easy way to check is to move to the cell with the lookup value. 
Press F2 to put the cell in edit mode and you can see that the cursor is 
located one space away from the final letter. This indicates that there is a 
trailing space in the entry.

One way to solve the problem is to use the TRIM function. Entering 
=TRIM(D4) as part of your VLOOKUP formula will remove leading spaces 
and trailing spaces, and will replace any internal double spaces with a single 
space. In this case, TRIM works perfectly to remove the trailing space. The 
formula would look something like this:

= VLOOKUP TRIM B12 FruitList 2 0 A12( ( ), , , )* ).

Breaking a VLOOKUP  If you have created a VLOOKUP in a model such as the 
one above, this should work well—until someone enters or deletes a column 
in your source data! With a formula such as =VLOOKUP(B12,FruitList,
2,0)*A12, it specifically asks for the second column, so it will not work if 
someone inserts a column within the FruitList range. This is because your 
required column becomes the third column, but the VLOOKUP is asking 
for the second.

VLOOKUPs and HLOOKUPs are not very robust formulas—you can see 
how easy they are to break! For this reason, try some of the alternatives below 
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to make your LOOKUP functions more robust; otherwise, use another function 
or protect your model so that users cannot insert or delete rows or columns.

Improving VLOOKUPs with MATCH  The best way around this is to make the 2 in 
your VLOOKUP a formula instead of a hard‐coded number. One way of do-
ing this is to nest the VLOOKUP with a MATCH function. In the following 
eight steps, we will create the MATCH formula in a separate cell and then 
replace the 2 with the MATCH formula.

	 1.	Using the VLOOKUP example above, test the problem by inserting 
or deleting a column in our sheet. You will see that the value in your 
VLOOKUP is now incorrect.

	 2.	Now go to another spare cell, say cell C3, and create a MATCH for-
mula that will find the word Price in the range B6:C6 below and tell us 
its position in the range.

	 3.	Your Formula Wizard should look like Figure 6.19.
	 4.	By putting a 0 in the Match_type range, you are asking it to return you 

an exact match instead of a close match.
	 5.	When you hit OK, your formula should be 

=MATCH($C$6,$B$6:$C$6,0) and the result should be 2.

	 6.	Go into the MATCH formula bar, highlight the entire formula (except 
for the = sign), and press Control+C (Command+C in Excel for Mac 
2011) to copy it. Hit Enter, or Escape. Now, go back to your original 

Figure 6.19  MATCH Function Dialog Box
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VLOOKUP, and replace the 2 in your VLOOKUP formula with this en-
tire MATCH formula by highlighting the 2 within the formula and past-
ing the MATCH formula over it by pressing Control+V (Command+V 
in Excel for Mac 2011). Hit Enter.

	 7.	Your formula should look like this:

= VLOOKUP B12 FruitList MATCH C 6 B 6 C 6 0 0 A12( , , ($ $ ,$ $ : $ $ , ), )* .

	 8.	Test that this works, by inserting or deleting a column. You can now 
clear the formula in cell C3, as this is no longer necessary.

Note

Note that the function wizard only works when you have a single function in a cell. Now that 
you have created a nested function (i.e., a function within a function), the function wizard 
no longer works.

Tip
This technique whereby we create each function in a separate cell and then nest them 
together is by far the easiest method to create nested functions. It becomes confusing 
and easy to make a mistake if you try to create a nested function all in one go. It’s much 
easier to create a separate function in each cell, and then copy and paste them together 
as shown above.

Another way of making a LOOKUP formula more robust would be 
to use the COLUMN function for a VLOOKUP or ROW function for 
an HLOOKUP instead of MATCH. This will automatically return the 
range’s column or row reference. Using this, the formula instead would be: 
=VLOOKUP(B12,FruitList,COLUMN(C6)‐1,0)*A12. (The 1 is required 
because the range is starting from column B.)

Note

Note that the column function will only work if we change the size of the range included in the 
formula. If an additional column is inserted to the left of the range, the nested COLUMN function 
returns an incorrect result. For this reason, the MATCH nested function is a superior solution.

HLOOKUP (Horizontal Lookup)

HLOOKUP works in exactly the same way as the VLOOKUP, except that 
the data is arranged horizontally instead of vertically. See Figures 6.20 and 
6.21, for example.
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HLOOKUP is subject to exactly the same issues as the VLOOKUP and 
works in exactly the same way, except for the orientation. If your source 
data in the range is orientated vertically, use the VLOOKUP, and if it is hori-
zontal, use the HLOOKUP.

Figure 6.20  Use of the HLOOKUP Function

Figure 6.21  HLOOKUP Function Dialog Box
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LOOKUP Function

The LOOKUP function is much simpler than either the VLOOKUP or the 
HLOOKUP, and it has the added advantage of being able to have the re-
sults column or row either to the left or the right of the criteria column or 
row—a huge advantage. However, the data must be sorted in alphabetical 
order or it won’t work. This does limit its usage significantly, and it is for 
this reason that it is far less popular than the VLOOKUP or HLOOKUP 
formulas.

It’s worth knowing how it works, though, so here’s a brief example. 
Let’s say you have a tiered pricing structure, as shown in Figure 6.23.You 
can create this sheet yourself, or a template can be found along with the 
accompanying models to the rest of the screenshots in this book at www 
.plumsolutions.com.au/book.

	 1.	Select LOOKUP from the Function Wizard.
	 2.	There are two types; choose the first option as shown in Figure 6.22.
	 3.	Similar to an HLOOKUP or VLOOKUP, the criteria being tested go in 

the first field.
	 4.	The column (or row) containing the criteria goes in the second field, and 

then the column (or row) containing the result goes in the last field. See 
Figure 6.23

	 5.	Copy the LOOKUP function down and multiply the price by the total 
amount to complete the pricing table as shown in Figure 6.24.

Note that this works exactly the same whether the data is shown verti-
cally or horizontally. Importantly, unlike a VLOOKUP or HLOOKUP, it 

Figure 6.22  LOOKUP Function Option

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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Figure 6.23  LOOKUP Function Dialog Box

Figure 6.24  Completed Pricing Calculation
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does not matter whether the result data is to the left or right, above or below 
the lookup data.

However, you would use a LOOKUP only for numerical values where 
the numbers are sorted and you want a close match, not an exact match. 
You would not use a LOOKUP function for text, as shown in the last 
fruit‐shopping list VLOOKUP example, because it will only return a close 
match, and this is dangerous. This makes the LOOKUP function almost 
useless in many cases where a LOOKUP is required. The only time a mod-
eller would use a LOOKUP is when he specifically wants a close match. 
See Table 6.1 below for the advantages of the different LOOKUP func-
tions just described.

Table 6.1  Advantages and Disadvantages of LOOKUP Functions

Function Advantages Disadvantages

VLOOKUP ■■ Data does not need to 
be sorted alphabetically 
as long as you use 0 or 
FALSE in the last field.

■■ The column number 
is hard‐coded, so if a 
column is inserted, it can 
mess up the formula. 
(You can use a MATCH 
formula to fix this.)

■■ The column containing 
the results must be to the 
right‐hand side of the 
column containing the 
lookup criteria.

HLOOKUP ■■ Data does not need to 
be sorted alphabetically 
as long as you use 0 or 
FALSE in the last field.

■■ The row number is 
hard‐coded, so if a row 
is inserted, it can mess 
up the formula. (You can 
use a MATCH formula 
to fix this.)

■■ The row containing 
the results must be to 
the right‐hand side of 
the row containing the 
lookup criteria.

LOOKUP ■■ The column/row number 
is not hard‐coded.

■■ It does not matter where 
the columns or rows are 
in relation to each other.

■■ Data must be sorted or 
it will give the wrong 
result.
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Nesting INDEX and MATCH

Using INDEX and MATCH to Create a More Robust Formula

As described in “Linking to External Files” in Chapter 4, robust formulas, 
such as a nested formula using a combination of an INDEX and a MATCH, 
used with named ranges will make the link a lot less likely to break and 
cause problems in models.

Let’s say that you are referencing a table in another file. Your coworker 
keeps inserting and deleting rows and columns. The VLOOKUP solution 
as previously described may work, but with large tables an INDEX and 
MATCH formula combination will be more efficient.

Figure 6.25 contains the source data, showing we need to pick up the 
staff amenities costs for Geelong. You can create this sheet yourself or a 
template can be found, along with the accompanying models to the rest of 
the screenshots in this book, at www.plumsolutions.com.au/book.

You could simply reference the cell F5, using the formula =F5, but 
this will not help you if your file is closed, and someone else changes the 
referenced table. Let’s say your coworker inserts a column while your 
model is closed. When you open your file again, it will still reference F5, 
but Geelong has moved to column G, so the formula in your model will 
be wrong!

By using a combination of an INDEX and MATCH formula, we will be 
able, in 16 steps, to specify the exact coordinates of the required value, even 
if its position in the table changes.

	 1.	In cell B12, insert the word Geelong, and in cell A13, insert the phrase 
Staff Amenities. These cells will become input variables that we will link 
our formula to.

	 2.	Now let’s find the coordinates of the required data. Start by creating a 
MATCH formula in a spare cell that will find the word Geelong and tell 
us its position in the range of city names.

Figure 6.25  Sample Data

http://www.plumsolutions.com.au/book
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	 3.	Your formula should be =MATCH(B12,A1:I1,0), and the result should 
be 6. Note that you could type the word Geelong directly into the for-
mula, but linking it is considered best practice in financial modelling.

	 4.	Now do the same thing for the expense types. In another spare cell, cre-
ate a MATCH formula that will find the phrase Staff Amenities and tell 
us its position in the range of expense types.

	 5.	Your formula should be =MATCH(A13,A1:A9,0), and the result should 
be 5.

	 6.	Now create the INDEX formula that will return the value that you 
specify. Note that when you use the wizard, it will ask you which argu-
ment list you wish to use. Select the first one. See Figure 6.26.

	 7.	Once you are in the Formula Wizard, enter the array that is the whole 
range of data, starting from cell A1. Then hard‐code in the row number 
(5 in this case) and the column number (6 in this case). See Figure 6.27.

	 8.	Your formula should be =INDEX($A$1:$I$9,5,6), and the result should 
be $23,021.

	 9.	This formula will work fine, as long as no one inserts or deletes rows 
or columns. We know that hard‐coded numbers are not good financial 
modelling practice and so in order to make it completely robust, we 
need to replace the 5 and 6 with the results of the MATCH formulas. 
We are going to turn this into a nested formula, just like we did in the 
“”last section where we nested the VLOOKUP and MATCH functions.

	10.	Go back into the first MATCH formula bar (the one that returns a 6), 
highlight the whole thing (except the “=” sign), and press Control+C 
(Command+C in Excel for Mac 2011).

	11.	Go into the INDEX formula and replace the column reference with this 
formula. Highlight the 6 and press Control+V (Command+V in Excel 
for Mac 2011).

Figure 6.26  INDEX Function Options
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	12.	Now do the same for the row reference. Go into the second MATCH 
formula bar, highlight the whole thing (except the = sign), and press 
Control+C (Command+C in Excel for Mac 2011).

	13.	Go into the INDEX formula and replace the row reference with this 
formula. Highlight the 5 and press Control+V (Command+V in Excel 
for Mac 2011).

	14.	Don’t forget to add in some absolute referencing. Your formula should 
look like this:

= INDEX A 1 I 9 MATCH A13 A 1 A 9 0 MATCH

B12 A 1 I

($ $ :$ $ , ( ,$ $ :$ $ , ),

( ,$ $ :$ $11 0, )).

	15.	Test the robustness of your formula by inserting or deleting rows or 
columns. You can now cut this formula to another file, and it will work 
in the same way.

	16.	In Figure 6.28, we can see that named ranges have been inserted into the 
original data, and used in the formula, which has been cut and pasted 
to a separate file. Even if the data file is changed while the report file is 
closed the formulas will still remain accurate.

Note

Remember, if you want to move this formula around, to use the cut and paste functions, not 
copy and paste. Cutting (Control+X or Command+X) will move all formulas with it. If you cut 
this formula to another file, you should follow best practice by using named ranges in the 
formula, particularly where the INDEX function is referencing the data. This way, if the data 
is added to, the named range will expand accordingly.

Figure 6.27  INDEX Function Wizard
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OFFSET Function

The OFFSET function, in my opinion, is less useful than the other functions 
we have covered so far, as it can be tricky to build and is complex to audit. 
However, it can be handy in certain situations, and many financial modellers 
are fond of including it in their models, therefore you will be likely to come 
across it and need to know how to decipher it.

OFFSET is used to return the address of a cell or a range of cells through 
the use of a reference cell, and is generally used in order to stagger (or offset) 
a series of values by a variable amount. For example, if you want to delay 
a project by a certain number of months, but want the number of months 
to be variable, the OFFSET function will move the value by the number of 
months that is specified in the model.

To give a very simple example, let’s say in the data shown in Figure 6.29, 
you wanted to pick up the value in cell B3, which is located one column 
across and two rows down from cell A1.

Using the OFFSET wizard, the reference point given is cell A1, and the 
offset rows are 2 and offset columns are 1, as shown in Figure 6.30.

Don’t worry about the height and width for now (this is for when 
you want the result to be a range, rather than a single cell. For an ex-
ample of using an OFFSET in a range, see “Dynamic Named Ranges” in 
Chapter 12.) Your formula will be =OFFSET(A1,2,1), and the result given 
should be 54.

This is picking up the cell one column to the right, and two rows below 
the reference cell. If you wanted to pick up a cell above or to the left of the 
cell, you would have used a negative offset number for the rows and col-
umns (e.g. −2 instead of 2).

Using an OFFSET to Model Cash Flow  So now that you know how to do an OFF-
SET function, let’s see how it’s used in a more practical context.

Figure 6.29  Example Data
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Let’s say that you have monthly sales data, but the terms of payment 
are one month, as shown in Figure 6.31. This means the cash is received one 
month after the sale is made.

You can create this sheet yourself or a template can be found, along 
with the accompanying models to the rest of the screenshots in this book, at 
www.plumsolutions.com.au/book.

Let’s create a Cash Receipts line in row 5 using the OFFSET formula, 
which will delay the cash receipts by the number in cell B1. We have indi-
cated that this number can be changed by formatting the cell as an input 
using the Styles menu.

	 1.	Start in cell C5, and create an OFFSET function that uses cell C4 as a 
reference point and offsets the number of columns by the number of 
months in cell B1.

	 2.	Leave rows blank, as you do not wish to move rows.
	 3.	Make the offset number of columns a negative number, because you 

wish to return the cell to the left, not the right
	 4.	Your wizard should look like Figure 6.31, and the formula in cell C5 

should be =OFFSET(C4,,‐$B$1).
	 5.	Copy this formula across the row.

Figure 6.30  OFFSET Function Wizard

http://www.plumsolutions.com.au/book
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Nesting OFFSET and COLUMN Formulas  The formula that we have created works 
when the terms are one month, but if you change the number of months in 
cell B1 to 2, it will pick up the word Sales in cell A4.

Copy the formula all the way across the row, and B5 returns a #REF! 
error value, as shown in Figure 6.32. This is a very common problem when 
using the OFFSET function; we need to edit the formula now to make this 
model more robust.

One method is to suppress the errors and text. Note that we have three 
possible value types being returned by this OFFSET:

	 1.	Error (in cell B5)
	 2.	Text (in cell C5)
	 3.	Number (in the rest of the cells in row 5)

If we suppress only the error using the IFERROR function, then this 
will allow the text. We could create a complex nested function that would 
suppress both the error and the text like this:

= −
−

IF OR ISERROR OFFSET B4 B 1 ISTEXT OFFSET B4

B 1

( ( ( ( ,, $ $ )), ( ( ,,

$ $ )))), , ( ,, $ $ )).0 OFFSET B4 B 1−

But a simpler way would be to return the value only in the case of 
a number (hence, specifying the value we want, not the values we don’t 
want!). Your formula should look like this, as shown in Figure 6.33:

= − −IF ISNUMBER OFFSET B4 B 1 OFFSET B4 B 1 0( ( ( ,, $ $ )), ( ,, $ $ ), ).

Test the formula by changing the value in cell B1 and check that the 
result is what you expect. If you are expecting no delay in cash receipts, you 
can enter a zero in cell B1, and the formula will still work.

Figure 6.32  OFFSET Function with Error and Text Values

Tip
Copy and paste the OFFSET(B4,,-$B$1) part of the formula, rather than creating it twice.
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Alternatively, you could also nest a COLUMN function to give a 
similar result. A COLUMN function will return the column reference of the 
formula. For example, COLUMN(B3) returns the value 2.

We need to add a formula in front of our OFFSET function to say that 
if the number of months in cell B1 is greater than the column position, it 
should return a zero. Your formula would look like this:

= >= − −IF B 1 COLUMN B4 1 0 OFFSET B4 B 1($ $ ( ) , , ( ,, $ $ )). 

See the sheet named “Fig 6.33a” in the supplementary Excel files for this 
chapter for a working demonstration in Excel.

Figure 6.33  Completed Dynamic Cash Flow Using a Nested OFFSET Formula

Tip
Note that cell C1 contains the word month instead of months. If you insert the formula 
=IF(B1=1, "month","months") into cell C1, the syntax will always be correct no 
matter what value you insert in cell B1.

Regression Analysis

Using a FORECAST or TREND Function

The FORECAST function in Excel predicts or forecasts data based on his-
torical data, using the linear trend. These functions are a simple way of per-
forming regression analysis in Excel, and are useful to include in forecasting 
models. The TREND function almost always gives the exact same result 
(but uses the least‐squares method instead of the linear trend), so for our 
purposes, the two can be used interchangeably.

Select the FORECAST (or TREND) function from the Formula Wizard. 
Basically:

■■ X is the date or number for which you want the numbers to be forecast.
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■■ Known y’s is the known historical data.
■■ Known x’s is the known historical dates or numbers.

Let’s say, for example, that you have the following historical data avail-
able, and you need to provide a forecast for Jul‐16. You can create this sheet 
yourself or a template can be found, along with the accompanying models to 
the rest of the screenshots in this book, at www.plumsolutions.com.au/book.

Date Sales 

Jan-16 650 

Feb-16 660 

Mar-16 680 

Apr-16 670 

May-16 700 

Jun-16 690 

Jul-16

Aug-16

Sep-16

Oct-16

Nov-16

Dec-16

If we were to quickly chart these numbers, we could add a linear trend 
line to visually see what we expect the forecast to look like. Create the chart 
by highlighting all the data and then selecting the Line Chart from the Insert 
Tab on the Ribbon. To create the linear trend line, right‐click on the series 
and select Add Trendline. See Figure 6.34.

We can see from the trajectory of the trend line that, based on historical 
data, the sales in July 2016 should be somewhere between 700 and 710. The 
formula tells us the slope, which is what the FORECAST function uses to 
calculate the projections. See Figure 6.35.

This is exactly how the FORECAST formula calculates forecasts: It 
looks at the historical relationship between the X‐axis and the Y‐axis, and 
projects based on these numbers.

	 1.	To create the FORECAST function, select cell B8.
	 2.	Bring up the =FORECAST Formula Wizard. The inputs for our formula 

fields will be:

http://www.plumsolutions.com.au/book
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Figure 6.34  Inserting a Linear Trend Line

Figure 6.35  Linear Trend Line
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X: A8 (Jul‐16) as the date for which we want to forecast.

Known_y’s: B2:B7 (650‐690) as the historical data we know already.

�Known_x’s: A2:A7 (Jan‐16‐Jun‐16) as the corresponding years for 
the numbers we know already.
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Figure 6.36  FORECAST Function Wizard

	 3.	Your Formula Wizard should look something like Figure 6.36.
	 4.	The forecast sales for Jul‐16 is 706, and the line chart that you created 

earlier will show forecasted values that match the trend line exactly, as 
shown in Figure 6.37.

Tip
Be sure to use absolute referencing in the second two ranges of your FORECAST 
function. If you don’t, then the forecast’s original data range will move, making it less 
accurate over time.

Note

If you were in a hurry, you could have simply highlighted the original data, and dragged it 
down, returning the exact same results as the FORECAST or TREND functions! However, this 
will hard-code the data, make it very difficult to audit, so using a function to forecast your 
data is much better financial modelling practice.

CHOOSE Function

The CHOOSE function returns a value from a list of values based on a given 
position.

For example, let’s say you want to pick up the second value in the fol-
lowing list of data in Figure 6.38.
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Figure 6.37  Completed Line Chart Showing Results of FORECAST
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Figure 6.38  CHOOSE Function Wizard

	 1.	Type out the list of days, starting with Sunday.
	 2.	Select cell A9. Go into the Function Wizard and select CHOOSE.
	 3.	Index_num is the value that you want the formula to return. Enter 2 in 

this field.
	 4.	Enter the values from which you want the formula to choose. Note that 

you can hard‐code these, or use a reference the way that we have done 
here. See Figure 6.38.

	 5.	Hit OK, and your formula should be:

= CHOOSE 2 A1 A2 A3 A4 A5 A6 A7( , , , , , , , ).
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Using a Nested CHOOSE Formula with Dates  Let’s say you’d like to be able to 
enter in any date and have a formula that tells you, in words, the day of the 
week it is.

	 1.	Go to cell B9 and enter your date. This could be your birth date, or 
you could create a formula with today’s date by typing =TODAY(). Ev-
ery time you open the model, it will show the current date. Note that 
=NOW() will show the date and the time.

	 2.	The formula =WEEKDAY(B9) will return the day of the week as a num-
ber, with Sunday being the first day of the week. Therefore, Sunday=1, 
Monday=2, and so on.

	 3.	Go back to your previous formula in cell A9, and turn it into a nested 
formula by replacing the hard‐coded 2 with the WEEKDAY formula.

	 4.	Your formula should be

= CHOOSE WEEKDAY B9 A1 A2 A3 A4 A5 A6 A7( ( ), , , , , , , ).

Now, each time you open the model, the formula in cell A9 will show 
the day of the week. See the next section for more date options.

Working with Dates

Excel treats dates and times as numbers, which means they can be computed 
mathematically. For example, you can subtract two dates to find the number 
of days in between. This feature is invaluable in financial modelling, as a 
very large proportion of financial models are times‐series based.

You can add some number of days to a date by using simple formulas. Since 
Excel stores dates as a number of days, you can change the date by including the 
date in a formula. For example, to add seven days to 1‐Jul‐16 in C3, use =B3+7, 
which gives 8‐Jul‐16, and hence a weekly cash flow report. See Figure 6.39.

Handy Functions

Many financial models require specific dates or sections of the dates for the 
analysis. Excel has a fantastic collection of functions to isolate various parts 
of the dates and calculate special dates like the last day of the month. Given 
below are some of the more commonly used handy date functions in Excel.

=TODAY(): This function gives today’s date, whenever you open the model.

=NOW(): This function gives the exact date and time, whenever you 
open the model.
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Figure 6.39  Using a Formula to Calculate Dates

Figure 6.40  Using the EOMONTH Function

=EOMONTH: This function gives you the last date of the month, with 
reference to any date. The snapshot in Figure 6.39 shows how this 
formula works. Note that the EOMONTH function is only avail-
able in the later versions of Excel (Excel 2007 or later).

The EOMONTH is an extremely useful function because it will al-
ways take you to the last day of the month, regardless of how many days it 
contains. In Figure 6.40, we have a project start date of 6 July 2016 in A2. 
The last date of the next month is 31 August 2016, which is represented in 
B2 and can be copied across the row.

The alternative way of doing a variable start date would be to use for-
mula =A2+30, and copy it across. But this is not very accurate, and if you 
have interest calculations running from the dates, for example, the calcula-
tions will not be exactly correct.

The other benefit of using the EOMONTH function is that it handles 
leap years very well. In Figure 6.41, if we have a February start day, and want 
to show six monthly milestones, you can see that by using the EOMONTH 
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function, it will always give us the last day of the month. The year 2016 is 
a leap year, so cell C3 gives us 29 February 2016, whereas cell E3 gives us 
28 February 2017, as 2017 is not a leap year.

While finding the last date of the month is the standard output of the 
EOMONTH function, with some improvisation you can also get the first 
day of the month. Since Excel treats dates as numbers EOMONTH()+1 
will give you the first day of the next month if this is required in your 
model.

=WEEKDAY  This function gives you the day number in the week correspond-
ing to the date specified. In Figure 6.42 you have the dates corresponding 
to 6 July 2016 through to 9 July 2016. However, 9 July 2016 returns a 7 
because it is the last day of the week, a Saturday.

In your financial model, you may have to make some decisions based 
on the day of the week, and in such cases, the WEEKDAY function can be a 

Figure 6.42  The WEEKDAY Function Will Return the Day 
of the Week

Figure 6.41  The EOMONTH Function Calculates a Leap Year Correctly
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useful filter criterion. For example, trading or stock prices are not shown on 
the weekends, so you would skip those days for certain calculations.

Note

The complete syntax of the WEEKDAY function is =WEEKDAY(date,return type). The return 
type lets you decide the week cycle for your model. Here are the various options Excel offers 
you for the return type.

Value Series of Weekdays

1 Sunday (1) to Saturday (7)

2 Monday (1) to Sunday (7)

3 Monday (0) to Sunday (6)

Note

The input to this function must be a valid date in Excel. If the text is not in proper date format, 
you will get garbled output.

=YEAR  This function is used to identify the year in a specified date. If 
your model needs to use the year in the date for a particular calculation 
or analysis, this function can help you build the necessary logic. Note that 
the =YEAR function does not help if your fiscal year does not match the 
calendar year. For example, in Australia, the financial year ends at the end 
of June, so if you need to return a fiscal year (e.g., 2016/17), you need to 
create a table showing which dates fall in each financial year, and then use a 
formula such as a VLOOKUP function to return the value.

=MONTH  This is another very similar function that returns the month num-
ber in the date.

These functions are particularly useful for summarising and collating 
raw data. For example, we can use the MONTH function to identify the 
month, which can then be used as the criteria in a chart, PivotTable, or a 
SUMIF formula to summarise the raw data into the required format. In Fig-
ure 6.43, we have used a MONTH function in column B to automatically 
pick up the month number of the date. This has then been used as a range 
in a SUMIF function in column G to aggregate the data, which can be then 
shown on a column chart. You can create this sheet yourself or a template 
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Figure 6.43  The MONTH Function used to aggregate data

can be found, along with the accompanying models to the rest of the screen-
shots in this book, at www.plumsolutions.com.au/book.

NOTE

If using a PivotTable instead of a SUMIF function as shown in the example shown in 
Figure 6.43, you could use the Group feature in PivotTables to aggregate the months.

=DAY  This returns the day in the date. As evident, this is very similar to the 
MONTH and YEAR function. Note that this is different from the =WEEKDAY 
function, which will return the day of the week. =DAY will return the day of 
the month. For example, as shown in Figure 6.44, on 6 July 2016 the =DAY 
function will return a 6, rather than a 4 as shown previously when using the 
WEEKDAY function in Figure 6.42.

http://www.plumsolutions.com.au/book
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Note that for all the three functions, MONTH, YEAR, and DAY, the in-
put must be in a valid date format. Without proper input the desired results 
cannot be returned!

Date Format Dilemma

Two of the most popular standards used in the world today are the 
dd/mm/yy (U.K.) and the mm/dd/yy (U.S.) formats. Depending on the 
regional relevance of the information, the first two numbers could mean 
the month or the date. Your financial model must eliminate any such 
ambiguity, particularly if the model is working across several differ-
ent regions. It is therefore best practice to format date as 5‐June‐2017 
instead of 5/6/17. This way there is no chance of it being interpreted 
erroneously as 6 May 2017!

Long and Short Date Formatting  A shortcut exists on the Home tab that allows 
you to very quickly change the date format on any cell from the Number 
Ribbon, as shown in Figure 6.45.

Figure 6.44  Using a DAY Function to Return the Calendar 
Day of the Month

Tip
When you drag a series of dates in Excel, it will auto fill it for you. If you want to exclude 
the weekends in your financial model, Excel can do it automatically for you with the 
Auto Fill options. Select Fill Weekdays to exclude weekends. See Figure 6.46.
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In the drop‐down menu you should see both the options Short Date 
and Long Date. (Note that this may differ depending on your regional 
settings.) The samples for both are shown in the drop‐down itself for easy 
understanding. While you could use any format in your calculations, you 
can eliminate confusion by sticking to long date format for any information 
that requires user interaction.

The short and long dates are not the only formats that Excel provides; 
you can choose from a much wider range of formats by clicking on the 
dialog box launcher in the Number Ribbon, or by selecting More Number 
Formats shown at the bottom of the drop‐down menu in Figure 6.45.

This brings up the Format Cells dialog box, which you can use to change 
the way the date appears. In Excel for Mac 2011, the Format Cells dialog 
box can be found by selecting Format—Cells from the toolbar.

Note that in all versions of Excel, the Format Cells dialog box can be 
found by right‐clicking on the cell and selecting Format Cells.

See the section on “Custom Formatting” in Chapter 7 for greater detail 
on how to create different formats.

Figure 6.46  Select Fill Weekdays to Exclude Weekends from Autofill
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Financial Project Evaluation Functions

Financial functions are designed to save Excel users time when calculating 
long and complicated formulas such as interest repayments, depreciation, 
or net present values (NPVs). They can be created manually, and if you 
have studied business or finance at the university level, you will have had 
to create these calculations the long way or using a financial calculator. 
The predefined function in Excel saves time and makes it much easier to 
calculate commonly used financial calculations.

There are three financial functions that are commonly used to assess a 
business case or any series of cash flows: NPV, internal rate of return (IRR), 
and payback period. There are predefined functions in Excel for calculating 
NPV and IRR, but there is not one for payback period. For methods on 
how to calculate a payback manually, see the section on “How to Calculate 
a Payback Period” in Chapter 9.

Net Present Value

NPV is the value of the expected future cash flows from an investment, ex-
pressed in today’s dollars. The investor specifies a target rate of return (the cost 
of capital) for investing capital; it is an opportunity cost concept. Investors have 
the choice of investing in a project, or putting their funds elsewhere, so they de-
termine the hurdle rate, or the amount they want to get back from the project.

The general rule (and the one you would have studied in your university 
finance textbooks) for considering the investment is: If the NPV is greater than 
zero, the investment should be accepted; if the NPV is negative, it should be 
rejected. A positive NPV means the investor can expect to earn a rate of return 
greater than the required return rate for such an investment. However, from a fi-
nancial modelling perspective, the decision‐making process is much more com-
plicated than a deal‐or‐no‐deal situation. It really depends on the scenario and 
sensitivity analysis from the financial model to test whether or not the project 
should go ahead. Large companies often have policies regarding the standard 
cost of capital or how long the payback period can be before it is rejected.

What Cost of Capital Should We Use?  How much time is spent calculating the 
cost of capital really depends on how detailed your modelling is. Many 
models will simply use a nominated amount and document this as an 
assumption. This nominated cost of capital could be anything between, say, 
6 and 15 percent (although sometimes higher), and it can fluctuate depend-
ing on the perceived risk of the project. We may decide to use a very high 
required rate of return for a risky project to compensate for the risk taken.

However, instead of simply nominating a cost of capital amount, as 
we will do in the example in Figure 6.47, you may decide to calculate the 



Functions for Financial Modelling 175

weighted average cost of capital (WACC). This calculation takes into ac-
count the mixture and rates of debt and equity in the company, and is there-
fore a much more accurate way of evaluating the expected rate of return for 
a project. For greater detail on how to calculate the WACC, see the section 
on “Weighted Average Cost of Capital (WACC)” in Chapter   9  .    

 What Is Wrong with the npV Function?   Note that a key assumption of the NPV 
function is that the cash fl ows occur at the end of the period, whereas in 
reality they will probably occur unevenly throughout the year, with a large 
portion of costs spent closer to the beginning of the period. In the example 
shown below, we have included the initial investment in the fi rst year. If, 
however, we know that a large initial investment will be made prior to the 
start of the project, then this should be included in Year 0, and added to the 
NPV calculation like this:  =NPV(B4,B2:F2)+Y0_investment.        

    hoW to CaLCuLate the npV  

 With a series of cash fl ows as shown in Figure   6.47  , the NPV is calcu-
lated as follows. 

   1.  Select NPV function. At the Rate prompt, link it to the cost of 
capital, which we will assume is 12 percent. 

   2.  At the Value1 prompt, link the formula to the cells that con-
tain the expected return (i.e., as we are calculating the fi ve‐year 
NPV, it will be the profi t or loss for 2017 to 2021). The formula 
should be = NPV(B4,B2:F2) . 

   3.  The result of your formula should be $127,568.   

    FIgure   6.47    Using the NPV Function 

(continued)
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 Internal rate of return 

 IRR equates the present value of the cash infl ows and the present value of 
the cash outfl ows. The decision rule in this case is: If the IRR is greater than 
or equal to the investor’s required rate of return, the investment should be 
accepted; otherwise it should be rejected.  

 Comparing Irr with the risk Factor   Knowing about the IRR is of little use un-
less you can make decisions using it. To do that, you must compare the IRR 
with the risk factor. 

 There are two possible outcomes when you compare IRR with the risk. 

   1.  The projected returns from the investment are greater than the risk. In 
other words, the returns from the investment are high enough to justify 
the risk of the investment. This is a positive recommendation to invest. 

   2.  The projected returns from the investment are less than the risk. In oth-
er words, the returns from the investment are not high enough to justify 
the risk of the investment. This is a negative recommendation, caution-
ing against investment.   

 Like NPV, IRR uses all three criteria—returns, risk, and time—in its 
evaluation, and for this reason, many managers fi nd it an easy, accurate, and 
dependable tool to use.   

 using npV and Irr to Make Decisions   Just because the NPV is positive, and our 
IRR is greater than our required rate of return, does not necessarily mean 
that we should go ahead with the project! Blindly accepting the output of a 
model is a dangerous business. As we know, a model is only as good as the 
assumptions that go into it, and if we have included aggressively optimistic 
assumptions in our model, of course the NPV will look good—but this does 
not mean the project will do well! 

 All fi nancial models should be subjected to, at minimum, a base case, 
best case, and worst case scenario, which are used to evaluate the sensitivity 
of outputs to changes in inputs. The NPV, IRR, and payback period, which 

 In this case, the NPV is greater than zero, meaning that the return 
is greater than the required rate of return of 12 percent stated by the 
company. This means that, theoretically, the project should be accept-
ed. However, scenario and sensitivity analysis will help determine how 
sensitive the model is to changes in inputs and gain a better perspective 
on whether or not this project should be accepted. 
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are calculated by the model, should be used as decision‐making factors and 
not the ultimate deciding factors of the fate of the project.      

 the problem with Irr   There are a few issues with the IRR function that the 
modeller needs to be aware of. 

    hoW to CaLCuLate the Irr  

 Using the same investment assumptions as in the previous example, 
the rate of return on the initial investment can be calculated as follows: 

   1.  Select the IRR function. 

   2.  At the Values prompt, select or specify the cells that contain the 
requested information. 

   3.  Leave the Guess prompt blank at this stage. (See the section on 
“The Problem with IRR” for greater detail on when and why 
you need to include a guess.) In this instance all the cash fl ows 
are positive, so we don’t need to enter a guess. 

   4.  Click on the OK button and the yield (IRR) is displayed. The 
formula should be: = IRR(B2:F2) . 

   5.  The result of your formula should be 13.3 percent and look 
something like Figure   6.48   .   

 In this case, the IRR is higher than the required rate of return of 
12 percent, as stated by the company. This means that, theoretically, 
the project should be accepted. 

    FIgure   6.48    Using the IRR Function 
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Sometimes the IRR function in Excel can produce multiple results. Ev-
ery time the cash flows change sign (i.e., from negative to positive or from 
positive to negative), the formula will create another solution. This is why 
it is a good idea to insert a guess amount—especially if the sign of the cash 
flows is not consistent.

Take the following set of cash flows in Figure 6.49 as an example.
If we use the ordinary IRR function without using the guess [entered 

as =IRR(B2: H2)], we get a result of 13 percent. However, because there 
are several negative returns in this series of cash flows, there are mul-
tiple results. If you enter the following guesses, different IRRs will be 
returned:

■■ =IRR(B2:H2) gives a result of 13 percent.
■■ =IRR(B2:H2,0) gives a result of 6 percent.
■■ =IRR(B2:H2,30%) gives a result of 25 percent.
■■ =IRR(B2:H2,400%) gives a result of 481 percent.

Which one is correct? They all are! There are several valid IRRs. Excel 
goes through an iterative process and comes up with the first solution it 
finds, which does not necessarily give you the result you want. This is why 
it’s important to use the guess. If the guess is omitted, IRR is assumed to be 
10 percent because this is close to a usual rate of return.

Another issue with the IRR is that the way the IRR function calculates 
in Excel, it assumes that cash generated during the investment period will 
be reinvested at the rate that has been calculated by the IRR. If the project 
is generating a lot of cash, the IRR calculation can overstate the financial 
benefits substantially, which is something that needs to be considered, and 
possibly manually manipulated in the calculations.

We don’t normally make any changes to the calculations to account for 
these problems, but it’s important to be aware of these issues when calculat-
ing the IRR.

Figure 6.49  IRR Calculation with Multiple Results
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 What Difference Does an X Make? XnpV and XIrr 

 The NPV formula assumes that the values entered into the formula are an-
nual, are in chronological order, and occur at the end of the period 

 XNPV and XIRR are relatively new functions introduced for Excel 
2007 that offer more fl exibility, as you can specify exactly when the pay-
ments occur. 

 XNPV allows you to enter payments that occur at varying intervals, 
not necessarily in chronological order (although the fi rst payment must 
still be shown fi rst), and occur at any time. Therefore, it is a much more 
fl exible and useful function. Also, because it does not assume that the 
payments occur at the end of the period, the XNPV formula will be more 
accurate. 

 Be careful when comparing the NPV and XNPV functions, as the 
NPV assumes the current period (the date we are in right now) is a 
full year prior to the fi rst cash amount and therefore discounts the fi rst 
amount back by a full 12 percent (or whatever the nominated discount 
rate is). If this is not the case, you need to exclude the fi rst period from 
the function, and add it in separately, like this: = NPV(B4,B2:F2)+Y0_
investment . 

 The XNPV function, however, assumes that the current date is the date 
of the fi rst cash fl ow, so in the example above, the current date is assumed 
to be 1 June 2017. Therefore, the fi rst cash amount is not discounted at all. 
IRR and XIRR have the same issue. This is quite misleading, as most people 
naturally assume that the functions, being slight variations on the same for-
mula, work in a similar way, but the way they treat the fi rst cash amount is 
quite different!        

    hoW to CaLCuLate the npV usIng the XnpV FunCtIon  

 If you were to be more precise about the actual timings of the expected 
cash fl ow, you would get a more accurate NPV calculation using XNPV. 

 Instead of saying that you expect a net outfl ow of $3.2 million 
in 2017, let’s be a little more specifi c about when the outfl ows actu-
ally occur. Let’s say you split that into $2 million in June 2017, and 
the rest at the end of the year. We will also put a date in the middle 
of the year for subsequent years, which is more likely to accurately 
refl ect what will happen, instead of assuming that payments are 
made or received at the end of the period, as it does with the NPV 
calculation. 

(continued)
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 Figure   6.50    shows the cash fl ows. 

 Using the XNPV formula, and assuming that the cost of capital 
is, say, 12 percent, the formula should be  =XNPV(B4,B2:G2,B1:G1) , 
giving us a result of $190,828. 

 Similarly, the XIRR can be calculated using the formula = XIRR 
(B2:G2,B1:G1) , giving us a result of 13.8 percent. 

    FIgure   6.50    XNPV Function 

 Loan CaLCuLatIons 

 Calculating debt is an important part of many fi nancial models, and under-
standing the theory behind how loan repayments are calculated will help 
in fi nancial modelling. The way that interest, principal, and periodic pay-
ments are calculated can be complicated, and fortunately for us, Excel has 
many useful functions that make calculating loans a lot easier. However, 
you should still have a basic understanding of how loan calculations work.  

 Loan-Interest Calculation Method 

 Interest on loans can be calculated using either the simple interest method, 
or the compound interest method. The simple interest method charges the 
same amount of interest each year, but under the compound interest method, 
the interest is added to the loan, thereby increasing the loan amount each 
year. From the moment at which the interest is added to the loan, it charges 
interest on itself, increasing the interest on a compounding basis. The com-
pound interest method is by far the most commonly used method, and in 
the examples in this chapter we assume that the interest is compounding. 
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When evaluating a loan, you may also need to consider the compounding 
frequency. If the interest is added to the loan on a daily basis, this would 
actually make the loan interest payments much higher than if it were added 
monthly or annually. Most loans are normally calculated on a daily basis, 
and this means the interest rate actually charged is higher.

Note that the PMT function shown further on, if calculated on an an-
nual basis, does not compound the interest. You will need to convert the 
interest rate from a nominal or effective rate before using in the calculation.

Nominal and Effective Interest Rates

We are used to seeing interest rates expressed as an annual rate (e.g., an 
interest rate of 12 percent means that we are charged 12 percent per year). 
However, this is only the nominal rate, and this does not mean that we are 
charged 1 percent per month. In fact, if the interest is calculated daily, we are 
charged 12 percent divided by 365, or 0.33 percent on the first day of the 
loan. This amount is added to the principal, so on day two, we are actually 
paying interest on the interest from the previous day. I know this sounds 
trivial but it can make a big difference to your calculations on a large debt.

Tip
An easy way to work out the effective interest rate is to use the EFFECT function (avail-
able since Excel 2007) to calculate the effective rate of 12 percent, compounded daily. 
Use the formula =EFFECT(12%,365). The answer is 12.75 percent. See the section 
on “Understanding Nominal and Effective (Real) Rates” in Chapter 9 for greater detail 
on how to use this function as well as the NOMINAL function.

Loan Repayment According to an Amortisation Schedule

The most common form of calculating loan repayments is to apply an amorti-
sation schedule. Regular repayments of equal value made over the term of the 
loan are used to pay both the interest charged as well as a portion of the princi-
pal amount. With each repayment, an amount equal to the value of the interest 
charged for the period is applied first to the interest portion, and the remainder 
of the repayment is then set off against the principal. In this way, the principal 
decreases after each repayment and the interest calculated for the next period 
will therefore be less, as it is calculated on a smaller principal amount.

To calculate the amount of the equal repayments to be made, the inter-
est rate, the principal amount, and the term of the loan must be known. 
As interest rates are usually subject to change, the monthly repayment will 
often have to be revised during the course of the loan.



182� Using Excel for Business Analysis

If you need to calculate the repayments in long‐hand using the amorti-
sation method, the following formula is used:

Repayment
oan amount= × +
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where
i = the interest rate per annum, which must be divided by the 

number of repayment periods per annum (e.g., 12 if payments are 
made monthly).

n = the number of repayment periods (e.g., 24 if the loan is for a 
period of two years and repayments are made monthly).

Excel Amortisation Functions  Whilst it’s good to know the theory of how the 
repayments are calculated, fortunately Excel offers several loan calculation 
functions that can be easily included in financial models. The following are 
some of the most common functions available in Excel for loan‐related 
calculations.

PMT  This is the very basic function that calculates the fixed amount you 
need to pay at regular intervals to repay the loan along with fixed interest. 
This is the syntax for using the PMT function: PMT (rate, number of pay-
ments, principal amount, final amount, type). In this syntax, the following 
applies:

■■ Rate: This is the fixed interest rate for the loan period.
■■ Number of repayments: This is the number of instalments within which 
you want to repay the loan.

■■ Principal amount: Amount of original loan (no interest included).
■■ Final amount: The total amount at the end of all the instalments. This is 
not a mandatory field and the default value is set to zero.

■■ Type: This determines when the payment needs to be made. The default 
value is zero, which means at the end of the period; one means at the 
start of the period.

In Figure 6.51, we have a loan of $1 million repaid over a 10‐year 
period (annually) at an 8 percent interest rate. You can create this sheet 
yourself or a template can be found, along with the accompanying mod-
els to the rest of the screenshots in this book, at www.plumsolutions.com 
.au/book.

In cell B11, the PMT function can calculate the fixed payment amount 
payable each year, which in this case is $149,029. The function wizard 
should look like Figure 6.52.

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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Figure 6.51  Loan Template

Figure 6.52  PMT Function Wizard

IPMT  The IPMT function is complementary to the PMT function. While 
PMT calculates the entire repayment instalment amount, IPMT gives the 
interest component of the instalment. Like the PMT, this is calculated for 
fixed principal and interest rate for a given duration of time. The syntax for 
IPMT is IPMT (rate, period, number of payments, principal amount, final 
amount, type), where the following applies:

■■ Rate: This is the fixed interest rate for the loan period.
■■ Period: This is the period for which the interest amount needs to be 
calculated. For the first period (week, month, year, etc.) this would be 1, 
and for subsequent periods it will increase as 2, 3, 4, and so on.
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■■ Number of repayments: This is the number of instalments within which 
you want to repay the loan.

■■ Principal amount: Amount of original loan (no interest included).
■■ Final amount: The total amount at the end of all the instalments. This is 
not a mandatory field and the default value is set to zero.

■■ Type: This determines when the payment needs to be made. The default 
value is zero, which means at the end of the period; one means at the 
start of the period.

In Figure 6.53, C10 represents the period that changes in the formula, 
while all other parameters are fixed references to the loan amount.

PPMT  This is another complementary function to the PMT function. PPMT 
is similar to the IPMT, but it returns the other component of the instalment: 
principal amount.

The syntax for PPMT is PPMT(rate, period, number of payments, prin-
cipal amount, final amount, type). In this syntax, the following applies:

■■ Rate: This is the fixed interest rate for the loan period.
■■ Period: This is the period for which the interest amount needs to be 
calculated. For the first period (week, month, year, etc.) this would be 1, 
and for subsequent periods it will increase as 2, 3, 4, and so on.

Figure 6.53  IPMT Function



Functions for Financial Modelling� 185

■■ Number of repayments: This is the number of instalments within which 
you want to repay the loan.

■■ Principal amount: Amount of original loan (no interest included).
■■ Final amount: The total amount at the end of all the instalments. This is 
not a mandatory field and the default value is set to zero.

■■ Type: This determines when the payment needs to be made. The default 
value is zero, which means at the end of the period; one means at the 
start of the period.

In Figure 6.52, C10 again represents the period that changes in the for-
mula, while all other parameters are fixed references to the loan amount. All 
three completed functions can be seen in Figure 6.54.

Figure 6.54  Loan with Completed PMT, IPMT, and PPMT Functions

Tip
If you want to verify your calculations, always remember that the sum of IPMT and 
PPMT must equal PMT. This is a great opportunity to enter an error check!

Why Does the Interest Amount Decrease on a  
Fixed Interest Rate?

When using an amortisation schedule for loan‐repayment calculations, the 
initial interest amounts are high, but with each period the interest amount 
goes down and the principal amount increases. This is reflected in Figure 6.55, 
which is a stacked column chart based on the results in Figure 6.54.

Looking at the graph, the calculations may initially seem incorrect since 
the interest rate is constant but the interest amount is decreasing. This can 
be better understood by delving into the actual amounts. The original prin-
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cipal amount was one million dollars and the interest was calculated on this 
principal amount as $80,000. The rest of the instalment ($69,029) went 
toward repaying the principal.

In the second year, the principal amount was reduced by the first instalment 
($69,029 went toward the principal). This means the new principal is $1 million 
less the first instalment, which is $930,971. Due to reduced principal amount, 
the net interest amount is reduced. However, to maintain the constant instal-
ment amount, the principal amount is increased. Extrapolating this calculation, 
it is evident that as the period number increases, the unpaid principal amount 
decreases, and so does the interest amount. However, the principal amount be-
ing repaid increases to maintain constant repayment instalments.

Summary

In this chapter we have covered a few of the important aggregation, lookup, 
referencing, date, and finance functions that, at minimum, are important for a 
financial modeller to know. As we know, however, there is a lot more to being 
a good financial modeller than knowing hundreds of different Excel functions! 
The most challenging part is to know when to use these functions in your mod-
elling. When faced with a problem, creating a modelling solution that contains 
the most appropriate tools and functions is the task faced by the financial mod-
eller. Usually, there are several different possible tools that can be used, and the 
one that is the most concise, yet easiest to follow will be the best solution.

Figure 6.55  Principal (PPMT) and Interest (IPMT) Components of Loan Re-
payments over 10 Years
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Chapter 7
Tools for Model Display

Leaving aside the formulas and calculations of a model, in this chapter we 
will focus on the look and feel of a model. There are many Excel tools 

that can be used to make the model more attractive and friendly to the user. 
We’ll look at the basic formatting, and then more complex custom format-
ting, conditional formatting, and then form controls, which can be built to 
help the user interact with the model more easily.

Basic Formatting

Believe it or not, as simple as it may sound, good formatting is an important 
part of building a financial model. While it’s critical of course to get the 
numbers right, making your model look good is the next step! A model that 
is well formatted will be more readable, user‐friendly, and easy to navigate. 
Additionally, you, the modeller, will find it easier to work with the model if 
it is clearly formatted.

In the latest version of Excel, all the formatting options for colour, font, 
and alignment are clearly displayed on the Home tab. A shortcut exists on 
the Home tab where you can very quickly change the number format on any 
cell from the Number Ribbon, as shown in Figure 7.1.

For detailed instructions on the more basic formatting tools, includ-
ing changing number formats, percentage and currency formatting, number 
alignment, cell attributes, and styles, please see the supplementary material at  
www.wiley.com/go/steinfairhurstrevised, available for download in PDF format.

Custom Formatting

We can go one step further with our formatting to customise the way data 
is displayed in cells without changing the underlying data. For instance, the 
function =NOW() gets the current date and time from your computer and, 

http://www.wiley.com/go/steinfairhurstrevised
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by default, displays it in the format “dd/mm/yyyy hh:mm” (or according to 
the date conventions in your computer’s Regional and Language Options 
within Control Panel).

We can change the look of this date without disturbing its intrinsic 
value by formatting it differently. Let’s have a look at how we’d do this:

	 1.	Open a blank spreadsheet and type into cell A1 Report as at, and into 
cell B1 type the function =NOW() or =TODAY() as shown in Figure 7.2.

	 2.	Size the column widths to match the data, then select cell B1 for formatting.
	 3.	Choose the formatting drop‐down in the Home tab on the Ribbon as 

shown in Figure 7.4. Select More Number Formats at the bottom of the 
drop‐down list that appears.

In Excel for Mac 2011, from the Format menu, select Cells.
The dialog box in Figure 7.3 appears, showing how Excel has al-

ready customised the cell.
As can be seen from the dialog box, there are many preset format-

ting options for numbers, from General to Accounting to Custom. As 
suggested within the dialog box, we can type our own codes over preset 
ones if the format we want isn’t available.

	 4.	To create a customised format, select Custom from the Category list. 
Overwrite Excel’s choice of “dd/mm/yyyy hh:mm” with just the three 
characters “mmm” and observe what Excel does with your date. Add 
a further “m” to make our custom formatting “mmmm” and the result 
will be, after reflection, obvious.

	 5.	Custom format your current date to the following format: 24 Feb 2017 
(your date will be different in content).

Figure 7.2  Showing the Current Date and Time Using 
the =NOW() Function

Figure 7.1  Formatting in the Ribbon
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The Ribbon has an additional shortcut to preset formats in the Number 
section of the Home tab, as seen in Figure 7.4.

Excel for Mac 2011 has the most commonly used formats preset on the 
Formatting toolbar in the numbers section; namely currency, percent, thou-
sands separator, and decimal places, but dates are not there. You’ll need to 
use the Format Cells dialog box to format cells to dates.

Custom Currency Symbols

As mentioned earlier, changing the look of a cell doesn’t affect the underly-
ing data. So far we’ve played with dates (which are numbers to Excel even 

Tip
In all Windows Excel versions, the shortcut key Control+1 will invoke the formatting 
dialog box as seen in step 3, above. For Excel for Mac 2011, press Command+1.

Figure 7.3  Format Cells Dialog Box
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though they’re generally displayed as text), but there are plenty of other 
preset number formats that we can, if necessary, customise in four steps.

	 1.	Go to a blank sheet, and type in 582504 into a cell. If you have not de-
fined any formatting on that cell yet, Excel will assign a General format 
to it.

	 2.	Change the number to currency preceded by your country’s monetary 
symbol, by using the Currency category in the Format Cells dialog box.

	 3.	Change the currency symbol to that of the Japanese Yen, or some other 
commonly used currency.

	 4.	Change the currency symbol to that of a currency we’ve made up—
Elbonian Spree (EL).

As you might have suspected, the Elbonian Spree isn’t available in the 
list of symbols. We’ll have to build a custom format for it.

Select the Custom category and overwrite Excel’s ¥ symbol with EL, 
as follows: [$¥‐804]#,##0 is changed to "EL" #,##0.

Note that EL, as invented by us, is probably unknown to your ver-
sion of Excel and therefore must be presented as a string (i.e., in quotes). 
This custom currency symbol will be saved with the workbook and will 
be available for future use.

Understanding Excel’s Number Formats  Number formats have four elements:

	 1.	Positive number
	 2.	Negative number
	 3.	Zero
	 4.	Text

Each is separated by a semicolon. None of them are mandatory but 
there should be a positive element, at least.

Consider the elements in the format $ * #,##0; [Red]$ * ‐#,##0; $ * "4";"*"

Positive Negative Zero Text

Format $ * #,##0 ; [Red]$ * #,##0 ; $ * "4" ; "*"

Value 1000.00 100.00 0.00 Jack

Representation $ 1,000 $ 100 $ *

Leading zeros of both positive and negative numbers will be sup-
pressed wherever # is specified. Negatives will show the minus symbol 
after $ and zeros will display. The text Jack will be represented as a 
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single asterisk. The monetary symbol asterisks ($ *) indicate that the 
symbol must be fixed to the left and not follow the number as it shrinks 
or expands.

You’ll note that Excel sometimes uses codes, particularly in currency 
formats. These are used, for instance, in differentiating between Australian 
and U.S. dollars—and we know that specifying currency units is important 
for financial modelling best practice!

The important thing to remember is that the underlying number doesn’t 
change no matter how we format it. It retains its decimal places even if we 
can’t see them. Arithmetic can continue to be done on a cell’s contents, even 
if it’s invisible.

Useful Formatting Options

If you intentionally leave an element blank, it will be rendered invisible. 
;$#,##0.00;; will show negatives only, all the other elements being deliber-
ately suppressed. The entry;;; will make everything in the cell invisible (so 
will changing the font colour to match the background).

To display a number as 000s, while still retaining its full value, custom 
format it as $#,##0, (the format followed by a comma). Millions are repre-
sented by $#,##0,, "m." $458,243,555.42 will display as $458m, which, if 
multiplied by one, will return $458,243,555.42. If this does not work, your 
digit grouping symbols within Regional and Language Options in the Con-
trol Panel are not set as commas.

To physically change a number to rounded thousands use the 
ROUND, ROUNDUP, or ROUNDDOWN functions, employing minus 
digits. ROUND(458243,‐3) will change the number to $458,000. The for-
mat $#,##0, will display $458, which, if multiplied by one, will return 
$458,000.

To make currency negatives by default show in parentheses, change 
your negative Currency Format options within Regional and Language Op-
tions in the Control Panel to default to parentheses.

Custom Formatting in Reporting

Let’s say you have a report similar to the one shown in Figure 7.5. You 
can create this sheet yourself or a template can be found, along with 
the accompanying models to the rest of the screenshots in this book, at  
www.plumsolutions.com.au/book.

We are going to format the numbers in the following two steps so 
that they look similar to Figure 7.6 (without changing the underlying 
data):

http://www.plumsolutions.com.au/book
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	 1.	Highlight the data and, as described above, go to the Custom Format-
ting dialog box.

	 2.	Add a comma to the end of the format type as shown in Figure 7.6.

This will change the look of the numbers without changing the value 
of the numbers at all. We can see in the formula bar in Figure 7.6 that the 
underlying value of cell B4 is 582,504, but because of the custom formatting 
we have used, the cell shows the value 583.

Next, add up the visible values of the cells B4:B8 manually like this: 
=583+236+151+0+642. You’ll see that the total should be $1,612, not 
$1,611! Use the =ROUND function, as shown in Figure 7.7, to round the 
numbers to the nearest thousand, such that your report or PowerPoint slide 
is correct. Change the formatting back to show the additional zeros if you 
wish. Your formula should be =ROUND(B4,‐3). Normally, the ROUND 
function is used to remove decimal place, but in this case, it has been used 
to remove precision in reporting.

Conditional Formatting

Conditional Formatting is a tool that allows you to apply formats to a cell 
or range of cells, and have that formatting change, depending on the value 
of the cell or the value of a formula. For example, you can have a cell appear 
bold only when the value of the cell is greater than 100. When the value of 
the cell meets the format condition, the format you select is applied to the 

Figure 7.5  Sample Report
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cell. If the value of the cell does not meet the format condition, the cell’s 
default formatting is used.

This is handy for variance analysis on a profit and loss (P&L), for ex-
ample. If you want to highlight any instance where a variance is greater than 
10 percent higher than budget, the cell will turn red.

Remember that Conditional Formatting is the same as adding one or 
more formulas to each cell in which you use it, so applying Conditional 
Formatting to a large number of cells may cause performance degradations. 
Use caution when applying to large ranges!

Conditional Formatting was greatly improved with the introduction of 
Excel 2007. There are many more options (including the handy Data Bars), 
and the limitation of three conditions was lifted.

To Apply Conditional Formatting

	 1.	Select the desired cell or cells in the spreadsheet. Let’s say, for example, 
you wanted to highlight with a red font any cell value that is between 1 
and 10.

	 2.	On the Home tab, in the Styles group, select Conditional Formatting. 
Select Highlight Cells Rule and then Between. Type in 1 and 10, and 
define the desired font colour. See Figure 7.8.

Add a new rule for each new condition; you can have as many as you 
like (unlike in the old Excel 2003, where you were limited to three rules).

Figure 7.7  Using the ROUND Function to Truncate Values
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To Remove Conditional Formatting

On the Home tab, in the Styles group, select Conditional Formatting. Select 
Manage Rules, and you can delete your chosen rules one by one. Alternatively, 
you can clear rules from selected cells or from the entire sheet by clicking on 
Clear Rules.

Data Bars

Data bars are a new feature that was introduced in Excel 2007. Data bars 
are dynamic bar charts that you can apply to any numerical data in Excel. 
They graphically show the relative size of each value. See Figure 7.9. You 
can create your own examples or a template can be found, along with the 
accompanying models to the rest of the screenshots in this book, at www 
.plumsolutions.com.au/book.

Go to a table of numeric data, and highlight the numbers in the follow-
ing three steps.

Figure 7.8  Applying Conditional Formatting

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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	 1.	On the Home tab, in the Styles group, select Conditional Formatting, 
and then Data Bars.

	 2.	Choose your desired bar.
	 3.	Practice changing the underlying numbers, and see the bars change.

Icon Sets and Colour Scales

Icon Sets are a feature that was also introduced in Excel 2007. They allow 
you to conditionally display a small icon that represents changes in data. 
For example, if revenues are down this month compared to last, you may 
choose to represent this with a red arrow pointing down, or if your cash bal-
ance is above a certain threshold, you could use a green checkmark to give 
the user a quick way to see that everything is okay.

Your options for icons are shown in Figure 7.10, and these are extreme-
ly useful in Dashboards and other reports.

Figure 7.9  Applying Data Bars

Tip
While the traffic lights are popular choices for icon sets in dashboards and reporting, the 
round shapes are not very informative when the report is printed in black and white, nor 
are they useful for those afflicted by the commonest form of colour blindness. Consider 
using the up-down arrows, or the checkmarks and crosses instead of the traffic lights.

Another handy feature that was introduced in Excel 2007 is colour 
scales. Looking at Figure 7.11, how would you be able to quickly assess 
what is good, bad, and in‐between?
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Figure 7.10  Accessing Icon Sets

Figure 7.11  Sample Report without Formatting
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By using colour scales, you can assign rules for what is good, bad, and 
in‐between, and display the data with colour to represent these rules. You 
can see in Figure 7.12 how data is more useful when the user can quickly 
spot areas of concern.

Enhancements to Conditional Formatting

When using the later versions of Excel, you have access to more icon sets, 
including triangles, stars, and boxes. You can also more easily hide icons 
from view, as is evident in Figure 7.13. Editing the rule gives you a variety 

Figure 7.12  Sample Report Using Colour Scales

Figure 7.13  Edit Formatting Rule to Hide Icons
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of options, such as hiding certain icons, or even hiding the numbers and 
showing the icon only.

Being able to hide the icons is a new feature applicable to Excel 2010 or 
later and Excel for Mac 2011 only.

You can also easily mix and match data bars, colour scales, and icons 
from different sets. In Figure 7.14 the same range has both data bars and 
icons.

The automatic negative bars as shown in Figure 7.14 are a new feature, 
available in Excel 2010 or later and Excel for Mac 2011 only.

In Excel 2010 or later and Excel for Mac 2011, you can also create 
conditional formatting with references to a different sheet in the workbook. 
This means that you no longer need to copy or link your data to the same 
sheet when using conditional formatting.

Sparklines

Just like Conditional Formatting and the Icon Sets, Excel also has another 
interesting micro‐charting feature termed the sparkline. These lines are not 
as descriptive as regular graphs and charts, but they are very effective in 
displaying a quick view about the trends in the data or metrics. This new 
feature was introduced in Excel 2010, so it is an enhancement over the older 
versions. Note that sparklines can only be created and viewed in Excel 2010 

Figure 7.14  Applying Multiple Types of Conditional Formatting to a Single Cell
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or later, so if your model is viewed in Excel 2007 or earlier, the sparklines 
will disappear. This is one of the few instances where Excel 2007 and 2010 
differ in functionality.        

    hoW to Create a sparkLine    

   1.  Select the data series for which the sparkline needs to be created 
as shown in Figure   7.15   . You can create your own examples or a 
template can be found, along with the accompanying models to 
the rest of the screenshots in this book, at  www.plumsolutions
.com.au/book . 

   2.  Under the Insert tab in the Sparklines group, select Line. Note 
that sparklines are found in the Charts Ribbon under Insert 
Sparklines in Excel for Mac 2011. The sparklines group has 
been highlighted in Figure   7.15  . 

   3.  In the Create Sparklines dialog box, the data range is automati-
cally selected, so enter the cell or cell range in which you want 
the sparklines to be placed and click OK. See Figure   7.16   . 

    Figure   7.15    Choosing Sparklines from the Ribbon 

    Figure   7.16    Sparklines Dialog Box 

(continued)

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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 editing sparklines 

 The attributes of the sparklines can be modifi ed from options under the 
Design tab. To edit data, select the sparklines and click on the Edit Data in 
Sparkline Ribbon under the Design tab. See Figure   7.18   .  

 This will open the Edit Sparklines dialog box, where you can change the 
data range as well as the sparkline location. See Figure   7.19   .  

 To edit chart type, select the sparklines and click on one of the three 
options in the Type group under the Design tab. 

 The three options are: 

   1.  Line chart (as shown previously) 
   2.  Column chart 
   3.  Win/Loss: Maps the data in a win/loss format   

   4.   The sparklines are drawn in the selected cells. See Figure   7.17   . 

 Note that it is good practice to draw a grey border as shown in 
Figure   7.17   around the sparkline, to give the line a better perspective.    

    Figure   7.17    Completed Report with Sparklines 

    Figure   7.18    Editing Sparklines 
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To highlight important data points, such as high point or low point, 
select from a series of check boxes in the Show group, under the Design tab. 
You can also edit the style of the sparklines by changing the line colours and 
marker colours.

Figure 7.19  Edit Sparklines Dialog Box

Tip
In the previous example, the column chart could have been chosen instead of the line 
for a different effect. If you have negative as well as positive numbers, then try the win/
loss sparkline. Try out different types of sparklines to see which looks best with your 
data. Use a combination of sparklines and icons to create more meaningful representa-
tions of data points.

Tip
If you want to create a series of sparklines for a series of data points, you can create it 
for the first series and just copy and paste, or drag the sparkline to automatically create 
it for the rest of the series of data.

Changing Properties for a Group of Sparklines

While each sparkline represents a unique series of data, you can edit the proper-
ties of a group of sparklines using the group and ungroup features. When the 
sparklines are grouped, you can edit the properties for the entire group, even if 
you select just a single line from the group. To separate out the sparklines in the 
group, select Ungroup in the Group Ribbon under the Design tab.
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Bulletproofing Your Model

If your model is publicly available, or if you have a lot of users entering data 
into it (especially if their Excel skills are questionable), it’s a good idea to 
spend some time protecting it and making sure that all your hard work is 
not inadvertently corrupted!

Protection

Once you have completed building your model, there are three basic layers 
of protection you can include:

	 1.	Protect the file so that no one can open it without the password.
	 2.	Protect the structure of the workbook so that no structural changes 

can be made (normally used for hiding sheets and restricting access to 
them).

	 3.	Unlock individual cells on the worksheet and then protect the sheet so 
that only those cells that are unlocked can be changed.

Protecting the structure or worksheets can be done with or without a 
password. Passwords are case‐sensitive.

Warning

Bear in mind that passwords can be hacked reasonably easily. There 
are programs that can decode a password. (Try typing “crack Excel 
password” into Google sometime.) If your file contains highly sensitive 
information, do not rely on passwords in Excel. Password protection is 
intended to be a deterrent, not a definitive solution.

Protect the File

This is done by changing the options, and saving over the existing copy of 
the file. There are two options with this: protecting the file with a password, 
or recommending read‐only access.

Password-Protect a File  If you don’t want anyone to be able to open your file 
without a password, or make changes without a password, this is done under 
General Options. You can select Password to Open or Password to Modify.

This is recommended if you are e‐mailing a confidential file and are con-
cerned that it might be intercepted or viewed by the wrong person!
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 read-only recommended   Instead of using a password to prevent access, you 
could use the read‐only option to deter users from changing your workbooks. 
This way you prevent inadvertent changes to models.          

    hoW to passWorD-proteCt a FiLe    

   1.  Click on the File menu in the top left‐hand corner of your screen 
and select Save As. 

   2.  Click on the Tools button and select General Options. 

   3.  Enter the password and save over the fi le.   

    hoW to enaBLe reaD-onLY    

   1.  Follow the instructions as above (“How to Password‐Protect a 
File”). 

   2.  Instead of typing a password, check the Read‐Only Recom-
mended check box.   

 protect the structure 

 The most common use of protecting the structure is to protect hidden sheets, 
but it also stops users from adding or deleting sheets, or changing other 
structural aspects of your model, but not from editing cell contents. If you 
want to stop users from entering data or changing values in cells, you need 
to protect the worksheet.  

 protecting hidden sheets   If you have a sheet containing sensitive data, you can 
hide the entire sheet, and then protect the workbook so that the sheet cannot be 
viewed. This is particularly handy if, for example, you have salary data on a sheet 
in a budget model and don’t want all users to have access to the information.    

 protect the Worksheet 

 This is the most commonly used form of protection. If you have created a 
spreadsheet that you do not want to be altered by the others who might 
view it, you can protect the sheet. You can either protect the whole sheet, or 
just certain key cells in the sheet (probably those containing the formulas) so 
that new data can still be entered onto the sheet. 
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      Note  

 if the sheet has been protected it sometimes is not possible to adjust column width. This can 
be very frustrating for the user, so make sure your columns are the correct width!          

    hoW to proteCt a Worksheet    

   1.  Go to the sheet you wish to protect. 

   2.  On the Review tab, in the Changes group, select Protect Sheet. 
In Excel for Mac 2011, on the Review tab, in the Protection 
group, select Sheet. 

   3.  This will bring up the Protect Sheet dialog box, in which you 
can enter a password to prevent users from unprotecting the 
sheet. You do not have to use a password; you can just leave the 
Password box empty, and this may be enough of a deterrent to 
prevent users from modifying your model. 

   4.  Enter a password (if desired) and click OK. 

   5.  If you have entered a password, you will be asked to confi rm the 
password. 

   6.  Type the password again. 

   7.  The whole sheet is now protected. Users will not be able to 
change the contents of any cell. If you need to change cell con-
tents, you will need to unprotect the sheet.   

    hoW to proteCt hiDDen sheets    

   1.  Put all sensitive information on one sheet. 

   2.  Hide the sheet. Right‐click on the sheet tab name and select Hide. 

   3.  Now protect the structure of the workbook so that users can-
not unhide sheets. On the Review tab, in the Changes group, se-
lect Protect Workbook and then Protect Structure and Windows 
from the drop‐down box. In Excel for Mac 2011, on the Review 
tab, in the Protection group, select Workbook and then check the 
Protect Structure and Protect Windows boxes on the dialog. 

   4.  If you enter a password, users will need a password in order to 
view the sheet(s) you have hidden.   
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 protect Data by Locking Cells   By following the process outlined above to pro-
tect the worksheet, you will fi nd that you won’t be able to make any changes 
at all to any cell! If you want to allow entry into certain cells, but leave part 
of the sheet protected (perhaps the cells containing formulas), you’ll need to 
unlock those cells to be edited fi rst, before protecting the sheet. Make sure 
you turn off your protection before unlocking cells! 

 By default, every cell in a sheet has a lock applied to it. It is the lock that 
is activated when the sheet is protected and stops people from editing cells. 
You need to unlock those cells that should be changed.           

    hoW to unproteCt a Worksheet    

   1.  Select the tab name of the sheet you wish to unprotect. 

   2.   On the Review tab, in the Changes group, select Unprotect Sheet. 

 In Excel for Mac 2011, on the Review tab, in the Protection 
group, select Sheet.  

   3.  If no password was originally used to protect the sheet, then the 
sheet will automatically be unprotected at this point. 

   4.  If a password has been used, the Unprotect Sheet dialog box will 
appear. Enter the password and click OK.   

    hoW to LoCk or unLoCk speCiFiC CeLLs  

 You will need to have sheet protection turned off before you do this. 
These instructions are the same in all versions of Excel. 

   1.  Select the cells you wish to change. 

   2.  Right‐click and select Format Cells to bring up the Format Cells 
dialog box. 

   3.  Then select the Protection tab. 

   4.  Turn off Locked if you want users to be able to edit the selected 
cells once the sheet has been protected. 

   5.  The Hidden option is used to stop users from viewing the for-
mulas of the selected cells in the Formula Bar (once the sheet 
has been protected). 

   6.  Click OK. Now when you protect the sheet, cells that are no 
longer locked will be editable.   



208� Using Excel for Business Analysis

Customising the Display Settings

The following is an example of a model that’s been very highly protected, 
and the display settings have been changed so that it almost does not even 
look like an Excel file. You can download a copy of this file called “Repay-
ment Comparison Calculator” from www.plumsolutions.com.au/book and 
if you would like to unprotect it, use the password plumsolutions. You will 
need to unprotect the sheet as well as the file structure, and how to do this 
is outlined in this section.

To make your model highly protected, like the model in Figure 7.20, 
you may choose to change a few settings to make your model look less like 
an Excel sheet, and more difficult for the user to change.

Useful Display Settings

Display settings can be changed by clicking on the File tab in the top left‐
hand corner, and then selecting Options. On the Advanced tab, there are 
a number of useful settings that can be edited to make your model more 
“bulletproof”:

■■ Hide row and column headings by unselecting Show Row and Column 
Headers

■■ Remove sheet tabs by unselecting the Show Sheet Tabs box
■■ Disable the scroll bars by unselecting the Show Vertical and Horizontal 
Scroll Bars

■■ Hide the formula bar by unselecting Show Formula bar

Figure 7.20  Model with Customised Display Settings

http://www.plumsolutions.com.au/book
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In Excel for Mac 2011, these options can be found under Excel, then 
Preferences and under View, in the Window Options section.

Minimising the Ribbon

Again, the instructions here differ slightly between Excel 2007 and later ver-
sions of Excel. Note that this only changes the view in your Excel on your 
computer; it does not change the model. Hence if colleagues open up the 
same model and their Excel settings have the Ribbon maximized, they will 
see the whole Ribbon.

To minimise the Ribbon, go to the top right‐hand corner of your screen 
and click on the little icon as shown in Figure 7.21, and select Auto-hide 
Ribbon, or Show Tabs from the menu.

If you are using Excel 2007, go to the Customise Quick Access Toolbar 
button in the top left‐hand corner of your screen, and select Minimise the 
Ribbon from the menu.

Tip
You can also minimise or maximise the Ribbon by simply pressing Control+F1 (Option+ 
Command+R in Excel for Mac 2011).

Figure 7.21  Minimising the Ribbon

Restrict the Work Area

You can also make the work area of the sheet much smaller so that users 
cannot enter data in cells you don’t intend them to. See Figure 7.22.

To restrict the work area, it is exactly the same in all versions of Excel:

	 1.	Highlight the first column you don’t want to see (for example, column 
F) and press Control+Shift+Right Arrow (Command+Shift+Right 
Arrow in Excel for Mac 2011). Now right‐click and select Hide.

	 2.	Highlight the first row you don’t want to see (for example, row 6) and 
press Control+Shift+Down Arrow (Command+Shift+Down Arrow in 
Excel for Mac 2011). Now right‐click and select Hide.
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To unhide, highlight column E and then click drag the cursor across 
to where column F would be. Let go of the mouse button, and move 
the cursor back to column E. Right‐hand click, and then select Unhide. 
Unhiding the rows works in exactly the same way.

Restricting Incorrect Data Entry with Data Validations

Usually we are building models for others to use, and they might not 
have the same level of Excel skill as we do. Users often have a knack for 
finding strange and wonderful methods of entering data in the wrong 
format, which can mess up your formulas. They might enter text where 
the model requires numbers, or spell names in a different way to what the 
criteria in a VLOOKUP are expecting, for example. If unsure of a number 
they sometimes write TBA (for to be advised), or if the value is a range, 
they might enter 5–10%. They don’t realise that the model must have a 
numeric value to calculate properly, and so they need to choose between 
5 and 10 percent or enter the average of 7.5 percent! Using data valida-
tion will allow you to control the data that is typed into your model, and 
avoid errors.

Every cell will allow any value at all. Therefore, you can enter any type 
of data, of nearly any length (up to several thousand characters) into any 
cell. You can use the data validation feature to restrict the values users enter 
into cells in the model.

Figure 7.22  A Worksheet with Restricted Work Area
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 Data validations take protection one step further: Instead of restricting 
where  data can be entered, they can also restrict  what  can be entered into 
the cell. 

 Once users enter a wrong value, they have to either enter the right value, 
or hit the Esc (escape) key to get out of the error message. Hitting Esc will 
clear the entry in the cell they are trying to enter data into. 

 There are a couple of handy little tools you can add into the data valida-
tion while you are here. You can enter in‐cell comments on the Input Mes-
sages, as shown in Figure   7.23   . Some text will pop up to help users or give 
them important information whenever the cell is selected.  

 See the section on “Methods and Tools of Assumptions Documenta-
tion” in Chapter   3   for more information on how to create the data valida-
tion comment shown in Figure   7.23  .    

    Figure   7.23    Data Validation Comment 

    hoW to appLY Data VaLiDations    

   1.  We’d like to restrict a cell’s entries so that is will allow only 
values between 1 and 10. 

   2.  Select your input cell(s) (either select a single cell or highlight a 
whole range). 

   3.  On the Data tab, from the Data Tools group, click on the Data 
Validation button. 

   4.  Choose Whole Number under the Allow drop‐down. 

   5.  Leave the Between option as it is, and enter the values 1 and 10 
under the Minimum and Maximum value fi elds and click OK.   
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In the data‐validation dialog box, you can also enter your own, cus-
tomised error message on the Error Alert tab as shown in Figure 7.24. This 
message will be shown if users enter invalid data. Resist the temptation to 
write something silly (or rude!). Now try entering incorrect data, and your 
error message will pop up as shown in Figure 7.25.

Note that you can control how vigilant the data‐validation restrictions 
on your model will be. One day your department may have grown and it 
suddenly really is valid to have more than 500 staff. If you change the op-
tions on the Error Alert tab to Warning instead of Stop, then the message 
will alert users and discourage them from entering staff number 501, but it 
will allow it, if necessary. The error message will then prompt users that the 
restriction should be changed. The users can choose Yes to allow the entry 
of 501.

If you change the options on the Error Alert tab to Information instead, 
users are alerted that they entered an unexpected value, but the message 
defaults to OK and allows them to keep the value that they entered.

Figure 7.24  Creating a Customised Error Message
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Using Validations to Create a Drop-Down List

Instead of specifying a range, you can be more specific and only allow cer-
tain predefined entries. This is how we can create drop‐down lists with data 
validations.

	 1.	First, create a list of valid regions, such as the list below:
United Kingdom

Germany

India

Australasia

France

United States

	 2.	Select the cell that should contain the drop‐down list.
	 3.	Bring up the Data Validation box:

■■ On the Data tab from the Data Tools group, click on the Data Valida-
tion button.

■■ In Excel for Mac 2011, on the Data tab from the Tools group, click 
on the Validate button.

	 4.	In the Allow section, change Any Value to List, as shown in Figure 7.26.
	 5.	In the Source field, enter the range that contains the data you want 

to appear in the drop‐down list. Leave In‐cell Dropdown selected. See 
Figure 7.27.

	 6.	Any time that the cell is selected, a drop‐down arrow will appear and 
users will be able to select from the list. See Figure 7.28.

If users try to enter data that is not on the list, an error alert will appear. 
Also, if you change the source data, the drop‐down options will also change. 
Practice this; try changing United Kingdom to Britain. You’ll see that Britain 
now appears on the list instead of United Kingdom.

Figure 7.25  Customised Pop‐up Error Message



214� Using Excel for Business Analysis

Figure 7.26  Creating a Drop‐Down List

Figure 7.27  Enter the Source Data Range
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Be aware, however, that it is possible to paste values over a restricted 
cell! You may have spent a long time protecting and setting up your work-
sheet so that users cannot enter incorrect data; however, it is very easy for 
users to inadvertently (or perhaps deliberately) paste over a data valida-
tion without receiving the error message or restrictions that would have 
appeared had they tried to enter the data directly into the cell.

Referencing Source Data on Another Sheet  In older versions of Excel a restric-
tion with data validation drop‐downs is that the source data and the drop‐
down needed to be on the same page. In later versions of Excel, we can 
now link directly to source data on other sheets when creating a data‐vali-
dation drop‐down box without having to use a named range. However, the 
file will not be compatible with Excel 2007 or earlier—the drop‐down will 
simply not contain any data in the list. Microsoft says that it did install 
a patch to fix this in Excel 2007 but when testing this on various clients 
who were still using 2007, I found that it still did not work. It is there-
fore recommended to always use named ranges when linking drop‐down 
boxes to source data on another page to ensure compatibility with earlier 
versions of Excel. Here’s how to use a named range in a data validation 
drop‐down box:

	 1.	Highlight the source data list and assign a named range to the list (for 
example, countries). See the section on “Named Ranges” in Chapter 5 
for instructions on how to do this.

	 2.	When creating the data‐validation drop‐down, in the List box, enter an 
equal sign followed by the name of the range as shown in Figure 7.29. 
You must type = and then spell the named range correctly for it to work.

Tip: Use the F3 shortcut if you cannot remember exactly how you 
spelt the named range!

Figure 7.28  Completed 
Drop‐Down List
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Form Controls

Form controls are objects such as drop‐down boxes and option buttons 
that sit over the top of Excel sheets, like charts do. They can interact with 
formulas so that when the option is selected, it changes the formula and 
can drive the model. They can be especially useful for scenario selection 
and assumptions in a financial model, as well as interactive, dynamic 
dashboards.

Building form controls into a financial model can be time consuming 
for the modeller, but they do make the model look very professional and the 
interface becomes extremely easy to use.

Accessing Form Controls

You will need to have the Developer tab showing in the Ribbon. If you can-
not see it in the Ribbon, you’ll need to change your options.

Figure 7.29  Creating a Drop‐Down List Using a Named Range
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Showing the Developer Tab in the Ribbon

The Developer tab contains several functions that are useful when develop-
ing macros and form controls. Take a look at Figure 7.30, which shows the 
Developer tab in the Ribbon. The default installation version of Excel will 
not have the Developer tab showing in the Ribbon, so if you can’t see this 
tab, you’ll need to install it. You will need to change this setting only once, 
unless you re‐install Excel, or move to another machine.

This is one of the few instances where the instructions for 2007 differ 
from later versions of Excel. To display the Developer tab in the Ribbon in 
Excel 2010 or 2013:

	 1.	Click on the File menu in the top left‐hand corner of your screen.
	 2.	Scroll down to Options at the very bottom and select it.
	 3.	Select Customize Ribbon.
	 4.	In the box to your right, tick the Developer box.

In Excel 2007:

	 1.	You need to click on the Microsoft Office button in the top left‐hand 
corner of your screen.

	 2.	Under Excel Options, go to the Popular section.
	 3.	Check the Show Developer Tab in the Ribbon.

In Excel for Mac 2011:

	 1.	Click on the gear box in the top right‐hand corner of your screen.
	 2.	Select Ribbon Preferences.
	 3.	In the dialog, check the Developer box.

Check Boxes

Check boxes are very handy tools that can help users choose their desired 
options from a list. By building check boxes into a financial model, the de-
veloper allows users to customise the model by adjusting the combinations 
of inputs for the financial model’s assumptions.

Figure 7.30  The Developer Tab
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    hoW to Create CheCk BoXes    

   1.   Go to the Developer tab on the Excel toolbar and click on 
Insert. See Figure   7.31   . If you cannot see the Developer tab, fol-
low the instructions above on how to show the Developer tab 
in the Ribbon. 

 Below is how the Developer tab in the Ribbon looks if you 
are using Excel for Mac 2011. See Figure   7.32   .  

   2.  From the Form Controls menu, select the check box as shown 
in Figure   7.33   . 

    Figure   7.31    Insert Controls Icon 

    Figure   7.32    Form Controls in Excel for Mac 

    Figure   7.33    Inserting the Check Box 
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   3.  Draw the check box anywhere in your sheet, and you should see 
the box with a name Check Box 1. Subsequent check box names 
will be Check Box 2, Check Box 3, and so on. You can move it 
around, or change the check box name to anything you like by 
holding down the control key. 

   4.   You can now link the checkmark in this box to any cell in your 
model. To do that you need to open the Format Control associ-
ated with the check box. Right‐click on the check box and select 
Format Control as shown in Figure   7.34   . 

 Alternatively, select the check box and click Properties on the 
Ribbon under the Developer tab.  

   5.  In the Format Control dialog, you can select the default value 
of the check box (unchecked, checked, or mixed) and the cell to 
which you want to link the check box status. In Figure   7.35   , it 
is linked to C5. To enhance the look of the check box, you can 
select 3‐D shading. 

    Figure   7.34    Selecting Format Control to Assign 
Check Box Options 

(continued)
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   6.  The cell to which the status is linked will have a Boolean value 
of TRUE or FALSE. Because TRUE has a value of 1 and FALSE 
has a value of zero, we can use this in our calculations as shown 
in Figure   7.36   . See greater detail in “Boolean Logic (Binary 
Codes)” later in this chapter. 

   7.  You can add multiple check boxes corresponding to the items 
in the list. Based on the Boolean status, you can design your fi -
nancial model to pick the respective items, such as the example 
in Figure   7.36 .    

    Figure   7.35    Format Control Dialog Box 
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 Columns A and B contain the raw data. A group of check boxes has 
been created in column E, and the format control output cell that corre-
sponds to each check box has been placed in column D. The formula in col-
umn F will then only pick up the values for the items that have a checkmark 
next to them. Because D2 contains a FALSE (or zero) value, multiplying a 
number by D2 will return a zero value. This technique can easily be applied 
to charts and dashboards. 

 You can fi nd this model along with the accompanying models to the rest 
of the screenshots in this book at  www.plumsolutions.com.au/book .       

    Figure   7.36    Check Boxes in a Financial Model 

    Tip  
 When creating a list of check boxes, or option buttons, it’s easiest to create one in 
a single cell and then copy that cell multiple times so that they appear in a straight 
line below each other. if you create each object free-form, they will appear in random 
locations, as shown in figure   7.37   , and it’s then diffi cult to get them lined up neatly. 

 option Button 

 Sometimes users may need to choose one item from a list, which drives the 
rest of the calculations and analyses. The Option button (sometimes called a 
Radio button) offers you the ability to create this logic to restrict the num-
ber of options users can choose in the fi nancial model.       

http://www.plumsolutions.com.au/book
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    Figure   7.37    Randomly Arranged Check Boxes 

    hoW to Create option Buttons    

   1.  Go to the Developer tab on the Excel toolbar and click Insert. 

   2.   From the Form Controls select the Option Button, as shown in 
Figure   7.38   . 

    Figure   7.38    Inserting the Option Button 
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 In Excel for Mac 2011, go to the Developer tab on the Excel 
toolbar. Select Radio Button, as shown in Figure   7.39   .  

   3.  Draw the Options button in front of the item in the list. Like 

the check boxes, the Option button default name starts with 
Option Button 1 and increases by one number with each new 
button. The name can be changed by holding down the control 
key. 

   4.   You can edit the properties of the button using Format 
Control. You can access the format control dialog in the same 
manner as for check boxes. Right‐click and select Format 
Control, or click Properties in the Ribbon under the Developer 
tab. 

   5   In the Format Control dialog box you can select the default 
value of the option button (unchecked or checked) and the 
cell to which you want to link the option button status. (In 
the example shown in Figure   7.40   , it is linked to E1.) To 
enhance the look of the option button you can select 3-D 
shading. 

  The cell to which the status is linked will have a numerical 
value of the item in the list. In Figure   7.40  , the fi fth item was 
selected, hence $E$1=5.  

    Figure   7.39    Radio Button in Excel 
for Mac 

(continued)
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      Note  

 By design, all the option buttons will always refer to a single cell, unlike check boxes. if you 
change the cell link for one option button, it will automatically update the rest.     

 spin Buttons 

 Spin buttons are useful for controlling what users can enter into the input 
fi elds in your fi nancial models. By including a spin button, users can increase 
or decrease the number in the increments that you specify. For example, if 
you set it to increments of 5, and the current value is 400, when users hit 
the up arrow, it will change to 405, then 410, 415, and so on, and the same 
with the down arrow.       

   6.  You can add multiple option buttons corresponding to the items 
in the list. Based on the item number selected, you can design 
your fi nancial model to carry out the necessary analysis. 

   7.  Practice adding multiple items to the list and associating option 
buttons to each item. As you switch between each item in the 
list, you can observe the number change in the linked cell. 

   8.  The next step would be to create a formula linked to the output 
cell. If you want to display the value for the selected option, 
then use an INDEX or CHOOSE function to return the fi fth 
result from the table, as shown in cell F1 of Figure   7.40  .   

    Figure   7.40    Worksheet with Option Button 
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    hoW to Create a spin Button    

   1.  Go to the Developer tab on the Excel toolbar and click on Insert. 
   2.   From the Form Controls select the Spin Button, as shown in 

Figure   7.41   . 

 In Excel for Mac 2011, go to the Developer tab on the Excel 
toolbar. Select the Spin Button.  

   3.  Draw the spin button next to the input box for the value you 
want to control. Figure   7.42    shows an example of a completed 
spin button that has been incorporated into a model. 

   4.  You can edit the properties of the button using Format Con-
trol. You can access the format‐control dialog in the same 

    Figure   7.41    Inserting the Spinner 

    Figure   7.42    Completed Spin Button in a Financial Model 

(continued)
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manner as for a check box. Right‐click and select—Format 
Control, or click Properties in the Ribbon under the Devel-
oper tab. 

   5.  Figure   7.43    shows the Format Control dialog box for the spin 
button in Figure   7.42  . Here you should specify the minimum 
value for the spin button (here it is set to 0), maximum value 
(here it is 30,000—which is the highest amount possible), and 
the incremental change (here it is 1,000). You must also specify 
the cell in which you want to change the values in the cell link 
that in this case is B3, the loan amount in our model. 

   6.  Practice pressing the arrows up and down and see the values in 
the model change. You can fi nd this model along with the ac-
companying models to the rest of the screenshots in this book at 
 www.plumsolutions.com.au/book .   

    Figure   7.43    Format Control Dialog Box 

http://www.plumsolutions.com.au/book
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Note

There are a few annoying limitations with a spin button. The maximum value cannot be 
greater than 30,000, and the incremental change cannot be less than one. This means that if 
you want to use it for percentages, you need to do a workaround, and divide the output cell 
by 100 to express a percentage driven by a spin button.

Note

Note that the scroll bar works in a very similar way to the spin button, except that the button 
is oriented horizontally instead of vertically.

Combo Boxes

Creating a drop‐down box is an important tool in many user‐friendly mod-
els where the modeller wants the user to select from a predefined number of 
options, making the model easier to use, and also avoiding mistyping and 
potential errors. The advantage of the combo boxes is that you eliminate 
any ambiguity in user inputs and still keep things simple for users to provide 
the inputs. See Figure 7.44.

The combo box is an alternative to using the data‐validation drop‐down 
tool. See the section on “Bulletproofing Your Model” earlier in this chapter 
for instructions on how to create a data‐validation, in‐cell drop‐down box. 
The only advantage of the combo box is that the drop‐down arrow is visible 
whether the cell is selected or not. This is a significant advantage if users are 
not very Excel savvy.

From the modeller’s perspective, however, a combo box takes much 
longer to build, requiring more cells for the process, and is therefore less 
efficient. For these reasons, most modellers prefer the data‐validation drop‐
down tool.

Figure 7.44  Completed Combo Box 
Drop‐Down
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    hoW to Create a CoMBo BoX    

   1.  Go to the Developer tab on the Excel toolbar and click on 
Insert. 

   2.   From the Form Controls select the Combo Box as shown in 
Figure   7.45   . 

 In Excel for Mac 2011, note that combo boxes can only be 
used in conjunction with VBA, and therefore the instructions in 
this section do not apply to Mac users.  

   3.  Draw the combo box next to the input box for which you want 
to control input. Figure   7.46    shows an example of the combo 
box. Note that it does not need to fi t neatly into a cell. 

   4.  To fi x the inputs, create an input box with inputs such as shown 
in Figure   7.47   . 

    Figure   7.45    Inserting the Combo Box 

    Figure   7.46    Drawing the Combo Box 
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   5.  You can now associate these inputs with your combo box using 
Format Control. You can access the Format Control dialog box 
in the same manner as for the other form controls. Right‐click 
and select Format Control, or click Properties in the Ribbon 
under the Developer tab. 

   6.   In the Format Control dialog box, give the Input Range (here it 
is B9 to: B11), and the Cell Link (here it is C1). Select 3‐D shad-
ing to enhance the combo box. See Figure   7.47  . 

 The output cell will only indicate the item number selected; 
so C1 will refl ect a value of 1 for optimistic, 2 for likely, and 3 
for pessimistic. To translate these numbers into meaningful per-
centages from the chart, you need to link the growth amounts 
in column C to C1; this can be done using IF, INDEX, or even a 
CHOOSE function in Excel (and I’m sure you can think of even 
more options).  

   7.  INDEX is a more elegant way of representing this link than an 
IF, for example. Use the formula  =INDEX(C9:C11,C1,1)  to cre-
ate the necessary linkage. See Figure   7.48   . 

(continued)

    Figure   7.47    Scenario Source Data 
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 Boolean Logic (Binary Code) 

 Most form controls use Boolean logic, which converts everything to one of two 
values: a one or a zero. For example, if a check box is selected, it will return a 
value in the output cell of TRUE, which equals 1; and if it is left blank, it will be 
FALSE, which equals zero. We can use the output cell to drive a formula. 

 In Figure   7.49   , the output cell is B5. When the check box is checked, it 
shows the value TRUE, which is equal to one, so this has been incorporated 
into the model by using the formula:  =B7*((B5*B2)+1).   

   8.  Practice changing the combo box, and see the values change.   

    Figure   7.48    Using the Combo Box Output in a Formula 

    Tip  
 To keep the model tidy, you can change the font colour of cell D8 to white so that the 
text is invisible to the user but available for calculation. Alternatively, you can hide the 
output cell behind the combo box. Move the combo box out of the way, cut and paste 
the output cell to cell c3, and then move the combo box back over c3 to hide the output 
cell value. This is the most common method as it stops other users from inadvertently 
deleting the output cell value. 
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Figure 7.49  Checked Check Boxes Drive Calculation

Figure 7.50  Unselected Check Boxes Drive Calculation

If the check box is left blank, the output cell would display FALSE, 
which gives the value zero, and according to the formula, the GST would 
then not be included in the total. See Figure 7.50.

Similar formulas can be created to link to other form controls such as 
option buttons and combo boxes.
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Form Controls versus ActiveX Controls

You may have observed that the Insert button under the Developer tab has 
two sets of options: form control and ActiveX controls. While both have the 
same set of functions, they have a slight difference. The ActiveX controls are 
tailor‐made for a Microsoft Office environment and use Microsoft ActiveX 
to enhance their functionality. If you are absolutely certain that your finan-
cial model would be used in the MS Office environment only, then you could 
possibly add a few additional enhancements to your controls. However, if 
your users might also be using other environments like Mac OS, the ActiveX 
controls can cause problems—as Apple’s operating system does not support 
Microsoft ActiveX.

If you want to keep your financial modelling product platform indepen-
dent, stick to form controls. As far as core functionality is concerned, form 
controls will offer you all the necessary flexibility required for a smooth user 
experience.

Summary

Formatting and displaying the data and inputs are important parts of build-
ing a financial model. Of course, the accuracy of the model and its calcula-
tion are most important, but having a model that looks good and is easy to 
use certainly adds to the integrity and usability of the model. A model with 
which the model builder has obviously taken care to use clear colour coding, 
borders, and correct formatting will be trusted more, and given more cred-
ibility by the user. Therefore, good modellers should spend a little time (not 
too much) during the model build to format colours, borders, and styles to 
make it more accessible.
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                                                       CHAPTer   8                     
 Tools for Financial modelling   

  in this chapter, we’ll look at the basic commonly used tools of hiding and 
grouping. We’ll then cover some more advanced tools such as array formu-

las, goal seeking, PivotTables, and macros. Whilst the best fi nancial models 
are the simplest and easiest to understand (and therefore often don’t contain 
these complex tools), it’s important that the fi nancial modeller has a grasp 
on how to use these tools if functionality requires.   

 HiDing SeCTionS oF A moDel 

 Being able to hide sections of a model is a very handy tool, especially when 
tidying up a model to conceal cells that are necessary for the model to work, 
but not necessary for the user to see. You can hide rows or columns in the 
model, or you can hide an entire sheet. If you have information in a model 
you don’t want users to see (for example, unnecessary detail or a calculation 
that will only serve to distract from the model), you can hide the section of 
the model that contains the data.  

 Columns and rows 

 It is possible to hide a column or row of data to stop it printing out, or to 
stop other people from viewing it. 

    HoW To HiDe A Column or roW  

     1.  Select the column or row by clicking on the heading. 

   2.  Right‐click and select Hide.   

 The column or row will be hidden from view. But if you look at the 
column or row headings, you can see which column or row is missing. 
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Tip
If you have hidden column A, or row 1, it can be tricky to unhide it. You’ll need to hold 
down the mouse and select across the row or column headings left or upward in order to 
unhide the column or row. The trick is that you have to right-click with the mouse in the 
highlighted row or column, as shown in Figure 8.1. If you click elsewhere, it won’t work.

Figure 8.1  Unhiding Rows 1 and 2

You can hide multiple columns or rows at the same time. Just select all 
the columns or rows at the same time and follow the steps outlined above.

Sheets

Hiding sheets is also very useful. If you have information on a model you 
do not want users to see at all (e.g., salary information on budget mod-
els), you can hide the sheet with sensitive information, and then protect the 
workbook. The hidden sheets disappear from view, but links are retained as 
the sheet has not been deleted from the workbook.

Note

Although we can easily hide multiple worksheets at a time by selecting several sheets using 
the Control key, only one sheet can be unhidden at a time!
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    HoW To VieW (unHiDe) A Column or roW  

 The diffi culty of bringing back a hidden column or row is that you 
need to select it fi rst. As it is hidden, you cannot see the row or column 
to click on it. The trick is to select the headings on either side of the 
hidden column or row. This will select the columns or rows before and 
after, as well as the hidden column or row itself. 

   1.  Click and drag across the headings to select those before and 
after the hidden column or row. 

   2.  Right‐click and select Unhide, as shown in Figure   8.2   .   

    Figure   8.2    Unhiding Rows 
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    Tip  
 A way to hide a sheet even more securely is to change the properties of the sheet in the 
Visual Basic code to Very Hidden. This method is not commonly known and will ensure 
that only a user experienced with programming will be able to work out how to unhide 
your sheets. 

   1.  To try this out, right-click on the tab name of your worksheet, and select View 
code, as shown in figure   8.3   . 

   in Excel for Mac 2011, select Tools, then Macro, then Visual Basic Editor. 

   2.  This will bring up your Visual Basic Editor. This should look fairly similar in all 
versions of Excel. 

   3.  click on the sheet that you want to hide in the top left, and change properties of 
that sheet in the bottom left from Visible to Very Hidden, as shown in figure   8.4   . 
in Excel for Mac 2011, control click on the sheet you want to modify, and your 
options will be available.   

    Figure   8.3    Viewing the Source Code 

    To HiDe or unHiDe A SHeeT  

      1.  Select the sheet(s) you want to hide or unhide. 

   2.  Right‐click on the sheet tab and select Hide/Unhide.   
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By default, all sheets are set to Visible. If you change the properties to Hid-
den, this will change the sheet so that it is hidden using the ordinary Hide 
Sheets tool, and it can be unhidden as easily as normal. If it is “Very Hidden,” it 
cannot be seen even when you try to unhide the sheets. The only way to unhide 
a Very Hidden sheet is to change the properties in the VBA code!

For more information on the Visual Basic Editor using macros, see the section on 
“Macros in Financial Modelling Case Studies” later in this chapter.

Figure 8.4  Changing the Visibility Options in the Visual Basic Editor

Using Protection  As just outlined, there are two methods of hiding: either 
hide rows and columns, or hide the worksheet itself. Depending on what is 
hidden, you might want to use another layer of protection to ensure that the 
data cannot be viewed. Password protection is a good option in such a case.

See the section on “Bulletproofing Your Model” in Chapter 7 for greater 
detail on how to apply protection to models.



238� Using Excel for Business Analysis 

Errors Caused by Hiding

Hidden sheets, rows, and columns may hide complexity from the user and 
make the model less confusing, but many users don’t like using what they per-
ceive to be a black box. It’s up to you, the model developer, to decide how much 
power you will give to model users. If you hide everything and then protect the 
model so that they can’t see how it has been calculated, this makes the model 
easy to use, but it does not inspire confidence in users. It often depends on who 
is using the model. If a model is for other modellers to use, they probably won’t 
appreciate being locked out of certain sections of the model, as they’d like to 
check it for themselves to ensure that it is working properly. If users have limited 
Excel use, then hiding with protection is probably appropriate to make sure 
they don’t mess up the formulas or make unauthorised changes.

There are many well‐documented cases where hidden rows and columns 
have been overlooked in financial models and caused significant errors. In 
2008, Barclays Capital was forced to file a legal relief motion relating to its 
acquisition of Lehman Brothers’ U.S. assets after a reformatting error in an 
Excel spreadsheet resulted in 179 toxic deals being mistakenly included in 
the purchase agreement.

The spreadsheet contained nearly 1,000 rows with more than 24,000 in-
dividual cells and had to be reformatted and converted into a PDF document 
before being posted on the bankruptcy court’s website by the end of the day.

But a junior associate reformatting the work was unaware that the orig-
inal Excel document included hidden rows containing contracts that were 
marked with an n to signify they should not be part of the deal.

The document was posted on the website, but the hidden cells had be-
come visible when the employee globally resized the rows in the spread-
sheet—without the original n designations. The error was not spotted until 
Barclays posted a revised list of contracts, with notice to the affected parties.

This story illustrates why it is highly recommended to use the Group-
ing Tool when hiding rows and columns in financial models. Google 
“Excel Horror Stories” and you’ll find a long list of the latest horrific 
Excel error story. For more tips on how to avoid being part of your own 
Excel horror story, see the section on “Error Avoidance Strategies” in 
Chapter 4.

Grouping

Determining whether there are hidden rows or columns on your worksheet 
can be difficult. Using the grouping tool can make hidden data more obvi-
ous and avoid its being overlooked.
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 Go to the Data tab and select Group/Ungroup from the Outline sec-
tion. When grouping is applied to a model, it will look like Figure   8.5    when 
collapsed. You can fi nd this example, along with the accompanying models 
to the rest of the screenshots in this book, at  www.plumsolutions.com.au/
book . 

     The same sheet will look like Figure   8.6    when expanded. 

    HoW To ProTeCT HiDDen SeCTionS oF A moDel  

 If you have hidden rows or columns, apply the protection  to the 
worksheet itself  by selecting Protect Sheet from the Review tab.      In 
Excel for Mac 2011, select Sheet from the Review tab in the Protec-
tion group. 

 If you have hidden a sheet, apply protection to the  structure  of 
the workbook by selecting Protect Workbook from the Review tab.   
   In Excel for Mac 2011, select Workbook from the Review tab in the 
Protection group.   

    Figure   8.5    Collapsed Grouping 

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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Notice the little 1 and 2 numbers in the top left‐hand corner for the 
rows and the columns. Clicking on these numbers is a very quick and easy 
way to expand and contract hidden rows and columns. Clicking 1 will con-
tract the data, and 2 will expand it.

Array Formulas

Array formulas are an advanced type of Excel calculation. Before we 
launch into what an array formula is, let me begin by saying that I don’t 
recommend you include array formulas in your models unless there is not 
possibly any other way. Array formulas can be difficult to understand and 
hard to edit if you don’t know what they are, because you cannot change 
part of an array. In general, array formulas are very difficult to edit and 
audit because they add a new layer of complexity that is often unnecessary. 
Most array formulas I have seen are either legacy models built in older ver-
sions of Excel or Lotus, long before some of the more efficient functions 
became available. Other array formulas I have seen have been built by 
consultants who want to ensure that the client is unable to edit the model 
themselves, so guaranteeing themselves work in the future! An array is ba-
sically just a collection of data of the same type that can be treated as a sin-
gle entity. An array formula treats the entire array as a single input to the 
formula. The reason that array formulas are difficult to understand is that 
they don’t follow the usual rules of ordinary formulas. Trace Precedents 

Figure 8.6  Expanded Grouping
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and Trace Dependents will work on arrays, but don’t help very much! 
Many people don’t know how to use them, and if you have never seen an 
array formula before, they can be pretty difficult to work out. Therefore, 
if you are building a model for others to use, using array formulas is not 
recommended, because they may have difficulty making necessary changes 
to the model.

However, in order to seriously consider yourself an Excel super‐user, 
you should know how to build an array formula—or at least be able to 
recognise and edit one if you come across it—if only to remove it from the 
model and replace it with a far more auditable and user‐friendly formula.

Array formulas are very powerful tools, and there are many reasons 
why analysts use them. One of the main advantages is security—nobody 
can accidentally delete part of the array block when using an array formula. 
Also, because the data can be manipulated as a whole block and used in the 
formula as a single unit, it’s a lot harder to make a mistake when building 
the formula.

You can identify an array formula because it includes curly brackets 
(like these: {}). Data tables are a type of array formula—probably one of 
the most useful ones—especially for the financial modeller. (See “Using Data 
Tables for Sensitivity Analysis” in Chapter 11 for how to build a data table.)

Advantages and Disadvantages of Using Array Formulas

The advantages of using array formulas are as follows:

■■ They ensure consistency because all formulas in the table are exactly 
the same.

■■ A model containing arrays will use less memory and be more efficient.
■■ Because it’s not possible to change a single cell on its own within an 
array formula, it is unlikely that you or someone else will change your 
formula accidentally.

■■ Because array formulas are difficult to understand, it means those with 
only basic Excel knowledge are less likely to change (and mess up!) your 
formulas.

■■ Array formulas do make it possible to perform some calculations that 
would otherwise be impossible. This is really the only reason you should 
use an array formula.

The disadvantages of using array formulas are as follows:

■■ Although array formulas use less memory, if you use too many large 
arrays in one model it can slow down your calculations.
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■■ You cannot use column references (such as A:A or D:D) in your array 
formulas. This is not best practice in financial modelling anyway, so no 
great loss!

■■ They are difficult to audit for many Excel users and require special-
ist skills, though this can be considered both an advantage and a 
disadvantage.

Simple Array Formula Example

 	1.	Create two simple blocks of data (arrays) as shown in Figure 8.7.
	 2.	Now, instead of simply multiplying Quantity by Price, we are going to 

create an array formula instead. Highlight the block of cells C1:C10 
and type/highlight =A2:A10*B2:B10 in the formula bar as shown in 
Figure 8.7.

	 3.	Now, hold down the Control and Shift keys while hitting Enter at the 
same time (Control+Shift+Enter).

	 4.	The formula will appear in the whole array block, as shown in Figure 
8.8. Note that curly brackets have appeared around the formula.

	 5.	Try deleting row 2, or one of the cells in column C. Note that you now 
cannot make any changes to the array block.

Please also note that array formulas are sometimes referred to as CSE 
formulas, because you press Control+Shift+Enter to enter them.

Figure 8.7  Entering an Array Formula
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Array Formula Uses

Financial modellers generally advocate the use of array formulas only when 
it is not possible to do something any other way. Some examples of these 
situations are as follows:

■■ Data tables are a form of array formula that is extremely useful for sce-
narios and sensitivity analysis in financial modelling. Instead of changing 
inputs one at a time, an array shows hypothetically what an outcome 
would be simultaneously in a single table.

■■ TRANSPOSE allows you to transpose a range of data either vertically 
or horizontally, and retain links. We’ll take a look at how to use this 
very handy technique.

■■ Using a SUM and a VLOOKUP together as an array formula makes 
a very concise formula. For example, =SUM(VLOOKUP(value, list, 
{2,3,4},0)) will give you a sum of values in rows 2, 3, and 4 instead of 
having to do =VLOOKUP(value, list,2,0) + VLOOKUP(value, list,3,0) 
+ VLOOKUP(value, list,4,0). Note: You need to hold down Control, 
Shift, and Enter for this to work.

Transposing Data Using an Array

One of my favourite uses of an array formula is to create an =TRANSPOSE 
function, which will transpose data, allowing a link to be maintained within 
the model.

Figure 8.8  Completed Array Formula
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Let’s say you have some city and temperature data in a table, as shown 
in Figure 8.9, but you’d like to transpose the data so that months and cit-
ies are switched around, as shown in Figure 8.10. You can create this sheet 
yourself, or a template can be found along with the accompanying models 
to the rest of the screenshots in this book, at www.plumsolutions.com.au/
book.

Before you start cutting and pasting, try the transpose values tool first.

	 1.	Highlight the original table, and copy it to the clipboard using Control+C 
(Command+C in Excel for Mac 2011).

	 2.	Right‐click in the cell that you want the data to appear, and select Paste 
Special.

	 3.	Check the Transpose box as shown in Figure 8.11, and click OK.

Figure 8.9  Temperature Data

Figure 8.10  Transposed Temperature Data

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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This will paste all of the transposed values as hard‐coded data in a new 
table. Using this method creates two separate, independent tables of data.

Using a TRANSPOSE Array Function  However, you may wish to maintain the 
original table as the source data, and have the second table linked to the 
first. Instead of linking each cell individually (time‐consuming and prone to 
error), you could use a TRANSPOSE Array Function in five steps.

	 1.	Highlight a range with exactly the correct rows and columns for the 
destination data.

Figure 8.11  Paste Special Dialog Box

Tip
It’s difficult to see exactly how many rows and columns you’ll need, so it’s easiest to use 
the Paste Special—Transpose procedure as described above to determine exactly how 
big the selection range needs to be.

	 2.	In the formula bar, type the formula =TRANSPOSE, referencing the 
original data (i.e., =TRANSPOSE(B3:M6)), as shown in Figure 8.12.
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	 3.	Now, hold down the Control and Shift keys while hitting Enter at the 
same time (Control+Shift+Enter).

	 4.	The formula will appear in the whole array block. Note that the curly 
brackets have appeared around the formula, so the formula will be 
{=TRANSPOSE(B3:M6)}.

	 5.	Note that changes you make in the original block of data will be re-
flected in the second block.

Goal Seeking

Goal seek is a very handy and commonly used tool in financial modelling 
and analysis. Goal seek is used to adjust the value in a specified cell until 
a formula dependent on that cell reaches the result you specify. In other 
words, it will change the inputs such that the output is set to the exact 
amount you want it to be.

In order to run a goal seek, you must have:

■■ A formula.
■■ A hard‐coded cell that drives that formula.

The formula and its input cell do not need to be on the same sheet or 
even in the same model. As long as there is a direct link between the two 
(no matter how many calculations are in‐between), the goal seek will work. 
However, it’s important to remember that the input cell must be hard‐coded. 
An input cell that contains a formula will not work.

A common use of goal seek is in break‐even analysis. We normally want 
to know how many units we need to produce to break even (i.e., how many 
units we need to produce in order to recover our costs). In this instance, 
we’d change the number of units in the model until the profit amount is set 
to zero. See “Break‐Even Analysis” in Chapter 9 for an example of this.

Here’s another example in 10 steps. Let’s say you borrow $1 million at 
an interest rate of 6.5 percent.

	 1.	Use the PMT function to calculate the monthly repayments over 15 years.
	 2.	If you use the PMT formula wizard, your input should look as shown in 

Figure 8.13.
	 3.	The result will be ‐$8,711. Put a minus sign in front of it to make it a 

positive number.
	 4.	Your formula should be =‐PMT(B2/12,B3*12,B1).

See “Loan Calculations” in Chapter 6 for greater detail on how to 
use PMT and other loan calculation functions.
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Let’s say that we can afford for our repayments to go up to, say, 
$10,000 per month. How much of an increase in interest payments can 
we afford? Maybe we should fix our rate.

	 5.	On the Data tab, in the Data Tools group, click on What‐if Analysis and 
select Goal Seek from the drop‐down list. In Excel for Mac 2011, go to 
the Data tab. Then, in the Analysis group, click on What‐if Analysis and 
select Goal Seek from the drop‐down list.

	 6.	In the Set Cell box, enter the reference for the cell containing the for-
mula that produces the desired end result (B4, in this case).

	 7.	In the To Value box, enter the result you would like to achieve in the Set 
Cell (type in 10000).

	 8.	In the By Changing Cell, enter the reference for the cell that Excel is to 
change (B2, the interest rate).

Figure 8.13  Loan‐Repayment Calculation Using PMT Function
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	 9.	This will bring up the Goal Seek Status dialog box containing the result 
of your seek. See Figure 8.14.

	10.	Click OK to accept the new values, or Cancel to go back to the original 
values.

The answer to this problem is that we can afford for interest rates to 
increase to 8.75 percent. If the bank were to offer us a fixed interest rate of 
8 percent, then we should take it!

Whilst this calculation could have been done by trial and error, it’s 
much quicker to use a goal seek. Goal seek will work in huge models and 
run through a large number of calculations, giving the result you need to 
achieve your desired outcome.

Structured Reference Tables

The Table feature in Excel (not to be confused with PivotTables or Data 
Tables) is a great tool for organising and analysing large amounts of data. 
For this reason, like PivotTables, they are not commonly used in pure finan-
cial modelling, but as a very useful tool in reporting and analysis, they are 
also worth a brief mention.

The two useful features of a Table are:

	 1.	A Table will automatically resize depending on the number of rows. If 
you have a formula or a PivotTable referencing the Table, additional 
data will automatically be included in the range.

	 2.	Formulas created within a Table are automatically populated, hence en-
suring consistency in formulas for blocks of data—a fundamental point 
of financial modelling best practice.

Figure 8.14  Goal Seek Dialog Box
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    To CreATe A TAble  

     1.  Organise your data so that it is arranged in a block, with head-
ings on each column as shown in Figure   8.15   . You can create 
this sheet yourself, or a template can be found along with the 
accompanying models to the rest of the screenshots in this book, 
at  www.plumsolutions.com.au/book.   

  2.  Click on any cell within the sheet and select Table from the In-
sert tab, or use the shortcut Control‐T. In Excel 2011 for Mac, 
click on the Table tab, then click the New icon in the Table Op-
tions section of the Ribbon. 

   3.  This will bring up the Create Table dialog box, and if your data is 
arranged correctly with headings on each column, you can leave 
the check box “My table has headers” selected, and press OK. 

   4.  When the table has been created, it will format the table using 
alternate fi ll colour. You can easily change the colours from the 
Table Styles section on the Table Tools Design tab. 

   5.  Note that you can also change the name of the table in the Table 
Name box in the far right of the Design tab. In Excel 2011 for 
Mac, click on Rename on the tables’ Ribbon. (The Table Name 
box has been highlighted in Figure   8.15  .) This is similar to cre-
ating a named range and makes your table easier to refer to in 
formulas and PivotTables. 

   6.  Now try typing in an extra heading such as “GST” in cell E1. 
You’ll see that the table automatically expands to include the 

    Figure   8.15    Creating a Structured Reference Table 

http://www.plumsolutions.com.au/book
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         PiVoTTAbleS 

 Excel PivotTables are a very useful and powerful feature of Excel. They can 
be used to summarise, analyse, explore, and present your data. A PivotTable 
is a great reporting tool that sorts and sums independent of the original data 
layout in the sheet. 

 For example, you can take the sales data with columns like salesperson, 
region, and product‐wise revenues, and use PivotTables to quickly fi nd out 
how products are performing in each region. Figure   8.16    is a snapshot of 
a PivotTable that has been used to summarise the spend by each customer. 

additional column. If you add a formula in cell E2, you’ll see 
that the formula is automatically copied down the entire col-
umn in the table.   

    Figure   8.16    Source Data and PivotTable 
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Using PivotTables in Financial Modelling

Useful as they are, PivotTables are not used very widely in financial 
modelling. This is because they are static until refreshed, and this does not 
fit very well with the methodology of most financial models. As discussed in 
earlier sections, the whole point of financial modelling is that you are able 
to change the inputs, and the outputs change!

It’s far too easy for a user to change the inputs, and then forget to 
refresh the PivotTable. This results in using incorrect outputs from the 
model.

It is for this reason that I recommend the use of an alternative live, dy-
namic formula, such as SUMIF or SUMIFS, in place of a PivotTable when 
building a classic financial model that depends on inputs being changed. 
See “Aggregation Functions” in Chapter 6 for how to use the SUMIF and 
SUMIFS functions.

Whilst it is possible to change the settings so that the PivotTable will 
automatically refresh whenever the file is opened, there is no guarantee that 
the user will open and close the file before using the data, and it cannot be 
relied upon.

It’s not a bad idea to change the settings to automatically refresh in 
any case, however. You can do this by right‐clicking on a PivotTable, then 
go to PivotTable Options as shown in Figure 8.17. On the Data Tab, select 
Refresh data when opening the file.

Common Uses of PivotTables  PivotTables are more widely used in management 
reporting than in pure financial models.

Here are some commonly used examples of PivotTables:

■■ Summarising data, such as finding the average sales for each region and 
for each product, from a product sales data table.

■■ Listing unique values in any column of a table (this can also be done 
with the remove duplicates functionality in later versions of Excel). 
Prior to the Excel 2007 release, PivotTables were a common way of 
obtaining a unique list.

■■ Filtering, sorting, and drilling‐down data in the reports without writing 
any formulas or macros.

■■ Transposing data (i.e., moving rows to columns or columns to rows).

Other Things You Should Know about PivotTables

■■  You can apply any formatting to the PivotTables. Excel has some very 
good PivotTable formats that can be easily accessed via the Styles on 
the Design tab.



Tools for Financial Modelling� 253

■■ You can easily change the PivotTable summary formulas. Right‐click on 
the PivotTable and select the Summarise Data By option from Sum to 
Count or Average for example.

■■ You can also apply conditional formatting to PivotTables, although you 
may want to be a bit careful as PivotTables scale in size depending on 
the data.

■■ Whenever the original data from which PivotTables are constructed 
changes, just right‐click on the PivotTable and select Refresh Data.

■■ A new feature of Excel 2013 is Recommended PivotTables, as shown in 
Figure 8.18, which gives you a preview of what your data will look like 
in a PivotTable.

Figure 8.17  PivotTable Options Dialog Box

Tip
If you want to drill down on a particular summary value, just double-click on it. Excel 
will create a new sheet with the data corresponding to that pivot report value. It’s very 
useful!
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How to Create a PivotTable

If you need to create a report summarising sales by customer, for example, 
you can follow these eight instructions:

	 1.	Highlight the entire database, ensuring that the headings are at the top 
of the range, or just click somewhere in the block of data.

Tip
If you convert your source data to a Structured Reference Table first, before creating 
the PivotTable, and then use this as the source data, then the range will automatically 
update when the data expands or contracts.

	 2.	Select PivotTable from the Insert tab, in the Tables section (found in the 
Data tab, in the Analysis section in Excel for Mac 2011). See Figure 8.19.

Figure 8.19  Creating a PivotTable
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	 3.	By default, it will put your PivotTable on a new page. If you prefer, 
you can change the options to locate it on the existing or a different 
page.

	 4.	Press OK. The PivotTable Field List will appear on the right‐hand side.
	 5.	If you drag Customers into the Row Labels field and Price into the Val-

ues field, it will summarise your data and create a PivotTable report that 
looks like Figure 8.20.

	 6.	If you now drag the Product field to the Rows field below the Custom-
ers field, it will split your report into subcategories.

	 7.	Try slicing and dicing your data in different ways. Swap the customer 
and product fields, or try moving products from the Rows field to the 
Column field.

	 8.	The PivotTable can now be quickly formatted using the drop‐down 
styles on the Design tab.

Tip
If you have dates in the columns or rows fields, then consider grouping these on the 
PivotTable instead of in the raw data.

	 1.	C lick on the first date in the column field as shown in Figure 8.21, and select 
Group. In Excel 2011 for Mac, click the Data tab, then click Group from the Rib-
bon in the Group and Outline section.

	 2.	C hoose Months, Quarters, Years, or however you’d like the dates to be ag-
gregated. In the example shown in Figure 8.22, we have chosen to group by 
Months, so we can see a forecast of fees by month in this PivotTable.

Filtering and Using Slicers

Using the data from the previous example, we could drag the Product field into 
the Filters field in order to filter the data by Product, as shown in Figure 8.23.

This filter can be used to show DVDs only, CDs only, or a combina-
tion. Note, however, that if we select “Multiple Items” as we have done in 
Figure 8.24, it ceases to show which items have been selected, which is not 
very helpful from a reporting perspective!

If you are using Excel 2010 or later, then you will have access to Slicers. 
Using a Slicer in this instance will make the report more user friendly.
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Figure 8.21  Grouping the Dates in a PivotTable

Figure 8.22  Grouping by Month
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    Figure   8.24    Selecting Multiple Items in a Filter 

    To inSerT A SliCer  

     1.  Remove any fi lters by clearing it (selecting all options) and 
dragging the fi ltered fi eld out of the Filter Field List. 

   2.  Click on the PivotTable, and Select Slicer from the Insert Tab 
on the Ribbon, or from the Insert Slicer icon on the Analyze 
tab. If the Slicer icon is greyed out, it could be because the 
model is in Compatibility Mode, and slicers are not supported 
in older versions of Excel, so make sure the fi le is saved as an 
.xlsx fi le type. 
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   3.  The Insert Slicers dialog box will appear, so select the fi eld by 
which you would like to slice (or fi lter) the data. Let’s choose 
Product in this case. 

   4.  It’s not good practice to put images, charts, or slicers below 
or to the right of a PivotTable (because these are designed to 
expand or contract), so resize your columns E or F and resize 
the Slicer to fi t nicely to the left of the PivotTable, as shown in 
Figure   8.25   . 

   5.  Try clicking on one of the buttons to slice the PivotTable. If you 
want to show multiple items, hold down the control key.   

    Figure   8.25    Slicer in a PivotTable 

    Tip  
 slicers were fi rst introduced for PivotTables in Excel 2010, and in Excel 2013 they can 
now also be applied to structured reference Tables. 
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Note

At the time of writing, Slicer was still not available in Excel for Mac 2011 unfortunately, so 
Mac users will have to do without this handy functionality for the time being. Let’s hope that 
changes with the next version!

Macros

Many aspiring modellers think that they need to be proficient in macro‐
building in order to become serious financial modellers. Whilst it’s not a 
bad idea to have a working knowledge of macros—and the language they 
are built in, Visual Basic for Applications (VBA)—it’s certainly not critical 
for a financial modeller to become a super VBA programmer. As discussed 
in previous sections, the best sort of financial model uses the simplest tools, 
and introducing macros to a financial model brings a whole new level of 
complexity.

Before launching further into the pros and cons of including macros 
in your financial model, let’s have a quick overview of what macros are 
and how to build them. VBA in Excel is a huge topic in itself, and one 
I’m not planning on going into too deeply here. Once you start writing 
macros, it’s quite easy to get hooked, as you can do some truly amazing 
things in Excel, which will bring the functionality of your work to a whole 
new level. If you develop an interest in the subject, there are lots of books 
and training courses specifically focused on macros and VBA. Make sure 
that you buy a book or attend a course on VBA for Excel and its use in 
finance, as there is a lot of programming that is done in VBA that is not 
finance‐related.

A macro is a collection of commands that are performed in a set order. 
A macro enables you to repeat operations that you would normally do by 
hand, but it is much faster and, when written correctly, much more reliable. 
Often, a macro will do in seconds what takes hours or days by hand. It can 
also perform tasks that are physically impossible manually. If you find you 
are performing the same commands or actions over and over again, in ex-
actly the same sequence, you can create a macro to record all those actions 
for you. You can then assign the macro to a button and run it using a single 
click, or you can even assign the macro to a keyboard command.

Macro Settings

Before we begin creating macros, there are a few settings in Excel you’ll 
need to change:
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■■ Showing the Developer tab in the Ribbon is not strictly required to re-
cord and run macros, but it contains tools that make it easier to run and 
edit macros, as well as some handy control tools and buttons.

■■ Changing the security settings is required, and you must change this set-
ting if you want to run macros.

The default installation version of Excel does not have these settings. 
You will need to change these settings only once, and you will not need to 
do it again unless you reinstall Excel, or move to another machine.

Showing the Developer Tab in the Ribbon  Whilst it is possible to record a macro 
by clicking on the launch button in the bottom left‐hand corner of your 
screen, as shown in Figure 8.26, the Developer tab contains other functions 
that are useful when developing macros and other tools, so it’s best to install 
the Developer tab.

If you do not see the Developer tab, click on File—Options—Customize 
Ribbon. Check the Developer box. Excel for Mac 2011 users go to Excel—
Excel Preferences—Ribbon and check the Developer box. For more detailed 
instructions on how to do this, read “Showing the Developer Tab in the Rib-
bon,” under “Form Controls” in Chapter 7.

Figure 8.26  Macro Launch Button
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 Setting macro Security levels   Macros perform various automated functions 
that run via executable code. While most macros are useful and harmless, 
some malicious macro viruses can destroy data or otherwise damage your 
machine. For this reason, many people decide to disable macros altogether or 
turn security up so that macros can be run only from documents written by 
trusted publishers. However, turning up the security may disable legitimate 
macros, so changing the security level is an individual decision. You may also 
want to change this setting before you open documents from different sources. 

 You will need to determine the level of security appropriate for the way 
that you work. If you only ever run macros that you have written yourself, 
then Low may be suitable. High will be diffi cult to work with, as it won’t al-
low you to run macros at all! If you are often running macros from a trusted 
location, you may choose to select the Enable All Macros option. 

 To change your macro security settings: 

   1.  Click on the File menu or the Microsoft Offi ce Button in the top left‐
hand corner of your screen. 

   2.  Scroll down to Options or Excel Options at the very bottom and select 
it. 

   3.  Select Trust Center and click on Trust Center Settings. 
   4.  Choose the desired level of security. 
   5.  Close the model down, and then reopen it.   

 In Excel for Mac 2011: 

   1.  Click on the Excel menu at the top left‐hand corner of your screen. 
   2.  Click Preferences. 
   3.  Click the Security button, and go to the Macro Security section. 
   4.  Choose the desired level of security. 
   5.  Close the model down, and then reopen it.      

 recording and running a Simple macro 

 The best way to get started with macros is to record one. 

    To reCorD A mACro  

 These are the basic steps to create a simple macro by recording it. 
In the View tab in the Macros section, click on the arrow under the 
Macro button, then Record Macro. See Figure   8.27   . 
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 In Excel for Mac 2011, click the Record button in the Developer 
Ribbon in the Visual Basic section. 

 Excel will come up with the suggested name Macro1. You can 
type over this. Macro names must be one word with no spaces. It is 
best to give the macro a name that relates to what it does (i.e., Print-
CompanyData), rather than a nondescriptive name such as Macro1. 
Type a name for the macro into the Macro Name box. You can also 
allocate a shortcut key. 

 You are now recording your macro. Every command or action 
you perform will be added to the macro. 

   1.  Perform all the actions you wish to be included in the macro. 
For example, print, save, change colour, and insert or delete 
rows and columns, will all be included in the macro if you per-
form these actions while the macro is recording. 

   2.  When you wish to stop recording the macro, click on the arrow 
under the Macro button, then Stop Recording. In Excel for Mac 
2011, in the Developer Ribbon in the Visual Basic section, click 
the Record button again, which will stop the recording.   

    Figure   8.27    Record Macro Dialog Box 
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     This macro will save within the Excel fi le you used when recording the 
macro. This macro is available whenever you have the fi le open. 

    To run THe mACro  

     1.   In the View tab in the Macros section, click the Macro button. 

 In Excel for Mac 2011, click the Macro in the Developer 
Ribbon in the Visual Basic section. 

 This will bring up the Macro dialog box, containing a list of 
all the available macros.  

   2.  Click in the list to select the macro you wish to run. 

   3.  Click on the Run button. All the actions you performed in the 
steps above will repeat themselves.   

     Practical exercise   Let’s try recording a macro that will be useful. Say you 
want to change the formatting of a cell from 150000 to $150,000—a very 
commonly performed task. (This macro will save you some time, as it’s not 
possible to change this formatting with a single mouse click or keystroke.) 
Follow these 12 steps: 

   1.  Type  150000  into cell A1 on a blank worksheet. 
   2.  Begin recording, as shown above. Call the macro  FormatCurrency . As-

sign a shortcut key (e.g., Ctrl+m), and click OK. See Figure   8.28   . 
   3.  Select cell A1, and change the formatting to $150,000. This can be done 

through the menu bar, or right‐click, Format cells, and change the cur-
rency to the desired format. 

   4.  Stop recording. 
   5.  Now we can test to see if the macro worked. Go back to cell A1 and 

change the formatting to a percentage, for example. 
   6.  Then run the macro as shown above. The formatting of cell A1 will 

revert to the formatting we specifi ed in the macro. Now we can edit the 
macro and make changes within the VBA code as follows: 
  a.  Select the Macros icon from the View or Developer tab on the Rib-

bon (the Visual Basic tab in Excel for Mac 2011). The Macro dialog 
box contains a list of all the available macros. 

  b.  Select the macro that you want to edit, and press Edit. This will take 
you into the Visual Basic for Applications coding editor, where you 
can manually edit a macro. 



Tools for Financial Modelling� 267

c.	 Change things such as sheet names or cell references, rather than 
re‐recording the macro. You can even make the macro run more ef-
ficiently by removing the duplication of the .select command.

d.	Change the code, and close down the editor.
	 7.	Try editing our macro. If you haven’t been into the VBA editor before, 

it can seem a bit scary, but don’t worry. You can always close down the 
editor to get back into your Excel model.

	 8.	The VBA editor screen should look something like Figure 8.29.
The text in green font is purely descriptive text. Any text preceded 

by the apostrophe (‘) will be ignored by the macro when running. You 
can delete or replace this with documentation of your own, describing 
what the macro does.

Take a look at the code. It contains two steps: It selects cell A1, and 
formats it as we have specified. This means that every time we run this 
macro, it will select cell A1 and format it. If we remove the reference to 
cell A1, it will change the formatting of whatever cell is selected. This is 
much more useful!

	 9.	Remove the descriptive text and the first line of code. Your code should 
now be:

Sub FormatCurrency()

Selection.NumberFormat = "$#,##0"

End Sub

Figure 8.28  Naming the Recorded Macro
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	10.	Close down the VBA editor and return to your model.
	11.	Type some random numbers anywhere in your model—even on a differ-

ent page.
	12.	Select the cells and run the macro by using the shortcut. These numbers 

should change to your desired format.

Note

The next time you save this file, it will prompt you to save it as a Macro Enabled File type 
(.xlsm), or you may get the warning message shown in Figure 8.30. If you click Yes on the 
warning message, this will save it as Macro-free workbook (.xlsx), then all your macros will 
disappear! As soon as you start creating a macro, save it immediately as a Macro Enabled 
file.

Figure 8.29  Viewing the Recorded Macro in the VBA Editor

Figure 8.30  Macro‐free Workbook Warning
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    HoW To CreATe A SHAPe  

     1.  On the Insert tab, in the Illustrations group, a Drawing Shape 
can be used as a macro button. Use Autoshapes (Insert—Shape 
. . . in Excel for Mac 2011). The style can be changed to look 
like a coloured rectangular button. 

   2.  Right‐click to add descriptive text (e.g., Press Me or Run Macro). 

   3.  Right‐click to assign the macro to the button. Whenever you 
press this button, the assigned macro will automatically run.   

 Alternatively, the more traditional macro button can be used. 
 If you wish to create a traditional form macro button in later ver-

sions of Excel, it’s still possible, but it’s been hidden very well. You 
need to have the Developer tab showing before you can create these 
buttons. See the explanation from earlier in this chapter on how to 
make the Developer tab show in the Ribbon. 

    HoW To CreATe A TrADiTionAl Form buTTon  

     1.  On the Developer tab, in the Controls group, select the Insert 
button and select the Form button. In Excel for Mac 2011, on 
the Developer tab, in the Form Controls group, select the But-
ton button. 

   2.  Now click and drag over the spreadsheet to create the shape. 

   3.  When you let go of the mouse button, the Assign Macro dialog 
box will appear. Select appropriate macro. 

     Creating macro buttons 

 You can assign a macro to almost any object or shape on your Excel 
worksheet, including shapes, buttons, and even combo‐box drop‐downs. 
The most commonly used object is a rectangular‐shaped button. There 
are two ways of creating these buttons, either as shapes or traditional 
form buttons. 

(continued)
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 macros in Financial modelling Case Studies 

 There are hundreds of situations where macros can save time and increase 
accuracy. They might not necessarily be built and saved within fi nancial 
models, but they could be used in the collection of the data that goes 
into the model. Here is a small sample of a few of the most common 
problems in fi nancial modelling that are solved by macros. You can 
download some of these example models at  www.plumsolutions.com
.au/book . 

 ■    A company is doing a salary comparison between different countries, 
and wants to know how much they would need to pay in Malaysian 
ringgit so that their salary is the same as someone working in Singa-
pore. If a worker in Malaysia earns the equivalent of 100,000 MYR 
after tax, how much would the company need to pay the worker be-
fore tax? The problem is that tax is calculated on pretax salary, so our 
formula gives us a circular reference. We can use a macro with a goal 
seek to repeatedly set the pretax salary to the amount entered by the 
user. 

 ■    Fifty identical budget templates have been created, and you discover a 
formula needs to be changed. Instead of making the change 50 times, 
record a macro. It will be much quicker and far less prone to error. 

 ■    A nonprofi t organisation sets its pricing so that all costs are fully 
recovered to break even. The costs keep changing, though, and the 
user is a senior account manager who doesn’t know how to do a 
goal seek in Excel. The modeller creates a simple macro using a goal 
seek so that all the user needs to do is change the costs and press the 
button to fi nd out how much the pricing needs to change under the 
new costing. 

 ■    A dump of information containing several thousand rows is exported 
from a database into Excel every day. The data needs to be format-
ted and manipulated manually to be used in a daily takings report. 
Automating this with a macro can literally save hours of manual data 
manipulation. 

   4.  To change the assigned macro, right‐click on the shape and click 
on Assign Macro. 

   5.  You should add the appropriate text and format the shape with 
colour, shadow, and so on.   

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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■■ A reporting model is built using a PivotTable, but when new data is en-
tered, the user sometimes forgets to refresh the PivotTable. The modeller 
builds a button to refresh a PivotTable every time it’s pressed.

Dangers and Pitfalls of Using Macros

Wonderful as they are, macros should always be used with caution. Quite 
often formulas or filtering will achieve the desired result, without the need 
for building a macro. Always try a formula or standard Excel solution be-
fore considering the inclusion of a macro in your model.

■■ Unless ranges are defined properly using relative cell references, macros 
don’t move their references the way that formulas do, and therefore 
named ranges are recommended when building macros. If any data has 
moved since the macro was written, the macro will refer to the wrong 
cell. A badly written macro can copy and paste over data, and you won’t 
know what it has done!

■■ Visual Basic is a complex programming language, and a skill that many 
people don’t have. Therefore, many people are not able to edit or follow 
what a macro is doing—especially if it hasn’t been documented properly.

■■ Macros are time consuming to write, and often a much quicker and more 
transparent solution can be built just as easily with a plain formula.

■■ Running macros requires security settings to be changed (as shown above), 
and if your model is used by other people, they may not realise they need 
to change their settings, causing the model to not work properly.

■■ Macro‐enabled files need to be saved in.xlsm file format. If they are ac-
cidentally saved as an .xlsx macro‐free workbook, the macros will be 
removed from the file. If this happens, the macros have been deleted, 
and you’ll need to either rewrite the code, or copy it back in from a 
backup copy!

■■ Unless you will be maintaining the model yourself, most business Excel 
users have more than enough to do without also trying to learn how to 
program.

■■ If you’re the one running the macro each time the model needs to be 
updated, that’s fine, but what will happen after you’re gone? If the pro-
cess stops working due to a macro problem, it can hold up monthly 
procedures significantly.

Basically, there are more things that can go wrong if a financial mod-
el contains macros. When it comes to building financial models, consider 
whether a VBA solution is absolutely necessary before including it in your 
model. Macros should not be used unless there is no other option!
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Summary

The tools for financial modelling covered in this chapter range from the ba-
sic, such as hiding and grouping, to more complex tools such as macros and 
array formulas. As always, we try to make our models as simple as possible, 
and as complex as necessary. Therefore, if you can create a model using just 
basic functions and tools, by all means, do so.

If, however, you find that your simple solution does not provide your 
model with the desired functionality, then you may consider including a 
more complex nested formula, or even possibly a macro. The best sort of 
financial models are those that are clearly laid out and use very simple and 
clearly defined tools—not because we don’t know how to create complex 
models, but because they are easier to follow. So, in conclusion, it’s very dif-
ficult to be a top‐notch financial modeller without knowing all the complex 
tools and functionality in Excel, but that does not mean that you should use 
these tools in every model. On the contrary, complex tools should be used 
only when absolutely necessary.
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Chapter 9
Common Uses of Tools in 

Financial Modelling

Now that we know how to use many of the useful tools, functions, and fea-
tures of Excel, let’s take a look at actually using these tools to solve com-

mon problems, calculations, and situations encountered in financial models.

Escalation Methods for Modelling

There are several different ways of applying a growth, indexation, or escala-
tion method over a period of time to a principal amount. We often need to 
be able to include escalation in our models for the purpose of forecasting 
sales growth year over year, for example, or increasing costs by an inflation 
amount. Calculating a growth amount might seem straightforward initially, 
but there are several different methods that can be used, and when applying 
growth rates in a model you need to be clear about which method you are 
using.

Whilst we can use functions to calculate future values based on set or 
varying growth rates, we’ll first calculate them manually so that we under-
stand the mechanics of the calculations, and then use the functions.

Using Absolute (Fixed) Growth Rate

Here we have compound growth over five years at a fixed interest rate. 
The capital grows each year by 5 percent. At the simplest level, our for-
mula is base amount*(1+growth). The reason we are adding 1 (effectively 
100 percent) to the growth rate (5 percent) is that we want the capital 
sum returned along with the accrued interest. Multiplying an amount by 
(1+growth) is a very common calculation in financial modelling.
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Exercise: Fixed and Compounding  You can create this example yourself in the fol-
lowing four steps, or you can find this template, along with the accompany-
ing models to the rest of the screenshots in this book, at www.plumsolutions 
.com.au/book.

	 1.	Create the exercise, as shown in Figure 9.1. The rate is fixed in a single 
cell (B4). Therefore we need an absolute reference, namely $B$4. So, af-
ter the first year (in 2018) create the formula in cell C7: =B7*(1+$B$4).

	 2.	Copy the formula in C7 to cells in D7 through G7.
This method grows the amount at a fixed rate, which compounds 

each year.
With most models we normally want to show the amount that is 

forecast in each year, but if you want a shortcut formula that will show, 
in a single cell, how much we’ll have at a fixed, 5‐percent growth after 
five years, we can use the Future Value (FV) function. Let’s verify the 
amount you calculated for the year 2022 by using this function.

	 3.	Somewhere in a cell to the right of this table, enter Excel’s FV func-
tion. Either type =FV( into the cell and follow the prompts, or select FV 
from the function wizard. Because there are no periodic payments being 
made, we need to include the yearly rate, the period in years, and the 
present value (PV).

	 4.	Prefix the function with a minus symbol to get a positive result. Your for-
mula should be =‐FV($B$4,5,0,B7), and the totals using both methods 
should be the same. Your sheet should look something like Figure 9.2.

Exercise: Fixed and Non-Compounding  Another variation on this escalation meth-
od is to still use a fixed growth rate, but not compound it. To do this, we will 
use an escalation index across the top. This may be more practical in some 
model designs, but bear in mind that it yields different results. See Figure 9.3.

Figure 9.1  Fixed, Compounding Exercise

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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	 1.	In row 10, create your escalation index row using the formula 
=B10+$B$11 in cell C9, and copying across.

	 2.	Escalate in cell C14 by using the formula =$B$14*C10, and copying 
across.

This formula gives you a lower result in Year 5 than the exercise exam-
ining fixed and compounding interest because it is not compounding on the 
previous year. It simply adds a flat $5,015 × 5 percent each year, instead of 
adding the growth rate to the increased total.

Using Relative (Varying) Growth Rates

The next example returns the future value of an initial principal after apply-
ing a series of interest rates. While the rate was fixed in the example above, 
here it fluctuates from year to year. This is considered to be a superior model 
design, as it allows for fluctuation of growth rates. Even if the growth rate 
does not change from year to year, by building the model in this way, we are 
allowing for changes in the future. By using the aforementioned design with 
a single growth rate, we are restricted to having only a rate that does not 
change. See Figure 9.4.

Figure 9.2  Completed Fixed, Compounding Exercise

Figure 9.3  Fixed, Non‐Compounding Exercise



276� Using Excel for Business Analysis

We’ll no longer use absolute references for the interest rate, but will al-
low both it and the value to change from year to year as we copy the formula 
across D22 through to G22. Cell C22’s formula is base amount*(1+growth), 
as previously, but this time the growth does not have an absolute reference 
applied to it. =B22*(1+B19).

Exercise: Relative and Compounding
	 1.	Complete cell C22 in the exercise workbook to achieve the result above, 

then copy the result to the right.
Let’s try a shortcut function to get directly to the results without go-

ing through the annual calculations.
To the right of the results, enter Excel’s FVSCHEDULE function to 

verify the figure for 2022.
Use the function FVSCHEDULE in your exercise spreadsheet.
Your sheet should look something like Figure 9.4.

Exercise: Relative and Non-Compounding  In this next example, we are using an-
other escalation index across the top. See Figure 9.5.

	 1.	In row 25, create your escalation index row using the formula =B25+B26 
in cell C25, and copying across.

Figure 9.4  Relative, Compounding Exercise and FVSCHEDULE Function

Figure 9.5  Relative, Non‐Compounding Exercise
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	 2.	Escalate in cell C29 by using the formula =$B$29*C25, and copying across.
This formula gives you a lower result in Year 5 than of the fixed and 

compounding example because it is not compounding on the previous year.

Using Exponential Operations on an Absolute  
(Fixed) Growth Rate

This exercise is similar to the first one, except that we will include the use 
of the caret symbol (^) to perform exponential (to the power of) operations. 
For instance, 3 × 3 × 3 = 27. So does 33 and, in Excel’s equivalent, 3^3.

Exercise: Complex Escalation  Figure 9.6 shows compound growth over a pe-
riod at a fixed 5 percent per annum interest rate.

Our formula will allow for start and end dates to the period, in the form of:

Base amount*((100%+growth)^(End year‐Start year))

Excel will perform the exponential operation before the multiplication, 
so the encompassing set of parentheses is not essential. The formula in C37 
is therefore

=$B$37* (1+$B$4)^(C36 $B$36)−( )

Note that instead of using End year‐Start year, you may also insert a 
helper row at the top to link to instead, which makes a slightly less complex 
formula. The next exercise shows how this can be used.

	 1.	Complete the formula for cell C37 and copy it across to achieve the 
results in the diagram above.

	 2.	The function =FV(B34,G36-B36,0,B37) will verify the answer for the 
year 2022.

Figure 9.6  Complex Escalation
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Practical Usage of Exponential Growth Rates

You will notice that we achieve the same result ($6,401) under the fixed, 
compounding exercise as we did under the relative and compounding exer-
cise, but with a far less complex formula. Using exponential growth rates is 
useful when you need to compound the growth rate, but want each cell to 
operate independently.

If, for example, you have start dates and end dates that need to be in-
cluded in a formula as well as compounding escalation, you will need to use 
exponential growth rates. In Figure 9.7, we will create a formula to evaluate 
the start date and end date, only inserting the cost in the relevant years and 
then compounding the inflation.

This will require the IF and AND functions to be used in combination to 
establish whether the column heading year falls within an employee’s start 
and end dates.

For instance, in English terms we will be checking that IF(AND(2017 
> = Employee Startdate,2017<, = Employee EndDate) is true before writing 
inflation‐escalated costs into the appropriate cell of column F. Otherwise we 
will write a zero.

Use the term in years (row 5) to exponentially escalate the costs (in col-
umn C). For instance, if the year 2017 (F6) meets the IF test, F7 will equate 
to Cost*(1+inflation)^0, which leaves it, in this case, unchanged.

Your formula should be:

= IF(AND(F$6,<= $E7,F$6 >= $D7),$C7 *(1 + inflation)^ ,0)F$5

And the sheet should look something like Figure 9.7.

Understanding Nominal and Effective (REAL) Rates

From a financial modelling perspective, there are two interesting aspects of 
nominal and effective rates that we should be aware of.

	 1.	Escalation calculations. We need to consider whether an escalation, 
growth rate, or indexation amount includes the effect of inflation (i.e., 
whether it is real or effective) and what this actually means in real terms.

	 2.	Loan calculations. When comparing and calculating interest rates, the 
frequency of compounding can make a difference to the amount of in-
terest actually paid. This can be calculated in Excel using the EFFECT 
and NOMINAL functions.
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When including escalation or growth rates into a financial model, we 
sometimes need to consider whether the growth percentage is expressed as 
a nominal or real rate. Normally we express the growth percentage as a 
nominal rate, meaning that we don’t take into consideration the effect of 
inflation or other factors that would impact the value of that rate. The real 
or effective rate will include the effect of other factors, such as inflation, to 
give you the real or adjusted value.

For example, if you earn a $100,000 salary, and after a year of working for 
the company, your boss unexpectedly gives you a raise of 10 percent, you think 
you’re going to have an extra $10,000 in your pocket, right? Well, not exactly. 
Theoretically, in the 12 months since you began working for the company, 
your cost of living has increased and eroded the purchasing power of your 
salary. Therefore, if we assume that the consumer price index (CPI), or rate of 
inflation, is 3 percent, then your $100,000 is not buying you as much now as it 
did when you first started the job. To calculate the effective salary increase that 
you received, you’d need to deduct the inflation from the raise. Your nominal 
increase was 10 percent, but the real or effective raise was only 7 percent.

Normally when modelling escalation amounts, we use the nominal rate, 
and we know, when considering the calculations, that it does not take into ac-
count the purchasing power in the future. For example, in the exercise described 
in the previous section, we indexed the sales revenue at 5 percent, as shown 
below. It goes without saying that the 5 percent is a nominal amount. We know 
that the $6,401 that is received in Year 5 is not really $6,401 in today’s terms 
because inflation will have eroded its purchasing power. See Figure 9.2.

If we wanted to compare an investment in today’s terms, we’d need to use 
the effective rate, and to calculate this, we would simply deduct the inflation 
amount—let’s say it’s 3 percent—from the growth rate, and hence our effective 
growth rate is 2 percent. As always, we need to be very explicit about the rates 
we have used. Note that expressing amounts in effective terms is not commonly 
used in financial models and unless otherwise stated the user would assume 
that a rate is nominal. Therefore, if you choose to use an effective rate, make 
sure that you state it clearly as an assumption, as shown in Figure 9.8.

Adjusting Loan Rates with NOMINAL and EFFECT Functions

Calculating effective growth rates as outlined above is quite simple, and 
we certainly don’t need a dedicated Excel function to calculate them. There 
is another use for the nominal and effective concept in finance, and the 
calculation is far more complex. Nominal and real rates affect mortgage 
calculations, too. As discussed in “Loan Calculations” in Chapter 6, due 
to the effect of compounding, we actually pay a higher interest rate than is 
expressed in the nominal rate when quoted by the lender. Most loans are 
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calculated and compounded daily, and therefore every single day we pay 
interest on the interest that was charged on the previous day.

The nominal rate is basically the simple interest rate for the complete 
period of the mortgage (i.e., the rate you are quoted when you take out 
the loan). The effective rate takes into account the compounding and will 
therefore be higher, depending on how frequently the loan is compounded.

The nominal and effective rates in Excel are related as follows:

Effective interest rate
Nominal interest rate= +





−1 1
N

N

where N is equal to the number of compounding intervals in the year.
As usual, Excel has made these calculations simple for us by offering 

two important predefined functions to convert nominal to effective rates, 
and effective to nominal. These are NOMINAL and EFFECT.

=NOMINAL() This function returns the annual nominal interest based 
on the effective rate and compounding intervals in the year. The syntax for 
this command is:

■■ NOMINAL(Effective_Rate, Compounding_Period), where
■■ Effective_Rate: The effective interest rate for the year.
■■ Compounding_Period: The total number of compounding intervals 
in the year.

=EFFECT() This function returns the effective interest based on the an-
nual nominal rate and compounding intervals in the year. The syntax for 
this command is:

Figure 9.8  Assumption Documentation in Growth Calculations
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■■ EFFECT(Nominal_Rate, Compounding_Period), where
■■ Nominal_Rate: The annual nominal interest rate for the year.
■■ Compounding_Period: The total number of compounding intervals 
in the year.

The next exercise shows how the effective rate can be calculated from 
nominal rate.

Exercise: Comparing Two Nominal and Effective Interest Rate Offers  Let’s say you 
need to borrow some money, and you’re offered two different interest rates 
from competing lenders.

	 1.	Lender A is offering a nominal rate of 7.9 percent, compounded daily.
	 2.	Lender B is advertising an effective rate of 8.2 percent, compounded 

monthly.

Which is the best deal? Here are three steps to arrive at the answer:

	 1.	Set up the inputs side by side, so that you can compare the effective rate, 
as shown in Figure 9.9.

	 2.	Calculate the effective rate of Offer A using the EFFECT function.
	 3.	Your formula in cell B4 should be =EFFECT(B2,B3).

The effective rate of Offer A is 8.2219 percent, which means that Offer 
B is in fact a lower effective rate.

Let’s calculate the nominal rate of Offer B, for interest’s sake.

	 4.	Your formula in cell C2 should be =NOMINAL(C4,C3).

Let’s see what effect the number of compounding periods has on the 
rate. If Lender A had compounded monthly instead of daily, would that 

Figure 9.9  Comparison of Interest Rates
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have made a difference to the effective rate? It certainly would! Change the 
number of periods in cell B3 from 365 to 12, and we will see that this drops 
the effective rate to just slightly lower than that of Offer B. See Figure 9.10.

Although only a very simple calculation, this is a good example of how, 
by following financial modelling best practice and linking the formulas to 
the hard‐coded input variables, we can easily perform sensitivity analysis on 
our numbers by changing the calculation assumptions.

Calculating Cumulative Totals

As always, we try to follow best practice when building financial models, 
and one of the important points of best practice is to ensure that formulas 
are as consistent as possible. Calculating cumulative totals is a common cal-
culation in financial modelling, and this is one such situation where ensuring 
consistent formulas can be tricky.

We need to calculate the cumulative number of customers in order to 
calculate the revenue, and Figure 9.11 shows one solution to the problem. 
It will achieve a correct total, but it necessitates using different formulas in 
adjacent cells.

Figure 9.10  Comparison of Rates with Changed Compounding Periods

Figure 9.11  Cumulative Totals Using Inconsistent Formulas
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Sometimes this is the only solution (without creating an overly compli-
cated formula) and, if necessary, you may simply need to resign yourself to 
the fact that consistent formulas are not possible. There is, however, a simple 
solution: Using the formula =SUM($B$3:B3) and then copying it across will 
achieve the same result with consistent formulas, as shown in Figure 9.12.

How to Calculate a Payback Period

There is no suitable formula in Excel for calculating a payback period. How-
ever, there are a couple of different ways of doing it manually. Demonstrat-
ed below are two methods, but this is by no means an exhaustive list. The 
first method is very simple, but not very accurate, and the second is quite 
long‐winded, but more precise. You can find this template, along with the 
accompanying models to the rest of the screenshots in this book, at www 
.plumsolutions.com.au/book.

Simple Payback Calculation

In a business case summary as shown in Figures 9.13 and 9.14, we can 
see that the payback period (the point at which the sum of our cash flows 
becomes positive) is between three and four years—at 2020. We can easily 
estimate this by highlighting the cash totals for each year and looking at 
the sum amount at the bottom right‐hand corner of the page. However, we 
would like to create a cell that automatically calculates the payback year so 
that as inputs change due to scenario and sensitivity analysis, the payback 
year will always be shown in the model, based on the cash flow amounts.

	 1.	In row 14, create a formula that calculates the cumulative amount of 
cash. See “Calculating Cumulative Totals” later in this chapter for how 
to do this. Your formula should be =SUM($B$13:B13).

Figure 9.12  Cumulative Totals Using a Consistent Formula

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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	 2.	In cell B16, insert a formula that will return the year in which the cumula-
tive cash amount becomes positive. Remember that we want to look along 
the row and find the moment at which it becomes zero or greater. Your 
formula should be something like this: =LOOKUP(0,B14:K14,B3:K3).

	 3.	Note that this formula is looking for a close match, which means that 
it will look along row 14 until it finds zero, and it will return the value 
before it passes zero. In this case, it will find the value under 1,677,907, 
as this is the last value before zero.

	 4.	This will give you the value 2019, but we actually want 2020, so 
simply add a +1 to the end of the formula. Your formula should be: 
=LOOKUP(0,B14:K14,B3:K3)+1.

	 5.	Alternatively, you could add the cumulative calculation in row 14, and 
then use an HLOOKUP function to find the year at which the cumula-
tive cash flow becomes positive. In this case, your formula in cell B16 
would be =HLOOKUP(0,B2:K3,2,TRUE)+1. Having the cash flow 
showing above the years looks a little odd, so you’d probably hide it. I 
prefer the LOOKUP solution for this reason.

Note that this method is only a sample of several different tools 
and functions that could be used to calculate the payback period. For 
example, you could use a nested IF function instead, and an INDEX/
MATCH combination. See Figure 9.14 for what your completed version 
could look like.

As the numbers for your business case change, so will your payback 
year. The result is only a rough estimate. For a more specific (albeit theoreti-
cal) payback date, we can use a more complex calculation, as shown by the 
following.

Figure 9.14  Completed Simple Payback Calculation



Common Uses of Tools in Financial Modelling� 287

More Complex Payback Calculation

If you want to see exactly the year and month at which (theoretically) your 
project turns a profit, there is a more complex method. This way is also quite 
straightforward, but a little more time consuming.

	 1.	On a new sheet, in column C, type in 1 Month, 2 Months . . . 1 Year and 
1 Month, and so on, up to 10 years or so.

	 2.	In column A, insert the years that correspond with the months. In this case, 
the first year is 2017, so enter 2017 into cell A2. Copy this down, and 
change it to 2018 after 12 months. This can be most easily done by entering 
the formula =A2+1 into cell A14, and copying it right down to the bottom.

	 3.	We are going to use column A as the criteria to pick up the cash in each 
year. In column B, enter a formula that will reference the profit and loss 
(P&L) page, and return the cash for that year, which should be divided 
by 12 to show the cash for each month. Your formula in cell B2 should 
be =HLOOKUP(A2,'P&L'!$B$3:$K$13,11,0)/12. This is (theoretical-
ly) how much cash the project has cost after one month of operation. 
We are assuming, in this formula, that the sheet that contains your cash 
flow is called P&L.

	 4.	Then make this a cumulative amount in column B, by changing the for-
mula in Month 2 so that it adds to the previous total. Your formula in 
cell B2 should be =HLOOKUP(A3,'P&L'!$B$3:$K$13,11,0)/12+B2. 
Copy this down the column.

	 5.	Your sheet should look something like Figure 9.15.
Unfortunately, the cumulative SUM calculation that was performed 

in the last exercise will not work in this instance, so we need to create 
an inconsistent formula. If this really bothers you, you could add a row 
and put a zero in cell B2 instead, so that the formulas are consistent.

	 6.	Continue this calculation right down the page until you reach Year 7 or 
8, or as far as you want your payback calculations to work. Remember 
that if you’re doing sensitivity and scenario analysis on this later, you 
don’t want the formula to return an error if the calculations can’t handle 
a larger value, so go down a little bit further than you think you’ll need.

	 7.	You can now perform a close-match VLOOKUP or LOOKUP, which 
will return the year and month at which the return becomes positive. 
This is the payback period.

	 8.	Enter the formula =VLOOKUP(0,Payback!B1:C200,2,TRUE) in the 
payback period cell on the P&L sheet. This will return the exact month 
and year that the project will (theoretically, of course) become profitable. 
See Figure 9.16. Of course, the close-match VLOOKUP will return the 
value preceding the value which is greater than zero. You may deem this 
to be close enough, or else move the months and years down by one row.
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Figure 9.15  Payback Period Workings

Tip
There is some debate as to whether payback period should be discounted or not. I gen-
erally do not discount payback periods (as shown in this example), but whether or not 
it has been discounted needs to be stated clearly in your assumptions.

Weighted Average Cost of Capital (WACC)

Before investing in a project or new venture, we need to evaluate whether 
the expected returns justify the risks. Many financial models are built for the 
purpose of new project evaluation, and the most commonly used tools that 
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we use for evaluating the expected returns are NPV (net present value), IRR 
(internal rate of return), and payback period. How to calculate these measures 
is discussed in detail in “Financial Project Evaluation Functions” in Chapter 6.

However, in order to calculate the NPV, we need to know our cost of 
capital or our required rate of return for the project. You may also hear the 
cost of capital referred to as the discount rate or hurdle rate. The cost of cap-
ital is basically the opportunity cost of the funds invested, or, in other words, 
the rate of return that investors would expect to receive if they invested the 
money somewhere else, rather than in this particular project. In effect, by 
investing in the business, the investor is willing to forego the returns from 
other avenues. Therefore, cost of capital is the minimum required return 
for a project—the returns need to be greater than the cost of capital for the 
project to be accepted.

The importance of WACC is that it becomes a baseline to determine 
suitable investments for success of the business. WACC is typically repre-
sented as a percent, so any investment decisions taken by the company must 
aim to deliver returns greater than the WACC to make them worthwhile. 
For example, if the WACC of a company is 15 percent, then most of the 
investments that the company makes must be with the goal of generating 
returns greater than 15 percent. WACC is not just calculated to the entire 
company or business. It can also be calculated for individual projects to 
determine if it is worthwhile for the company to pursue the project.

Company capital is sourced from many avenues and is targeted for 
various areas of business growth and sustenance. Typically, the two major 
sources of capital are debt and equity. Both these tools are distinctly differ-
ent, have different costs, and hence need to be considered differently in our 
calculations. As a result, not all capital carries the same weight, which is 
why we sometimes need to calculate the WACC in order to work out how 
much our capital is worth. Sometimes when calculating the NPV of a proj-
ect, a modeller may simply use a nominated cost of cost capital (we used a 
rate of 12 percent in the section “Net Present Value” in Chapter 6), but to 
evaluate a project more accurately, we can calculate which WACC will give 
us the exact cost of capital for that company. Note that the WACC will be 
completely different for each company, depending on its individual mix of 
equity and debt.

How to Calculate the WACC

The WACC is the average return on capital weighted proportionally based 
on category. Typically, a company sources its capital from stocks (common 
and preferred), bonds, and long‐term debts. Each category of capital is 
invested in different avenues to help the business sustain and grow. WACC 
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represents the average cost of capital with proportional contributions from 
the various sources.

WACC can be calculated using the given formula:

WACC =
Debt

Debt + Equity
Cost of Debt (1- Tax Rate)

+
Equity

De

×








 ×

bbt + Equity
Cost of Equity×











where
Debt equals total capital raised from debts.

Equity equals total capital raised from equity. Note that if the company 
has common and preferred shares, then the two need to be weighted 
and factored accordingly.

Cost of debt equals the cost of raising the debt. If taken as bank loans, 
then it is the interest that needs to be paid to the banks.

Cost of equity equals the return that the shareholders or investors ex-
pect from their holding in the company. Common ways of calculat-
ing this are the capital asset pricing model (CAPM) or Gordon’s 
growth model.

Tax rate equals the prevalent corporate tax rates.

Exercise: Calculating the WACC in Excel  While the formula looks very complex, 
once the concepts are clear, WACC can be calculated relatively easily in 
Excel. Let’s do an exercise where we need to manually calculate the WACC.

Let’s say you have the following inputs:

■■ Debt is $6,023,000, for which you are paying 8.5 percent.
■■ Equity is $4,421,000, for which you expect a return of 15 percent.
■■ Tax is 30 percent.

	 1.	Set up your sheet as shown in Figure 9.17.
	 2.	In row 4, calculate the cost of debt and equity before tax.
	 3.	Your formula in cell B4 should be =B2*B3. Copy it across to cell C4.
	 4.	In row 6, remove the tax from the debt amount.
	 5.	Your formula in cell B6 should be =B4*(1‐B5). Copy it across to cell 

C6. Although there is no tax applicable to the equity amount, we’ll still 
copy the formula across to maintain consistency of formulas (hence fol-
lowing best practice).

	 6.	Add together the value of debt and equity in cell D2, and cost after tax 
in cell D6.



292� Using Excel for Business Analysis

	 7.	 Now calculate the WACC, which will be the cost after tax of debt 
and equity as a proportion of the total.

	 8.	 Your formula in cell D7 should be =D6/D2, and your worksheet 
should look something like Figure 9.18.

Hence the weighted average cost of capital for this company is 9.78 percent. 
This means that when this company is evaluating new opportunities, the mini-
mum required rate of return would be 9.78 percent, as this is what its capital 
is currently costing it. When calculating the NPV for a new project, this would 
be the input for the discount rate in the NPV function. Theoretically, the NPV 
at this discount rate must be greater than zero, and the IRR of a series of cash 
flows needs to be higher than this amount in order for a project to be accepted.

Figure 9.17  WACC Calculation Layout

Figure 9.18  WACC Completed Calculation
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Building a Tiering Table

Calculating an amount based on tiering tables is a pretty complex formula, 
and is commonly used in pricing models. There are two types of tiering 
tables (also called volume breaks, block, or stepped pricing). The simplest 
version calculates the entire amount at the tier. The more complex table, like 
the tax tiers, is progressive such that the first number of units is calculated 
at the first tier and the next number of units at the next tier, and so forth.

For example, in a tax table where an income of $8,000 would be taxed 
at zero for the first $6,000 and then the next $2,000 is taxed at 15 percent, 
you would only pay $300 (15 percent of $2,000), not 15 percent on the 
whole amount.

Flat Tiering Structure

Let’s say, for example, you have the pricing structure shown in the pricing table 
in Figure 9.19. If the customer purchases 5 items, each item costs $15, but if 
the order is for between 6 and 50 items, they are priced at $12 each, and so on.

We’d like to calculate how much a customer would be charged at dif-
ferent volumes.

A horribly long and complicated IF statement will do the trick:

= IF(A3<F3,G3, IF(A3<F4,G4, IF(A3<F5,G5, IF(A3<F6,G6,G7))))

But there is a much simpler way, using a close‐match VLOOKUP or 
LOOKUP.

	 1.	In cell B3, calculate the per‐unit price using a close‐match VLOOKUP. 
Your formula should be:

= VLOOKUP(A3,$E$3:$G$7,3,TRUE).

Note

Note that we could also omit the last field like this: =VLOOKUP(A3,$E$3:$G$7,3). Both will 
return a close match, not an exact match, but I prefer to include the TRUE because it shows 
that we are deliberately creating a close-match VLOOKUP and we haven’t simply forgotten to 
put something in the last field.

	 2.	Multiply the unit price by the number of units and add them up. Your 
total should be $7,564, and your sheet should look something like 
Figure 9.19.
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Figure 9.19  Completed Flat‐Tiered Pricing Calculation

Tip
Because we need a close match, not an exact match, we could have used the LOOKUP 
function instead like this: =LOOKUP(A3,$E$3:$E$7,$G$3:$G$7).

This has the added advantage of not having to have the criteria to the left of the result 
because LOOKUPs are able to search backward. You also do not have to worry about 
someone inserting or deleting columns in the source data range and messing up the 
formula. For greater detail on how to use LOOKUPs and VLOOKUPs, see “LOOKUP 
Formulas” in Chapter 6.

Progressive Tiering Structure

If the tiering calculation is not as straightforward as the one in Figure 9.19, 
we may need to calculate under a progressive tiered structure. A good 
example of this is the way that the Australian tax calculations work, as 
shown in Table 9.1. This formula calculation is not for the faint‐hearted, 
so unless you specifically need to calculate a progressive tiering table, 
feel free to skip this section. You can find this template, along with the 
accompanying models to the rest of the screenshots in this book, at www 
.plumsolutions.com.au/book.

The first person’s salary is $123,130, which means that this person is 
in the $80,000 to $180,000 tax bracket. However, we can’t do a flat tiering 
calculation on this because the first $18,200 is tax‐free, the next bracket is 
only taxed at a rate of 19 percent, and so on. The formula in column I takes 
care of the calculations below the threshold. Note that the tiers begin with 
one cent (e.g., $18,200.01).

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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Tip
Hint: This calculation will be easier if you calculate these in separate cells, and then 
combine them at the end—just like we have done with previous examples of nested 
functions, such as INDEX/MATCH or VLOOKUP/COLUMN.

Figure 9.20  Tiered Personal Australian Tax Calculation Example

You’ll need to split your calculation into several parts, as shown in 
the diagram above. First work out the lowest tier, and then calculate the 
difference between the salary and the tier (in this case $80,000). Then the 
remainder should be calculated at the marginal tax rate.

	 1.	Start by using a close-match VLOOKUP to pick up column I (the 
amount payable up to the threshold). Your formula should be 
=VLOOKUP(C2,$F$2:$I$6,4).

	 2.	Next, we need to work out the amount over the total salary that is 
above the lowest tier (in this example, $123,130=$80,000=$43,130). 
To do this, we’ll do another close-match VLOOKUP returning the first 
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column and subtract this from the salary amount. In a separate cell, 
your formula should be =C2-VLOOKUP(C2,$F$2:$F$6,1). Your an-
swer should be $43,130.

	 3.	Next, we need to find out how much to multiply the $43,130 by (i.e., 
the highest tax tier). To do this, create a VLOOKUP returning the third 
column. Your formula should be =VLOOKUP(C2,$F$2:$H$6,3). Your 
answer should be 37 percent.

	 4.	Now, put all three formulas together like this:

= VLOOKUP(C2,$F$2 : $I$6,4) + (C2 - VLOOKUP(C2,$F$2 : $F$6,1))

*VLOOKKUP(C2,$F$2 : $H$6,3).

The good news is that if you’ve used cell referencing correctly, you can 
simply copy the formula down. See Figure 9.21.

Modelling Depreciation Methods

How we treat capital expenditure, its effect on cash flow, and the subsequent 
depreciation is an important part of financial modelling—especially if your 
model includes a P&L statement, cash flow, and balance sheet. Capital ex-
penditure is recorded in several different places:

	 1.	In the cash flow in the period in which it was purchased.
	 2.	On the balance sheet as a fixed asset.
	 3.	On the P&L statement as depreciation over the useful life of the asset.

In this section, we will focus on translating a purchase of a fixed asset 
into a depreciation charge to be shown on the P&L.

Figure 9.21  Completed Progressive Tiered Calculation
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Why Depreciate?

The definition of a fixed asset is an asset that is used in production, or that 
supports business activities in some other way. Common examples are ma-
chinery, vehicles, and equipment such as computer hardware. Fixed assets, 
by definition, have an expected useful life of more than 12 months, and the 
cost of these assets must therefore be written off as an expense over the pe-
riod in which they are used. Depreciation is the charge calculated to write 
off these assets over their expected useful lives.

In the examples that follow, in Year 1 we purchase a piece of machinery 
for $200,000 that has a useful life of five years (i.e., it will be generating 
income for the next five years), as shown in Table 9.1.

Instead of expensing the whole cost in Year 1, we should spread the cost 
of it over the five years, as this is a much more accurate method of showing 
the profitability in each year.

Adjusting depreciation is an attractive way for companies to increase 
expenses and lower taxable earnings, and for this reason, the regulatory leg-
islation around which method of depreciation can be used is strictly moni-
tored by the tax office. Bear in mind that finance and accounting rules differ 
between countries. Financial modellers do not need to be accountants, but 
they do need to ensure that accounting, tax, and finance rules are applied 
correctly if the calculation method is material to the model.

Depreciation Methods

In the example above, we have used the most common form of depreciation, 
which is the straight‐line method. Under this method, the cost is equally 
spread over the number of years it is in use. However, there are several more 

Table 9.1  Depreciation for a $200,000 Piece of Machinery

Year 1 Year 2 Year 3 Year 4 Year 5

Sales $150,000 $160,000 $170,000 $180,000 $190,000

Machinery ($200,000)

Net Income ($50,000) $160,000 $170,000 $180,000 $190,000

Year 1 Year 2 Year 3 Year 4 Year 5

Sales $150,000 $160,000 $170,000 $180,000 $190,000

Machinery 
Depreciation

($40,000) ($40,000) ($40,000) ($40,000) ($40,000)

Net Income $110,000 $120,000 $130,000 $140,000 $150,000
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complex depreciation methods also in use. It can be calculated either by us-
ing both a fixed rate and a fixed depreciable base value, or by varying one 
or both of these variables. For this reason, the depreciation charge each year 
as calculated by the different methods will not be the same. Figure 9.22 il-
lustrates the charges each year.

The exercise below will show step by step how to calculate deprecia-
tion using the different methods, and by doing this, we’ll see how very dif-
ferent each of the methods is. This is not an exhaustive list of depreciation 
methods; rather it’s an overview of the most common forms of depreciation 
calculations used in financial modelling.

Straight-Line Method (=SLN Function)  Straight‐line depreciation (also called 
prime cost method) is the simplest and most‐used technique that calculates 
depreciation at a fixed rate over the expected useful life of an asset. We es-
timate the residual value (salvage or scrap value) of the asset at the end of 
its useful life and will expense a portion of original cost in equal increments 
over that period. The salvage value is an estimate of the value of the asset 
at the time it will be sold or disposed of, but often it is zero. If the asset is 
expected to have a salvage value at the end of its useful life, we need to take 
the salvage cost away from the base before depreciating it. The formula for 
calculating depreciation is therefore:

( )Cost Salvage /Expected useful life+

Figure 9.22  Comparison of Different Depreciation Methods
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Figure 9.23  Asset Depreciation Example

For example, we purchase an asset for $50,000, its useful life is 10 
years, and we think we can sell it for $5,000 at the end of its useful life. 
We’d simply calculate the amount to be depreciated, which is the cost of the 
asset minus the residual value ($50,000 - $5,000 = $45,000) and divide it 
by 10, so the depreciation amount on the P&L would be $4,500 per year 
for 10 years.

It’s pretty easy to work this method of depreciation by using this sort 
of formula: = (50000 - 5000)/10, or you could use the SLN formula: 
=SLN(50000,5000,10), which will deliver the same result.

Calculating depreciation using the straight‐line method is by far the 
most common method of calculating depreciation in financial modelling.

In order to demonstrate the comparison of the different methods, let’s 
take a look at Figure 9.23, which shows an asset that has a purchase price of 
$50,000, a salvage value of $5,000, and a useful life of 10 years.

To prepare a depreciation schedule for this asset in Excel using the 
straight‐line method, the following steps are followed:

	 1.	Using an SLN formula, calculate the depreciation per year in row 11 
columns B to K.

	 2.	Your formula in B11 should be =SLN($B$5,$B$6,$B$7). This formula 
requires cost value, salvage value, and life in years.

	 3.	Once the absolute value signs have been added, the formula in B11 can 
be copied across into columns C to K. Using the straight‐line method, 
the depreciation charge for each year is the same.

	 4.	The amount in each year should be $4,500. After completing the table, 
check that the total is equal to cost less salvage value.
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Note

Unlike the other depreciation methods functions, the SLN function does not stop when it has 
fully depreciated the asset. If you continue to copy row 11 across to cell K11, you will notice 
that it continues to apply depreciation, even though the asset has been fully depreciated. 
If you have assets being fully depreciated during the life of the model, this will need to be 
calculated manually if using the straight-line method. See “Calculating Depreciation at the 
End of Useful Life” later in this chapter for how to calculate depreciation on assets that have 
been fully depreciated.

Declining Balance Value Methods

These methods are also called the reducing balance, diminishing value, or 
accelerated methods. You could argue that assets are more useful when they 
are new, and therefore depreciate more quickly in the first few years of ac-
quisition. Therefore, some companies use depreciation methods that pro-
vide for a higher depreciation charge in the first year of an asset’s life and 
gradually decrease charges in subsequent years. These are called accelerated 
depreciation methods.

Fixed Declining Balance Method (=DB Function)  The fixed declining balance 
method calculates depreciation at a fixed rate. This rate is calculated by the 
formula:

1 Salvage/Cost 1/Life− ∧(( ) ( ))

But it’s much easier using the =DB Excel function! The depreciation 
charge for each period is not the same, as the depreciation rate for a period 
is applied to the net book value at the beginning of that period, and not to 
the original cost. With this method, the starting net book value is the cost 
price, so depreciation is applied to cost and not the value of cost less salvage. 
This is because using this method, the net book value can never reach zero.

Instead of treating each year the same, the fixed declining method de-
preciates more quickly in early years and more slowly in later years. The 
book value of the asset at the beginning of the period is multiplied by a fixed 
rate (e.g., in Year 1, 10 percent of $45,000 is $4,500 of depreciation). In 
Year 2, the same 10 percent is multiplied by the remaining $40,500 of book 
value, which then gives a depreciation value of $4,050.

The most difficult part in the fixed declining method is to figure out 
the correct percentage to use for each year, which is done with a rather 
complicated algebraic formula. If you use the predefined DB function in 
Excel, however, you don’t need to be concerned with the calculations. Bear 
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in mind, however, that when Excel calculates the rate, it rounds to three 
decimal places, and this does cause the calculation to be off by a few dollars 
at the end of the useful life.

Therefore, unlike the straight‐line method, you pretty much have to use 
the Excel formula. Using the example above, your fixed declining formula 
for Year 1 would look like this: =DB(50000,5000,10,1).

Applied to the example above, to prepare a depreciation schedule for a 
particular asset on Excel using the fixed declining balance method, the fol-
lowing steps are followed:

	 1.	Using a DB formula, calculate the depreciation per year in row 12, col-
umns B to K.

	 2.	Your formula in B12 should be =DB($B$5,$B$6,$B$7,B10). This for-
mula requires cost value, salvage value, life in years, and period for 
which depreciation is being calculated.

	 3.	Note that the additional requirement of a specified period is a result of 
the depreciation calculated each year being unique to that particular 
year, or period. For this formula to return an accurate result, both life 
and period must be entered using the same unit (e.g., years).

	 4.	Once the absolute value signs have been added, the formula in B12 can 
be copied into columns C to K.

	 5.	If you create a total in L12, this will not be exactly equal to cost less 
salvage, as was the case for the straight‐line method. This is a result of 
the fixed declining balance method producing a hyperbolic function and 
not a linear function and, therefore, never allowing the net book value 
to be zero.

	 6.	Once the table has been completed, check that the total calculated in 
L13 is not more than cost less salvage. If this is the case, a manual ad-
justment to the last period’s depreciation charge will be required.

Your worksheet should look something like Figure 9.24.

Double Declining Balance Method (=DDB function)  The double declining balance 
method also calculates depreciation at a fixed rate. This rate per annum is 
calculated as:

( ( ))%2 100/Expected useful life×

Again, the Excel function (=DDB) makes this calculation a lot easier!
As with the fixed declining balance method, the depreciation charge for 

each period is not the same. This is a result of the depreciation rate being ap-
plied to the net book value at the beginning of each period, and not to the 
original cost. Here, too, the starting net book value is the cost price and not 
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Figure 9.24  Calculating Fixed Declining Depreciation

cost less salvage. This method is quite similar to the fixed declining method 
shown above, except that the first year’s depreciation uses double the percent-
age of the straight‐line method. For each additional year of the asset’s life, 
opening book value is multiplied by the same percentage. When the amount 
calculated by the double declining method is less than what it would have 
been using the straight‐line method, then the straight‐line method is used.

In the example above, using the double declining balance method, the 
depreciation rate would be 20 percent in the first year instead of 10 percent 
using the straight‐line method. This amount then reduces until it is less than 
$5,000, and then it switches to the straight‐line method.

�Again, using the following Excel function is recommended: 
=DDB(50000,5000,10,1).
To prepare a depreciation schedule for a particular asset on Excel using 

the double declining balance method, the following steps are followed:

	 1.	Using a DDB formula, calculate the depreciation per year in row 13, 
columns B to K.

	 2.	Your formula in B13 should be: =DDB($B$5,$B$6,$B$7,B10). This 
formula requires cost value, salvage value, life in years, and period for 
which depreciation is being calculated.

	 3.	Once the absolute value signs have been added, the formula in B13 can 
be copied into columns C to K.

	 4.	Once again, the total in L13 will not be exactly equal to cost less sal-
vage, as was the case for the straight‐line method. This is a result of the 
double declining balance method also producing a hyperbolic and not a 
linear function.

	 5.	Once the table has been completed, check that the total calculated in 
L13 is not more than cost less salvage. If it is, a manual adjustment to 
the last period’s depreciation charge will be required.
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Your worksheet should look something like Figure 9.25.

Sum-of-the-Years’-Digits Method (=SYD Function)  Unlike the previous three methods 
of calculating depreciation, the sum‐of‐the‐years’‐digits (SYD) method calcu-
lates depreciation at varying rates for each period. As with the straight‐line 
method, however, it uses a constant depreciable base, being cost less salvage 
value. The sum‐of‐the‐years’‐digits is calculated as:

( ( ))n n + 1 /2

where n is equal to the useful life in years.
Depreciation for each period is then calculated as:

( ) ( )Cost Salvage Useful life Number of previous periods /
Sum-of

− × −
--the- -digitsyears’

Sum‐of‐the‐years’‐digits is a depreciation method that results in a more 
accelerated write‐off than straight-line, but less than the declining balance 
method. Under this method, annual depreciation is determined by multiply-
ing the depreciable cost by a schedule of fractions.

Use the Excel formula =SYD(50000,5000,10,1).
To prepare a depreciation schedule for a particular asset on Excel using 

the sum‐of‐the‐years’‐digits method, the following steps are followed:

	 1.	Using an SYD formula, calculate the depreciation per year in row 14, 
columns B to K.

	 2.	Your formula in B14 should be: =SYD($B$5,$B$6,$B$7,B10). As 
with the previous two methods, this formula requires cost value, sal-
vage value, life in years, and period for which depreciation is being 
calculated.

Figure 9.25  Calculating Double Declining Depreciation
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	 3.	Once again, the additional requirement of a specified period is a result 
of the depreciation calculated each year being unique to that particular 
year, or period. Unlike with the two previous methods, however, the dif-
ference in yearly depreciation charges is a result of a change in rate, and 
not a change in the depreciable base.

	 4.	Once the absolute value signs have been added, the formula in B14 can 
be copied into row 14, columns C to K.

	 5.	Check that the total in L14 is, as with the straight‐line method, exactly 
equal to cost less salvage value. Despite using varying rates, this method 
also produces a linear function.

Your worksheet should look something like Figure 9.26.
Of course, there are many other methods of depreciation, most of which 

also have an Excel function, to make what would otherwise be an extremely 
complicated calculation much easier. Don’t completely rely on the function, 
however! As always, sense‐check the results and double‐check the timing of 
the purchase date and the period at which the asset is deemed to be fully 
depreciated.

Calculating Depreciation at the End of Useful Life

When building a model to depreciate assets using the straight‐line method, 
whether calculating it longhand, or using the SLN function, it is possible to 
continue to calculate depreciation on an asset that has already been fully de-
preciated past its useful life. This results in an ever‐increasing negative net 
book value, which is impossible, and can be the cause of an error in the model.

In order to prevent depreciation from being calculated once the asset 
has reached the end of its useful life, the Excel depreciation formula needs 
to be amended.

Figure 9.26  Calculating Sum‐of‐the‐Years’‐Digits Depreciation
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Let’s say you have a list of capital items in a database, as shown in 
Figure 9.27. You can find this blank template, along with the completed 
version and other accompanying models to the rest of the screenshots in this 
book, at www.plumsolutions.com.au/book.

The first item on the capital expenditure register is for some IT equip-
ment that was purchased in July 2014. The useful life is three years, which 
means that it will be fully depreciated in July 2017, and therefore if we cre-
ate a forecast model for 2017, we need to ensure that the depreciation does 
not continue past the end of its useful life, and we need to create a formula 
to do this.

This will be a rather long formula, but we’ll use a simple building block 
methodology where we create a simple formula, test it, and check it before 
adding to it. We then test and check it again, before adding to it. In this way, 
we minimise errors by making sure the formula syntax is correct.

	 1.	Begin by calculating the depreciation for January 2017 for the as-
set in cell G4, using the straight‐line depreciation method. Remem-
ber it’s for a month, not a year. Your formula should look like this: 
=SLN($D4,$E4,$C4)/12.

Test this by copying across and down the page to make sure that the 
cell referencing is correct.

	 2.	Once we’ve got this right, we need to consider the spend date. In some 
instances, the spend date for the item has not yet elapsed, so we need to 
evaluate whether this date has passed or not, and only allow the depre-
ciation to show if the date has passed. We can achieve this by inserting 
an IF statement around the SLN function like this: =IF(G$2>=$B4,SLN
($D4,$E4,$C4)/12,0). Test this by copying across and down the page to 
make sure that the cell referencing is correct.

	 3.	Now we need to consider the end‐of‐useful‐life date. We could do 
this all in one formula, but it will make our calculations easier to fol-
low if we insert this as a date within the model. In cell F4, calculate 
the date at which the item will be fully depreciated. We can do this 
using the formula =B4+(C4*365). However, note that it gives you a 
value of 29th June 2017, because 2016 is a leap year. You can get 
around this by using the EOMONTH or DATE functions or by using 
365.25 instead of 365—or you can simply leave it as it is (it won’t 
make a lot of difference to our calculations). Copy the formula down 
column F.

	 4.	Next, we need to add in the end‐of‐useful‐life date to our formula in cell 
G4. The best way to do this is by adding the AND function using the 
syntax. Your formula should look like this: =IF(AND(G$2<= $F4,G$2 
>=$B4),SLN($D4,$E4,$C4)/12,0).

http://www.plumsolutions.com.au/book
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	 5.	Copy the formula across and down, and test to see if it is working cor-
rectly. The depreciation for the IT equipment should stop in July 2017.

	 6.	Your worksheet should look something like Figure 9.27.

Break-Even Analysis

Including break‐even analysis in a financial model is very useful for budget-
ing purposes and especially for any business that is starting or expanding its 
operations. Break‐even analysis is a very effective tool to determine profit-
ability and give you a snapshot of the sales volume target that is required to 
start making profit. For a new startup venture, this analysis is very effective 
in projecting sales targets. For established companies that are looking to 
launch new products and services, this analysis is invaluable in developing 
the pricing strategy.

There are several different ways to carry out the break‐even analysis, 
depending on the perspective you want to look at. If you keep your pricing 
fixed, you can determine the units you need to produce and sell to break 
even (zero profit and zero loss). On the other hand, if your market position 
allows you to change the pricing, then you can determine the optimal pric-
ing strategy to make your department or business break even within the 
stipulated target sales.

Let’s take an in‐depth look at some of the different methods of calcu-
lations for break‐even analysis. It is also very helpful to show break‐even 
points graphically so we will also include some line charts when calculating 
the break‐even points in our model in this section.

Calculating Break-Even Point

The break‐even point is dependent on the total cost of production, the price 
of units, and the number of units. In its most simplified form, the break‐even 
point is achieved when:

Total cost of production Price Number of units= ×

However, in real businesses the equation is not this simple because the 
cost of production is never completely fixed. There is a variable component 
to it, which is related to the total units produced. This component includes 
everything from the price of raw materials, labor costs, and additional over-
heads. Thus total cost of production is the sum of the fixed costs and the 
variable costs.

Total cost of production Fixed costs Variable costs= +
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By varying the total number of units and/or the selling price of each 
unit, you can calculate the break‐even point for your business. Figure 9.28 
shows an example of the various break‐even points at three different price 
points: $100, $150, and $200. We can see that the lower the selling price per 
unit, the more units we need to sell in order to break even.

Example Using Excel  Let’s look at an example of how to calculate the break‐
even point for a new product. Let’s say you want to start producing custom‐
made birdcages. You have determined your fixed and variable costs for the 
first year are as follows:

■■ Fixed costs $250,275 (this includes rent, machinery, electricity, etc.)
■■ Raw materials of $5 per cage
■■ Labor of $25 per cage
■■ Overhead of $10 per cage

Using the layout in Figure 9.28, calculate the net profit at each level of pro-
duction. Ensure you use consistent formulas! At what level of production does 
the business begin to make a profit? The answer follows in the numbered list.

	 1.	Fixed costs will remain $250,275 regardless of the production level. 
The formula in cell F5 should be =$C$3. Copy it across.

	 2.	Variable costs will fluctuate depending on the volume produced. The 
formula in cell F6 should be =F4*$C$8. Copy it across.

	 3.	Add together the fixed and variable costs in row 7.
	 4.	Calculate the total revenue in row 8. The formula in cell F8 should be 

=F4*$F$3. Copy it across.
	 5.	Now calculate the net profit at the various production volumes in row 9.
	 6.	The formula in cell F9 should be =F8-F7. Copy it across.

Your worksheet should look something like Figure 9.28.

Figure 9.28  Break‐Even Calculations
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We can see that somewhere between 2,000 and 3,000 cages is when the 
revenue begins to cover our costs.

Charting the Break-Even Point

It is also interesting to look at the numbers graphically, and we can create 
a line chart that shows the point at which the revenue from the business 
becomes greater than the cost. See Figure 9.29.

For detailed instructions on how to create this chart, see the supplemen-
tary material available on www.wiley.com/go/steinfairhurstrevised.

We can see what the break‐even point is roughly just under 3,000 units 
by looking at the chart, but this can be a pretty laborious task when done 
manually, and it is also not very accurate. We can calculate this exactly, 
however, using two methods in Excel:

	 1.	A formula calculation.
	 2.	A goal seek.

Calculating Break-Even Using a Formula

Using a formula is the fastest way of calculating the break‐even point. It can 
be calculated using the following formula:

Fixed cost
Price Variable cost−

Figure 9.29  Break‐Even

Bob’s Bird Cages Break-Even Analysis
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http://www.wiley.com/go/steinfairhurstrevised
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Price minus variable costs gives you the gross profit, or contribution of 
each unit. We can then divide the fixed costs by the contribution to see how 
many units need to be sold to cover the fixed costs. See Figure 9.30.

In our model, we can calculate the break‐even point by using this formula:

$ ,
$ $

, .
250 275
125 40

2 944 41
−

=

The Excel formula in our model to calculate this is:

C5/ C11 C10( )−

Break-Even Analysis Using Goal Seek

Another way to perform a break‐even analysis is to use the goal seek tool. 
For a refresher on how to use this tool refer to the “Goal Seeking” section 
in Chapter 8. While this method takes a little longer to set up and run than 
using a formula as described above, it is more flexible and allows more op-
tions for changing inputs.

Using our Bob’s Birdcage example, we need to set up the sheet as a 
simple P&L calculation, as shown in Figure 9.31.

Figure 9.30  Break‐Even Number of Units Using a Formula
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The number of cages produced is the unknown variable, and we have 
entered a value of 2,500 into cell C11 as a placeholder in the meantime 
(which we can see generates a loss). This is the variable that will change 
when we perform the goal seek. Remember that to perform a goal seek 
we need a formula, and a hard‐coded number that drives that formula. 
The formula will be the profit/loss amount in cell C16, and the hard‐
coded number is the number of cages in cell C11. Make sure that all of 
the formulas in cells C13 to C16 contain formulas; otherwise the goal 
seek won’t work.

So to perform the break‐even analysis, we need to set the net profit/loss 
value to zero by changing the number of cages produced. See Figure 9.31.

When you click OK, Excel calculates the exact break‐even point and 
edits the cell value accordingly, as shown in Figure 9.32.

We can see that we end up with a value of 2944.41176470588. You 
might like to round it to the nearest unit, which will show a small profit or 
loss, which might be confusing. Alternatively, change the formatting so that 
the decimal places don’t show.

If you have the power to manipulate the unit pricing, then you can 
change the price points to reach break‐even at the sale of a fixed number of 
units, and even set profit targets using the goal seek function. Let’s say you 
don’t think you can sell more than 2,500. What would you need to set your 
price at in order to make a profit of $50,000 if the maximum you will sell is 

Figure 9.31  Using Goal Seek to Calculate Break‐Even Point
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Figure 9.32  Completed Break‐Even Goal Seek

Figure 9.33  Break‐Even Goal Seek with Changed Inputs

2,500? Because of the way we have set up this model, this is relatively easy 
to calculate. See Figure 9.33.

If we want to make a profit of $50,000, we’d need to sell 2,500 cages 
at $160 each.
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Whilst the goal seek method takes a little longer to run and set up, it’s 
a great way to run different scenarios and test changes in inputs when per-
forming break‐even analysis.

Summary

In the first part of this book, we covered the tools, functions, and techniques 
that financial modellers need to know. In this chapter, we focused on the use 
of these tools in a financial modelling context. If you are pursuing a career 
as a financial modeller, you will almost certainly have to calculate escalation 
at some point, and it is quite likely that you will find yourself needing to 
use tiering tables, calculate depreciation, or perform a break‐even analysis.
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Chapter 10
Model Review

I f you are lucky, you will get to build your own model from scratch, but 
most often you will be handed someone else’s model to validate, modify, 

and make your own. One of the toughest tasks for any financial modeller is 
trying to use, understand, audit, or validate an existing model. While it may 
seem like a simple enough task where the hard work is already done, the real 
challenge will be to understand how the model was designed.

Excel is such a flexible tool, and there are so many different ways to 
achieve the same end, that trying to understand the way a model has been 
built is like trying to get inside another modeller’s mind! Give three differ-
ent modellers a problem, and you’ll undoubtedly have three different model 
designs, as each modeller will approach the model design in a different way 
and almost certainly using different formulas.

Rebuilding an Inherited Model

Obviously the best place to start when trying to understand a model is to 
talk to the original designer, if that is at all possible. There is no one who 
understands a financial model better than the modeller who designed it in 
the first place. However, the original modeller is often unavailable, and we 
therefore need to design the model in such a way that it can speak for itself!

If financial modelling best practice has been used, understanding a fi-
nancial model in Excel should be a fairly straightforward task. However, 
many inherited models have not been built by professional modellers, but 
rather cobbled together by different areas of a business to achieve a (usually 
short‐term) outcome. These kinds of inherited models can be a real night-
mare to unravel, and often it’s simply easier to start from scratch. If this is 
not practical, there are some tricks and techniques in Excel that can help 
you to take apart someone else’s model. By using these techniques, you can 
make the task of rebuilding an inherited model more achievable. We will 
explore some of these techniques in this section.
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Removing Redundant Assumptions and  
Source Data in a Model

Common problems modellers encounter when rebuilding an inherited mod-
el are redundant assumptions and sources in the data model. This can hap-
pen when modellers need to use source information that is already in the 
spreadsheet, and re‐create it without realising that they are entering a dupli-
cate set of assumptions or data. Often as a model evolves, parts of the model 
calculations are deleted, but the assumptions that fed into those calculations 
remain, despite no longer being needed.

The easiest way to see if any formulas are linking to an input cell is to 
use the trace dependents formula‐auditing tool. This tool will allow you to 
trace forward and backward throughout the model. One technique you can 
use to remove redundant cells is to colour code all of the input assumption 
and calculation cells. Then go to the model outputs, and trace back the for-
mulas. As each input assumption is validated, change the colour of the input 
cells back to their original colour. At the end of the process, if any cells are 
still coloured, you will know that they are redundant and can be deleted.

If you think a section of the model is not being used, check it using the 
trace dependents formula‐auditing tool as described in this chapter before 
deleting it. Be aware that there are a few tools and formulas such as INDI-
RECT and OFFSET that sometimes can rely on a cell but that do not show 
up in the formula-auditing tool. For this reason, make sure you save before 
deleting, and check the output of the model for #REF! or other errors before 
continuing. If the deletion has caused a problem, you can simply undo or 
close without saving to revert to the version of the file prior to deletion.

Tip
It’s best to delete entire rows or columns instead of just clearing cells when removing sec-
tions of a model in this way. Deleting the cell will show an error and flag the issue if it had 
been linking to a formula, whereas clearing cells will simply change the value to zero, which 
will not necessarily return an error. This can cause undetected errors to remain in the model.

Formula Auditing

One of the most effective ways to start understanding a financial model 
(especially one that you did not build yourself!) is to look at the formulas 
and identify the precedents and dependents. This will give you an idea of 
the logic used by the previous builder of the model. Usually the best place 
to start in this technique is the final output. Take a look at each output and 
trace back the predecessors until you eventually find out what calculations, 
source data, and assumptions have been used by the original designer.
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If you have a formula and you want to know which cells it uses, an easy 
way to do this is to use formula auditing. You can access these features in 
Excel from the Formula Auditing Ribbon under the Formulas tab, as shown 
in Figure 10.1.

Tracing Precedents  To trace the precedents, select the cell you want to audit and 
click on Trace Precedents in the Formula Auditing Ribbon. See Figure 10.1.

The trace precedents feature allows you to see all the other cells whose 
values are used in the formula in the present cell. It is possible to understand 
the calculation just by observing the cell formula too, but the arrows make 
it easier to locate the cells, which reduces the chances of errors in auditing 
the model. See Figure 10.2.

Note

Double-clicking on the blue arrows will take you to the preceding cells. If you double-click 
again, it will bring you back to the original cell. Also note that if the preceding cells are on 
another page, the blue arrow will show a dotted line. To go to the precedent cell, simply 
double-click on the dotted line, and it will bring up a list of all the off-sheet references of that 
cell. Double-click on the reference to go to that cell.

Figure 10.1  Trace Precedents in Formula-Auditing Icons in the Ribbon

Figure 10.2  Using Trace Precedents on a Formula
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Tracing Dependents  Just like precedents, you can also trace the dependents to 
a particular cell. These are all the cells that use the value in the current cell 
for the calculations.

Select the Trace Dependents button, which is located directly beneath 
the Trace Precedents in the Formula Auditing Ribbon under the Formulas 
tab. This is particularly useful if you are considering deleting a cell and want 
to know what this will affect.

Tip
Click on the Trace Precedents button again to trace the precedents of the precedent 
cells. This is invaluable in auditing complex formulas.

While arrows are great visual aids to understand formulas, sometimes 
they can become a distraction, especially if there are too many of them. You 
can clear all the arrows by clicking on the Remove Arrows button below 
the Trace Dependents button. This is also important if you plan to print the 
spreadsheet. If you don’t remove the arrows before printing, they will show 
up on the printed document.

Note

There are some formulas upon which the Formula Auditor will not work very well, such as 
array formulas, data tables, and the INDIRECT formula. These are visible using the Depen-
dency Auditor tool, which can be purchased separately from Microsoft.

Tip
You can also jump to precedent cells by using these shortcuts:

■■ Control+[(open square bracket) to jump to and highlight precedent cells.
■■ Control+] (close square bracket) to jump to and highlight dependent cells.
■■ Press Control+G and then enter to return to the previous cell.

These shortcuts can be performed in Excel for Mac 2011 by using the same shortcuts.

Error-Checking Tools  There are times when we unintentionally introduce er-
rors in the financial model. This could be because we did not comprehend 
the logic completely or because we mistyped the formula. Excel provides an 
error‐checking function that helps identify the problem. This is extremely use-
ful when your incorrect formula is syntactically correct. Excel indicates the 
anomalies in the model with a green triangle in the top‐left corner of the cell.
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To understand the nature of the error, select the cell and click on the 
drop‐down menu. There are many categories of such errors, but inconsistent 
formula is one of the most common errors, as is omitting adjacent cells, as 
shown in Figure 10.3.

You can change the kind of error checking you want to perform on your 
model by selecting the Error Checking Options, as shown in Figure 10.4. 
This will display the screen where you can control the kind of checks you 
want performed.

You can also access the Excel Options dialog box from selecting the File 
tab or Microsoft Office button, then Options or Excel Options. In Excel for 
Mac 2011, access Excel Options by clicking Excel, then Preferences, then 
Error Checking.

You can review all the errors in the financial model using the error‐
checking feature in Excel, as shown in Figure 10.5.

Figure 10.3  Error‐Checking Tools Showing Error in Sum Formula
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Figure 10.4  Editing Error‐Checking Options

Figure 10.5  Error‐Checking Feature

Error checking offers two options:

	 1.	Error Checking: Used to check formulas in error.
	 2.	Trace Error: This is used to trace the source of the error in the final re-

sult. To use this feature, select the cell with the error (usually shown as 
#ERR?, #NAME?, etc.) and click on Error Checking—Trace Error.

Excel will trace back the source of the error with a red arrow, as shown 
in Figure 10.6.
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Evaluating Formula Tool  Sometimes it is difficult to decipher a complex nested 
formula just by looking at precedents and dependent relations. It is easier 
to actually evaluate it step‐by‐step to understand how it works. Excel facili-
tates this by the use of the Evaluate Formula feature.

To evaluate a formula in any cell, select the cell and click on Evaluate 
Formula in the Formula Auditing Ribbon under the Formula tab.

This will display an Evaluate Formula dialog that will show you the 
complete formula in the cell. Keep clicking on the Evaluate button to see 
how Excel calculates the value step‐by‐step. See Figure 10.7.

Figure 10.6  Tracing the Error Source

Figure 10.7  Evaluate Formula Dialog Box
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Once you have looked up the source of the parameter, you can click 
Step Out to continue the evaluation.

Note

The Evaluate Formula auditing option is currently unavailable for Excel for Mac 2011.

Tip
You can also evaluate a partial formula manually by selecting each expression and 
pressing F9. You must select an entire section of the formula that makes sense in its 
own right; for example, in the horribly long and complex formula such as =MAX(0,MIN
(SUM(B$2:B2),SUM(B$2:B3)))+MIN(0,MAX(SUM(B$2:B2),SUM(B$2:B3))) shown in 
Figure 10.8, we can select this portion of the formula: SUM(B$2:B2).

Figure 10.8  Viewing the Value of Part of the Formula

By then pressing F9, the formula will display the result of that expres-
sion, which in this case is 250. See Figure 10.8.

If you then hit the Enter key, it will paste that value into the formula 
(usually not what we want to do), but if you hit Escape, it will return to nor-
mal. This is a handy little trick that is sometimes easier and less complicated 
than using the Evaluate Formula tool. For greater detail on why you would 
want to break up a formula in this way, see “How Long Should a Formula 
Be?” in Chapter 4.

Note

The Evaluate Formula auditing option and the related shortcut are currently unavailable for 
Excel for Mac 2011.

Viewing All the Formulas  If you want to look at all the formulas and not the 
evaluated value, you can use the Show Formulas option in Excel. This is also 
a very effective tool to understand the general logic in the model and can 
sometimes make anomalies more evident.
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This can also be done using the CTRL+` shortcut key. Note that ` is usu-
ally located below the ~ key at the top left of the keyboard, and should not 
be confused with the CTRL+’ shortcut used to edit cells. See Figure 10.9. No 
keyboard shortcut exists at this time for Excel for Mac 2011.

Direct Editing  By default, Excel allows users to edit the formulas directly in 
the cell, when they double‐click the cell. However, while auditing any in-
herited spreadsheet, this may not be a good idea, as we could inadvertently 
mess up the formulas that are already in the cell. Excel allows users to dis-
able direct editing, which protects the cells to a degree, but it still allows 
users to view the formula. It is quite different from protection, which does 
not let you do anything at all on the cell, and it’s much easier to turn off and 
on than protection.

Using this tool is also quite useful for auditing because you can double‐
click on the cell to trace back, and ensure that you understand the assump-
tions made by the original modeller and take care that you are not making 
any inadvertent changes to the formulas in the cell. You can still make any 
changes necessary directly in the formula bar.

You can disable Direct Editing from the File menu. Click Options, then 
Advanced, and select Allow Editing Directly in Cells. Note in Excel for Mac 
2011 this option is found in Excel > Preferences > Edit. Select Double‐Click 
Allows Editing Directly in Cells. See Figure 10.10.

Once this box has been unselected, now when you double‐click on the 
cell, it will highlight all the cells used as parameters in the formula, but 
not let you edit the cell directly. Figure 10.11 shows what happens if you 
double‐click on cell F4 when direct editing has been disabled.

Improving Model Performance

One of the problems that we often have to deal with in inherited files is that 
of slow, unwieldy, and inefficient models. If the model has not been built effi-
ciently and calculates slowly, there are a number of checks you can perform 
to improve the model’s performance. Most of the time, the performance 

Figure 10.9  Show Formulas Option in the Ribbon
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Figure 10.10  Disabling Direct Editing in Cells

Figure 10.11  Direct Editing Disabled

problems are due to the size of the model. Let’s explore some ways of reduc-
ing the file size, and hence speed up the model’s performance.

Reducing File Size

By far the quickest and most effective way of reducing file size will be to 
check your file type. Although the .xlsx file type has been around since Excel 
2007, models often still end up saved as .xls files. This is often seen in old, 
legacy models that have been around since prior to the upgrade. The other 
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    hoW to Change FIle tYpe  

 If you see “Compatibility Mode” at the top of the page next to the 
fi le name, then this means your fi le saved in .xls format. To change 
it to .xlsx format, go to File, Save as, and save the fi le again but this 
time change the “Save as Type” to Excel Workbook, instead of Excel 
97–2003 Workbook, as shown in Figure   10.12   . 

    FIgure   10.12    Save File in .xlsx Excel Workbook Format 

 If you’re still having problems with fi le size, here are some other things 
you can try: 

 ■    Remove any unnecessary formatting or formulas. Ensure colours and 
other formatting apply only to the necessary range, not an entire row 
or column. More important, go to the outer edges of your workspace 

reason for this can be when data is extracted from other systems, it defaults 
to an .xls fi le type, and the modeller uses this as a basis for his model. Because 
the .xlsx is a much more compact fi le type, this can make a huge difference 
to your fi le size.     



326� Using Excel for Business Analysis

and delete all (apparently empty) rows and columns from there to 
the end of the Excel sheet. There may be formatting in places you are 
unaware of.

■■ Hitting Control+End will take you to the last cell in the working range, 
so that will give you some idea of how large the calculation area of the 
sheet is.

■■ Make sure formulas reference only the range they need (i.e., not select-
ing the entire row or column).

■■ PivotTables are pretty heavy on memory so try saving them as values, 
if you can live without the functionality. Make sure that if you have 
multiple live PivotTables in a model that you copy the same PivotTable, 
rather than creating an entirely new one, as two separate tables will 
double memory use.

■■ Remove external links to other files (use Edit Links to check if there are 
any external links, and then Break Links to paste them as values).

■■ If you must have external links, then have the source file open while 
working with the file as this can make the model work faster.

■■ Functions such as INDEX, CHOOSE, and OFFSET are generally con-
sidered to use less memory than LOOKUP and SUMIF.

■■ Consider using array formulas, as these can use less memory.
■■ Turn the calculation onto manual, then hit F9 only when you need to 
recalculate.

■■ For clarity of workspace, making charts in a separate sheet is advised 
over placing them in the same sheet as their data. However, they do take 
up more memory this way. If you have a lot of charts in your workbook, 
this could make a difference.

■■ A last resort method is to leave one cell at the top of the column with 
the live link, and paste all the other cells as values. Copy the cell down 
and recalculate when you need to refresh. Certainly not a preferred op-
tion, but one method you might consider if you are really desperate!

Improving Excel Memory and File Performance

If you have tried the tips suggested above and still have sluggish Excel mod-
els, it might not just be the file size that is slowing things down. Often it’s 
the memory being used and when things get really bad, you might even 
get a “Not enough Memory” or “Not enough system resources to display 
completely” error message. When you get this frustrating message, the only 
solution is to close Excel and restart it, so let’s look at some ways to im-
prove the performance of your Excel models. Typically you might consider 
upgrading your RAM or switching from a laptop to a desktop to counteract 
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these problems, but these are unlikely to help as it’s quite possibly the way 
that Excel is being used that is holding you back—not your machine.

Understanding Excel Memory Allocation  If you get a memory error message, check 
the task manager for memory utilisation. If you have a RAM of more than 
2GB you’ll know that your computer has ample memory—although Excel is 
complaining about none being available. The reason for this is that Excel has 
its own memory manager and memory limits, regardless of the memory capac-
ity of your machine. In fact all the Excel versions after Excel 2003 were de-
signed to use a maximum of 2GB memory. So while your computer may have 
4GB or even 8GB RAM, Excel can use only 2GB of that. If it reaches this limit 
you get the error messages. This is why upgrading your computer’s memory 
probably won’t help! The 64‐bit version of Excel has boosted this memory 
limit exponentially. Hence, 64‐bit Excel versions can use the entire system 
memory, giving you much better performance, but read the section on “32-Bit 
versus 64‐Bit Excel” in Chapter 1 before you jump straight in and upgrade.

Countering Memory Exhaustion Problems  Now that you know why you have 
these limitations, we’ll see how to minimise their occurrence. Check the pre-
vious section on “Reducing File Size” and here are some more tips to reduce 
the working memory used by your Excel file.

When you are building a model in Excel, there are a few ways of work-
ing that are not only good practice, they will also reduce the chances of 
encountering memory problems in your model.

■■ Plan your Excel solution designs properly. If you insert a new column in 
the spreadsheet, it forces Excel to recalculate all of the formulas affected 
by that insertion. Depending on the number of impacted formulas and 
their complexity, you could run out of memory. A better planned design 
ensures you can avoid such changes.

■■ Work from left to right. Excel starts calculating from the top left‐hand 
corner, then continues across and down the sheet. This means that input 
values should be to the left and above the formulas that are referencing 
them.

■■ Avoid creating formulas referencing the entire columns or rows. Some 
Excel users create a formula using $D or $AA to reference the entire 
column to simplify the calculations. While it was fine with older Excel 
versions, the new versions have over a million rows per column—so 
entire row or column references causes Excel to calculate the formula a 
million times, and work much harder than it needs to.

■■ Keep things neat. Try to keep things in one single workbook, as external 
links can slow things down, as well as cause errors. Keeping input cell 
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and their formulas on one page will also reduce memory, but from a 
financial modelling best practice perspective it’s a good idea to split 
inputs and assumptions from their calculations.

■■ Check your used range. Sometimes Excel “remembers” a used range, 
even though you have deleted the reference, and this can increase the file 
size and memory usage. To check this on each sheet, press Control+End. 
This will take you to the last used cell of the workbook, and if it’s far 
beyond what you need, then delete the rows and columns that are not 
being used. This can greatly reduce the file size.

■■ Open every large Excel file on a separate “instance”; i.e. open up a new 
session of Excel for each workbook. The memory limitation in Excel is 
for every instance and not for the entire application. Opening every file 
on a separate instance gives you dedicated 2GB memory rather than 
shared. Ideally, you’d only have one file open at a time, but if you’re run-
ning a large process, you might like to keep working in Excel on another 
file whilst waiting for the large file to finish its process.

■■ Besides memory restrictions Excel also imposes a maximum source cell 
limit of 32,760 cells for smart filling. If you are planning to use the smart 
fill feature, you should look at just using the last 2–3 rows or columns and 
drag rather than selecting all the content from the first row. This will help 
control the number of source cells and ensure you do not reach this limit.

■■ Check for unwanted shapes: If you are adding pictures from websites 
into the spreadsheet, you could end up importing a lot of shapes that are 
not clearly visible but are eating into your memory. You need to open 
the selection panel (Home Ribbon > Find & Select > Selection Panel) 
and remove all the shapes that you do not want.

■■ Last, check the add‐ins and ensure they are updated. Typically, the up-
dated versions of third-party add-ins are more efficient and can help 
improve the Excel performance greatly.

Auditing a Financial Model

Any model used to support output required for decision-making purposes 
should be checked and tested at some level by an independent party (wheth-
er internal or external to the organisation) for both logic and accuracy be-
fore it is handed over to the end user. Reviewing, checking, and auditing a 
model are important parts of the model‐building process. As discussed in 
the section on financial modelling best practice, checking should be done by 
the modeller during the model-building process. However, once the model 
is complete, or near completion, it should be reviewed by another party not 
involved in the model build.
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How detailed the audit needs to be will depend on the importance of 
the financial model to the organisation using it. Whether it’s a simple pricing 
model or a multi million‐dollar merger, at least some level of checking and 
testing appropriate to the model needs to take place in order to identify and 
eliminate spreadsheet error and to ensure that calculations, assumptions, 
and logic within the model are correct. Below are listed a few different levels 
of testing and audit that may be appropriate for a model.

■■ Informal check: In many models this process could be an informal check 
by a colleague before passing it on to senior staff.

■■ Quality assurance (QA) procedure: For larger projects, such as the one 
outlined in “Steps to Building a Model” in Chapter 2, particularly if a 
team is involved, it is an important final step in the build process prior 
to handing over the model. This would be a more formal (QA) proce-
dure carried out and documented by the modelling team, and is also 
usually conducted internally.

■■ Formal model audit: When a high‐profile transaction, such as an acquisi-
tion or high‐stakes project finance, is planned, an external auditing spe-
cialist will be engaged to conduct an independent audit of the financial 
model. These audit procedures are often a requirement of banks, lenders, 
and investors as part of the due diligence process to satisfy themselves 
that the projections and results of the financial model are reliable and 
accurate.

The type of audit that needs to take place will depend on the size, scope, 
and importance of the financial model you have been working on. Unless 
you work for a model audit firm, you are unlikely to be involved in an exter-
nal model audit, so let’s take a look at how to go about the internal checks, 
which you are most likely to be involved with.

Informal Check

Let’s face it; the majority of financial models built will only get an informal 
check by colleagues. Depending on how much time they have available, they 
could spend anything from an hour to several weeks testing your model. 
Below are some techniques that can be used to test the integrity of the model 
on an informal basis.

■■ The traditional method of auditing is commonly known as the “tick‐
and‐bash method,” whereby the model checker goes through the model 
cell‐by‐cell to check for consistency and logic. This is not a particularly 
effective method of checking, as it is highly likely that the tester will 
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very quickly become bored with this tedious task and miss anomalies. It 
is also a task commonly given to junior staff who often do not have the 
practical modelling experience to know common errors.

■■ A more effective, but more costly, method is to commission the devel-
opment of a parallel model to support the primary model. This can 
be done by providing an independent modeller with the input page to 
a model and the output layout required—without the numbers. The 
modeller is then required to build a high‐level parallel model (minus the 
bells and whistles, of course). This can then be compared to the results 
produced by the primary model and confirm that the primary model is 
working correctly. This is a rather time‐consuming exercise, but one of 
the most effective ways of checking model accuracy.

■■ Ditch the spreadsheet and use a calculator! Print out the results of the 
model and see if you can roughly achieve the same results offline.

■■ Another effective method of testing a model is to use scenarios, sensitiv-
ity analysis, and stress‐testing. Change the inputs to something unex-
pected and see what happens. If you change the price of all your prod-
ucts to zero, does you revenue become zero also? It should, and if it does 
not the tester needs to understand why. See “Scenarios and Sensitivity 
Analysis in a Business Case” in Chapter 11 for greater detail on how to 
perform sensitivity and stress‐tests.

■■ Create lots and lots of charts. Create metrics, and plot as many inputs and 
outputs on the same charts as you have time for. Calculate the revenue per 
customer and chart it against market share on a line/column combination 
chart on two separate axes. (See “Charting with Two Different Axes and 
Chart Types” in Chapter 12 for how to do this.) Make sure that you un-
derstand every single trend and movement in the charts as these can flush 
out anomalies in the model that may not have been visible previously.

QA Procedure

Working on a QA procedure is the most labour‐intensive type of audit most 
modellers are likely to be involved in. Below are some detailed instructions 
of how to go about a financial model QA procedure. The QA of a model 
involves two main tasks:

	 1.	Logic checking, which aims to test whether the logic underpinning the 
model is reflected accurately in the model. These tests check that the 
model does what it is supposed to do. This form of QA should be car-
ried out once the model is completed and before it is used to generate 
outputs. It should be repeated again later if significant changes have 
been made to the model structure.
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	 2.	Data checking to ensure that the correct input data is used and has been 
entered into the model accurately. This type of QA may be more appro-
priately undertaken closer to finalization of the report, when final deci-
sions have been made on parameters that should be used in the model.

QA Logic Testing

Step 1: Scope of the QA Work  Before you begin, the scope of the QA needs to 
be established. The person undertaking the QA should clarify what parts 
of the model need a QA and, in particular, whether there are any parts that 
need special attention. For example, certain calculations may be crucial to 
the model and the model developer may want assurance that the logic of the 
formulas used is appropriate. In some cases the model developer may seek 
feedback on possible improvements to the model, so as to enhance transpar-
ency, clarity, or some other aspect.

It is important to ensure that all supporting documentation is available to 
undertake the QA process. The model developer and/or the project team should 
provide all the documentation and source data in either hard or soft copy.

Step 2: QA Checks of Calculations and Logic  Logic checks are carried out in order to:

■■ Check that cell referencing in a formula is consistent and correct.
■■ Ensure that formulas are mathematically correct.
■■ Confirm that the formulas used are suitable.
■■ Ensure consistency within the model in relation to the use of inputs such as:

■■ Nominal or real values.
■■ Units (for example, $’000,000 or $’000; kL or ML).
■■ Timing assumptions, where applicable.
■■ Labelling, which should be clear.

To check the logic of a model, quality assurers must first understand the 
output the model is required to produce and determine if the calculations 
correctly produce that output. Some of the tasks required in undertaking a 
logic check are therefore the same as those that would be done in the model 
building process.

To check the calculations and logic, the following five steps should be 
followed:

	 1.	Understand the purpose and limits of the model. This includes ascertaining 
what the model is supposed to do, what questions the model is supposed to 
answer, how the model tries to answer the questions, what the limitations 
of the model are, and what the model cannot do. This will most certainly 
require discussions with the project team and model developer.
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	 2.	Stress‐test the model as a whole by entering a wide range of inputs and 
checking that the outputs are logical. This includes testing values at the 
extremes to ensure the model processes the input as expected, especially 
where validation and protection are used. While testing a wide range of 
combination of input variables may identify some hidden bugs in the cal-
culations, using 0 or 1 is a good way to highlight obvious errors, as the 
outputs should be simple. For example, a unit price of zero should generate 
a revenue of zero, and if it does not, you’ll need to investigate why not!

Another way of testing this is to use historical figures as input and test 
whether the model can replicate actual results. For example, key outputs 
such as profit, growth rate, and other financial ratios that are calculated 
by the model can be compared to the known historical results.

Yet another way is to check the sensitivity of outputs (dependent 
variables) to changes in the inputs (independent variables). This in-
volves checking that the direction and magnitude of the change are in 
accordance with how you logically expect the outputs to behave.

	 3.	Establish which cells contain formulas. This can be done using audit 
software such as Spreadsheet Detective (an add‐in available for pur-
chase), which allows easy identification of which cells are fully hard‐
coded, which contain formulas, and whether formulas are consistent 
across rows and columns.

	 4.	Check both the logic and the reference accuracy of each identified for-
mula. This is usually done by tracing the outputs back to the inputs to 
ensure that calculations produce accurate and logical output. See the 
“Formula Auditing” section earlier in this chapter for details on how to 
use the Trace Precedents tool.

To assist with the logic and calculation checks, you may choose to 
write down the formulas in Excel notation using cell names and also 
in plain English by substituting the cell names in the formula with the 
actual variable names. For example:

Excel notation: J25=J6*J9

Plain English: total variable cost = variable cost per unit × number 
of units

Logic: number of units drives total variable cost

This is a simple and effective method to check and document the logic 
of the formula used by the model developer, and pick up any cell refer-
encing errors. Sometimes a formula can be quite long, especially if Excel 
nested functions are used. Writing it out and breaking it down into its 
components makes it easier to thoroughly check each component (e.g., 
ensuring that they are referenced correctly, consistent in years, units, 
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etc.). Another third‐party tool called Dependency Auditor can help with 
this auditing by providing the Excel notation.

	 5.	Check that the calculations have been suitably applied. For example, an 
indexation formula may be correct, but may not be suitable where it is 
applied, if, for example, the underlying data is already inflated.

Step 3: QA Checks of the Model’s Structural Layout and Documentation  Apart from 
its underlying calculations and logic, each model’s structural layout, appear-
ance, and documentation should be checked.

Checking the structural layout of each sheet and workbook involves 
reviewing these to make sure that they are simple, transparent, and easily 
navigable. Elements to look out for are:

■■ Logical sequencing of the components in the model.
■■ Whether calculations are spread out all over the model or if they follow 
neatly down and across in a logical fashion. (Note that in larger models 
not everything will follow neatly!)

■■ Whether hard coding is only on the input sheet.

Checking the model’s appearance and documentation involves checking 
the spelling and formatting, as well as that the documentation and notations 
in the model are clear, easily understood, and accurately reflect what is in 
the model.

Step 4: Document Your QA Work  The QA procedure needs to be documented. 
The quality assurer should note all issues (minor and major), bring these to 
the attention of the model developer, and record the actions taken to remedy 
any problems.

At the start of the process, quality assurers should make a copy of the 
model to be audited and insert a new worksheet called QA Log (see the 
template in Appendix 10.1 at the end of this chapter).

All issues should be documented in the QA Log sheet. The quality as-
surer may also wish to insert comments near the actual cells in the model 
where issues have been found, as this can be useful for the model developer 
when locating and fixing the problems identified.

Step 5: Report Your Findings  Once the QA work has been completed, any is-
sues should be discussed with the model developer. Alternatively, issues can 
be progressively discussed and addressed as they arise.

Normally, the model developer will be able to advise whether an identi-
fied issue must be corrected, or whether it is intentional and should be left 
as is. All decisions and reasons should be recorded in the QA Log. Agreed 
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changes should be checked again to ensure that they have been made cor-
rectly. This should also be recorded in the log.

Some changes may be very minor. Common sense should be exercised 
as to which changes can be left to the model developer to change without 
further final checking.

Input Testing

While logic checks focus on the calculations, structure, and layout of the 
model, input checks focus on the data entered into a model that is already 
built. Checks of input will usually involve:

■■ Matching input values to source documents to ensure that data has 
been entered accurately.

■■ Checking that inputs, especially assumptions, are consistent with the 
original output specifications.

■■ Checking that units are consistently applied, spelling and naming are 
consistent throughout the model, and the documentation of inputs and 
assumptions is clear.

As with a logic check, documenting the QA work and reporting the 
findings is required when conducting a QA of data inputs.

QA of Model Inputs  The aim of checking input data in a model that will be 
used to produce a report is to ensure that the model and its output are ac-
curate. The following are things to look out for:

■■ Check the inputs back to the source data for accuracy of data entry. 
This includes checking the actual numbers and also the units. For ex-
ample, a common error is that the source data may be in $’000,000, 
while the model is set up in $’000.

■■ Check that the inputs used are consistent with those approved by the users 
of the report to be produced. Where possible, cross‐reference the input data 
back to the minutes of meetings held to determine the required output.

■■ Check that the naming and explanations for the inputs are clear and 
easily understood.

■■ Check that the units are applied correctly and consistently throughout 
the model.

■■ Check for spelling and grammatical errors.
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Summary

While reviewing, auditing, or taking apart other people’s models is certainly 
not the most fun (or sexy) part of financial models, chances are you’ll need 
to be involved in the process at some stage. Even if you are fortunate enough 
to be charged only with the model build, it’s critical that a good financial 
modeller understand the model review and audit process, and build the 
model in such a way as to make the audit process easier for the reviewer.
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Chapter 11
Stress-Testing, Scenarios, 
and Sensitivity Analysis in 

Financial Modelling

Any good financial model will usually contain scenario and sensitivity 
analysis functionality, at least to some degree. Scenarios are an important 

part of financial modelling, and the reason we have left this to near the end 
of the book is that it is usually a task performed at the end of the model‐
building process. If the model has been properly designed using best prac-
tice, it is not difficult to add, edit, and change scenarios in the model.

Scenarios and sensitivity analysis are great ways to insulate your model 
from risk. What would be the absolute worst that could happen? If every-
thing that can go wrong does go wrong, will my business/project/venture 
still be okay? There are usually effects and interactions between multiple 
variables that may change in the model.

Scenarios can assist with decision analysis. They are laid out in advance 
so that the decision makers can see the expected impact of each course of 
action. How close to reality these scenarios are really depends on the accu-
racy of the assumptions implicit in the model—but that’s another story! (See 
“Document Your Assumptions” in Chapter 3.)

Scenario analysis is a very important part of financial modelling—in 
fact, in some cases, being able to perform a scenario analysis is almost the 
whole point of building a financial model in the first place! Many of the 
principles of best practice in financial modelling discussed in earlier sections 
were to ensure that the model is set up in such a way that scenarios can be 
easily included in our model.

There are several different technical methods of creating scenarios and 
sensitivities in financial models, which we will discuss, but all scenarios in-
volve changing input variables to see the impact of the change on the model 
outputs. By following good practice when building the model in the first 
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place—particularly when it comes to linking to the source, and only entering 
data once—creating scenarios and sensitivities in the model is quite simple. 
(See Chapter 3, “Best Practice Principles of Modelling.”) With a well‐built 
model that has all inputs linked to outputs, it is relatively easy to change 
inputs and watch the outputs change.

Building scenarios is a task normally best left to the end of the model 
build process because we need to get the model design and layout finalised, 
and make sure the model is working correctly, before we can change the 
input assumptions by adding scenarios. As with many complex model func-
tions, perform a simple task first, then test it, check it, and make sure it is 
correct, before adding more complexity, such as scenarios.

What Are the Differences between Scenario, 
Sensitivity, and What-If Analyses?

Scenario analysis, sensitivity analysis, and what‐if analysis are really only 
slight variations of the same thing.

A sensitivity analysis, otherwise known as a what‐if analysis, in finan-
cial modelling refers to the process of tweaking one key input or driver in 
a financial model, and seeing how sensitive the model is to the change in 
that variable. Scenarios, on the other hand, involve listing a whole series of 
inputs and changing the value of each input for each scenario. For example, 
a worst‐case scenario could include interest rates increasing, number of new 
customers being less than expected, and unfavourable exchange rates.

Scenarios should really focus around the area or assumption around 
which we have the least certainty. For example, let’s say we are analysing the 
costs of reducing carbon emissions:

Scenario Fossil Fuel Prices
Nonfossil Fuel 

Technology Cost

Best Case −10% +10%

Likely Case – –

Worst Case +10% 10%

In this very simple example, you could model the prices that you think 
are most likely and then tweak each of these up or down. It is possible to 
create many more than three scenarios in a financial model.

I’m often asked how many scenarios should be in a model, and it really 
depends on the amount of time and the degree of detail and certainty that are 
required for the model. Three scenarios, as shown in this example, should 
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be a minimum. It’s possible to have 20, 30, or even 50 scenarios modelled, 
but it does become rather unwieldy and confusing so unless you really need 
them, I’d probably recommend sticking to around a dozen scenarios.

Scenarios and Sensitivity Analysis in a Business Case

In a volatile economic environment, creating a business case for a new proj-
ect or product that contains financial projections is an extremely difficult 
task. Looking at historical data and extrapolating the numbers to create 
future projections simply doesn’t cut it anymore. Creating a business case 
is imperative for companies to plan for the future, attract investor fund-
ing, and gain approval for projects, although most of the time, there is so 
much uncertainty involved that financial projections are way off the mark. 
How do we create a financial model for a business case that is not complete 
guesswork?

Thorough stress‐testing, along with scenario and sensitivity analysis, 
will provide a business case that has the rigour and robustness to cope with 
various fluctuations in economic inputs. At an absolute minimum, any busi-
ness case financial model should have a best‐, base‐, and worst‐case scenar-
io. The scenario analysis may include answers to the following questions, as 
well as others specific to the industry. Obviously, particular attention should 
be paid to the downside!

■■ What is our break‐even number of customers?
■■ What happens if we lose our biggest expected customer? What if we 
gain another customer?

■■ What if we lose a supplier? Will this impact costs?
■■ What if interest rates increase or decrease?
■■ What if we lost a key staff member?
■■ It’s unlikely, but what if all of the above negative outcomes eventuate?

Of course, if you count on the worst‐case scenario, you’ll probably end 
up doing nothing, and you definitely won’t get any funding or approval! 
However, by creating a well‐built, robust financial model, we can know ex-
actly what the possible outcomes are so that we can show that we are pre-
pared for the best or worst eventualities.

Stress-Testing a Financial Model versus a Business

Following the global financial crisis, there was quite a lot of discussion on 
the importance of stress‐testing businesses, and I need to point out that 
this is quite different from stress‐testing a financial model. Stress‐testing a 
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business involves putting the business’s financial forecasts through scenario 
modelling. Stress‐testing a financial model is more about testing the techni-
cal inner workings of the model (i.e., varying the inputs to see how much 
the outputs change).

Strategies to stress‐test a model include:

■■ Set inputs to zero and check that the outputs respond as you would 
expect. For example, by setting the price to zero, you would expect 
revenue to also be zero.

■■ Double your units sold. Does your revenue double?
■■ If you are indexing costs, try setting the indexation percentage to zero 
and see if the costs remain flat.

Stress‐testing your financial model by way of scenario and sensitivity 
analysis will help you to be prepared for varying outcomes as a result of 
fluctuating external factors. Once you have completed your financial model 
you should stress‐test the workings of the model to ensure that it is robust 
and accurate.

Overview of Scenario Analysis Tools and Methods

Many people will create a financial model and save it as a base case. They then 
change all the numbers and save it as a worst case. Then they change all the 
numbers again and save it as a best case. Whilst this method will work, it’s not 
a very efficient way of performing scenario analysis. If a subsequent change 
needs to be made to the model, it will need to be made several times, and there 
is a high possibility that an error will be made between the different versions.

Let’s take a look at the technical methods available in Excel for creating 
scenarios and sensitivities, which will provide a much better way of building 
models. Essentially, there are three ways:

	 1.	Manual drop‐downs
a.	 In‐cell drop‐downs (using data validation)
b.	 Object drop‐downs (using combo boxes)

	 2.	Scenario Manager
	 3.	Data Tables

Manual Drop-Downs

Creating scenario analysis using manual drop‐down boxes means that you 
can only view one scenario at a time.
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In-Cell Drop-Downs (Using Data Validation)  In an in‐cell drop down, the value sits 
within the cell of data validation drop‐down box. See Figure 11.1.

In this case, the modeller has limited the valid entries to this cell to one 
of three options: either Best Case, Base Case, or Worst Case. This is the easi-
est and most commonly used type of drop‐down box.

See “Bulletproofing Your Model” in Chapter 7 for how to create a 
data validation drop‐down box, and “Comparing Scenario Methods” later 
in this chapter for a practical exercise on how to use them in scenario 
analysis.

Object Drop-Down Boxes (Using Combo Boxes)  There is very little difference from 
the user perspective with a combo box drop‐down, but it’s built very differ-
ently. See Figure 11.2.

This type of box is an object that sits on top of the sheet, rather 
than within the cell itself. If you look very closely, you can see that the 
box is sitting across several cells instead of within a single cell. This type 
of box is a little more difficult to build, but is easier for the user, as the 
drop‐down arrow appears all the time, rather than only when the cell is 
selected.

See “Form Controls” in Chapter 7 for how to create a combo box drop‐
down, and “Comparing Scenario Methods” later in this chapter for a practi-
cal exercise on how to use them in scenario analysis.

Figure 11.1  Data Validation Drop‐Down Box

Figure 11.2  Combo Box Drop‐Down
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Scenario Manager

Scenario Manager is an Excel tool in which you can create multiple sce-
narios. Once it is set up, the user can select a scenario, and input cells will 
change automatically. Scenario Manager is fairly limited and is not particu-
larly helpful in large and complex models. It is therefore not a very widely 
used tool for scenarios in financial modelling. See Figure 11.3.

Scenario Manager is a tool that has been grouped together with Goal 
Seek and Data Tables in the What‐if Analysis section of the Data tab. Being 
grouped with other tools that are so useful would lead the aspiring modeller 
to believe that Scenario Manager is also a critical tool to know. However, 
despite its useful‐sounding name and the good company it keeps, Scenario 
Manager is quite limited in its functionality and is not particularly helpful 
in large and complex financial models. It is therefore not commonly used by 
expert financial modellers; however, for the sake of completeness, we will 
cover it very briefly.

Let’s take a very simple example of a person creating her personal bud-
get for next year. Let’s assume that she does not know what her mortgage 

Figure 11.3  Scenario Manager Dialog Box
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payments will be, due to the changing rate of interest, or how much her rail 
card will cost.

You can define different scenarios and then switch between them to 
do what‐if analysis to see if she will end up in debt or be able to afford a 
holiday. Scenarios work best on complex spreadsheets where there is a large 
knock‐on effect from changes in the variable data.

Scenarios are created and managed using the Scenario Manager in the 
following 13 steps:

	 1.	Create and format the spreadsheet as shown in Figure 11.4. You can 
leave the input variable cells in B6 and B8 empty.

	 2.	On the Data tab, in the Data Tools section, click on the What‐if Analysis 
icon, and select Scenario Manager from the drop‐down list.

	 3.	This will bring up the Scenario Manager dialog box.
	 4.	Click on the Add button to create a new scenario.
	 5.	This will bring up the Add Scenario dialog box.
	 6.	Enter a name for the first scenario into the Scenario Name box (i.e., Best 

Case).
	 7.	Enter the cell references for the variable cells into the Changing Cells 

box. Use absolute references, and separate each reference with a comma 
(if there is more than one), but don’t use spaces. You can actually hold 
down the Control key and click on each cell in the spreadsheet to insert 
the references into the box. Click OK.

Figure 11.4  Scenario Manager Example
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	 8.	This will bring up the Scenario Values dialog box.
	 9.	Enter the variables’ values for this scenario (i.e., Base Case). For ex-

ample, $15,000 for mortgage and $2,000 for travel. Click OK.
	10.	This will take you back to the Scenario Manager dialog box.
	11.	Follow the previous steps again to create each scenario (i.e., Worst Case: 

$20,000 for mortgage and $3,000 for travel, and Best Case: $10,000 
for mortgage and $1,500 for travel).

	12.	When you have created all the scenarios you can use the Scenario Man-
ager to view each scenario.

	13.	Scenarios are sheet‐specific, meaning they only exist in the sheet where 
you created them.

As we can see, Scenario Manager is a rudimentary tool, which simply 
changes hard‐coded numbers. It’s not very easy to see, display, or print the 
different options unless we go into the Scenario Manager tool. Using the 
summary tool creates a summary report of the scenarios created, but they 
are not dynamic or interactive, and are therefore of little use as a modelling 
tool. The biggest downfall of Scenario Manager is that the user cannot see 
the results on the sheet unless she actually goes in to view the scenarios.

Using Data Tables for Sensitivity Analysis

Data tables are one of the more advanced and complex financial modelling 
tools. They can be used for scenarios and sensitivity analysis, but they are 
not as commonly used as drop‐down scenarios, mostly because users don’t 
know much about them. Because data tables use array formulas, they are 
unlike most other formulas in that you cannot trace dependents, and they 
are very difficult to follow unless you are familiar with them.

Note that a modeller who does not know data tables will be unable to 
edit the table, or make any changes.

Let’s create an interest rate calculator upon which we can test the sen-
sitivity of monthly repayments to changes in interest rates and loan terms.

	 1.	First, set up the model with the hard‐coded input assumptions, as shown 
in Figure 11.5.

	 2.	In cell B12, use a PMT formula to calculate the monthly repayments. 
See “Loan Calculations” in Chapter 6 for more information on how to 
use this function.

	 3.	Using the wizard, it should look like Figure 11.6.
	 4.	Your formula should be =PMT(B8/12,12*B10,B6). The function re-

turns a negative value because this is an expense. For our purposes, 
change it to a positive by preceding the function with the minus symbol.
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One-Variable Data Table  The data table presents a body of data derived 
from a function. The rows and columns of the table are drawn from one 
or two of the inputs or variables fed to the function. In this case, the 
data comes from the results of the PMT function, using the interest‐rate 
variable (cell B8).

	 1.	We will decide what the column elements will be by entering them in 
cells E7 to E12. For this exercise, use 6.00 to 8.50 percent in increments 
of half a percent, as shown in Figure 11.6.

Figure 11.5  Loan Calculation Layout

Figure 11.6  One‐Variable Data Table
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	 2.	Merge cells D7 to D12, and change the orientation under the Alignment 
tab under Format Cells if you wish to have the interest rate title oriented 
vertically, as shown above.

	 3.	Enter in cell F6 the formula =B12, which is the cell containing the PMT 
function. The table, when created, will use the PMT function to popu-
late the table according to the values in the input column (this will 
become clearer once the table is populated).

	 4.	Highlight cells E6:F12 as shown in Figure 11.6. You must highlight all 
the cells for it to work. Select the What‐if Analysis from the Data tab. 
Choose Data Table from the options that appear. 

	 5.	The Data Table dialog box will appear. Because we are only doing a 
one‐variable data table, we only need to enter data for one of the inter-
est‐rate or term variables, but which one depends on whether our input 
variable is arranged in a row or a column. Because it is in a column, we 
should use the Column input cell field. Link this field to the input field 
for the interest rate (cell B8).

	 6.	Your dialog box should look like Figure 11.6.
	 7.	Click OK, and your data table will populate. Note that the formula 

in the cells will have curly brackets around them, denoting that it is 
an array formula: {=TABLE(,B8)}. You will not be able to edit the 
cells.

	 8.	Your sheet should look something like Figure 11.7.

Figure 11.7  Completed One‐Variable Data Table
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Two-Variable Data Table

	 1.	Now, let’s change this to a two‐variable data table. Clear cells F7:F12. 
You will need to highlight and clear them all at once, as you cannot 
change or delete part of a data table.

	 2.	With a two‐variable table, the output cell needs to be at the top‐left of 
the table, at the intersection of the row and column variables. Therefore, 
cut and paste cell F6 to cell E6.

	 3.	In cells F6:I6, enter the number of years you wish to test in your data 
table. For this exercise enter the values 20, 25, 30, and 35 across the 
table. Change the formatting as necessary. We now have the makings of 
a table with the term across the top row and the interest rate down the 
left‐hand column, as shown in Figure 11.8.

	 4.	Now highlight the table area cells E6:I12 as shown. You must highlight 
all the cells for it to work.

	 5.	Select Data Table from the drop‐down list under the What‐if Analysis 
icon in the Data Tools section on the Data tab.

	 6.	Your row input cell will be the entry field for the values shown in the 
row (the term in years), and the column input cell will be the entry field 
for the values shown in the column (the interest rate). Your dialog box 
should look like Figure 11.8.

	 7.	Your table should now look like Figure 11.9.
	 8.	You might wish to change the font in cell E6 to white; while it is re-

quired for the data table to work, it does not add any value visually (and 
is simply confusing).

Tip
Data tables look great when you apply colour scales as shown in Figure 11.10, as you 
can visually see the incremental change to the data. For more information on how to use 
colour scales, see “Conditional Formatting” in Chapter 7.

Figure 11.8  Two‐Variable Data Table
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Figure 11.9  Completed Two‐Variable Data Table

Limitations of Data Tables  We can see from the example above that data tables 
are a great way to look at multiple scenarios or sensitivity analyses one at a 
time. Instead of manually changing the interest rate, or the term of the loan, 
we can display at a glance the impact of these changes.

However, data tables have a few limitations that make them inappropri-
ate for some scenarios or sensitivity analysis situations. These three limita-
tions are:

	 1.	The inputs and outputs need to be on the same page.
	 2.	You have a limitation of showing only two inputs and one output at a 

time. This is not a restriction with other forms of scenario analysis.

Figure 11.10  Data Table with Colour Scales
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	 3.	Formula auditing (trace precedents and trace dependents) doesn’t work 
very well in data tables.

Data tables are extremely useful when, as in the example shown above, 
you want to see the incremental change of one or two inputs on a single 
output. For example, how much does my profit margin change by if I change 
my price from $450 to $460, $470, $480, $490, or $500? A data table 
would not be an appropriate solution if the output of your financial model 
were a full set of financial statements, for example. In this situation, a drop‐
down scenario would be most appropriate.

Advanced Conditional Formatting

A data table is a good opportunity to use conditional formatting with a 
formula. We can use advanced conditional formatting to enhance a two‐
variable data table, making it more visually interesting and interactive for 
the user.

Our final result will look similar to Figure 11.11, using the term of the 
loan and the interest rate as the two variables to drive the conditional for-
matting. If you changed the interest rate in cell B8 from 7.5 to 7 percent, the 
row currently being highlighted will change from row 10 to row 9. Similarly, 
if the term of the loan was changed in cell B10 from 25 to 30, the column 
currently being highlighted will change from column G to column H. In this 
way, we can see at a glance which inputs have been selected currently in the 
model.

Figure 11.11  Completed Data Table Using Advanced Conditional Formatting



350� Using Excel for Business Analysis

For a review of the basics, see “Conditional Formatting” in Chapter 7. 
As you know, conditional formatting allows you to apply formats to a cell 
or range of cells, and have that formatting change depending on the value of 
the cell (or the value of a formula).

In this particular example, we want the interest rate and term to inter-
sect at the appropriate repayment instalment. As the variables to the PMT 
function are changed, the intersection point will move to spotlight the re-
payment amount.

One way we can accomplish this is to apply conditional formatting 
by means of a formula to each row within the table and, likewise, to each 
column. For instance, in Figure 11.12, we can stipulate that if cell E10 is 
equal to the interest rate (B8), then Excel must colour row 10 within the 
table.

This would require 10 formulas if we were to cover each of the six inter-
est rates and each of the four terms. However, we can accomplish the exer-
cise with two formulas only: The first locks either the rows or columns with 
absolute references; the second allows other elements of the cell address to 
float across the row or up and down the column by using relative references. 
This exercise illustrates how this is done.

	 1.	Select the entire table (cells E6 to I12). Choose Conditional Format-
ting on the Styles section of the Home tab. Select New Rule from the 
drop‐down list, and then Use a Formula to Determine Which Cells to 
Format.

In Excel for Mac 2011, select the entire table (cells E6 to I12). Choose 
Conditional Formatting on the Format section of the Home tab. Select 
New Rule from the drop‐down list and then Use a Formula to Deter-
mine Which Cells to Format.

	 2.	Choose to use a formula to determine which cells to format. Note that E 
in Figure 11.13 is an absolute reference to hold us in column E, but that 
the row number (presently 6) is free to roam down within the column.

	 3.	Format the cell as required using the Format button.
	 4.	Repeat the exercise to format the terms. In this case, the formula will 

reverse the relative and absolute references like this: E$6, locking in row 
6. The rules should look like Figure 11.14.

	 5.	To modify the conditional formatting, highlight the relevant rules (in 
this case the entire data table). Choose Manage Rules . . . from the Con-
ditional Formatting menu.

Alternatively, we can highlight just the single cell where the inputs for 
the two variables intersect using an ordinary Conditional Formatting Rule, 
as shown in Figure 11.15.
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Figure 11.13  Conditional Formatting Rule Dialog Box

Figure 11.14  Conditional Formatting Rule Manager Dialog Box
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Figure 11.15  Conditional Formatting Rule Showing Intersection of Inputs

Comparing Scenario Methods

Let’s create a very simple property development feasibility model to dem-
onstrate the difference between the methods of scenario analysis. You are 
considering purchasing an empty block upon which you are considering 
developing a residential villa complex. You can find this template, along 
with the accompanying models to the rest of the screenshots in this book, at 
www.plumsolutions.com.au/book.

The assumptions are:

■■ The land will cost $4.3 million to purchase.
■■ Council contribution fees will be $750,000.

http://www.plumsolutions.com.au/book
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■■ The properties that we develop will be 5,000 square metres in total.
■■ Building costs will be $1,500 per square metre.
■■ We will sell the properties for $3,000 per square metre.
■■ Sales commission to the estate agent will be 2.5 percent of the sale price.

To create the working model, follow these eight steps:

	 1.	Lay out the model, and enter the assumptions as shown in Figure 11.16.
These assumptions are all input variables, so these should be format-

ted as inputs with blue font and beige background.
	 2.	Calculate the income from selling the properties in cell C11 by multiply-

ing the sale price per square metre by the total number of square metres. 
Your formula should be =D8*C8.

Figure 11.16  Model Layout for Drop‐Down Scenario Method
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	 3.	Similarly, calculate the building costs in cell C14 by multiplying the 
building cost per square metre by the total number of square metres. 
Your formula should be =B8*D8.

	 4.	Calculate the sales commission by multiplying the income by the sales 
commission. Your formula should be =C11*E8.

	 5.	Add the expenses in cell C17.
	 6.	Calculate the net profit in cell C19 by deducting the expenses from the 

profit.
	 7.	Calculate the profit margin in cell C20 by showing the profit as a per-

centage of the revenue. Your formula in cell C20 should be =C19/C11.
	 8.	The calculations in your model should look something like those in 

Figure 11.16 so far.

We have now completed the workings of the model and are ready to 
add some scenarios. Note that this is a very simple one‐page model, which 
we will use to demonstrate how to build scenarios. Your model can be a lot 
more complex than this, containing many more pages and calculations, but 
the methodology for creating a scenario will be exactly the same.

Manual Sensitivity Analysis

The two input variables that we think are the most likely to change are the 
building cost and the sale price per square metre. Note that because of the 
way we have built this model, with these assumptions hard‐coded and all 
the calculation linking to these inputs, we can quite easily change these in-
puts manually and this will affect the output of the model. We can see that if 
the building costs were to decrease from $1,500 to $1,200 per square metre, 
this would increase the profit margin to 24 percent. Additionally, if the sale 
price were to increase from $3,000 to $3,300 per square metre, this would 
increase the profit margin further, to 31 percent.

You can see that we can also manually change the sales commission and 
the total number of square metres in the development, although we have 
determined that these are unlikely to change.

Creating Built-In Scenarios Using a Data Validation Drop-Down  Tweaking these in-
put variables manually is a form of sensitivity or what‐if analysis, but it’s 
difficult to control and not very auditable. It’s much better practice to build 
some pre‐defined scenarios into the model, and allow the user to switch 
between the scenarios using a drop‐down box.

Let’s build some scenarios using this 10‐step method.

	 1.	In cells A4 to A6, enter Best Case, Base Case, and Worst Case.
	 2.	Enter in hard‐coded assumptions, as shown in Figure 11.17.
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	 3.	At the very top of the model in cell B1, create a data‐validation drop‐
down box that the user can select from to choose the scenario they’d 
like to see. For instructions on how to do this, see “Using Validations to 
Create a Drop‐Down List” in Chapter 7.

	 4.	The data validation should be linked to the source cells, as shown in 
Figure 11.18. The drop‐down box should then look like Figure 11.19.

	 5.	Now we need to change the input assumptions in cells B8 and C8 from 
hard‐coded inputs to formulas that will change depending on the sce-
nario that has been selected from the drop‐down box.

Figure 11.17  Model Scenario Inputs

Figure 11.18  Data Validation Drop‐Down List Dialog Box
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	 6.	There are several different functions that we can use to achieve this; an 
IF statement, a VLOOKUP, or a SUMIF will all return a similar result. 
If you choose a SUMIF, the formula in cell B8 should look like this: 
=SUMIF($A$4:$A $6,$B$1,B4:B6).

	 7.	If you’ve got the cell referencing correct, you can simply copy the for-
mula across to cell C8 without changing the formula.

	 8.	Change the cell and font colour of cells B8 and C8 to denote that they 
now contain formulas instead of hard‐coded values.

	 9.	Your completed sheet should now look something like Figure 11.20.
	10.	Practice changing the scenario drop‐down in cell B1, and watch the 

numbers change! Under the best case, you’ll be making a 29 percent 
profit, and in the worst case, you’ll have a loss of 5 percent.

Creating Scenarios Using a Combo Box Drop-Down  Now that we’ve got our sce-
narios working, let’s take a look at what we could achieve using a combo 
box drop‐down instead. Note that combo boxes require VBA code, as previ-
ously discussed in “Form Controls” in Chapter 7.

If you are using the template provided, choose the next tab across, called 
“Combo Drop-Down.” If you are creating this model from scratch, then 
leave the scenario model we’ve just created intact, and make a copy of the 
sheet by right‐clicking on the sheet tab at the bottom. Select Move or Copy 
and then select Create a Copy, and click OK.

	 1.	If you have copied the sheet, then remove the data validation drop‐
down we created in cell B1. The easiest way to do this is to copy a blank 
cell and paste it over cell B1. This will mess up your calculations, but 
don’t worry; we’ll fix them later.

Figure 11.19  Data Validation Drop‐Down List
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	 2.	Now create a combo box drop‐down in the same area. For instructions 
on how to do this, see the “Combo Boxes” section in Chapter 7.

	 3.	Right‐click on the combo box, and select Format Control. On the Con-
trol tab, under Input Range, select the words Best Case, Base Case, and 
Worst Case in cells A4 to A6.

	 4.	Also choose a cell link, which is where you want the output cell from the 
drop‐down box to be. We often choose the cell behind the combo box, 
in this case cell B1, as this will be hidden behind the drop‐down, and 
unlikely to be accidentally deleted. You may need to move the combo 
box out of the way temporarily (select the combo box whilst holding 
down the Control key to do this).

Figure 11.20  Completed Data Validation Drop‐Down Box Model with Scenario 
Formulas
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Figure 11.21  Combo Box Format Control Dialog Box

	 5.	Your format control dialog box should look like Figure 11.21.
	 6.	Click OK. Click away from the combo box, and then select it again. 

Practice changing the options from the drop‐down, and you’ll notice the 
number in cell B1 changing. See Figure 11.22.

	 7.	What we need to do now is to change the formula in cells B8 and C8, 
which are driving the calculations in the model. The SUMIF (or IF, 
VLOOKUP, or whatever you used) function we created earlier will not 
work because cell B1 no longer contains the name of the scenario. This 
now needs a formula that will select the first option if it contains a 1, 
the second option if it contains a 2, and so on.

	 8.	Again, there are several functions we can use to achieve this, a CHOOSE 
or an INDEX to name two. If you use a CHOOSE function, your 
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formula in cell B8 will be =CHOOSE($B$1,B4,B5,B6). If you use abso-
lute referencing, you can copy this across to cell C8.

	 9.	Practice changing the drop‐down box and make sure it works properly. 
Your model should now work in exactly the same way as it did earlier, 
except that we are now using a combo box instead of a data validation 
drop‐down.

	10.	Hold down the Control key, and move the combo box so that it covers 
the cell link output number in cell B1.

	11.	Your sheet should now look something like Figure 11.23.

What’s the Difference between a Data Validation and Combo Box Drop-Down?  From 
the user perspective, the data validation and the combo box drop‐down 
should be almost indistinguishable from each other. They both work in 
the same way: The user selects from a drop‐down list, and the model will 
change. However, there are a few key differences from the model developer’s 
perspective:

■■ The combo box takes longer to build, as it requires inputs and outputs.
■■ As we can see in the previous example, the formulas we use to link to it 
are quite different.

■■ The combo box can easily be embedded in a chart.
■■ We can assign macros to a combo box so that unbeknownst to the user a 
macro is launched as soon as an option is selected from the drop‐down.

■■ The source data that appears in the combo box must be oriented verti-
cally, not horizontally. This is an important point when designing the 

Figure 11.22  Model with Combo Box Drop‐Down
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model. If you plan to use a combo box for scenario analysis, make sure 
that the input assumptions are listed vertically. Sources for data‐valida-
tion drop‐down boxes can be oriented either horizontally or vertically.

As shown in Figure 11.24, combo boxes will not work if the source data 
is oriented horizontally instead of vertically.

Creating Scenarios Using a Two-Variable Data Table

Let’s take a look to see if we could achieve the same result on our property 
development feasibility model using a data table method of scenario analy-
sis instead of a drop‐down box.

If you are using the template provided, choose the next tab across, 
called “Data Table.” If you are creating this model from scratch, then leave 

Figure 11.23  Completed Combo Box Model
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the scenario model we’ve just created intact, and make a copy of the sheet 
by right‐clicking on the sheet tab at the bottom. Select Move or Copy and 
then select Create a Copy, and click OK.

Instead of creating base‐, best‐, and worst‐case scenarios from which 
users need to select the scenario that they want to display, we are instead go-
ing to create a single matrix in six steps, where users can see simultaneously 
the results of different inputs. If you’ve copied the sheet, then you’ll need to 
change the design of the model to look like Figure 11.25 in order to create 
this scenario analysis using a data table instead.

	 1.	To create the titles for the data table inputs, use Merge Cells, and then 
for the vertically oriented title, wrap text, and right‐hand click. Select 
Format Cells and on the Alignment tab change the orientation. To show 
the title on the right‐hand side of the cell instead of the center, choose 
Right text alignment instead of Center under the Text Alignment area.

	 2.	Once we have the layout right, then link cell B2 to profit margin in cell 
C20, as this is the output we want to show on the data table.

	 3.	Now create a two‐data table by selecting the input assumption for sale price 
for row, and building cost for column. For detail on how to create a data 
table, see “Using Data Tables for Sensitivity Analysis,” earlier in this chapter.

	 4.	Highlight the entire data table, and go to the data table tool under the 
Data tab, in the What‐if Analysis section.

Figure 11.24  Combo Box Drop‐Down with Horizontally Oriented Source Data
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	 5.	The Data Table dialog box will look like Figure 11.26.
	 6.	When completed, the data table will look like Figure 11.27.

This gives us exactly the same results as the drop‐down box options, 
but instead of having to flick through the drop‐downs, the user can see at a 
glance all the results of the different scenarios simultaneously.

In this situation, the data table is an appropriate option for displaying 
the sensitivity of our profit margin to changes in inputs because the inputs 
and outputs are all on one page, and we are only interested in a single out-
put. We do lose some detail by using the data table method, as we cannot 
see, for example, the building cost amount under each different scenario, 
only the final outcome.

This feasibility model shows clearly the difference between three of the 
scenario methods. We have chosen not to use Scenario Manager, because 

Figure 11.25  Model Layout for Data Validation Scenario Method
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even though it is perfectly possible on this model, it is not a particularly 
useful tool. In this example, the data validation drop‐down, combo box 
drop‐down, and the data table scenario analysis methods are all suitable. 
However it really depends on the size, layout, and required output of the 
model as to which method is best to use.

Figure 11.26  Creating a Two‐Variable Data Table

Figure 11.27  Completed Data Table
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Summary

In this chapter, we have covered the different tools that are available in 
Excel for scenarios and sensitivity analysis. Depending on the inputs and 
outputs for the scenarios, different tools are most appropriate.

As discussed, the drop‐down method is the most popular, as that allows 
for many different scenario inputs as well as outputs. Scenario Manager is 
not a particularly useful tool, and data tables are most useful for sensitivity 
analysis where there are a maximum of two input variables, and only one 
output that needs to be shown. Whilst there are several different scenario 
tools available, the methodology and logic behind creating the scenarios 
remains the same.
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Chapter 12
Presenting Model Output 

Once a model has been built, we then need to display its results clearly and 
concisely to get your message across, via a written report or oral presenta-

tion. The output and presentation of the results is just as important as the rest 
of the model-building process, because there is no point in having a fantasti-
cally built model that none of the decision makers know about! This final stage 
of the model‐building process is sometimes not given as much focus by many 
modellers, particularly those whose skills are often more analytical than visual.

Preparing an Oral Presentation for Model Results

Many analysts and modellers would agree that public speaking is not their 
favourite part of the job and whilst it might be fun to imagine your senior 
management in their underwear, it might be more helpful to be prepared 
and follow these basic tips.

As the person who knows the model best, financial modellers are often re-
quested to communicate the results of the financial model as a formal presenta-
tion to the board or senior management. Understandably, many detail‐oriented 
analysts often find that it is quite a challenge to distill their 20‐megabyte finan-
cial model that has taken weeks to build into a 10‐minute presentation!

Although most senior management may not be interested in seeing the 
model itself, they might like to see live and changing scenarios. If the model is 
built correctly, you’ll be able make a single change to the input assumptions 
and the audience will be able to see the effects of these changing scenarios 
in real time. Make sure that you test all possible inputs in advance—nothing 
looks less professional than a #REF! error during a live sensitivity analysis.

Not all presentations require you to use PowerPoint, and it’s not always 
appropriate, but in this kind of environment, where it is necessary to convey 
lots of information, having the summary tables or charts on a slide behind 
you while you are speaking will be helpful. It can also help to take the focus 
off you if you are a little nervous.
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Follow these basic rules of presentations:

■■ Only display one key message per slide. Don’t crowd it or try to convey 
too much at once.

■■ Give them a more detailed report to look through, but what you show 
on the screen should be a very concise summary of this report.

■■ Make sure the font is big enough and clear on a data projector. Test it 
in advance if you can—sometimes colors look great on a monitor, but 
look washed out when projected on the wall.

■■ If you are showing the model itself on the screen, increase the zoom in 
Excel so that your audience can see the numbers. Test this in advance, 
and remember you’ll only be able to show a small portion of the screen 
in this way.

■■ Use charts and graphics to display your message. Generally the output 
from a model will be numerical, and charts are a great way of showing 
this. Research also shows that audience attention and retention of in-
formation increases significantly when graphics are used instead of pure 
text in presentations.

Most important, be prepared for questions regarding the output, inputs, 
assumptions, or workings of the model. Make sure that you can defend the 
assumptions that have been used, or the way something has been calculated. 
If you are not comfortable with some of the assumptions, say so up front. 
The model output is only as good as the assumptions that have gone into 
it, so you need to make sure that the audience accepts the key assumptions 
before they will accept the model results.

If you have the opportunity, spend some time with the key audience 
members in advance and walk them through the assumptions and meth-
odology of the model. They might have some questions or comments that 
you have not anticipated, and it will give you a chance to make changes or 
prepare your answers to likely questions in advance.

Summarizing and Displaying Model Results

If you have a 10‐minute slot during which you need to convey the high‐level 
output of the model, you probably need about four slides. If we have put 
together a business case for a new product, for example, outputs for a typi-
cal financial model, may include:

	 1.	A summary of projected cash flows or profitability. You won’t be able 
to fit more than about 5 years onto a PowerPoint slide, so if you need to 
show 20 years, just show Years 1, 5, 10, 15, and 20, for example.
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	 2.	Key assumptions. Use your judgment here to choose which assumptions 
are important. Select the ones that either impact the model the most, or 
that you are most certain of.

	 3.	Scenarios analysis. You’ll probably comfortably be able to fit four to five 
scenarios on a slide, so choose wisely. At a minimum, display a best‐case, 
base‐case, and worst‐case scenarios. See “Scenarios and Sensitivity Analysis 
in a Business Case” in Chapter 11 for greater detail on how to create these.

	 4.	Results of sensitivity testing. Show the results of tweaking a single as-
sumption. For example, if we were to get our customer take‐up amount 
wrong by 1 percent, this will cause a $500,000 change to the NPV—and 
this is something the audience needs to be aware of!

If you have longer than 10 minutes, you might be able to show the 
model itself if the presentation is more of a workshop than a formal presen-
tation. In either case, you should be able to give each person a hard‐copy 
summary report of the first few pages of the model with more detailed num-
bers than you have been able to include in the PowerPoint presentation. If 
the model has been well written, each page will form the back up data and 
source information for the model, and can be printed or distributed if the 
recipient of the summary results requests further information.

Preparing a Graphic or Written Presentation  
for Model Results

Charts are a way to present a series of data in a visual presentation so that 
patterns of information can be identified. Charts can be a powerful tool for 
the end user if they are built correctly and help simplify and summarize data.

A common mistake many analysts make is to try to put as much infor-
mation as possible into one chart in an attempt to make it look impressive. 
In reality, the chart just looks cluttered and fails to get the message across. 
Remember that charts are for the purpose of visually presenting information 
that is easier to digest than the raw data. When creating a chart, balance the 
amount of information presented along with the formatting. It may be more 
useful to create two charts, dividing up information, rather than putting it 
all on one chart. Consider Figure 12.1.

Is this chart useful? There is so much data presented that the chart has 
no real value. As well, the type of chart isn’t necessarily the best choice. 
Consider instead Figure 12.2.

With the same set of data, we have created a different chart that gives 
us much more intelligence, using less of the data. In Figure 12.2, a viewer 
can see at a glance the trend in revenues and profitability. It also shows the 
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Figure 12.1  Line Chart with Multiple Series

composition of marketing and G&A (general and administrative) expenses 
month to month. Note that using a stacked bar chart allows the user to see 
the total expenses, including Cost of Goods Sold (COGS). Compare this to 
the original line chart, and you can see it is almost impossible to compare the 
expenses in the line chart, as there is so much interference.

By breaking up the data into two chart types on two separate axes, and 
limiting the information presented, we have gone from useless and confus-
ing to informative and interesting.

Additional Tips for Charting

Use the following tips to really make your charts have an impact:

■■ Reduce clutter by representing less data, using fewer words in the legend, 
and avoiding unnecessary labels.
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Figure 12.2  Chart on Two Different Axes and Chart Types (Combo Chart)

■■ Use gridlines sparingly. Let the relative ups and downs of the chart 
speak for themselves.

■■ Limit the number of bars to seven in a bar chart; limit the number of 
lines to three in a line chart.

■■ Use standard imagery instead of special artwork; it’s too distracting (i.e., 
a stack of coins to represent an expense rather than a standard bar).

■■ Choose your x‐ and y‐axis ranges so that the space is utilized effectively.
■■ If you have fewer than 12 periods for a time‐series chart, consider using 
a bar chart instead of a line chart.

■■ Avoid the use of 3‐D charts. Remember: Keep things simple!
■■ Be cautious of excessive use of colors and shading.
■■ If the data has no natural order, sort the data from largest to smallest.
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Chart Types

Before looking at how to build charts from a technical perspective, let’s first 
look at which chart to use. The most common types of charts are line and 
bar charts, but there are many other charting options Excel has to offer, and 
which chart types will display the data in the best, most visual way really 
depends on the available data and the message you are trying to convey.

Choosing a Chart Type

The first step in creating a useful chart is to choose the correct type of chart. 
Bar charts, pie charts, line charts, areas, scatter plots, donuts, radars, and 
bubbles are all options. Which one makes the most sense? Note that when 
displaying information outputs of a typical financial model, line and bar 
charts are the predominant types of charts used, but this is not always the 
case. It’s quite a skill to choose the most appropriate chart to display the 
output information in the best possible way.

Sometimes it’s a matter of trial and error. The best way to choose a chart 
is to try several different charts to get a sense of which one is the best. Fortu-
nately, it’s very easy to flick between different chart types in Excel.

Summary of Common Charts and Applications

Table 12.1 is a brief summary of different chart types and their uses for 
displaying data graphically. The next section describes in detail what each 
of these charts does and what sort of data it best displays.

Table 12.1  What Type of Chart Best Fits Your Data?

Chart 
Type Suitable for . . .

Application in 
Financial Models

Line Trend and functional relations; useful 
for spotting trends.

Very useful for 
time series

Pie Single series of positive percentages or 
ratios.

Useful, but often 
overused!

Column Data point (Y) variation over a short 
range of values (X). Suitable for 
comparison of data points.

Very useful

Bar Same as column charts. Very useful

Radar Displaying multivariate information for 
statistical analysis.

Rarely used
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Take a look at the sales data and the chart options in Figure 12.3. Which 
chart type would best represent the sales data to show a regional compari-
son? We need to create a chart to visually display to our readers the output 
of our analysis, which is to compare the departments to each other. Which 
would be the best fit to get our message across?

Line charts and area charts are best for showing the connection between 
the data points, usually in time series, which is not the case, so they are not 
particularly useful in this situation.

The column or bar chart is best for comparing this kind of information, 
as we can easily see which area is highest and which is lowest. The pie chart 
shows the proportion and looks visually pleasing, but it is not as good for 
showing comparisons between the data points.

Detailed Chart Types

Figure 12.3 shows six different chart types that are readily available in Ex-
cel. Some of these charting options are better choices than others, so let’s go 
into each of these chart types in a little more detail.

	 1.	Line charts. These are lines joining data points to display the infor-
mation. Line charts are most appropriate for indicating trends. Like 
column charts, the simplicity of these charts makes them one of the 
favorites in displaying data. While column and line charts can be used 
interchangeably, line charts are best used for trending information and 
columns are better to study absolute data metrics.

We can see in Figure 12.3 that a line chart is not the most appropriate 
method of displaying these different costs, as it insinuates that there is 
some connection between the data points.

Chart 
Type Suitable for . . .

Application in 
Financial Models

3-D Showing data three‐dimensionally 
instead of two‐dimensionally, e.g., cone 
chart.

Sometimes 
used but not 
recommended

Area Similar to line chart; represents variation 
of data points relative to each other.

Sometimes used

Donut Stacking multiple pie charts. Rarely used

Bubble Enhancing scatter plots with additional 
variable.

Sometimes used
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There are also stacked line and 100‐percent stacked line chart options 
in Excel, as there are with column charts. Sometimes line charts con-
vey information in a more meaningful manner when the data points are 
marked. Excel offers the line chart with marker options for this purpose.

For detailed instructions on how to build a basic line chart, see the sup-
plementary materials available at www.wiley.com\go\steinfairhurstrevised.

	 2.	Pie charts. Pie charts have variable size sectors indicating the percentage 
of each variable in the overall picture. Pie charts are great for displaying 
ratios or percentage information, such as market share or penetration. 
They are very popular, particularly among graphic designers, but are 
notoriously poor for displaying information. In Figure 12.3, the pie 
chart is visually appealing, but it conveys very little information and 
makes it difficult to compare which department has the highest expense.

Figure 12.3  Comparison of Single‐Series Chart Types

http://www.wiley.com\go\steinfairhurstrevised
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	 3.	Column charts. Column charts are one of the most commonly used 
charts available in Excel, and they are a staple of presenting unrelated 
data points graphically. The height of the columns indicates the value 
or the parameter on the y‐axis while the width indicates value along 
the x‐axis. Column charts are a very effective method of displaying a 
message instantly, due to the simple format in which they represent the 
information. We can see in Figure 12.3 that the column chart is the most 
accurate way of displaying the sales data in this situation—this one is 
the best choice for the message we are trying to get across with our data.

	 4.	Bar charts. Bar charts are transposed column charts. They represent 
the same information as column charts from a different perspective. 
Most times the choice between column and bar charts will depend on 
how you want to represent the information depending on the space 
constraints of the display area. Most commonly, bar charts are used to 
represent time or future projections along the x‐axis. See Figure 12.3.

	 5.	3‐D charts. Excel also offers 3‐D versions of these column charts as bar, 
cylinder, and cone charts. Whilst 3‐D bar and cylinder charts are easy to 
comprehend, understanding cone charts can get complicated, so they are 
not very commonly used to display data. In general, 3‐D charts do not 
convey any more information than 2‐D charts, so usually a 2‐D chart is 
a simpler and clearer way of displaying information. Figure 12.3 shows 
an example of a 3‐D chart with a cone shape, which is an extremely poor 
way of comparing the four sales figures, because the pointy tip of the cone 
is much more difficult to compare to other results than a flat column.

Note

The cone chart type feature was an “improvement” added in Excel 2007. They have now 
(very sensibly!) taken it off the charting options menu, and it is now a column shape instead 
of a standard chart type. I think it’s highly unlikely that anyone will miss it, but you can find it 
in Excel 2013 under Format Data Series > Series Options > Column Shape.

	 6.	Radar charts. Radar charts plot the points on a circular axis rather than 
an x‐ and y‐axis. Hence, the data points are indicated by their relative 
distances from the center. They are easy enough to build, but can be 
confusing and are not particularly good at displaying quantitative infor-
mation and, therefore, are not commonly used. See Figure 12.3.

Another Example with More Data

Figure 12.3 showed a one‐series situation where we had only four numbers 
to plot. What if we need to show more data on our chart with multiple series? 
Figure 12.4 shows expenses that have been split into three types: Staff Costs, 
Admin, and IT. Let’s look at a few ways we can display this data in a chart.
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Excel offers multiple variations in column, bar, and line charts, such 
as the seven listed below. Some of them are very effective in conveying the 
message, while others may look good but distract from your main point.

	 1.	Clustered column charts: These are multiple series of basic column 
charts arranged next to each other. Instead of creating multiple charts 
for similar information, it may sometimes be better to use the clustered 
charts instead. However, you must ensure that columns are not too con-
gested, as that would defeat the purpose. A clustered column chart is a 
good option for Figure 12.4, as there are only three departments and 
three expense types. It provides good comparison between the numbers 
without appearing too cluttered.

Figure 12.4  Comparison of Multiseries Chart Types
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	 2.	Clustered bar charts: This is also a good way to display the data, al-
though we often reserve the x‐axis for time series, so a clustered column 
is probably a more commonly used solution, and therefore may be more 
easily understood by the reader.

	 3.	Stacked column charts: These are a variation on a basic column chart, 
with multiple variables stacked on top of each other. They are particular-
ly good for showing proportionate totals. For example, in Figure 12.4, 
not only can we see how each region compares to each other, but how 
much each department contributes to costs in total. It does, however, 
make the comparison between IT costs more difficult, for example, so 
this is where the intention of your message becomes important. If your 
focus is on total costs, I would choose a stacked column, but if you’d 
like to compare each of the data points, then a clustered column would 
be more appropriate.

Note that including a data table will add more detail to the stacked 
column chart, and help the reader to compare the values in the upper 
stacks. See “Handy Charting Hints” later in this chapter for instructions 
on how to add a data table.

	 4.	100‐percent stacked column charts: As the name suggests, these are column 
charts that stack on a percentage basis. They are most appropriate for use 
in comparing data where we are comparing percentages and ratios rather 
than an absolute number. When using 100‐percent stacked column charts, 
make sure that the labels clearly show that it is displaying percentages rath-
er than absolute numbers. In Figure 12.4, the percentages are very similar, 
so not a particularly helpful way of displaying the data in this case!

	 5.	Stacked line charts: As with the single series described above, the stacked 
line is not a helpful way of displaying the data in Figure 12.4.

	 6.	Area charts: Area charts are similar to line charts but have a shaded area 
below. Like line charts, they are good for displaying data that is connect-
ed. These can be stacked or not stacked, similar to column charts. Figure 
12.4 shows a stacked area chart—again, not a particularly effective way 
of displaying four different regions with no connection between them.

	 7.	Donut charts: Visually, donut charts are pie charts with a hole in the 
center. While it may not seem like a big difference at first, this gap in 
the donut hole allows several series to be stacked in the same chart. Pie 
charts can be used to represent a single series of values; multiple series 
require a separate chart for each series. This can be overcome with do-
nut charts, where multiple series can be stacked centrally.

However, since donut charts are not commonly used, interpreting them 
can become cumbersome. If you want to use this chart, you need to plan it 
properly and make it as intuitive as possible. Consider Figure 12.5. We want 
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to show the Australian population and see if there is any correlation to land 
area. This donut chart is interesting but quite difficult to interpret.

Combination Charts   Sometimes using the same chart type to represent differ-
ent data metrics is not very effective. In such cases, using a combination of 
chart types can be a very powerful solution. One of the most popular rep-
resentations is the combination of column and line charts. Such combina-
tions can convey a lot of information without cluttering the chart. These are 
particularly useful in dashboard reporting and other instances where you 
want to display as much information as possible in a small amount of space.

Figure 12.5  Donut Chart
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Quite often we might want to show two different measures, such as num-
ber of units and profits on the same charts. For instructions on how to do this, 
see “Charting with Two Different Axes and Chart Types” later in this chapter.

Consider Figure 12.6, which also displays the population versus the 
land area. Whilst not as visually appealing as the donut chart, it is some-
what easier to interpret, and we can see that there is very little correlation 
between population and land area.

Figure 12.6  Combination Chart
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Figure 12.7  Bubble Chart

Bubble Chart  Bubble charts are an enhancement to scatter charts. The bub-
ble chart can compare three characteristics: It can plot not only the x‐ and 
y‐axis but also reflect bubble size for each category. See detailed instructions 
later in this chapter for how to build a bubble chart. See Figure 12.7.

Note

If you are not keen on creating a full-fledged chart to represent data, you can use the sparkline 
features, which were introduced in Excel 2010. To learn more, refer to “Sparklines” in Chapter 7.

Working with Charts

The following outlines some of the most commonly used features of charting. 
Note that in Excel 2013, a lot of the options that used to appear in the Ribbon 
in earlier versions have now been moved to the chart itself. The Layout tab is 
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no longer in the Ribbon, and most of these options have been moved to the 
chart. You’ll notice that when you click on the chart, several new icons appear 
on the right, as shown in Figure 12.8. These three options are:

	 1.	The plus sign will add chart elements, such as titles and labels to the chart.
	 2.	The paintbrush will help you to change the colors and styles of the chart.
	 3.	The filter is a quick way to change the data, series, or names.

Changing the Type of Chart

Displaying data graphically is usually an iterative process, and if you create 
a chart based on your model data and it doesn’t look quite right, it is rela-
tively quick and easy to change the chart type displayed.

To change the chart type, display the Change Chart Type dialog box by 
right‐clicking on the chart area and selecting Change Chart Type from the 
drop‐down menu that appears.

Choose the chart you’d like to display, and click OK. Note that you can 
also change the chart type through the Design tab on the ribbon.

Figure 12.8  Pie Chart Depicting Units Sold Data
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Changing the Source Data

You can also quite easily change the source data for your chart while retain-
ing the original chart type.

In Figure 12.8, the pie chart is based on sales data per region (B2 through 
to B5). To depict expenses per region (E2 through to E5), you would need 
to change the source data.

The easiest way to change the source data is to simply click on the chart 
until the source data is highlighted. We can see in Figure 12.8 that the source 
data is in columns A and B. Now, just hover the mouse on the blue line to the 
right of column B, and drag it across to column E as shown in Figure 12.9. This 
works in any kind of chart where you can see the source data on the same page.

Figure 12.9  Changing the Data Source to Depict Expenses

Tip
There is another similar quick trick for adding a series to a chart. Let’s say you’ve got 
a single series showing on a chart as shown in Figure 12.10. If you wanted to add Ex-
penses as a new series, simply copy the source data in column E, select the chart, and 
paste the data straight in by using Control-V (or Command+V in Excel 2011 for Mac). 
Another series will automatically appear in the chart, as shown in Figure 12.11.
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Figure 12.10  Single Series Column Chart

Figure 12.11  Double Series Clustered Column Chart
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If the data is not on the same page, or if the change is more complex, 
then this quick tip may not work and so you’ll need to do it the long way, 
with the seven steps that follow.

	 1.	Right‐click on the chart area and click Select Data from the menu that 
appears.

	 2.	The Select Data Source dialog box will be displayed.
	 3.	The field called Chart Data Range at the top of the dialog box shows 

the range of cells used in the data source for the chart.
	 4.	Click on the series name (Units sold, in this case) and click Edit.
	 5.	Select the new data range from the sheet with your mouse.

Tip
Make sure that you delete all of the original data from the series or it will mess up your 
graph. See Figure 12.12. This is a rather annoying habit of Excel charting; unless you 
highlight the existing range and then reselect the new data, it will automatically add it to 
the range with a plus (+) sign.

Figure 12.12  Edit Series Dialog Box with Incorrect 
Series Values Data

	 6.	When you have completed your data selection, the new data range ref-
erence will appear in the Edit Data Source dialog box. Click OK.

	 7.	The size of the pie slices will change to reflect the new data.

If you want to change the title of the chart to something more interest-
ing than Expenses, follow these next two steps:

	 1.	Right‐click on the title and select the Edit Text option from the drop‐
down menu. Or, in Excel for Mac 2011, simply double‐click on the title.

	 2.	Edit the text to change the title.
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Remember that if you change the underlying data in the model, the 
chart will change as well.

To add or remove data series, use these two steps:

	 1.	From the Select Data or Source Data dialog box, as shown above, click 
the Add, Edit, or Remove button.

	 2.	Enter a range of data for the series by selecting a range in the model.

Saving a Chart as a Template

If you’ve spent a lot of time getting the axes, colors, and formats the way 
that you want them, you can save this chart as a template to use again and 
again. This is one of the few instances where the instructions for the differ-
ent versions of Excel differ from one another.

To save a chart as a template in Excel 2007 or 2010, use the following 
four steps:

	 1.	Click on the chart area to display the Design ribbon.
	 2.	Click the Save as Template button on the Design ribbon to display a 

Save Chart Template dialog box. See Figure 12.13.
	 3.	Enter a name for the chart template and choose the location where 

you’d like the template to be saved.
	 4.	Click the Save button.

In Excel 2013, the Save as Template icon is no longer in the Ribbon, but 
can now be found by right‐hand clicking on the chart, and selecting Save as 
Template.

In Excel for Mac 2011:

	 1.	Click on the chart area to display the Charts ribbon.
	 2.	Click the Other button on the Charts ribbon to display a Save as 

Template dialog box.
	 3.	Enter a name for the chart template and choose the location you’d like 

the template to be saved under.
	 4.	Click the Save button.

Figure 12.13  Save as Template Option in the Chart Tools Ribbon in Excel 2010
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To use the chart template:

	 1.	Select a data range for the new chart.
	 2.	Click the dialog launcher, which is located at the lower‐right of the 

Charts button group. (This can be found in the Other menu in Excel for 
Mac 2011.)

	 3.	Select the template you’d like to use. See Figure 12.14.

Click on Set as Default Chart so that each time you create a chart, it will de-
fault to your template. (Note that this function is unavailable in Excel for Mac 
2011.) This is particularly useful when using the F11 shortcut to create a chart.

Handy Charting Hints

Here are some handy charting hints:

■■ The formatting on most of the areas of the chart can be changed by 
double‐clicking on the area you wish to change. You can play with this 
to make your graph look more attractive.

Figure 12.14  Using a Chart Template
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■■ The legend on the right‐hand side can be resized, moved, or deleted by 
selecting it.

■■ If the chart has been inserted in the worksheet, rather than on its own 
page, it can be easily dragged around the worksheet or resized.

■■ If you hide data in your source sheet, this will not show on the chart. 
Test this by hiding one of the columns on the Financials sheet and check 
that the month has disappeared on the chart. You can change the op-
tions under Select Data Source so that it displays hidden cells. This is a 
new feature that was introduced in Excel 2007, and it is unavailable in 
previous versions. See Figure 12.15.

■■ The chart can be changed to a different type of chart (e.g., a bar chart or 
a pie chart) by right‐clicking and selecting Change Chart Type.

■■ Including a data table (not to be confused with a sensitivity analysis 
data table we covered in Chapter 11!) that shows actual values below 
the chart is a great way to display the information visually while still 
providing detailed data. See Figure 12.16.

In Excel 2007 or 2010, select Show Data Table from the drop‐down 
menu under the Data Table icon on the Layout tab (Control+Click any-
where inside the chart, and choose Select Data in Excel 2011 for Mac), 
or in Excel 2013, click on the chart, select the Chart Elements icon, and 
select the Data Table option.

■■ Charts can be pasted directly into Microsoft Word or PowerPoint. Note 
that if you simply copy and paste, the links to the underlying data in Excel 
will be maintained. This is fine, if you want to be able to edit the Excel 

Figure 12.15  Changing the Hidden and Empty Cells Option
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data and have the chart update. Normally when you’ve copied and pasted 
a chart into Word or PowerPoint, you have finished it and don’t want the 
chart to change at all. Therefore, it needs to be pasted as a picture. Copy 
the chart and then Paste Special, pasting the chart into the destination 
document as a picture to make sure that the chart does not change.

Figure 12.16  Line Chart with Data Table
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Tip
To create a chart very quickly on a new sheet, highlight the data and use the F11 shortcut. 
This automatically creates a column chart in all versions of Excel. In Windows versions 
you can change the default settings under Change Chart Type.

Dynamic Named Ranges

A common problem in creating charts for modeling is that the size of the 
source data can change, and cause errors. The problem with specifying a 
range is that if someone adds data to right or below the table, it will not be 
included in the range, and therefore will not show in the chart. Look at the 
problem shown in Figure 12.17. We have some data that were used to create 
a chart. The user has now entered some additional data in row 8, but this 
has not been included in the chart, because it was created using the static 
range A1:B8.You can find these templates, along with the accompanying 
models to the rest of the screenshots in this book, at www.plumsolutions 
.com.au/book.

http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/book
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There are two ways of making your chart more dynamic:

	 1.	Structured reference table. By far the easiest way is to turn the data into 
a table, and then use the table reference to create the chart. Any addi-
tional data appended to the table will automatically be included in the 
chart. For more information on how to create tables, see the section on 
“Structured Reference Tables” in Chapter 8.

	 2.	Dynamic named range. It’s not always practical to turn your data into 
a table, and therefore we need to make the named range change size 
depending on the amount of data in the range, which will in turn affect 
the data included in the chart.

Let’s explore how to create a dynamic named range and include it in a 
formula or chart. Be warned, it’s not for the fainthearted! Before we start, 
you should be familiar with the concept of Named Ranges from Chapter 5, 
and the OFFSET function in Chapter 6.

Let’s start by defining an ordinary named range called Expense_data by 
highlighting the data in the range, and typing the name in the Name Box in 
the top left‐hand corner. Now, if a user wants to add data to this table (e.g., 
another expense item in row 8, or another city in column J), this new data 
will not be included in the range.

To make this named range dynamic, first we need to work out how big 
the range is. We’ll do this using a COUNTA formula in row 1 and column 
A. This counts the number of cells that are not blank. We can include this 
in the OFFSET, but use the result of the COUNTA function to specify the 
number of rows and columns in the range.

Note that the data needs to be a block, with no blank rows or columns, 
as this could throw the formula off by a row or column, and there needs to 
be a value in cell A1.

Figure 12.17  New Data Not Included in Formula
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Go to the Name Manager, and edit the named range you have just cre-
ated. However, instead of putting the absolute range of A1:I8 in the Refers 
To box, enter the formula

=OFFSET(Data!$A$1,0,0,COUNTA(Data!$A$1:$A$5000),COUNT
A(Data!$A$1:$Z$1)).

Note that it’s important to include the absolute references in the range.
This is telling the named range to start at A1 and to go as far up and 

down as there is data, (within the range of A1:Z5000). We are using the 
height and width sections of the OFFSET function in this case.

See Figure 12.18. You can now refer to this named range in formulas 
and charts, knowing that additional data will always be captured within the 
range.

Note

Be careful not to put anything extra in row 1 or column A, such as the title “Total Expenses,” 
because that will then be included in the COUNTA formula, and make the range larger by one 
row or column. See Figure 12.19, where the title has been put in column A, instead of cell 
B11 as it is in Figure 12.18.

Figure 12.18  New Data Included in Named Range, and Formula
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Note

For the formula in the named range, we could instead use the function =OFFSET(A1,0,0,
COUNTA(A:A),COUNTA(1:1)), but it is not normally good practice to use entire column 
or row references in formulas because they use a lot more memory. Because we have limited 
our range to A1:Z5000, we could add some color markings so that the user knows when he 
or she has exceeded the range limits.

Using a Dynamic Range Name in a Chart

Dynamic named ranges are helpful when you are creating a chart with a 
variable number of values. For example, let’s say you are creating a chart 
based on a financial model that contains a variable number of tenants. We 
know that users are unlikely to need to model more than five or 10 tenants 
in the model, but we’ve made the model flexible so that users can enter up to 
25 tenants, just in case they need that many. If we set up the chart allowing 
for 25 tenants, it would look perfectly ridiculous. See Figure 12.20.

The chart looks much better if we include only the tenants that actually 
have data in the chart. See Figure 12.21.

Figure 12.19  Having a Title in Column A Will Expand the Named Range by One 
Row



392

Fig
ur

e 
12

.2
0 

C
ha

rt
 w

it
h 

V
ar

ia
bl

e 
N

um
be

r 
of

 T
en

an
ts



393

Fig
ur

e 
12

.2
1 

C
ha

rt
 w

it
h 

Fi
ve

 T
en

an
ts



394� Using Excel for Business Analysis

However, using an ordinary chart, we’d need users to go into the source 
data and change the chart range manually, which would be time‐consuming 
and error‐prone. The alternative is to create dynamic named ranges in the 
source data, and then refer to the named ranges when creating the chart. 
This way the range (and therefore the labels picked up in the chart) will 
automatically expand and contract, depending on whether the cells contain 
data or not. Unused tenancy cells will remain blank and will not be included 
in the chart. See the following four steps.

Note

When using dynamic named ranges in a chart, each series must have its own named range 
and therefore each range must be one-dimensional (i.e., only contain data in a single row or 
column). You therefore need to create a range for the labels and then a separate range for 
each series that appears on the chart.

Referring to a multidimensional range like the one shown in the first example in Figure 
12.18 in a chart will not work. To create a chart using this data, you would need to create a 
separate named range for each series, for example, one for Superannuation, one for Workers 
Comp, and so on, which somewhat defeats the purpose of having a dynamic named range!

	 1.	To make this chart dynamic, then create three dynamic named ranges, 
one for each series, as shown in Figure 12.22.

	 2.	Next, create the chart normally and then go into the Select Data Source 
dialog box by right‐clicking on the chart and clicking on Select Data.

	 3.	Go into each of the two series, “Square Metres” and “Rent,” and edit 
the data source. Replace the Series values with the dynamic named 
range, such as “Sqm_data,” as shown in Figure 12.23. Note that unlike 
other named range references, you must leave the sheet reference intact. 
If you can’t remember the name, try using the F3 shortcut.

	 4.	Edit the “Horizontal” Axis Labels in the Data Source so that it is refer-
ring to the dynamic named range you have created for the tenant names.

Test the data by adding more or deleting tenants, and make sure the 
chart changes accordingly.

Charting with Two Different Axes and Chart Types

One of the best ways of analyzing the output of your model is to plot two 
different variables on the same chart, so that we can understand trends and 
look for correlations in the data. Sometimes the only way to spot a trend 
or an anomaly in the model is to look at it graphically. For example, how 
does our overall revenue compare to headcount? Surely as revenue increases 
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so should headcount, and if it doesn’t we need to understand why. What if 
we compare regions and their number of units sold and profit? Surely the 
regions with the highest number of units sold should be the most profitable. 
This may not necessarily be the case. Let’s take a look at some data, and plot 
the number of units sold and the profits using two different chart types on 
two axes. Note that in Excel 2013 the Combo Chart has been introduced as 
a standard chart type, so the instructions differ somewhat between versions.

If we have the data shown in Figure 12.24, we can create a chart to 
compare units sold and profits. The easiest way to select the ranges is to 

Figure 12.23  Referring to the Named Range in the Chart Series

Figure 12.24  Selecting Nonconsecutive Ranges by Holding Down the Control 
Key
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highlight the data in columns A, B, and D by holding down the Control key, 
as shown in Figure 12.24.

Creating a Combo Chart in Excel 2013

	 1.	Select Recommended Charts from the Insert tab on the Ribbon. The 
Insert Chart dialog box will appear.

	 2.	Select the All Charts tab, and select Combo, which can be found at the 
bottom of the dialog box, as shown in Figure 12.25.

	 3.	Click on Secondary Axis for one of Series Names, which will move it to 
the other axis, and press OK.

	 4.	Insert a title, and axis label from the Chart Elements option, which 
appears when you click on the chart.

Your completed chart should look like Figure 12.26.

Figure 12.25  Insert Chart Dialog Box in Excel 2013



398� Using Excel for Business Analysis

Creating a Combo Chart in Previous Versions of Excel

In previous versions of Excel, creating a combo chart requires several more 
steps.

	 1.	Hold down the control key to highlight the nonconsecutive ranges, as 
shown in Figure 12.24.

	 2.	Select the 2‐D line from the Insert tab on the Ribbon. In Excel for Mac 
2011, select the 2‐D line from the Chart tab on the Ribbon.

The chart so far will look something like Figure 12.27.

Figure 12.26  Completed Combo Chart
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Figure 12.27  Preliminary Line Chart
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This chart looks quite nonsensical because we are plotting two different 
types of units: number of units sold and profit (in dollars).

The first thing we need to do is move the units sold to a new y‐axis on 
the right‐hand side.

	 1.	Select one of the series by clicking on it. Make sure the entire series has 
been selected.

	 2.	Right‐click and go to Format Data Series.
	 3.	On the Series Options tab, click on Secondary Axis instead of Primary 

Axis. See Figure 12.28.

Figure 12.28  Format Data Series, Secondary Axis in Excel 2007 or 2010
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	 4.	This will create a new axis on the right‐hand side. Note that this can 
also be done on the Layout tab (or the Format tab in Excel for Mac 
2011) by clicking on Format Selection.

Insert the axis labels to make your chart clearer.
Choose Primary Vertical Axis Title and Secondary Vertical Axis Title 

from the Axis Titles on the Layout tab in the ribbon.
This will look better as a combination of a column and line graph, so 

let’s change the Profit series to a column graph.

	 1.	Select the Profit series.
	 2.	Right‐click and select Change Series Type.
	 3.	Choose a column chart.

Insert a title by selecting Chart Title from the Layout tab.

Tip
These charts can be a little confusing if you try to put too much in, so keep it simple by 
sticking to only two series. Make sure that the axes are formatted correctly if currency 
symbols are appropriate. Leave the legend, which will make it clearer which section of 
the chart refers to which series.

Bubble Charts

Bubble charts are a variation of other types of graphs, combining elements 
from column and scatter charts. They give the user a way to compare values 
based on the relative size of the bubble, as well as the location within the 
chart. They are most useful when there are three data points to display.

Let’s say you have collected the following historical information about 
your company’s profits and profit margins by year:

Year Profit Number of Staff

2013 $50,000 23

2014 $35,000 17

2015 $40,000 20

2016 $18,000 9

2017 $60,000 30

2018 $45,000 22
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Since you have three data points, it is difficult to represent this as a 2‐D 
graph. Consider the following example of how the data could be charted. 
See Figure 12.29. It can be difficult to compare the relativity of the gross 
margin dollars and the gross margin percentage. Essentially, having all of the 
information in this format loses the intended purpose.

In this situation, we can consider using a bubble chart. The same data 
presented in a bubble chart tells a different story. You are able to compare 
the profits and margins by using the vertical rise of each bubble (profit) and 
its corresponding y‐axis value, along with comparing the margins by look-
ing at the size of the bubbles.

Creating a bubble chart is a bit more involved than a standard bar 
chart, but the few extra steps are worthwhile. See the following 12 steps.

	 1.	Open up a blank worksheet and start by entering the data, as shown in 
Figure 12.29.

	 2.	The columns are reflected on the bubble chart, as shown:

Figure 12.29  Data Shown in a Two‐Dimensional Chart



402� Using Excel for Business Analysis

a.	 The first column contains the values for the horizontal x‐axis and it 
must contain numerical data—text such as Area A, Area B, and so on 
will not show up on the x‐axis.

b.	 The second column contains the values for the vertical y‐axis.
c.	 The third column will be shown as the size of the bubble.

	 3.	The first trick with a bubble chart is that all data needs to be format-
ted as Number; otherwise it will not be properly displayed. Change the 
formatting to ensure the data has been formatted as a number.

	 4.	We can now create a bubble chart from this data. The easiest way to 
do this is to highlight the whole range C2:E7, and create the chart. It is 
important to remember not to include the headers—another trick with 
bubble charts. Doing so will cause errors.

	 5.	Select the bubble chart under Other Charts from the column section 
on the Insert tab (or Charts tab in Excel for Mac 2011), and the basic 
bubble chart will appear automatically. See Figure 12.30.

	 6.	The chart should now look something like Figure 12.30 (although the 
colours and background might look a little different, depending on which 
version of Excel you are using).

	 7.	If the series legend appears, select and delete it.
	 8.	Add the title “Profit & No Staff.”
	 9.	Right‐click on the bubbles to select them all, then choose Add Data Labels.
	10.	The default will be the sales amounts. To change this, right‐click again 

on the bubbles, and choose Format Data Labels.
	11.	Under Label Options, unselect y‐axis, select Bubble Size, and also se-

lect Center. Then, right‐click on the actual labels, choose Format Data 
Labels, go to Alignment, and select Center under Label Position, and 
click OK.

	12.	To bold the data labels, you can highlight them first, then press Control+B 
(this trick works anywhere in Excel, Word, and most programs). This is 
Command+B in Excel for Mac 2011.

Your bubble chart should look something like Figure 12.32.

Creating a Dynamic Chart

When creating charts in financial models or reports, we should still follow 
best practice and try to make our models as flexible and dynamic as we can. 
As we discussed in the section “Best Practice Principles of Modelling” in 
Chapter 3, we should always link as much as possible in our models, and 
this goes for charts as well.
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Figure 12.32  Completed Bubble Chart

It makes sense that when we change one of the inputs in our model, this 
should be reflected in the chart data, as well as the titles and labels.

Let’s do a simple example with 13 steps to see how we can make our 
charts more dynamic. If you had the temperature data as shown in Figure 
12.33, we could create a comparison chart whereby the user could compare 
the temperature between months in different cities. You can find this tem-
plate, along with the accompanying models to the rest of the screenshots in 
this book, at www.plumsolutions.com.au/book.

	 1.	Create drop‐down boxes in cells P2 and Q2 from which the users can 
select the months they wish to compare. See “Using Validations to Cre-
ate a Drop‐Down List” in Chapter 7 for how to do this.

	 2.	Link the cities in column O.
	 3.	In columns P and Q, create formulas that will become the “active range” 

for our chart, and automatically pick up the months selected in the 
drop‐downs. There are several formulas that could be used here, but I 
have chosen my old favorite, the SUMIF function in this instance. If you 
choose the SUMIF, your formula in cell P3 should look like this: =SUM
IF($B$2:$M$2,P$2,$B3:$M3).

	 4.	Copy it across and down the whole of the range P3:Q6.
	 5.	Try changing the months, and check that it is picking up the correct 

temperatures for each city. Your model should look something like 
Figure 12.33 so far.

http://www.plumsolutions.com.au/book
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	 6.	Next create a clustered column chart from the active range. It should 
look something like Figure 12.34.

	 7.	Try changing the drop‐down boxes, and you’ll notice the data will 
change.

	 8.	Add a data table by checking the Data Table check box on the Chart 
Elements option on the chart if you are using Excel 2013, or by selecting 
Data Table from the Layout tab in the Ribbon if you are using previous 

Figure 12.33  Creating the “Active Range”

Figure 12.34  Creating a Chart Based on the Active Range
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versions of Excel. In Excel 2011 for Mac, select the Chart Layout tab, 
and then on the ribbon choose Data Table.

	 9.	Remove the legend, and change the colors if you wish.
	10.	Now we want to create a title for this chart, but we’d like to make it very 

obvious what is contained in the chart, so we’d like to include the months 
selected by the user in the chart title as well. In cell O1, create some linked 
text that we will use for our chart title. For a recap on how to combine 
text and cells together, see the section on “Linked Dynamic Text Assump-
tions Documentation” in Chapter 3.

	11.	Your formula in cell O1 should look something like this: ="Expenses 
Comparison for "&P2&" and "&Q2."

	12.	Insert a chart title if one is not already showing, and click on the title in 
the chart. Now, go to the formula bar, press “=” and click on cell O1. The 
text in cell O1 will now appear on the chart, as shown in Figure 12.35.

	13.	Try changing the months in cells P1 and Q1, and watch the chart change.

Additional Exercise

Try creating some additional commentary in a cell in your sheet, such as 
the maximum temperature for the selected period. Your formula would be 
="The maximum temperature for the period is "&MAX(P3:Q6).

Add a text box into the chart, by clicking on Insert > Text Box, and then 
link that text box to the single cell in the same way as you linked the chart 
title above. Your chart should look something like Figure 12.36.

Tip
Similar text containing a date can also be created in a single cell, and then linked to a 
title or text box in a chart. If you would like the current date to always show on the chart, 
use the =TODAY() function in your formula, and format it using the TEXT function so 
that it shows the date in your preferred format. In the section on “Linked Dynamic Text 
Assumptions Documentation” in Chapter 3, we used the TEXT function to format com-
mentary as a percentage, but it can also be used for dates.

Use the formula ="Report for "&TEXT(TODAY(),"mmm yy"), and each time 
you open the first file it will give you a title that includes the current month, such as: 
“Report for Oct 16,” assuming the current month was October 2016.

Waterfall Charts

Waterfall charts, also called bridge or stepped charts, have become popular 
in recent years, particularly when displaying the output of a financial model. 
A waterfall chart displays very effectively the incremental impact of each 
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period of time, or unit. It is a type of bar chart where the value of the second 
bar generally begins where the first one finished. To illustrate, a waterfall 
chart might look something like Figure 12.37.

Despite their popularity, waterfall charts are not yet a standard chart 
type in Excel and to create one can get very complicated. Many modellers 
have their own templates for creating them, as—let’s face it—most dash-
board and board papers nowadays normally include some kind of waterfall 
chart! In this chapter, we will cover two methods of creating these kinds of 
charts. First the “dummy stack” method which is simple to create but fairly 
limited in the data it can show as it’s restricted to positive values only. A 
superior method is to use up/down bars which are a little trickier to build, 
but far more versatile in the data it can display.

If the incremental cash amounts for each month are always positive, 
this makes a waterfall chart very simple and will only take a few minutes 
to build, as there are no values below the x-axis. First, we’ll take a look at 
creating a very simple waterfall chart using the dummy stack method, then 
we’ll tackle some more complex charts using up/down bars.

Creating a Basic Waterfall Chart Using the  
Dummy Stack Method

Let’s say you have a forecast for incoming cash for the next six months (see 
the data list that follows).
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$400,000

$350,000

$300,000

$250,000

$200,000

$150,000

$100,000

$50,000

$0
Sales COGS Wages Property

Company Profit Waterfall

Overheads Profit

Figure 12.37  Completed Company Profit Waterfall
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Month Profit

Jan $250

Feb $200

Mar $1,000

Apr $120

May $650

Jun $800

You could forecast it as a cumulative bar chart. See Figure 12.38.
But we’d like to see the incremental contribution of each month indi-

vidually, which will add a new dimension to the analysis.
Contrary to popular belief, you don’t need fancy software to build a ba-

sic waterfall chart. They are really not that difficult to build in Excel and are 
achieved with a few little tricks, as shown in the following list of 11 steps.

	 1.	Open a blank worksheet and start by entering the dates and your cash 
amount in columns A and C as shown, leaving column B blank.

	 2.	In column B, we need to create a dummy series, or “dummy stack,” 
which will be used to push each cash series bar up to where the last one 
ended. So column B will contain the cumulative balance from the previ-
ous period. You’ll see what I mean in a minute.

	 3.	We need to make cell B3 a cumulative balance, so the formula in cell 
B3 should be =B2+C2. Copy B3 down to B7. Let’s label it the Base 
column because it’s effectively where the bottom of each column starts. 
It should now look something like Figure 12.39.

Figure 12.38  Cumulative Bar Chart
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	 4.	We can now create a stacked bar chart from this data. The easiest way 
to do this is to highlight the whole range A2:C7 and create the chart.

	 5.	Select the stacked column from the column section on the Insert tab (or the 
Charts tab in Excel for Mac 2011) and the chart will appear automatically.

The chart should now look something like this (although the colours 
and background might look a little different if you are using an older 
version of Excel). See Figure 12.40.

	 6.	Click on the series legend and delete it.
	 7.	Change the title to “Cash Forecast Waterfall.”
	 8.	Click on the bottom series and change the series fill colour of the bars to 

white or no fill by right‐clicking and selecting Format Data Series. You may 
also like to edit the colour of the chart series that is showing on the chart.

Figure 12.39  Basic Waterfall Chart Formulas

Figure 12.40  Draft Basic Waterfall Chart
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Figure 12.42  Completed Basic Waterfall Chart

	 9.	You can remove the background gridlines by clicking on them and deleting.
	10.	If there is a border around the white series, you can remove this by go-

ing into Format Data Series again and selecting the No Border option.
	11.	Your waterfall chart should look something like Figure 12.42.

The method described above is a very simple method of creating a wa-
terfall chart, but it only works when the incremental cash amount is posi-
tive. Let’s look at some more complex examples.

Creating a Waterfall Chart Using Up/Down Bars

What if your cash forecast changed, however, and in April you are expecting 
a poor month, with a loss amount of $500? See the following list of data:

Month Profit

Jan $250

Feb $200

Mar $1,000

Apr ($500)

May $650

Jun $800
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Figure 12.43  Incorrect Waterfall Chart (with Positive and Negative Values)

Simply changing the data on your existing waterfall chart model will 
not display the chart correctly. Entering a negative value will cause the series 
to display below the x‐axis, which is not correct. See Figure 12.43.

There are a few ways of correcting this, and most methods can get very 
complicated and difficult to maintain. You can find additional waterfall 
chart templates, along with the accompanying models to the rest of the 
screenshots in this book, at www.plumsolutions.com.au/book. If we con-
tinue with the stacked column method for this example, the formulas get 
quite complicated. Below is a completely different method of 10 steps to 
create a waterfall chart using line charts and up/down bars, which is a far 
simpler and more robust method.

	 1.	Set up your data in vertical rows like we did in the last example, except 
this time we don’t need to leave column B blank for the dummy stack.

	 2.	This time, we need to calculate the “Upper” and “Lower” points for 
the boundaries of our Up/Down Bars. To create the Upper number, 
create a cumulative formula in column C. See section on “Calculating 
Cumulative Totals” in Chapter 9 if you need a refresher on how to do 
this. Your formula in cell C3 should be =SUM($B$2:B3). Copy it down 
the column and your model should look something like Figure 12.44 
so far.

	 3.	Now we can calculate the Lower number by subtracting the Cash 
amount from the Upper number. Your formula in cell D2 should be 
=C2‐B2. Copy it down the column.

http://www.plumsolutions.com.au/book
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	 4.	Next, create a line chart using the Upper and Lower numbers. We don’t 
need to show the cash amount on the chart. The easiest way to do this 
is to hold down the control key to highlight nonconsecutive ranges, and 
then create the line chart. Your model should look something like Figure 
12.45 so far.

	 5.	Click on the series legend and delete it.
	 6.	Change the title to “Cash Forecast Waterfall.”
	 7.	Now add the up/down bars to the line chart by clicking on the chart, 

and select Up/Down Bars from the Chart Elements option that ap-
pears, if you are using Excel 2013. For previous versions of Excel, 
then choose Up/Down Bars from the Layout tab on the Ribbon that 
appears when the chart is selected. For Excel 2011 on Mac, choose the 
Chart Layout tab to access the Up/Down Bars in the analysis section 
of the Ribbon.

	 8.	The up/down bars will appear between the line series, as shown in 
Figure 12.46.

	 9.	Click on each line, right‐hand click and select Format Data Series. 
Under Line or Line Color, select No Line. On Excel 2011 for Mac, 
Control+Click each line, go to Format Data Series, and under the 
Line option on the dialog box change Color from Automatic to No 
Line.

	10.	Change the colour of the bars (they automatically default to black and 
white) if you wish. This cannot be done through the colour scheme, 
so you need to select each series and manually change the colour, 
because they are not ordinary series; rather they depict the differ-
ence between the two lines. Although this looks like a column chart, 
it is still in fact a line chart! Your chart should look something like  
Figure 12.47.

Figure 12.44  Using a Cumulative Formula to Create the Upper Limit for the 
Waterfall Chart
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Creating a Complex Waterfall Chart (with Positive and 
Negative Values Crossing the X-Axis)

You may have noticed that the charts we created above all remain as posi-
tive total values. The dummy stack method will simply not work if the col-
umns are below the x‐axis. To create a waterfall chart that will handle both 
positive and negative values, as well as a balance that crosses the x‐axis 
using the dummy stack method, we’d need to create much more complex 
calculations. Fortunately, the up/down bar method is much simpler.

Using exactly the same method as described above, we can create a 
more complex waterfall chart that includes both positive and negative val-
ues, and crosses the x‐axis. See Figure 12.48 for the completed chart.
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Cash Forecast Waterfall

Figure 12.46  Adding the Up/Down Bars between the Series
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Figure 12.47  Completed Waterfall Chart Using Up/Down Bars
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Summary

Presenting the completed model is a part of the model‐building process that 
is typically not done well by most financial modellers. The majority of the 
focus has been on the building, structure, design, and layout, and on getting 
accurate calculations and results.

When senior managers or clients commission a financial model to be 
built, they are less interested in the structure or calculations of the model 
than they are in the output and the results of scenario analysis and sensitivity 
testing. Quite often the modeller does not consider how to best present and 
communicate these results to senior managers or clients.

It’s important that at the end of the model‐building process the modeller 
spends some time thinking about what the viewer of the model needs to 
see, whether it is a report, chart, or table, and how best to communicate 
both verbally and visually the methodology, assumptions, and results of the 
model in the clearest and most informative way.
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 Welcome to the website to accompany  Using Excel for Business Analysis: 
A Guide to Financial Modelling Fundamentals, Revised Edition  by 

Danielle Stein Fairhurst, located at  www.wiley.com/go/steinfairhurstrevised . 
The content of the website consists of several documents that supplement 

the information in the book, including additional instructions, materials, 
downloads, and models. Each chapter (except Chapter   1  ) has its own Excel 
fi le(s), which contain a soft copy of the many screenshots shown throughout 
the book and their applicable page numbers. Using these fi les, you’ll be able
to re‐create many of the modelling situations, tools, and functions described
in the book. Several Excel model exercises and sample models have also
been included. These accompanying fi les have been made freely available by
the author, but they might not make sense without the book.

For updated model templates and additional supplementary downloads, 
please check the author’s website,  www.plumsolutions.com.au/book . Please 
also visit  www.plumsolutions.com.au/elearning  if you would like to register 
for the author’s online courses that correspond to the book. 

The supplementary content available on the website includes:

Downloadable Resources:

 ■ How to create a break‐even chart (Chapter   9  ). 
 ■ Excel versions (Chapter   5  ) contains an overview of the history and key 
differences among the versions of Excel in use for business today.

 ■ Online resources (Chapter   1  ) includes a list of websites, blogs, and 
tutorials for Excel and fi nancial modelling. 

 ■ Shortcuts (Windows version) (Chapter   5  ) is a printable three‐page cheat 
sheet of the most useful shortcuts for fi nancial modelling in Windows
Excel.

 ■ Shortcuts (Mac version) (Chapter   5  ) is as above, but for Excel for Mac. 
 ■ QA log template (Chapter   10  , Appendix 10.1) is a sample template that 
can be used during the model QA process.   

                                                                      About the Website        About the Website

http://www.wiley.com/go/steinfairhurstrevised
http://www.plumsolutions.com.au/book
http://www.plumsolutions.com.au/elearning
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Models:

 ■    Model assessment checklist (Chapter   3  ). 
 ■    Lender repayment calculator (Chapter   7  ). 
 ■    Scenario comparison (including both exercise  and  completed versions) d
(Chapter   11  ).

 ■    Waterfall chart (including both exercise  and  completed versions)d
(Chapter   12  ).

. . . and much more.   



425

Index

A
Absolute referencing, 119–120, 

128, 130, 133–134
Access (Microsoft), 9, 11–12
ActiveX controls, 232–233
Add-ins, 8–15, 28
Aggregation functions, 87, 252
Alignment, 187, 262, 402
Amortisation schedule, 181–182, 

185
Ampersand, 67
Analysis ToolPak, 13
AND, 114–115
Area chart, 373, 377
Array formulas, 240–247, 318, 326, 

344, 346
Assumptions documentation, 6,  

40, 47, 55–56, 59–71, 72,  
77–78, 210

Assumptions layout, 31–33
Audit tool, 14
AVERAGE, 111
AVERAGEIFS, 133, 136–137, 138, 

140
Axes, 330, 370, 371, 379, 394,  

396, 400

B
Balanced scorecard, 6
Bar chart, 196, 370–377, 387,  

401, 410, 411, 412
Benchmarking, 5

Best practice, 3, 6–7, 23, 25–26, 
34, 46–49, 55–72, 78, 82–84, 
119–122, 154, 155, 171, 242, 
249, 283, 291, 315, 328,  
337, 338

Binary code, 230–231
Boolean logic, 230–231
Break-even analysis, 307–313
Break-even point, 307–310
Bubble chart, 378, 380, 400–403, 

405
Bulletproofing, 341
Business case, 2, 20, 34, 59, 67, 78, 

174, 284, 288, 339, 368, 369

C
Cell link, 223, 224, 226, 229, 358, 

360
Cell referencing, 57–58, 119–122, 

128, 296, 305, 331, 332, 356
Charts, 5–6, 8, 36–37, 41–43, 45, 

47–48, 196, 200, 201, 216, 221, 
307, 326, 330, 367–420

Chart type, 202, 372, 373, 374, 
381, 387, 394

Check boxes, 203
CHOOSE, 164–165, 359–360
Circular reference, 90–94, 270
Colour coding, 38, 57–58, 232
Colour scales, 197–199, 200,  

347, 348
Column chart, 375–380
Combination charts, 330, 378, 379



426� index

Combo box drop-down, 341, 357, 
358–360, 362

Communication, 22–24, 25
Compounding, 100, 180–181, 

274–277, 278–283
CONCATENATE, 67
Conditional formatting, 5, 41, 88, 

187, 193–196, 197, 199–200, 
253, 347, 349–353

Control key, 234, 261
Cost of capital, 20, 67, 174–175, 

180, 288–292
COUNT, 108, 109, 111
COUNTIF, 89, 98, 127–131, 134
COUNTIFS, 127, 133–136, 139
Cover sheet, 22–23, 35, 36, 51
CSE formulas, 242
Cumulative totals, 283–284, 415
Currency symbols, 189–191, 400
Custom formatting, 172, 187–193

D
Dashboard, 3, 6, 378, 410
Data bars, 195, 196–197, 200
Data collection, 45–46
Data tables, 40, 243, 318, 344–349, 

362–364
Data validation, 61, 210–213, 215, 

340, 341, 355–360, 363
Data validation drop-down, 357
Data validation input messages, 61
Dates, 35, 63, 166–173, 188, 199, 

277–278, 407, 411
DAY, 170
DB, 298–301
DDB, 301–302
Debt, 93, 174, 180–181, 343
Declining balance value methods, 

300–303
Depreciation methods, 296–300
Design skills, 21–22, 28, 31–33

Developer tab, 216–217, 263
Discount rate, 290–292
#DIV/0!, 49, 90
Donut charts, 377–378, 379
Double declining balance method, 

301–302
Drop-down boxes, 36, 40, 44, 123, 

215, 341

E
Edit links, 52, 84, 85, 326
EFFECT, 181, 278–282
Effective rates, 278, 281
Enter key, 75–76, 322
EOMONTH, 13, 167–168, 305
Equity, 174, 290–292
Error checks, 37, 74–75, 85, 89–90, 

95, 131, 185
Excel 2003 (Microsoft), 12, 14, 

101, 195, 327
Excel 2007 (Microsoft), 11, 14, 95, 

101, 103, 167, 179, 181, 195, 
196, 197, 201, 209, 215, 217, 
252, 324, 375, 385, 387, 399

Excel 2010 (Microsoft), 7, 9, 10, 
11, 15, 16, 101, 102, 200, 217, 
256, 261, 380, 385

Excel (Microsoft) versions,  
44, 189

Exponential operations, 277–278

F
F9, 106, 108, 113, 308, 322, 326
File size, 44, 324, 327
File structure, 52–53
Filter, 57–58, 138–141, 256–262
Financial functions, 99, 174
Fixed declining balance method, 

300
Fixed interest rate, 185



Index� 427

Font, 22, 38, 51, 56, 63, 100, 187, 
192, 195, 230, 267, 347, 354, 
357, 368

Footnoting, 63–64, 64, 72
Format control, 225–227,  

230–231
Formatting, 4–5, 22, 37, 40–41, 

57–58, 63, 68–70, 88, 105, 109, 
158, 171, 172, 187–200, 203, 
232, 252, 253, 266–267, 311, 
325–326, 333, 347, 349–353, 
369, 402

Formatting: basic, 187
Formatting: custom, 68, 188
Form control, 216–217, 218, 232, 

263, 269, 341, 358
Formula, 1, 4–5, 14–19, 25–26, 

32, 34, 38, 46–49, 51, 56–58, 
65, 67–72, 75–80, 81–83, 111, 
113, 116, 166, 173, 175–186, 
193, 195, 205, 207, 208, 210, 
216, 221, 224, 229, 230–231, 
233, 238–247, 252, 270–271, 
280–287, 290–292, 298–310, 
315–323, 344–346, 349–353, 
389–390, 391, 405, 407, 411, 
412, 415, 416

Formula auditing, 92, 316–318, 
321–322, 332, 349

Formula errors, 13, 75–80
Function, 9, 14–19, 22, 25–26, 32, 

44–46, 52, 67–72, 87–91,  
97–119, 187–188, 192, 193, 
195, 201, 217, 224, 229, 232, 
233, 243, 262, 278–280, 286, 
290, 292, 294, 298, 300,  
301–302, 303–305, 318, 326, 
338, 344, 345, 346, 350,  
359–360, 386, 389, 391, 405

Function Wizard, 113
Funding, 94, 339
FVSCHEDULE, 276

G
Golden rules, 33–35
Grouping, 192, 233, 238–239
Growth, 5, 31–32, 59, 66, 73, 82, 

100, 273–279, 290–291, 332

H
Hiding, 200, 204, 210, 233–239, 387
HLOOKUP, 98, 146, 148–152, 286, 

287
Hurdle rate, 174
Hyperlinks, 60, 64–65, 72

I
IF, 24, 56, 86–90, 97–98, 112–118, 

138, 229, 278, 293, 356
IFERROR, 90
In-cell comments, 60–61, 211
INDEX, 84, 97, 153–156, 224, 229, 

286, 295, 326, 360
Indexation, 77, 273, 278, 333, 340
Inflation, 36–37, 74, 278
Information requests, 50–51
Inherited model, 315–316
Input sheet, 36, 37
Interest, 1, 4–5, 9, 27, 73–74, 93–94, 

99, 167, 173–180, 247–249, 262, 
273, 275–277, 278–280, 291, 
310, 339–340, 342–364

Interest calculations, 167
Interest calculations: circular 

reference, 90–94, 270
IPMT, 183–185
IRR, 20, 97–98, 173–180
Iterative calculations, 94–95

K
Key assumptions, 22, 36, 55–56, 

78, 368, 369
KPI, 5



428� index

L
Labelling, 57–58, 331
Line chart, 307–308, 309–310, 

370–371, 373, 388, 398, 417
Linked text, 67, 72
Linking, 3, 6, 47, 52–53, 56–58, 67, 

72, 82–86, 95, 123, 133, 134, 
153–154, 215, 245, 283, 316, 
338, 351

Linking: to external files, 84, 95
Loan calculations, 180–188, 278, 

290
Loan rates, 280
Locking cells, 207
Logic, 2, 20, 24, 28, 31–32, 35–38, 

41, 46–49, 52, 70–72, 78, 98, 
109, 113, 169, 220, 221, 230, 
316, 318, 322, 330–336, 365

Logical functions, 98, 112
Logic errors, 48, 78–79
LOOKUP, 119, 140, 147–150, 

284–287
Lookup functions, 140, 150, 286, 

294

M
Macro, 19, 25, 44, 50, 57–58, 93, 

123, 217, 233, 236–237, 252, 
262–271, 361

Macro: buttons, 262
Management report, 3, 13, 252
Manual sensitivity analysis, 355
MATCH, 84, 147–149, 152, 153, 

154–155, 286, 295
MAX, 98, 110
Methodology, 28, 72, 79–80, 124, 

355, 365, 368, 420
Microsoft products. See Access 

(Microsoft); Excel 2003 
(Microsoft); Excel 2007 

(Microsoft); Excel 2010 
(Microsoft); Power Pivot 
(Microsoft); Project (Microsoft)

MIN, 110, 111
Mixed referencing, 57–58, 120
Model audit, 76, 329
Model layout 16, 32, 45
MONTH, 169

N
#N/A, 90, 146
#NAME?, 320
Named ranges, 14, 47, 84–85, 

122–123, 125–126, 142–143, 
156, 215, 388–391, 396

Nested formulas, 115–119
NOMINAL, 180–181, 278–283, 

331
Nominal rates, 180, 282
NOW(), 166, 187–188
NPV, 35, 67, 99, 173–176, 179, 

290, 292, 369
Number formats, 188, 191
Numeracy, 23–24, 28

O
OFFSET, 157–158, 160, 316, 326, 

389–390, 391
Option button, 216, 221, 222–224
OR, 115
Oral presentation, 367–368

P
Password protection, 204, 237
Payback period, 173–174, 176, 

284–288
Period, 35, 58, 94, 173–180, 

273–274, 277, 280–288, 297, 
300–304, 371, 407, 410, 411



Index� 429

Pie chart, 374, 377, 381
PivotTable, 57–58, 130, 132–133, 

169, 233, 252–262
PMT, 99, 180–188, 247–248, 

344–346, 350
Power Pivot (Microsoft), 7, 9–12, 

13, 15, 17, 101, 102, 127
PPMT, 184–188
Pricing, 2, 20, 32–33, 36–37, 

52–53, 78, 84, 116–119, 150, 
151, 270, 291, 293, 294, 307, 
311, 329

Pricing model, 20, 32–33, 51, 291, 
293

Principal, 180–188, 273, 275
Profit, 2, 5, 20, 25, 35, 70, 93–94, 

388, 398, 405, 410
Progressive tiering table, 294
Project evaluation, 173–180, 288, 

290
Project (Microsoft), 5, 9, 12, 13
Project planning, 5, 12–13, 52
Protection, 49, 204–207, 211, 

237–239, 323, 332
Purpose of model, 336

Q
QA log, 333, 336
QA (Quality Assurance), 48, 

328–336

R
Radar chart, 375
Radio button, 221, 223
Rate, 1, 2–15, 20–24, 31–39, 

46–49, 52, 55–56, 58, 66, 69–70, 
79, 80, 84, 94–95, 100, 108, 
120, 173–180, 247, 248, 249, 
273–284, 288–307, 309–310, 
338–339, 341–351, 354–355

Redundant assumptions, 316
#REF!, 160, 316, 367
Regression, 161
Relative referencing, 120
Remove duplicates, 252
Repayments, 173, 180–188, 

247–248, 344, 350
Ribbon, 93, 172, 187–188,  

201–203, 209, 217, 222,  
250, 256, 262, 265–266, 317, 
318, 321, 323, 326, 380,  
381, 385, 397, 398, 400,  
406–407, 416

ROUND, 192, 193, 195

S
Scenario Manager, 341–344
Scenario methods, 341, 353–354, 

355, 362, 365
Scenarios, 2, 3, 40, 43, 51, 78, 

112, 243, 284, 287, 313, 330, 
337–346, 348–349, 354, 362, 
363–365, 367–368

Security settings, 263, 264, 270
Sensitivity analysis, 4, 56, 78, 241, 

243, 283, 284, 330, 337–340, 
343–344, 355, 367, 369, 387

Sensitivity testing, 369, 420
Shortcuts, 90, 103–106, 318,  

322–323
64-bit Excel, 15–17
Slicer, 101, 256–262
SLN, 298–299, 300, 304–305
Solver, 13, 14
Sparklines, 200–203, 380
Spin button, 36, 224–227
Spreadsheet, 1–5, 7, 13, 22, 25, 28, 

44, 67, 73–74, 76–77, 85, 124, 
188, 195, 205, 269, 276, 316, 
318, 323, 327–330, 343

Spreadsheet Detective, 332



430� index

Stress-testing, 49, 77–78, 337–340, 
344–345, 365

Structured Reference Tables, 57, 
249–251, 255, 261, 389

Styles, 39, 56, 158, 195, 196, 250, 
252, 350

SUM, 97, 108, 115–116, 243, 284, 
287

SUMIFS, 13, 127, 130–133, 
134–136, 138, 140, 252

SYD, 298, 303

T
Tables, 10, 57, 249–251
Tax, 20, 36, 98, 270, 280–281, 291, 

294–297, 306–307
TEXT, 68–70, 160, 407
32-bit Excel, 15–17
Tiering table, 119, 143, 293–294
Time series, 35, 371, 373, 377
TODAY(), 166, 188
Tool selection, 73–74
Trace error, 320
Tracing dependents, 318
Tracing precedents, 317
Training course, 26–27, 28, 262
TRANSPOSE Array Function, 

243–247
TREND, 161, 164
TRIM, 146

U
User-friendly (features), 35, 44, 

70–71, 227, 241, 256

V
Variance analysis, 2, 25, 195
VBA, 13, 228, 237, 262, 266–268, 

357
Version control, 51–53
Visual Basic Editor, 238
VLOOKUP, 19, 90, 97–98, 119, 

141–150, 152, 153, 154, 210, 
248, 293–294, 356, 360

W
Waterfall, 407–419
WEEKDAY, 166, 168, 169
Weighted average cost of capital 

(WACC), 36, 175, 288–292
What-if analysis, 338–339, 343

X
XIRR, 179–180
XNPV, 179–180

Y
YEAR, 169



WILEY END USER LICENSE
AGREEMENT

Go to www.wiley.com/go/eula to access Wiley’s ebook
EULA.

http://www.wiley.com/go/eula

	Using Excel for Business Analysis
	Contents
	Preface
	Chapter 1 What Is Financial Modelling?
	What’s the Difference between a Spreadsheet and a Financial Model?
	Types and Purposes of Financial Models
	Tool Selection
	Is Excel Really the Best Option?
	Evaluating Modelling Tools
	Budgeting and Forecasting
	Microsoft Office Tools: Power Pivot, Access, and Project
	The Final Decision
	32-Bit versus 64-Bit Excel

	What Skills Do You Need to Be a Good Financial Modeller?
	Spreadsheet and Technical Excel Skills
	Industry Knowledge
	Accounting Knowledge
	Business Knowledge
	Aesthetic Design Skills
	Communication and Language Skills
	Numeracy Skills
	Ability to Think Logically

	The Ideal Financial Modeller
	What’s the Typical Background for a Financial Modeller?
	Training Courses
	Do You Really Need an Advanced Excel Course?

	Summary

	Chapter 2 Building a Model
	Model Design
	Practical Example 1—Assumptions Layout
	Practical Example 2—Summary Categorisation

	The Golden Rules for Model Design
	Separate Inputs, Calculations, and Results, Where Possible
	Use Each Column for the Same Purpose
	Use One Formula per Row or Column
	Refer to the Left and Above
	Use Multiple Worksheets
	Include Documentation Sheets

	Design Issues
	The Workbook Anatomy of a Model
	Workbook Anatomy Issues

	Project Planning Your Model
	How Long Does It Take to Build a Financial Model?
	Building a Model under Pressure

	Model Layout Flow Charting
	Steps to Building a Model
	The Streamlined Version
	The Team Version

	Information Requests
	Version-Control Documentation
	File Structure

	Summary

	Chapter 3 Best Practice Principles of Modelling
	Document Your Assumptions
	Linking, Not Hard Coding
	Enter Data Only Once
	Avoid Bad Habits
	Use Consistent Formulas
	Format and Label Clearly
	Methods and Tools of Assumptions Documentation
	In-Cell Comments
	Footnoting
	Hyperlinks
	Hard-Coded Text

	Linked Dynamic Text Assumptions Documentation
	Practical Exercise 1
	Practical Exercise 2
	Practical Exercise 3

	What Makes a Good Model?
	Standards in Financial Modelling

	Summary

	Chapter 4 Financial Modelling Techniques
	The Problem with Excel
	Error Avoidance Strategies
	Avoiding Simple Formula Errors

	How Long Should a Formula Be?
	Linking to External Files
	Why You Should Use Named Ranges in External Links

	Building Error Checks
	Error Check Exercise
	Allowing Tolerance for Error
	Error-Check Alerts
	Avoid Error Displays in Formulas
	Circular References
	How to Fix Circular References
	Circular References in Interest Calculations
	Enabling Iterative Calculations

	Summary

	Chapter 5 Using Excel in Financial Modelling
	Formulas and Functions in Excel
	Excel Versions
	Summary of New Features
	Other Features

	Handy Excel Shortcuts
	Windows Shortcuts
	Mac Shortcuts

	Basic Excel Functions
	SUM()
	MAX ()
	MIN()
	AVERAGE ()
	Combining Basic Functions

	Logical Functions
	IF Statement
	AND Statement
	OR Statement

	Nesting: Combining Simple Functions to Create Complex Formulas
	Nested IF Functions

	Cell Referencing Best Practices
	Relative and Absolute Referencing
	Mixed Referencing
	Mixed Referencing Exercise

	Named Ranges
	Why Use a Named Range?
	Finding, Using, Editing, and Deleting Named Ranges

	Summary

	Chapter 6 Functions for Financial Modelling
	Aggregation Functions
	COUNTIF
	SUMIF
	AVERAGEIF
	COUNTIFS
	SUMIFS
	AVERAGEIFS
	Filtering IFS Functions by a Variable Value

	LOOKUP Formulas
	VLOOKUP (Vertical Lookup)
	HLOOKUP (Horizontal Lookup)
	LOOKUP Function

	Nesting INDEX and MATCH
	Using INDEX and MATCH to Create a More Robust Formula

	OFFSET Function
	Regression Analysis
	Using a FORECAST or TREND Function

	CHOOSE Function
	Working with Dates
	Handy Functions
	Date Format Dilemma

	Financial Project Evaluation Functions
	Net Present Value
	Internal Rate of return
	What Difference Does an X Make? XNPV and XIRR

	Loan Calculations
	Loan-Interest Calculation Method
	Nominal and Effective Interest Rates
	Loan Repayment According to an Amortisation Schedule
	Why Does the Interest Amount Decrease on a Fixed Interest Rate?

	Summary

	Chapter 7 Tools for Model Display
	Basic Formatting
	Custom Formatting
	Custom Currency Symbols
	Useful Formatting Options
	Custom Formatting in Reporting

	Conditional Formatting
	To Apply Conditional Formatting
	To Remove Conditional Formatting
	Data Bars
	Icon Sets and Colour Scales
	Enhancements to Conditional Formatting

	Sparklines
	Editing Sparklines
	Changing Properties for a Group of Sparklines

	Bulletproofing Your Model
	Protection
	Protect the File
	Protect the Structure
	Protect the Worksheet

	Customising the Display Settings
	Useful Display Settings
	Minimising the Ribbon
	Restrict the Work Area
	Restricting Incorrect Data Entry with Data Validations
	Using Validations to Create a Drop-Down List

	Form Controls
	Accessing Form Controls
	Showing the Developer Tab in the Ribbon
	Check Boxes
	Option Button
	Spin Buttons
	Combo Boxes
	Boolean Logic (Binary Code)
	Form Controls versus ActiveX Controls

	Summary

	Chapter 8 Tools for Financial Modelling
	Hiding Sections of a Model
	Columns and Rows
	Sheets
	Errors Caused by Hiding

	Grouping
	Array Formulas
	Advantages and Disadvantages of Using Array Formulas
	Array Formula Uses
	Transposing Data Using an Array

	Goal Seeking
	Structured Reference Tables
	PivotTables
	Using PivotTables in Financial Modelling
	How to Create a PivotTable
	Filtering and Using Slicers

	Macros
	Macro Settings
	Recording and Running a Simple Macro
	Creating Macro Buttons
	Macros in Financial Modelling Case Studies
	Dangers and Pitfalls of Using Macros

	Summary

	Chapter 9 Common Uses of Tools in Financial Modelling
	Escalation Methods for Modelling
	Using Absolute (Fixed) Growth Rate
	Using Relative (Varying) Growth Rates
	Using Exponential Operations on an Absolute (Fixed) Growth Rate
	Practical Usage of Exponential Growth Rates

	Understanding Nominal and Effective (Real) Rates
	Adjusting Loan Rates with NOMINAL and EFFECT Functions

	Calculating Cumulative Totals
	How to Calculate a Payback Period
	Simple Payback Calculation
	More Complex Payback Calculation

	Weighted Average Cost of Capital (WACC)
	How to Calculate the WACC

	Building a Tiering Table
	Flat Tiering Structure
	Progressive Tiering Structure

	Modelling Depreciation Methods
	Why Depreciate?
	Depreciation Methods
	Declining Balance Value Methods
	Calculating Depreciation at the End of Useful Life

	Break-Even Analysis
	Calculating Break-Even Point
	Charting the Break-Even Point
	Calculating Break-Even Using a Formula
	Break-Even Analysis Using Goal Seek

	Summary

	Chapter 10 Model Review
	Rebuilding an Inherited Model
	Removing Redundant Assumptions and Source Data in a Model
	Formula Auditing

	Improving Model Performance
	Reducing File Size
	Improving Excel Memory and File Performance

	Auditing a Financial Model
	Informal Check
	QA Procedure
	QA Logic Testing
	Input Testing

	Summary
	Appendix 10.1: QA Log

	Chapter 11 Stress-Testing, Scenarios, and Sensitivity Analysis in Financial Modelling
	What Are the Differences between Scenario, Sensitivity, and What-If Analyses?
	Scenarios and Sensitivity Analysis in a Business Case
	Stress-Testing a Financial Model versus a Business

	Overview of Scenario Analysis Tools and Methods
	Manual Drop-Downs
	Scenario Manager
	Using Data Tables for Sensitivity Analysis
	Two-Variable Data Table

	Advanced Conditional Formatting
	Comparing Scenario Methods
	Manual Sensitivity Analysis
	Creating Scenarios Using a Two-Variable Data Table

	Summary

	Chapter 12 Presenting Model Output
	Preparing an Oral Presentation for Model Results
	Summarizing and Displaying Model Results

	Preparing a Graphic or Written Presentation for Model Results
	Additional Tips for Charting

	Chart Types
	Choosing a Chart Type
	Summary of Common Charts and Applications
	Detailed Chart Types
	Another Example with More Data

	Working with Charts
	Changing the Type of Chart
	Changing the Source Data
	Saving a Chart as a Template

	Handy Charting Hints
	Dynamic Named Ranges
	Using a Dynamic Range Name in a Chart

	Charting with Two Different Axes and Chart Types
	Creating a Combo Chart in Excel 2013
	Creating a Combo Chart in Previous Versions of Excel

	Bubble Charts
	Creating a Dynamic Chart
	Additional Exercise

	Waterfall Charts
	Creating a Basic Waterfall Chart Using the Dummy Stack Method
	Creating a Waterfall Chart Using Up/Down Bars
	Creating a Complex Waterfall Chart (with Positive and Negative Values Crossing the X-Axis)

	Summary

	About the Author
	About the Website
	Index
	EULA



